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[bookmark: _Toc161996182][bookmark: concept1]Cornerstone HR Overview
Cornerstone HR adds functionality to general Cornerstone system functionality so that organizations can use Cornerstone to manage their employee records. Organizations can continue to feed data from 3rd party systems, but Cornerstone HR's added functionality enables organizations to additionally manage their people data within the Cornerstone system. In addition, employee data can be maintained within the Cornerstone system and updated, when necessary in 3rd party business applications.
Cornerstone HR enables organizations to manage their talent data and their employee data in the same system.
Cornerstone HR features the following:
· Enhanced auditing of user data
· Effective dating of user data
· Forms management
· Employee self-service
· Support for encrypted custom fields
· Reporting
Implementation
The Cornerstone HR functionality is available by request at an additional cost.
Enabling Cornerstone HR requires data migration. Because of this, Cornerstone HR can only be activated by submitting a case to Global Customer Support.
[bookmark: _Toc161996183]Universal Profile - My Absence Home
For organizations that have enabled the e-days Absence Management integration, a My Absence Home page is available in the Universal Profile. This page enables users to view their entitlement balances, such as Vacation balances and Sick Day balances. Users can also request an absence from this page.
The various widgets that appear on this page display the different entitlement types that are available to the user, and vary between organizations. Entitlement balances display as either days or hours depending on how they are displayed in e-days. 
[bookmark: concept2]To access the My Absence Home page, go to Home > Universal Profile. Then, click the Absence tab. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Absence Management – Absence Home – View
	Users with this permission can view the Absence Home page from the Universal Profile. Currently, this permission should only be used by organizations that are using the e-days Absence Management integration. This permission can be constrained by OU, User's OU, User, and User Self and Subordinates.
	Limited Use/Obsolete


[image: ]
Request Absence
Select the Request Absence button to submit a request for time off. This opens the e-days system and automatically logs the use.
Widgets
The various widgets that appear on this page display the different entitlement types that are available to the user, and vary between organizations. Entitlement balances display as either days or hours depending on how they are displayed in e-days. 
My Requests
This section displays the user's previously requested absences, including the status of each request.
[bookmark: _Toc161996184][bookmark: concept3]Benchmark - Overview
With the Benchmark platform, organizations can compare and visualize their performance across key HR metrics with other organizations based on their industry, region, and size, using up-to-date, accurate and consistent data across all of Cornerstone's clients, and across Cornerstone's extensive talent management product lines. Benchmark allows you to discover how well your organization is performing by comparing parts of the organization against itself, or comparing the entire organization against peer organizations. By aggregating workforce, diversity, learning, and recruiting metrics across Cornerstone client portals, you can conduct analysis to help identify gaps in your organization's processes and establish a baseline of information. These data-driven human capital and workforce decisions can help you plan more effectively and strategically for the future in order to achieve a competitive advantage.
Implementation
The Benchmark module is available for purchase, and can be activated only in Production portals. Benchmark can be purchased independent of other product lines, though its value to an organization increases when an organization is using multiple other products, especially Learning and Recruiting. Please contact Global Customer Support for more information and to enable Benchmark.
[image: ]
Benchmark Dashboard
See Benchmark Dashboard on page 5 for additional information.
[bookmark: _Ref355975674][bookmark: _Toc161996185]Benchmark Dashboard
The Benchmark dashboard provides administrators with a high-level overview of various types of internal workforce, learning, and recruiting data, along with how that internal data compares to industry averages. The Benchmark dashboard page displays several report widgets that feature visually dynamic charts and data averages. Clicking individual report widgets allows administrators to view specific types of data in greater detail.
To access the Benchmark dashboard page, go to Admin > Tools > Benchmark.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Widgets
The following widgets are available on the Benchmark dashboard page:
Tenure
The Tenure widget displays the amount of time employees remain at the organization and helps administrators determine whether retention efforts should be improved. If this metric is low, for example, the organization likely experiences a very high rate of turnover and could work to improve retention. If this metric is high, an organization might expect to soon experience a significant knowledge drain from a retiring employee population that has a very high tenure.
The following information is available in the Tenure widget:
· Title - This field displays the title of the widget.
· Report demographic - This field indicates which users are being analyzed in the report.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Tenure chart displays the average time employees remain in their positions, across all selected segments. The bar graph displays individual tenure metrics for your organization vs. other selected segments.
Click the Tenure widget to view and configure segments for the report. See Tenure - Segments on page 48 for additional information.
[image: ]
On Time Completion Rate
On Time Completion Rate helps you identify how well your organization completes training on time, compared to peer organizations. It identifies the types of training that have the highest on-time completion rates. This may help determine whether to keep or acquire certain types of content to effectively drive mandatory training and compliance within your organization.
The following information is available in the On Time Completion Rate widget:
· Title - This field displays the title of the widget.
· Timeframe - This field indicates what span of time is being analyzed in the widget.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The On Time Completion Rate chart displays the average training completion across both your organization and peer organizations. The web graph compares completion rates for various training types for your organization as well as the segments selected.
Click the On Time Completion Rate widget to view and configure segments for the report. See On Time Completion Rate - Segments on page 43 for additional information.
[image: ]
Tenure: Managers
The Tenure: Managers widget displays the median number of years managers have been with the organization at the current point in time. This can help determine how long managers are staying at the organization and whether or not your organization needs to improve retention efforts. A manager is defined as any employee with at least one direct report in the system. 
The following information is available in the Tenure: Managers widget:
· Title - This field displays the title of the widget.
· Report demographic - This field indicates which users are being analyzed in the report.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Tenure: Managers chart displays the average time employees categorized as managers remain in their positions, across all selected segments. The bar graph displays individual tenure metrics for your organization vs. other selected segments.
Click the Tenure: Managers widget to view and configure segments for the report.See Tenure: Managers - Segments on page 52 for additional information.
[image: ]
Tenure: Contributors
The Tenure: Contributors widget displays the median number of years that individual contributors have been with the organization at the current point in time. An individual contributor is considered to be any user without one or more direct reports. This can help you determine how long employees are staying at the organization and whether you need to improve retention efforts. 
The following information is available in the Tenure: Contributors widget:
· Title - This field displays the title of the widget.
· Report demographic - This field indicates which users are being analyzed in the report.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Tenure: Contributors chart displays the average time employees categorized as individual contributors remain in their positions, across all selected segments. The bar graph displays individual tenure metrics for your organization vs. other selected segments.
Click the Tenure: Contributors widget to view and configure segments for the report. See Tenure: Contributors - Segments on page 50 for additional information.
[image: ]
Time to Fill
The Time to Fill widget displays the number of days that a job requisition is open before being filled, during a selected time period. This metric helps identify whether your organization may be taking too long to fill requisitions, or indicate that the organization is hiring candidates too quickly. You can also track time to fill over time to understand whether the organization is trending toward reaching set goals.
The following information is available in the Time to Fill widget:
· Title - This field displays the title of the widget.
· Timeframe - This field indicates the span of time that is being analyzed.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Time to Fill chart displays the average number of days it takes to fill a position across all selected segments. The bar graphs provide a breakdown of how long it takes individual segments to fill a position.
Click the Time to Fill widget to view and configure segments for the report. See Time to Fill - Segments on page 54 for additional information.
[image: ]
Applicant Source 
The Applicant Source widget displays the distribution of applicants with respect to recruiting sources during a selected time period. This helps identify the recruiting sources that attract the highest number of applicants, and also allows you to track your applicants per source over time and determine whether or not you are trending toward reaching set goals. These metrics can also help decide how to utilize recruiting resources to reduce time to hire and improve talent mobility.
The following information is available in the Applicant Source widget:
· Title - This field displays the title of the widget.
· Report demographic - This field indicates which users are being analyzed in the report.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Applicant Source bar chart displays the percentage of applicants for a selected source type, by segment. The My Company line displays where your organization stands amongst its peers.
Click the Applicant Source widget to view and configure segments for the report. See Applicant Source - Segments on page 23 for additional information.
[image: ]
Applicants Per Requisition
The Applicants Per Requisition widget displays the number of applications a job requisition receives during a certain period of time, broken down by recruiting source. This helps identify the median number of applicants per job requisition by recruiting source, to help determine whether or not your organization is leveraging the right sources and using existing sources effectively.
The following information is available in the Applicants Per Requisition widget:
· Title - This field displays the title of the widget.
· Report demographic - This field indicates which users are being analyzed in the report.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Applicants Per Requisition plot chart displays the median number of applicants per requisition, by a selected source type. The My Company line displays where your organization stands amongst your peers.
Click the Applicants Per Requisition widget to view and configure segments for the report.See Applicants per Requisition - Segments on page 26 for additional information.
[image: ]
Span of Control
The Span of Control widget displays the median number and distribution of employees reporting to managers throughout the organization. This helps assess the costs and structure of the management staff. The number of direct reports a manager has is referred to as their "span of control." In terms of organizational design, a small number of direct reports creates a narrow span of control and hierarchical structure, also known as a "tall" organization. Narrow spans of control are more expensive for organizations, but they allow managers to have more time with direct reports, and they tend to spark professional growth and advancements. In contrast, a wide span of control refers to a large number of direct reports supervised by one manager, creating a "flat" organization.
The following information is available in the Span of Control widget:
· Title - This field displays the title of the widget.
· # of Current Direct Reports - This field indicates which how many users classified as direct reports are being analyzed in the widget data.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Span of Control bar chart displays the median number of direct reports for each selected segment.
Click the Span of Control widget to view and configure segments for the report. See Span of Control - Segments on page 46 for additional information.
[image: ]
Training Completion Rate
The Training Completion Rate widget helps identify how well your organization has completed outstanding training, compared to your organization's peers. Furthermore, it helps identify the types of training that have the highest completion rate. This information is valuable when deciding to keep or acquire types of content which drive leaning more effectively within the organization.
The following information is available in the Training Completion Rate widget:
· Title - This field displays the title of the widget.
· Timeframe - This field indicates what span of time is being analyzed in the widget.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Training Completion Rate chart displays the average training completion across both your organization and peer organizations. The web graph compares completion rates for various training types for your organization as well as the segments selected.
Click the Training Completion Rate widget to view and configure segments for the report. See Training Completion Rate - Segments on page 57 for additional information.
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Hiring Seasonality
The Hiring Seasonality widget displays the density of hiring activity time. This helps organizations anticipate how to allocate necessary resources to hire more talent. For example, if hiring seems to increase dramatically in the first quarter of the year, talent management can leverage this metric to allocate recruitment resources ahead of time and effectively reduce time-to-hire for quality candidates.
The following information is available in the Hiring Seasonality widget:
· Title - This field displays the title of the widget.
· Timeframe - This field displays what span of time is being analyzed in the widget.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Hiring Seasonality chart displays the average percentage of hires across all selected segments.
Click the Hiring Seasonality widget to view and configure segments for the report. See Hiring Seasonality - Segments on page 38 for additional information.
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Hiring Source
The Hiring Source widget displays the percentage of distribution for hired applicants, with respect to recruiting sources during a selected period of time. This metric helps identify which recruiting source attracts the highest number of hired applicants, and also allows you to track hired applicants per source over time, and help you understand whether your organization is trending toward reaching set goals.
The following information is available in the Hiring Source widget:
· Title - This field displays the title of the widget.
· Timeframe - This field indicates the span of time that is being analyzed.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Hiring Source bar chart displays the percentage of hired applicants per segment, by source type. The My Company bar graph displays where your organization stands amongst its peers.
Click the Hiring Source widget to view and configure segments for the report. See Hiring Source - Segments on page 40 for additional information.
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Gender Mix
The Gender Mix widget displays the percentage distribution of gender of your employees at the current point in time. This data helps understand the gender diversity at your organization.
The following information is available in the Gender Mix widget:
· Title - This field displays the title of the widget.
· Report demographic - This field indicates which users are being analyzed in the report.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Gender Mix chart displays the gender mix percentage, along with bar graphs representing the gender mix percentage across selected segments.
Click the Gender Mix widget to view and configure segments for the report. See Gender Mix - Segments on page 29 for additional information.
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Gender Mix: Managers
The Gender Mix: Managers widget displays the percentage distribution of manager gender. A Manager is considered to be any user with at least one direct report. This data helps determine the gender diversity of managers at your organization.
The following information is available in the Gender Mix: Managers widget:
· Title - This field displays the title of the widget.
· Report demographic - This field indicates which users are being analyzed in the report.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Gender Mix: Managers chart displays the manager gender mix percentage, along with bar graphs representing the manager gender mix percentage across selected segments.
Click the Gender Mix: Managers widget to view and configure segments for the report. See Gender Mix: Managers - Segments on page 35 for additional information.
[image: ]
Gender Mix: Contributors
The Gender Mix: Contributors widget displays the percentage distribution of individual contributor gender at the current point in time. An individual contributor is considered any user without at least one direct report. This data helps determine the gender diversity of individual contributors at your organization.
The following information is available in the Gender Mix: Contributors widget:
· Title - This field displays the title of the widget.
· Report demographic - This field indicates which users are being analyzed in the report.
· Help Tip - Hover over this icon to read a description of the widget.
· Chart - The Gender Mix: Contributors chart displays the individual contributor gender mix percentage, along with bar graphs representing the individual contributor gender mix percentage across selected segments.
Click the Gender Mix: Contributors widget to view and configure segments for the report. See Gender Mix: Contributors - Segments on page 32 for additional information.
[image: ]
[bookmark: _Ref419743580][bookmark: _Toc161996186][bookmark: _Ref902582526]Benchmark Segments Overview
On the Segments page for each metric, each metric displays applicable charts, and the data is broken down by segment. There are five default segments. By hovering over each segment, with the exception of My Company, you can view the Geography, Vertical, and Size specified for the segment. Additionally, you can configure the segments by clicking them. For example, if you click Immediate Vertical, you can customize the segments as needed and view segment data on a more granular level by adjusting the default selections. 
Header
[bookmark: concept5]The header of the Segments page for each Benchmark widget allows you to view and do the following:
· Drop-down menu: Click the drop-down menu to select a different Benchmark widget to view and configure data for that widget.
· Title - The title of the header displays the name of the current widget you are viewing.
· Learn More - Click the Learn More link to receive a pop-up window with additional information about the type of data the widget displays.
· Export - Click the Export drop-down menu to export the widget data to one of the following document types:
· PDF
· Spreadsheet
Add a Segment 
Click the Add Segment button to add and configure a different section to the widget. Select the link for either Internal Segment or External Segment. Note: If the maximum number of segments has already been selected for the widget, you must delete a segment before adding a new one.
To add a segment
1. In the Title field, click the edit icon and enter a title for the new segment. This title will display in the widget.
2. In the Add Description field, click the edit icon and enter a brief description for the segment.
3. Select one of the following:
·  If you are creating an internal segment, search for and select an organizational unit for each of the following filters:
· Division
· Position
· Location
· If creating an external segment, click the Expand icons and choose a value for each of the following filters:
· Industry
· Region
· Size
4. Click the Add Segment button to add the new segment to the widget.
Segments
Below the header of the Segments page, the different segments that have been selected for the widget display. By clicking a segment, you can edit, copy, and delete the segment if necessary.
· Title - Click the Edit icon next to the title to make edits to the segment title.
· Duplicate - Click the Duplicate button to make a copy of the segment, which can then be edited without impacting the original.
· Delete - Click the Delete button to delete the segment from the widget.
· Description - Click the Edit icon next to the description field to make edits to the segment description.
· Details - The Details section of the segment displays the following data:
· Users - This is the number of users captured by the segment.
· Companies - This is the number of companies captured by the segment.
· Regions - This is the number of regions captured by the segment.
· Industries - This is the number of industries captured by the segment.
· Filters - To make changes to the selected filters, either click the criteria selected for the filter or click the Add icon to select a new unit for the filter.
Default Segments
Five default segments are available. The five default segments include:
· My Company - Includes your organization's entire portal
· Global Segments - Includes all client portals from all geographies, verticals, and sizes
· Immediate Vertical - Includes all client portals from your organization's specific Vertical, of all geographies and sizes
· Immediate Geography - Includes all client portals from your organization's specific Geography, of all verticals and sizes
· Size Group - Includes all portals that are in the same size group as your organization, of all geographies and verticals
[image: ]
Metric Details
The bottom of each Segments page displays a Details section. The Details section shows similar information to the specific charts provided for each metric, but the information is displayed in a table format, broken down by segment. There are four different columns within the Details section:
· Median - This column displays the median of averages value for the segment
· Delta - This column displays your organization's median, minus the segments median
· Percentile - This column displays the percentage where your organization's median rests, compared to other organizations in the segment.
· Rank -This column displays the rank of your organization’s median against the segment
[image: ]
[bookmark: _Ref-2092568263]Applicant Source - Segments
The Applicant Source segments page displays three different charts:
· Segment Data
· Historical Segment Data
· Averages of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept6]To access the Applicant Source segments page, go to Admin > Tools > Benchmark and click the Applicant Source report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration


[image: ]
Segment Data
The Segment Data bar chart displays the percentage of applicants for the source type selected, by segment. The My Company line displays where your organization stands amongst its peers. The Proportion line analyzes the entire distribution’s proportion based on the selected source type. For example, if the Career Site source is selected, and the proportion calculation is 80%, this means that 80% of applicants for that segment apply through the Career Site.
To select a source type, click the Type drop-down menu below the Segment Data chart and choose a source from the list. The chart data will refresh accordingly.
Historical Segment Data
The Historical Segment Data bar chart displays the percentage of applicants by segment, for the selected source type, by the selected time interval. This is the same data displayed in the Segment Data chart above, except the Historical Segment Data chart shows how the data across segments has changed over time.
To change the time interval for the chart, click the By: drop-down menu and choose from the following time intervals:
· Month
· Quarter
· Year
After selecting a new time interval, the chart data will refresh accordingly.
Averages of Portals
The Average of Portals plot provides helpful data when there are portals in the Segment Data chart that might be skewing the data. For example, if there is a segment with five organizations, and four out of the five organizations display an average 40% of applicants applying from a Career Site, and one of the five has many more applicants than the others and shows an average of 85% applying from the Career Site, the organization with 85% of applicants from the Career Site may skew the data. To avoid potentially skewed data, the Averages of Portals graph uses the applicant source percentage of each portal, rather than the applicant source percentage from all applicants in the entire segment. By using the Averages of Portals chart, you can avoid potentially skewed data by viewing the average of averages.
[bookmark: _Ref-692255302]Applicants per Requisition - Segments
The Applicants per Requisition segments page displays three different charts:
· Segment Data
· Historical Segment Data
· Medians of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept7]To access the Applicants per Requisition segments page, go to Admin > Tools > Benchmark and click the Applicants per Requisition report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Segment Data
The Segment Data chart displays the median number of applicants per requisition, by selected source type. The My Company line displays where your organization stands amongst its peers. Applicants per requisition across all portals are included in the segment.
To select a source type, click the Type drop-down menu below the Segment Data chart and choose a source from the list. The chart data will refresh accordingly.
Historical Segment Data
The Historical Segment Data bar chart displays the percentage of applicants per requisition, by segment, for the selected source type, by the selected time interval. This is the same data displayed in the Segment Data chart above, except the Historical Segment Data chart shows how the data across segments has changed over time.
To change the time interval for the chart, click the By: drop-down menu and choose from the following time intervals:
· Month
· Quarter
· Year
After selecting a new time interval, the chart data will refresh accordingly.
Medians of Portals
The Medians of Portals box provides helpful data when there are portals in the Segment Data chart that might be skewing the data. For example, if there is a segment with five organizations, and four out of the five organizations have averages of five applicants per requisition, and one of the five organizations has many more requisitions than the other organizations and also has an average of 50 applicants per requisition, the organization with 50 applicants may skew the data. To avoid potentially skewed data, the Medians of Portals chart uses the median applicants per requisition of each portal rather than the applicants per requisition of all requisitions in the entire segment. By using the Medians of Portals chart, you can avoid potential potentially skewed data by viewing the median of medians.
[bookmark: _Ref-249807133]Gender Mix - Segments
The Gender Mix segments page displays three different sets of charts:
· Gender Mix of Users
· Distribution
· Gender Mixes of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept8]To access the Gender Mix segments page, go to Admin > Tools > Benchmark and click the Gender Mix report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration


[image: ]
Gender Mix of Users
The Gender Mix of Users charts at the top of the page display the gender percentage mix of all users for each segment. The Proportion line is the gender percentage mix of all females subtracted by males for that particular segment. The My Company line indicates where your organization’s gender mix stands compared to the different segments.
Distribution
The Distribution charts provide an overview of the gender percentage differences by segment. If Other displays, this means there is text other than “male,” “female," “m," or “f,” on the employee's user record in the system.
Gender Mixes of Portals
The Gender Mixes of Portals charts display the gender mix percentages between portals. For example, if five portals are included in a segment, the median number shown is the median percentage of those five portals. This data can help determine if a particular segment has the potential to skew the results. For example, if one of the five portals in a segment has many more employees and a significantly different gender mix than the other four portals in the segment, it may help to evaluate the gender mixes of portals for that segment to avoid a potentially skewed distribution. To avoid potentially skewed data, the gender mixes of Portals charts use the gender mixes of each portal, rather than the Gender Mix of all users in the entire segment.
[bookmark: _Ref-641633541]Gender Mix: Contributors - Segments
The Gender Mix: Contributors segments page displays three different sets of charts:
· Gender Mix of Users
· Distribution
· Gender Mixes of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept9]To access the Gender Mix: Contributors segments page, go to Admin > Tools > Benchmark and click the Gender Mix: Contributor report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Gender Mix of Users
The Gender Mix of Users charts at the top of the page display the individual contributor gender percentage mix of all users for each segment. The Proportion line is the gender percentage mix of all females subtracted by males for that particular segment. The My Company line indicates where your organization’s gender mix stands compared to the different segments.
Distribution
The Distribution charts provide an overview of the individual contributor gender percentage differences by segment. If Other displays, this means there is text other than “male,” “female," “m," or “f,” on the employee's user record in the system.
Gender Mixes of Portals
The Gender Mixes of Portals charts display the individual contributor gender mix percentages between portals. For example, if five portals are included in a segment, the median number shown is the median percentage of those five portals. This data can help determine if a particular segment has the potential to skew the results. For example, if one of the five portals in a segment has many more employees and a significantly different individual contributor gender mix than the other four portals in the segment, it may help to evaluate the gender mixes of portals for that segment to avoid a potentially skewed distribution. To avoid potentially skewed data, the Gender Mixes of Portals charts use the individual contributor gender mixes of each portal, rather than the gender mix of all individual contributors in the entire segment.
[bookmark: _Ref383930279]Gender Mix: Managers - Segments
The Gender Mix: Managers segments page displays three different sets of charts:
· Gender Mix of Users
· Distribution
· Gender Mixes of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept10]To access the Gender Mix: Managers segments page, go to Admin > Tools > Benchmark and click the Gender Mix: Managers report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Gender Mix of Users
The Gender Mix of Users charts at the top of the page display the manger gender percentage mix of all users for each segment. The Proportion line is the gender percentage mix of all females subtracted by males for that particular segment. The My Company line indicates where your organization’s manager gender mix stands compared to the different segments.
Distribution
The Distribution charts provide an overview of the manager gender percentage differences by segment. If Other displays, this means there is text other than “male,” “female," “m," or “f,” on the manager's user record in the system.
Gender Mixes of Portals
The Gender Mixes of Portals charts display the manager gender mix percentages between portals. For example, if five portals are included in a segment, the median number shown is the median percentage of those five portals. This data can help determine if a particular segment has the potential to skew the results. For example, if one of the five portals in a segment has many more managers and a significantly different manager gender mix than the other four portals in the segment, it may help to evaluate the gender mixes of portals for that segment to avoid a potentially skewed distribution. To avoid potentially skewed data, the Gender Mixes of Portals charts use the manager gender mixes of each portal, rather than the gender mix of all managers in the entire segment.
[bookmark: _Ref65323083]Hiring Seasonality - Segments
The Hiring Seasonality segments page displays two different charts:
· Heatmap
· Distribution
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept11]To access the Hiring Seasonality segments page, go to Admin > Tools > Benchmark and click the Hiring Seasonality report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration


[image: ]
Heatmap
Hiring Seasonality shows the density of hiring activity over the course of a year. The heatmap shows this data over the span of a year with colored tiles. Each tile is the percentage of hires for the specified time span vs. hires for the year. The darker the tile, the more hires for the selected unit of time.
The following filters can be applied to the heatmap:
· Annual/Trailing - Select the associated tab to switch the heatmap data to either annual data or trailing data.
· Year - Use the navigational arrows on either side of the Year filter to see a specific year's hiring seasonality data.
· Timespan - Select an increment of time from the drop-down menu to see hiring seasonality for the year broken down by any of the following:
· Monthly
· Quarterly
Distribution
The Distribution line chart shows the percentage of hires throughout the entire year, for each segment. Each segment is color-coded.
[bookmark: _Ref-2018963438]Hiring Source - Segments
The Hiring Source segments page displays three different charts:
· Segment Data
· Historical Segment Data
· Averages of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept12]To access the Hiring Source segments page, go to Admin > Tools > Benchmark and click the Hiring Source report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Segment Data
The Segment Data bar chart displays the percentage of hired applicants for the source type selected, by segment. The My Company line displays where your organization stands amongst its peers. The Proportion line analyzes the entire distribution’s proportion based on the selected source type. For example, if the Career Site source is selected, and the proportion calculation is 80%, this means that 80% of hired applicants for that segment apply through the Career Site.
To select a source type, click the Type drop-down menu below the Segment Data chart and choose a source from the list. The chart data will refresh accordingly.
Historical Segment Data
The Historical Segment Data bar chart displays the percentage of hired applicants by segment, for the selected source type, by the selected time interval. Month, Quarter, or Year. This is the same data displayed in the Segment Data chart above, except the Historical Segment Data chart shows how the data across segments has changed over time.
To change the time interval for the chart, click the By: drop-down menu and choose from the following time intervals:
· Month
· Quarter
· Year
After selecting a new time interval, the chart data will refresh accordingly.
Averages of Portals
The Average of Portals plot provides helpful data when there are portals in the Segment Data chart that might be skewing the data. For example, if there is a segment with five organizations, and four out of the five organizations display an average 40% of hired applicants applying from a Career Site, and one of the five has many more hired applicants than the others and shows an average of 85% applying from the Career Site, the organization with 85% of hired applicants from the Career Site may skew the data. To avoid potentially skewed data, the Averages of Portals graph uses the hired applicant source percentage of each portal, rather than the hired applicant source percentage from all hired applicants in the entire segment. By using the Averages of Portals chart, you can avoid potentially skewed data by viewing the average of averages.
[bookmark: _Ref-9694458]On Time Completion Rate - Segments
The On Time Completion Rate segments page displays three different charts:
· Segment Data
· Average Completion Rates
· Averages of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Segments Overview.
[bookmark: concept13]To access the On Time Completion Rate segments page, go to Admin > Tools > Benchmark and click the On Time Completion Rate report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Segment Data
The Segment Data chart displays the average percentage of training completed on time for organizations by segment. Each segment is a distribution of the on-time training completion rates of training across all portals. The My Company line displays where your organization's on-time training completion falls amongst its peers.
To select a training type, click the Type drop-down menu below the Segment Data chart and choose a training type from the list, or choose All to include all training types. The chart data will refresh accordingly.
Average Completion Rates
The Average Completion Rates bar chart shows the average on-time training completion for your organization vs. the segments selected, broken down by the selected time interval. The Average Completion Rates chart displays the same data as the Segment Data chart above, except it shows how the data across segments has changed over time.
To change the time interval for the chart, click the By: drop-down menu and choose from the following time intervals:
· Month
· Quarter
· Year
After selecting a new time interval, the chart data will refresh accordingly.
Averages of Portals
The Average of Portals plot provides helpful data when there are portals in the Segment Data chart that might be skewing the data. For example, if there is a segment with five organizations, and four out of the five organizations have on-time training completion averages of 30-50%, and one of the five has many more on-time completions than the other portals and also has an average on-time completion rate of 100%, the organization with the 100% on-time completion rate may skew the average on-time training completion. By using the Averages of Portals chart, you can avoid potential outliers, as this data shows the average of averages. To avoid potentially skewed data, the Averages of Portals chart uses the on-time completion rates of each portal, rather than the on-time completion rate of all training in the entire segment.
[bookmark: _Ref-156693988]Span of Control - Segments
The Span of Control segments page displays two different charts:
· Segment Data
· Medians of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept14]To access the Span of Control segments page, go to Admin > Tools > Benchmark and click the Span of Control report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Segment Data
The Segment Data chart displays the median number of direct reports for each segment. The four major sections of the chart, divided by dotted lines, are the quartile groups of the distribution. The stripe through the middle of the chart is the Scale Break. The Scale Break appears when the values on the Y-axis are increasing, denoting a break in continuity. The circle at the top of the chart displays the Outlier Max Value, which is the highest value for the segment. For Span of Control example, it would be the highest number of direct reports one employee has, in one organization.
Medians of Portals
The Medians of Portals chart provides helpful data when there are portals which have the potential to skew the Segment Data chart. For example, if one of the five portals in a segment has many more direct reports per user and far more users than the other four portals in the segment, it may help to evaluate the Medians of Portals for that segment and avoid a potentially skewed distribution. To avoid potentially skewed data, the Medians of Portals chart uses the median spans of each portal, rather than the spans of all managers in the entire segment.
[bookmark: _Ref-573246707]Tenure - Segments
The Tenure segments page displays two different charts:
· Segment Data
· Medians of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept15]To access the Tenure segments page, go to Admin > Tools > Benchmark and click the Tenure report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Segment Data
The Segment Data chart displays the median number of years employees stay with an organization. The Median line is the median number of years for all organizations’ users within the segment. The stripe through the middle of the chart is the Scale Break. The Scale Break appears when the values on the Y-axis are increasing, denoting a break in continuity. The circle at the top of the chart displays the Outlier Max Value, which is the highest value for the segment. For Tenure, the Outlier Max Value would be highest number of years for one organization, within the segment.
Medians of Portals
The Medians of Portals chart provides helpful data when there are portals in the Segment Data chart that might be skewing the data. For example, if there is a segment with five organizations, and four out of the five organizations has a median employee tenure of three years, and one of the five organizations has many more users than the others and also has a median employee tenure of 20, the larger organization may skew the data for a segment. To avoid potentially skewed data, the Medians of Portals chart uses the median tenures of each portal, rather than the tenures of all users in the entire segment. By using the Medians of Portals, you can avoid potentially skewed data, since it displays the medians of medians.
[bookmark: _Ref-914181751]Tenure: Contributors - Segments
The Tenure: Contributors segments page displays two different charts:
· Segment Data
· Medians of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept16]To access the Tenure: Contributors segments page, go to Admin > Tools > Benchmark and click the Tenure: Contributors report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Segment Data
The Segment Data chart displays the median number of years individual contributors stay with an organization. The Median line is the median number of years for all organizations’ individual contributors within the segment. The stripe through the middle of the chart is the Scale Break. The Scale Break appears when the values on the Y-axis are increasing, denoting a break in continuity. The circle at the top of the chart displays the Outlier Max Value, which is the highest value for the segment. For Tenure, the Outlier Max Value would be highest number of years for one organization, within the segment.
Medians of Portals
The Medians of Portals chart provides helpful data when there are portals in the Segment Data chart that might be skewing the data. For example, if there is a segment with five organizations, and four out of the five organizations has a median individual contributor tenure of three years, and one of the five organizations has many more individual contributors than the others and also has a median individual contributor tenure of 20, the larger organization may skew the data for a segment. To avoid potentially skewed data, the Medians of Portals chart uses the median individual contributor tenures of each portal, rather than the tenures of all users in the entire segment. By using the Medians of Portals, you can avoid potentially skewed data, since it displays the medians of medians.
[bookmark: _Ref274742117]Tenure: Managers - Segments
The Tenure: Managers segments page displays two different charts:
· Segment Data
· Medians of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept17]To access the Tenure: Managers segments page, go to Admin > Tools > Benchmark and click the Tenure: Managers report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Segment Data
The Segment Data chart displays the median number of years mangers stay with an organization. The Median line is the median number of years for all organizations’ managers within the segment. The stripe through the middle of the chart is the Scale Break. The Scale Break appears when the values on the Y-axis are increasing, denoting a break in continuity. The circle at the top of the chart displays the Outlier Max Value, which is the highest value for the segment. For Tenure, the Outlier Max Value would be highest number of years for one organization, within the segment.
Medians of Portals
The Medians of Portals chart provides helpful data when there are portals in the Segment Data chart that might be skewing the data. For example, if there is a segment with five organizations, and four out of the five organizations has a median manager tenure of three years, and one of the five organizations has many more managers than the others and also has a median manager tenure of 20, the larger organization may skew the data for a segment. To avoid potentially skewed data, the Medians of Portals chart uses the median manager tenures of each portal, rather than the tenures of all managers in the entire segment. By using the Medians of Portals, you can avoid potentially skewed data, since it displays the medians of medians.
[bookmark: _Ref1422444905]Time to Fill - Segments
The Time to Fill segments page displays three different charts:
· Segment Data
· Historical Segment Hires
· Medians of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept18]To access the Time to Fill segments page, go to Admin > Tools > Benchmark and click the Time to Fill report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Segment Data
The Segment Data chart displays the average number of days it took to fill a requisition, by segment. The My Company line displays the average number of days it took your organization to fill a requisition, compared to its peers. Requisitions across all portals are included in the segment.
To select a requisition type, click the Type drop-down menu below the Segment Data chart and choose a requisition type from the list. The chart data will refresh accordingly.
Historical Segment Hires
The Historical Segment Hires bar chart displays the average numbers of days to fill a requisition, constrained by the selected time interval. This is the same data displayed in the Segment Data chart above, except the Historical Segment Hires chart shows how the data across segments has changed over time.
To change the time interval for the chart, click the By: drop-down menu and choose from the following time intervals:
· Month
· Quarter
· Year
After selecting a new time interval, the chart data will refresh accordingly.
Medians of Portals
The Medians of Portals box provides helpful data when there are portals in the Segment Data chart that might be skewing the data. For example, if there is a segment with five organizations, and four out of the five organizations have a median of 30 days to fill a position, but one of the five has many more filled positions than the others, and also has a median of 200 days to fill, the organization that takes 200 days to fill positions may skew the data. To avoid potentially skewed data, the Medians of Portals chart uses the median time to fill of each portal, rather than the time to fill of all positions in the entire segment. By using the Medians of Portals chart, you can avoid potentially skewed data, as this chart displays the medians of medians.
[bookmark: _Ref-1846059328]Training Completion Rate - Segments
The Training Completion Rate segments page displays three different charts:
· Segment Data
· Average Completion Rates
· Averages of Portals
In addition to the charts described on this page, each metric's Segments page allows you to view and configure verticals and view metric details. See Benchmark Segments Overview on page 20 for additional information.
[bookmark: concept19]To access the Training Completion Rate segments page, go to Admin > Tools > Benchmark and click the Training Completion Rate report widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration
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Segment Data
The Segment Data chart displays the average percentage of training completions for organizations by segment. Each segment is a distribution of the training completion rates of training across all portals. The My Company line displays where your organization's training completion falls amongst its peers.
To select a training type, click the Type drop-down menu below the Segment Data chart and choose a training type from the list, or choose All to include all training types. The chart data will refresh accordingly.
Average Completion Rates
The Average Completion Rates bar chart shows the average training completion for your organization vs. the segments selected, broken down by the selected time interval. The Average Completion Rates chart displays the same data as the Segment Data chart above, except it shows how the data across segments has changed over time.
To change the time interval for the chart, click the By: drop-down menu and choose from the following time intervals:
· Month
· Quarter
· Year
After selecting a new time interval, the chart data will refresh accordingly.
Averages of Portals
The Average of Portals plot provides helpful data when there are portals in the Segment Data chart that might be skewing the data. For example, if there is a segment with five organizations, and four out of the five organizations have averages of training completion between 30-50%, and one of the five has many more completions than the other portals and also has an average completion rate of 100%, the organization with the 100% completion rate may skew the average training completion. By using the Averages of Portals chart, you can avoid potential outliers, as this data shows the average of averages. To avoid potentially skewed data, the Averages of Portals chart uses the completion rates of each portal, rather than the completion rate of all training in the entire segment.
[bookmark: _Toc161996187]Cornerstone HR: Compensation Management
For organization using Cornerstone HR, administrators with the appropriate permissions can access the Compensation Management page. 
Administrators can access the following pages from the Compensation Management page: 
· Employee Salaries - See Employee Salary Management.
· Currencies - See Compensation - Manage Currency Types .
· Organizations can also configure a data feed to feed currency conversion rates into the system. To enable this functionality, contact Global Customer Support.
· Bonus Types - See Bonus Types.
· Individual Targets - See Individual Targets.
· Salary Structures - See Salary Structures.
To access Compensation Management, go to Admin > Tools > Compensation Management.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Compensation Bonus Types - Manage
	Grants ability to create and manage additional bonus components within the compensation module. This is an administrator permission.
	Compensation - Administration



	Compensation Currency Rates
	Grants ability to define currency conversion rates and decimals of precision. This is an administrator permission.
	Compensation - Administration



	Compensation Individual Targets
	Grants ability to set bonus and equity targets for individual users. With individual targets, adjustment guidelines that have a bonus or equity type component have the option of setting target values to individual targets. This is an administrator permission.
	Compensation - Administration



	Employee Salary Management
	Grants access to the Employee Salary Management page to edit, add, and view users' salaries or rates. This permission can be constrained by OU, User's OU, and User. This is an administrator permission.
	Compensation - Administration


[bookmark: _Toc161996188]Cornerstone HR: User Records Administration - Employee Salary
An Employee Salary icon [image: ] is available in the Options column of User Records Administration page. This option is available to administrators who have permission to view users and manage employee salaries. Selecting this option opens the Employee Salary Management page for the user. There, the administrator can add, remove, and update the user's salaries.
See User Records Administration.
See Employee Salary Management.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Employee Salary Management
	Grants access to the Employee Salary Management page to edit, add, and view users' salaries or rates. This permission can be constrained by OU, User's OU, and User. This is an administrator permission.
	Compensation - Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration


[bookmark: _Toc161996189]Email Triggers for Cornerstone HR
This page contains email triggers that may apply to organizations using the Cornerstone HR solution.
Default Password Administration Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Default Password Email Reminder Template
	This email trigger can be used as a reminder when the default password is nearing expiration. This email is triggered a certain number of days before the default password expires. Administrators can configure when the email is triggered in relation to the default password expiration date. The emails are queued when the default password is set, so it is important to configure this email trigger prior to setting the default password. This email can be configured as a Reminder type email. This email can be sent to a specific administrator user.
	Default Password Administration


Form Management Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Form Approval Completed
	This email is triggered when a form request is completed by the approver. The form request is considered Completed if the request is approved, denied, or denied and returned. The email can be sent to Form Responder, Request Recipient, or a specific user. This email can be configured as a Notification or Reminder type email. This email is active by default.
This email is triggered by the status of the form request, not the status of the form. For example, if the form approval request is denied and returned, the form status is Returned but the email is triggered because the form approval request is considered Completed.
Note: The form responder is the user who submitted the form.
Use Case: This trigger notifies the form responder (user who submitted the form) and approvers that the form approval request is completed.
	Form Management



	Form Approval Required
	This email is triggered when a form request is assigned to an approver. The email can be sent to Request Recipient or a specific user. This email can be configured as a Notification or Reminder type email. This email is active by default and can be found in the Form Management action type section of Email Administration.
Use Case: This trigger notifies approvers that they have a pending form approval request to complete.
	Form Management



	Form Assigned
	This email is triggered when a form is assigned to a user. The email can be sent to Form Assignee or a specific user. This email can be configured as a Notification or Reminder type email. This email is active by default and can be found in the Form Management action type section of Email Management.
Use Case: Use this email to send notifications and reminders to users when forms are assigned.
	Form Management



	Form Completed
	This email is triggered when a form that is associated with a form task is completed. This email is not triggered if the form is not associated with a form task. The email can be sent to Form Assignee, Form Assignee Manager, or a specific user. This email can be configured as a Notification type email. This email is active by default and can be found in the Form Management action type section of Email Management.
Use Case: Use this email to send notifications to users when form tasks are completed.
	Form Management



	Self-Service Form Submitted
	This email is triggered when a self-service form is submitted for the given form. The email can be sent to Approver, Form Respondent, Manager, or a specific user. When a form is submitted via proxy, this email is not sent to the proxy user. This email can be configured as a Notification type email. This email is active by default and can be found in the Form Management action type section of Email Management.
Use Case: Use this email to send notifications when self-service forms are submitted.
	Form Management


Other Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Copy Down Scheduled
	A copy down completely copies your database from one environment to another. The Copy Down Scheduled email is triggered when a copy down is scheduled in the environment in which the email is enabled. This email must be configured and enabled in each environment in which an organization wants to receive notifications when copy downs are scheduled. For example, if a copy down is scheduled in Pilot from Production, the email is only triggered if the email is configured in Pilot. This email trigger ignores deadbox settings.
The following tags are available for this email trigger:
· DESTINATION.ENVIRONMENT
· PORTAL.NAME
· RECIPIENT.FIRST.NAME
· RECIPIENT.LAST.NAME
· REQUESTOR.EMAIL
· SCHEDULE.DATETIME
· SOURCE.ENVIRONMENT
It is highly recommended that the portal name, source environment, and destination environment email tags are included in the email body to ensure it is clear which portals and environments are being impacted by the copy down.
	Other



	Login Message Email
	This email is triggered when a recipient clicks an Action button that is configured in a login message to send an email to the recipient. The Login Message Email can only be added to login messages, which are configured in Login Message Preferences.
	Other



	Recurring Billing Processor Event
	This email is triggered when a user renews a subscription from the transcript page or when a manager assigns a curriculum extension to a user through inventory. This email can be sent to a specific user or the person in the Purchaser role. The user's manager can be copied on the email.
	Other


Planning Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	WFP Not Implemented System Event Email 
	This email is triggered if an event occurring in Planning does not have an associated email action available. This email is a Notification type email.
	Planning



	WFP Plan CoPlanners Changed 
	This email is triggered when the Co-Planners for a given plan are changed, whether that is adding or removing Co-Planners. The email i sent to User assigned as Primary Planner and Users assigned as CoPlanners (new).
The tags in this email reference the given plan, which is the recipient's plan. This email is a Notification type email.
	Planning



	WFP Plan Created
	This email is triggered to notify the user that the plan was created successfully. The email can be sent to User who created plan (owner). This email is configured as a Notification type email.
	Planning



	WFP Plan Due Date Changed
	This email is triggered when the Due date for a given plan is changed. The tags in this email reference the given plan, which is the recipient's plan.
The email is sent to User assigned as Primary Planner and Users assigned as CoPlanners. This email can be configured as a Notification type email.
	Planning



	WFP Plan Primary Planner Changed
	This email is triggered when the Primary Planner for a given plan is changed. The tags in this email reference the given plan, which is the recipient's plan.
The email is sent to User assigned as Primary Planner (new) and Users assigned as CoPlanners. This email can be configured as a Notification type email.
	Planning



	WFP Subplan Accepted
	This email is triggered when the Subplan is accepted by the parent planner. The tags in the email refer to the subplan, not the parent plan.
The email is sent to User assigned as subplan's primary planner and the subplan's CoPlanners. This email can be configured as a Notification type email.
	Planning



	WFP Subplan Assigned To CoPlanner
	This email is triggered when the Subplan is accepted by the parent planner. The tags in the email refer to the subplan, not the parent plan.
The email is sent to User assigned as subplan's primary planner and the subplan's CoPlanners. This email can be configured as a Notification type email.
	Planning



	 WFP Subplan Assigned To Primary Planner 
	This email is triggered a specific user when s/he is assigned as Primary Planner.
The email is sent to User assigned as Primary Planner in this event. This email can be configured as a Notification type email.
	Planning



	WFP Subplan Rejected
	This email is triggered when a subplan is rejected by Parent Planner. The tags in the email refer to the subplan, not the parent plan.
The email is sent to User assigned as subplan's primary planner and the subplan's CoPlanners. This email can be configured as a Notification type email.
	Planning



	WFP Subplan Submitted To Primary Planner
	This emails is triggered as notification that a subplan was submitted and needs review. The tags in the email refer to the subplan, not the parent plan.
The email is sent to User assigned as parent plan's primary planner. This email can be configured as a Notification type email.
	Planning



	WFP Subplan Submitted
	This emails is triggered as confirmation that a subplan was submitted for review. The tags in the email refer to the subplan, not the parent plan.
The email is sent to User assigned as subplan's primary planner and the subplan's CoPlanners. This email can be configured as a Notification type email.
	Planning


System Administration Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Admin Password Change
	This email is triggered when an administrator manually resets a user's password. The user's new password cannot be included in the email. Because of this, the administrator must communicate this password outside of the system. This email can be sent to User or User's Manager.
	System Administration



	Effective Dating Error
	This email is triggered when a user record change that was set with a future effective date attempts to process and an error is generated. The email can be sent as a notification to User, User's Manager, User's Approver, or a specific user.
The EFFECTIVE.DATING.ERROR.DESCRIPTION tag can be included in the email message to include the description of the effective dating error. If there are multiple errors, then each error description is displayed on its own line in the message.
	System Administration



	Forget Password
	If the Password Reset Option in Password Preferences is set to Reset By Email Notification, then the Forget Password email is triggered when a user clicks Forgot Password? on the Login page. This email can be sent to External User or Internal User. If the user clicks Forgot Password? multiple times and a password reset URL is included in the email, then a new URL is generated for each email and the previous URL is no longer valid.
This email must be configured for administrators to select the "Send Password Reset Email to user's email address" option when resetting a user's password on the Admin - Users page.
The PASSWORD.RESET.URL email tag is a link that opens a page on which the user can create a password. If this email is sent multiple times to the same recipient, then this URL is regenerated each time and the previous URL is no longer valid. Also, the password reset URL is only valid for 48 hours. If the user does not reset their password within the 48-hour validity period, then the user must click Forgot Password? again to get a new password reset URL.
Defining Availability
The availability settings do not apply to external users when External User is added as a recipient in the Send To field.
When Internal User is added to the Send To field, the availability settings defined in the Availability field apply to internal users based on the organizational unit (OU) to which they belong. The following rules apply by OU:
	Organizational Unit
	Rule

	Cost Center
	Cost Center if user is part of the Cost Center

	Custom Group
	Custom group if user is part of the Custom Group

	Division
	Division user belongs to

	Grade
	Grade user belongs to

	Location
	Location user belongs to

	Position
	Position user belongs to

	Self-Registration Group
	Self-Registration group if user is part of the group

	User
	User if user is added individually



	System Administration



	LAT Draft Review
	This email is triggered when a learning assignment draft is created, and the following are true:
· The High User Count threshold is exceeded
· The Restrict Submission setting is enabled
· The administrator who created the draft does not have permission to submit the draft
This email is triggered an additional time if an administrator edits and saves the same draft if all of the criteria are still true.
Example 1: Administrator A creates a draft assignment with a user count that is above the High User Count threshold, but the Restrict Submission setting is disabled. The email is not triggered. 
Example 2: Administrator A attempts to create a learning assignment that exceeds the High User Count threshold, and the Restrict Submission setting is enabled. Administrator A does not have permission to submit draft assignments. Administrator A receives the High User Count restriction and the can only save the assignment as a draft, and this triggers the LAT Draft Review email. 
This email can be configured to be sent to Draft Reviewers or specific users. When this email is sent to Draft Reviewers, this includes all administrators who have the Assignment Tool - Submit Draft permission regardless of permission constraints. Administrators may further restrict the recipient list by adding specific users or by restricting with availability.
	System Administration



	New User Record Created (via Add User Page)
	This email can be configured as a notification and is triggered when a new user record is created via the Admin - Users page. This email is not sent to users who are created via a data feed. This email can be sent to the User Created, User Creator, or the User's Manager.
The PASSWORD.RESET.URL email tag is a link that opens a page on which the user can create a password. If this email is sent multiple times to the same recipient, then this URL is regenerated each time and the previous URL is no longer valid. Also, the password reset URL is only valid for 48 hours. If the user does not reset their password within the 48-hour validity period, then the user must click Forgot Password? again to get a new password reset URL.
	System Administration



	Scheduled Report Complete
	Scheduled Report is complete
	System Administration



	Training Deactivation
	This email is triggered when a training item is about to be deactivated. This email is only triggered when the course is set to deactivate on a specific date via the Deactivate this course setting in the Course Catalog > General settings. This email is not triggered when the course is deactivated by via the Active checkbox. The email can be sent to Training Contact and Training Owner. This email can be configured as a Reminder type email. This email is active by default and can be found in the System Administration action type section of Email Management.
Use Case: An administrator would like to be reminded that a training item is set to deactivate on December 31st. The Training Deactivation email is configured to trigger one week before the training item deactivates. When the administrator receives the email, the administrator reviews the training item to determine whether or not to reset the deactivation date, allow the course to become inactive, or remove the deactivation settings altogether.
	System Administration



	Updated Training
	Training has been updated to a new version, or pre-work, post-work, or a prerequisite is has been updated or added to the LO.
This is triggered by the user getting automatically updated to a new version of a LO. This email is only triggered by updates to LOs that are versioned, such as an online course, material, test, or curriculum. This email will not trigger for child LOs when they are versioned; in case of child LO versioning, the email will only trigger for the curriculum on the user's transcript.
The TITLE tag enables email recipients to know which learning object (LO) is updated. This tag displays the name of the LO.
The MATERIAL.START.DATE tag displays the material's start date. If the material has multiple versions, then this tag is specific to the material version. If this field is not defined for the training, then this tag is not included in the email.
The MATERIAL.END.DATE tag displays the material's end date. If the material has multiple versions, then this tag is specific to the material version. If this field is not defined for the training, then this tag is not included in the email.
	System Administration



	User Password Change
	This email is triggered any time a user changes their password. This email can be sent to User or User's Manager.
	System Administration


Universal Profile Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Badge Provided Notification
	This email is triggered when an employee provides a badge for another employee on their Universal Profile - Feedback page. This email is not triggered for the Completed Goal post. This email can be sent as a notification to Feedback Recipient, Feedback Recipient's Manager, or a specific user.
	Universal Profile



	Feedback Provided Notification
	This email is triggered when an employee provides feedback for another employee on their Universal Profile - Feedback page. Feedback can be provided by posting directly to the Feedback page or by commenting on a Feedback post. This email is not triggered when the manager provides feedback to a direct report that is only visible to the user's manager. This email can be sent as a notification to Feedback Recipient or a specific user.
	Universal Profile



	Feedback Request Notification
	This email can be configured as a notification and is triggered when an employee requests feedback from their Feedback page. This email can be sent to a specific user, the Feedback Request Recipient, the Feedback Requester, or the Feedback Requester's Manager.
	Universal Profile


Additional Email Triggers
A full list of all email triggers is also available. See Email Triggers.
Troubleshooting Information
The following pages contain troubleshooting guides for using emails:
· See Troubleshooting Guide - Emails.
· See Email Troubleshooting Guide.
[bookmark: _Ref2014394956][bookmark: _Toc161996190]Cornerstone HR - Load User Data - Overview
Ability to perform Users and OU data loads and feeds using Data Load Wizard (DLW) was deprecated with an end-of-life in the May ‘22 Release for most customers. End-of-support for most customers occurred in the February ‘22 Release and support for defects related to DLW Users and OU loads and feeds also stopped at this time.
Important: For customers using the following Data Load Wizard features that are not available in Edge Import, we do not recommend migration of Inbound Data Feed (IDF) for Users and OUs from Data Load Wizard to Edge Import at this time:
· Sensitive Personally Identifiable Information (SPII) fields - Date of Birth/SSN
Customers using the above features will be informed when these features are available in Edge Import and will be given at least three months to deprecate.
Use the User Data Load for Cornerstone HR, to load multiple effective dated records for each user in a single load, including effective dated records. This functionality only applies to organizations using Cornerstone HR.
Users cannot be created in the system "as of" a point in time; users can only be created "as of" Right Now. To perform a data load of effective dated information, the users must currently exist in the Cornerstone system.
Effective dating is applied to the entire record. It cannot be applied on a field-by-field basis when loading data using the Data Load Wizard.
Backdating user data before 1901 is not supported.
Use Cases
1. Acme Corp. is deprecating an existing HR system that has employee data about the organization for the previous eight years.
2. Jeremy is an administrator at Acme Corp., and he is working migrating data from the HR system to the Cornerstone system.
3. Jeremy exports the data from his legacy HR system using the reporting tool and formats the data to be loaded into the Cornerstone system.
4. With this enhancement, Jeremy can include all eight years of data for his employees in a single load, meaning that it is much easier for him to migrate data from the legacy system into Cornerstone.
Begin Loading User Data
See Load User Data - Step 1 - Get Started (Cornerstone HR).
[bookmark: _Toc161996191]Form Management - Overview
The Form Management functionality provides a fast, intuitive user interface (UI) that allows administrators to create forms to support self-service. Forms can be utilized for requesting changes to User Record data, which is routed through pre-configured approval workflows. Once all approvals are granted, the requested changes are automatically reflected on the User Record.
Administrators can build forms based on the organization’s needs, by including OUs, Standard and Custom Fields. To support the self-service request with additional information, Question Bank fields can be added to provide additional information related to change. Administrators can pre-populate fields with existing User Record information, set fields to read-only, or as mandatory.
Users can initiate forms, for example, changing their home address, or Managers can start forms for their subordinates, for example, in cases of termination. Additionally, administrators can assign forms to users by creating form tasks. These tasks are automatically assigned to the users selected to receive the task.
The Form Management features are part of the employee onboarding process. This process also includes the ability to create onboarding workflows. Workflows are used to manage the onboarding process by creating various tasks, such as filling out forms, which are then completed and submitted by new and transitioning employees.
You can perform the following tasks in Form Management:
· Form Task Administration - Enables administrators to view, create, edit, copy, and delete form tasks. From this page, administrators can also access details of the form task from the Form Task Snapshot page.See Form Task Administration on page 84 for additional information.
· Form management - Provides a simple, intuitive process for creating and managing forms. From the Manage Forms page, administrators can view, create, edit, copy, and delete forms. Additionally,forms can be refreshed to reflect custom field name and translation adjustments which were done after the form is published. See Manage Forms on page 95 for additional information.
· Self-Service Form Submissions:
· Form Approvals Workflows Management - Edit, and copy form approval workflows. You can also check the active status of a workflow.See Form Approvals Workflows Management on page 78 for additional information.
· Action Item Forms - Displays the form tasks for the user to complete. See Action Item - Forms.
· Question Bank - Administrators can create and manage questions for use in any form. See Question Bank Overview (Forms) on page 129 for additional information.
Permissions
The following permissions are part of the Form Management functionality:
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Self-Service - Manage
	Grants access to manage Form Self Service and Self-Service Submissions within Manage Forms. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration



	Form Task Snapshot - Manage
	 Grants access to the Form Task Snapshot functionality within Form Task Administration. This permission cannot be constrained. This is an administrator permission.
	Forms Administration



	Form Task Administration - Manage
	Grants access to the Form Task Administration functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration



	Question Bank - Manage
	 Grants access to the Question Bank functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Management Administration


Availability
Forms are available to organizations that are using Onboarding or Cornerstone HR. For information on Training Forms, select the following link: See Training Forms Administration.
Use Cases
Use Case 1: Updating the personal contact details
Using the Form Management functionality, the HR administrator builds a form with the relevant address and contact Standard fields and makes the form available for all employees to select.
Use Case 2: Updating the bank account details
The HR administrator creates bank account-related Custom fields, builds the form, and publishes the form so that it is available for the relevant group of employees.
[bookmark: _Toc161996192]Form Management - Overview
The Form Management functionality provides a fast, intuitive user interface (UI) that allows administrators to create forms to support self-service. Forms can be utilized for requesting changes to User Record data, which is routed through pre-configured approval workflows. Once all approvals are granted, the requested changes are automatically reflected on the User Record.
Administrators can build forms based on the organization’s needs, by including OUs, Standard and Custom Fields. To support the self-service request with additional information, Question Bank fields can be added to provide additional information related to change. Administrators can pre-populate fields with existing User Record information, set fields to read-only, or as mandatory.
Users can initiate forms, for example, changing their home address, or Managers can start forms for their subordinates, for example, in cases of termination. Additionally, administrators can assign forms to users by creating form tasks. These tasks are automatically assigned to the users selected to receive the task.
The Form Management features are part of the employee onboarding process. This process also includes the ability to create onboarding workflows. Workflows are used to manage the onboarding process by creating various tasks, such as filling out forms, which are then completed and submitted by new and transitioning employees.
You can perform the following tasks in Form Management:
· Form Task Administration - Enables administrators to view, create, edit, copy, and delete form tasks. From this page, administrators can also access details of the form task from the Form Task Snapshot page.See Form Task Administration on page 84 for additional information.
· Form management - Provides a simple, intuitive process for creating and managing forms. From the Manage Forms page, administrators can view, create, edit, copy, and delete forms. Additionally,forms can be refreshed to reflect custom field name and translation adjustments which were done after the form is published. See Manage Forms on page 95 for additional information.
· Self-Service Form Submissions:
· Form Approvals Workflows Management - Edit, and copy form approval workflows. You can also check the active status of a workflow.See Form Approvals Workflows Management on page 78 for additional information.
· Action Item Forms - Displays the form tasks for the user to complete. See Action Item - Forms.
· Question Bank - Administrators can create and manage questions for use in any form. See Question Bank Overview (Forms) on page 129 for additional information.
Permissions
The following permissions are part of the Form Management functionality:
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Self-Service - Manage
	Grants access to manage Form Self Service and Self-Service Submissions within Manage Forms. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration



	Form Task Snapshot - Manage
	 Grants access to the Form Task Snapshot functionality within Form Task Administration. This permission cannot be constrained. This is an administrator permission.
	Forms Administration



	Form Task Administration - Manage
	Grants access to the Form Task Administration functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration



	Question Bank - Manage
	 Grants access to the Question Bank functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Management Administration


Availability
Forms are available to organizations that are using Onboarding or Cornerstone HR. For information on Training Forms, select the following link: See Training Forms Administration.
Use Cases
Use Case 1: Updating the personal contact details
Using the Form Management functionality, the HR administrator builds a form with the relevant address and contact Standard fields and makes the form available for all employees to select.
Use Case 2: Updating the bank account details
The HR administrator creates bank account-related Custom fields, builds the form, and publishes the form so that it is available for the relevant group of employees.
[bookmark: _Toc161996193]Form Approvals Workflows Overview
[bookmark: _Ref24742611]Form Approvals Workflows Management
From the Form Approvals Workflows page, you can view, edit, and copy form approval workflows. You can also check the active status of a workflow. When an approval workflow is added to a form, the form must go through the defined approval process once the form is completed and submitted by the user.
Forms are available to organizations that are using Onboarding or Cornerstone HR. For information on Training Forms, select the following link: See Training Forms Administration.
To access the Form Approvals Workflows page, go to Admin > Tools > Core Functions > Form Management. Then, select the Form Approval Workflows link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration


[image: ]
Create Workflow
To create a new approval workflow, click the Create Workflow button. This opens the Create Form Approval Workflow page. See Create Form Approval Workflow on page 80 for additional information.
Search Workflows
Workflows can be searched by title. To search for a workflow, enter a search term in the Title field and click Search. This filters the list of workflows to match the search terms.
Include Inactive
To include inactive workflows in the table, check the Include inactive option. The page refreshes to update the list to include inactive workflows.
Title/Description/Active
The title, description, and active status[footnoteRef:1] of existing workflows displays in the table. The information in the table columns is defined when configuring the workflow. The Title column is sortable. [1:  Active approval workflows can be used in forms] 

Edit Workflow
To edit the workflow, click the Edit link in the Options drop-down. This opens the workflow for editing. Workflows can only be edited if they have not yet been used in a form. Once they have been used in a form, the Edit option does not display.
Copy Workflow
To copy the workflow, click the Copy link in the Options drop-down. This opens the workflow with all fields copied except the Title field.
[bookmark: _Ref-1948329538]Create Form Approval Workflow
From the Create Form Approval Workflow page, you can build a form approval workflow. This workflow can be used for any form created in Manage Forms, and determines the approval steps required in order for the form to be approved. The approval workflow begins after the form has been submitted by the user and is used to ensure that the user's responses or the requests in the form are considered acceptable to submit.
To access the Create Form Approval Workflow page, go to Admin > Tools > Core Functions > Form Management > Form Approval Workflows. Then, select the Create Workflow button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration
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Title
Enter a title in the Title field, up to 100 characters. This is a required field. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
Description
Enter a description in the Description field, up to 500 characters. This is not a required field. If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
Active
Check or uncheck the Active box. When checked, the workflow can be selected as the approval workflow on a form. When unchecked, the workflow is considered inactive and cannot be used on a form.
Editing Note: Inactivating a workflow does not impact forms to which the workflow has already been added. However, the workflow will no longer be available to add to forms until the workflow is activated.
Add Approval Step
The approval steps make up the workflow of the approval process. Approval workflows must have at least one step and can have up to five steps. Up to two approvers can be added to each step.
To add an approval step:
1. Click the Add Approval Step button. This opens the options for adding an approval step and adding approvers to the step.
[image: ]
2. Click the Select drop-down to choose the approver. You can select from individual users, employee relationships, and organizational units (OUs). At least one approver must be selected. All steps must have at least one approver.
a. Users - Click the Users option. Then, click the Select a user icon [image: ]. This opens the Select a user pop-up from which you can search for and select the approver.
b. Employee Relationships - Click the Employee Relationships option. Then, click the Select an employee relation icon [image: ]. This opens the Select Employee Relationship pop-up from which you can select the relationship from the list. The relationships that display are the standard and custom employee relationships. The user who is defined for the employee relationship is the user who will be the approver. Note: For onboarding users who were external applicants, the employee relationships is the relationship once the user reaches their start date.
c. Organizational Units - Click the Select OU Criteria dropdown and select an OU type. Click the search icon which appears beneath the dropdown. This opens the Select window. Search for and select the specific OU or group you wish to add as an approver to the approval workflow step. For example, if you selected Group from the drop-down, you might search for and select the HR group from the Select Group window. Only one group or OU can be selected at a time. Note: The OU or group you wish to use in an approval step must already be created prior to creating the approval workflow.
3. Click the Add Approver button to add additional approvers to the step. When a step has more than one approver, decide if only one approver or all approvers must approve the form before the approval workflow can move to the next step.
a. Select AND to require that all approvers in the step must approve the form before the approval workflow can move to the next step.
b. Select OR to indicate that any of the approvers in the step can approve the form before the approval workflow can move to the next step.
To add approval steps, click the Add Approval Step button and repeat the steps above.
Move Step Up/Down
Click the Move Up arrow to move the step up in the workflow.
Click the Move Down arrow to the move the step down in the workflow.
Remove Approver
For steps with multiple approvers, you can remove an approver by clicking the Remove Approver button.
Remove Step
Click the Remove icon [image: ] to delete the step from the workflow.
Cancel/Save
Click Cancel to cancel creating/editing the workflow.
Click Save to save the workflow.
Edit Workflow
When editing an approval workflow that has not been used on a form, all fields are editable.
When editing an approval workflow that has been used on a form, only the Active field is editable.
[bookmark: _Ref218569892][bookmark: _Toc161996194]Form Task Administration
Use the Form Task Administration page to view, create, edit, copy, and delete form tasks. From this page, administrators can also access details of the form task from the Form Task Snapshot page.
The form tasks that display on the Form Task Administration page are within the administrator's permission constraints for the permission needed to access the Form Task Administration page. Form tasks that are not within the administrator's permission constraints do not display.
Forms are available to organizations that are using Onboarding or Cornerstone HR. For information on Training Forms, select the following link: See Training Forms Administration.
Note: Launching form tasks can only be done from the Actions tab in Universal Profile. Therefore, Universal Profile must be enabled in the portal in order for users to complete forms.
To access the Form Task Administration page, go to Admin > Tools > Core Functions > Form Management > Form Task Administration.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Task Administration - Manage
	Grants access to the Form Task Administration functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration
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Create Task
Click the Create Task button to create a form task. See Create Form Task - General Information on page 87 for additional information.
Search
Use the Search feature to filter the results in the Form Task table by full or partial task title, task type, task status, and task date range. Click Search to update the results in the table to display matching tasks. Note: If the Employee Onboarding functionality is enabled for the portal, then the date range filter does not display.
If the Employee Onboarding functionality is enabled for the portal, then the following additional filters are available:
· Status - This filter allows the administrator to filter the search results by the status of the task. The following options are available:
· Completed
· Expired
· In Progress
· Queued
· Include Inactive - Check the box to include inactive form tasks in the task table. When the box is not checked, the task table only displays active form tasks.
Form Task Table
The following information displays in the table:
· Task Title - This column displays the title of the task.
· Form Title - This column displays the title of the form included in the task. Note: Only one form can be included in a task, so this column only displays one form title.
· Start Date - This column only displays if the Employee Onboarding functionality is disabled. This column displays the start date for the task.
· Due Date - This column only displays if the Employee Onboarding functionality is disabled. This column displays the due date for the task.
· Date Criteria - This column only displays if the Employee Onboarding functionality is enabled. The information in this column is dependent upon the task type. The following information displays by task type:
· Standard Task Type - For Standard task types, this column displays the assignment from date to the assignment due date.
· Onboarding Task Type - For Onboarding task types, this column displays "Onboarding."
· Status - This column displays the current status of the task. The following are the possible statuses:
· Expired - This status indicates that the task due date has passed.
· In Progress - This status indicates that the task has started but the due date has not yet passed.
· Queued - This status indicates that the task has been saved and is being processed.
· Pending - This status indicates that the task start date has not yet occurred.
· Active - This column indicates whether or not a task is active. The column displays "Yes" for active tasks and "No" for inactive tasks.
· Options - The following are available in the Options drop-down:
· Copy - Click Copy to copy the task. The values in all fields are copied but can be modified.
· Delete - This option is only available if the start date has not yet occurred. Click Delete to edit the task. This opens a confirmation pop-up. Click Yes to delete the task, or click No to cancel the delete action.
· Edit - This option is only available if the start date has not yet occurred. Click Edit to edit the task. See Create Form Task - General Information on page 87 for additional information.
· Inactivate - This option displays if the task is active. Click the Inactivate option to inactivate the task. This opens a warning message pop-up that indicates that inactivating the task removes the task for users who are in an In Progress status. Click Yes to inactivate the task, or click No to cancel the action. For onboarding tasks, if the task is currently assigned and not yet completed, the task is not inactivated for the assignee. For standard tasks, the task is removed from users who have not yet completed the task. For users who have completed the task, the task remains as a completed task. Inactive tasks are not assigned as part of future assignments that include the task. Tasks that are in a Queued status cannot be inactivated.
· Reactivate - This option only displays if the task is inactive. Click the Activate option to move the task to an In Progress status. This reactivates the associated inactive tasks and re-assigns the tasks to users who were previously assigned the task.
· Snapshot - This option is only available once the form is in an In Progress status and is only visible for administrators who have permission to access the Form Task Snapshot page. Click Snapshot to view the Form Task Snapshot page. See Form Task Snapshot on page 93 for additional information.
Back
Click Back to return to the Form Management page.
[bookmark: _Ref-226911135]Create Form Task - General Information
When creating a form task, the first step is to define general information about the task, such as the title, instructions, and start date. In addition, the form that will be used in the task is also selected.
If the Employee Onboarding functionality is enabled for the portal, then a Task Type field also displays. Administrators can then create a normal form or a form that will be used in the onboarding process.
Pre-Step Note: At least one form must be created and published before you can create a form task. See Create Form Overview on page 98 for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Task Administration - Manage
	Grants access to the Form Task Administration functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration
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Complete the following fields on the Create Form Task page:
	Field
	Description

	Title
	Enter a title for the task, up to 100 characters. This is a required field.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 

	Instructions
	Enter instructions for the task, up to 500 characters. This is not a required field.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 

	Task Type
	The Task Type field only displays if the Employee Onboarding functionality is enabled for the portal. This field allows administrators to define the type of task. The following task types are available:
· Standard - When this option is selected, the form is assigned to users on the date in the Assignment Date field. Users can launch the form task from the Actions tab in Universal Profile.
· Onboarding - Note: This option is controlled by a backend setting that is disabled by default. To enable this option, contact your Client Succession Manager or Global Customer Support. When this option is selected, date options are not available in the Date Criteria section. The assignment and due date information is defined outside of the Form Task Administration functionality. When the task is created, the task moves to an In Progress status.

	Start Date
	Enter the start date in the box or use the calendar feature to select a date from the calendar. The start date is the date on which the form is assigned to users. This is a required field.If the Employee Onboarding functionality is enabled for the portal, then the Start Date field is renamed Assignment Date. The field still has the same functionality but displays with a different name.

	Due Date
	Enter the due date in the box or use the calendar feature to select a date from the calendar. The due date is the date on which the form needs to be completed by users. This is a required field.

	Select Form
	This field enables administrators to select the form that will be used for the task. This is a required field. Click the Select Form link to open the Select Form pop-up and select the form. The pop-up only displays forms that have been published. If there are no forms listed in the pop-up, then there are no published forms available. The forms that are available to select are the forms that are within the administrator's permission constraints for managing forms. Forms that are not within the administrator's permission constraints are not available to select.
Once the form is selected, it appears in the Select Form section. An options drop-down displays to the right of the form title, with the following options:
· Edit - Click Edit to change the form that is selected for the task.
· Delete - Click Delete to delete the form from the task.


Next/Cancel
Click Next to go to the next step in the form task.
Click Cancel to cancel creating the form task.
Create Form Task - Availability and Storage
When creating a form task, the second step is to define the availability for the task and the storage destination for the completed form. These options determine the users who will receive the task, as well as where the form will be stored once it is submitted.
If the Employee Onboarding functionality is enabled for the portal, then the availability settings also enable the selected users to add the form to the Transition Workflows page.
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Availability
This is a required field. To define the availability, select an organization unit (OU) from the Select OU Criteria drop-down. All OUs that are available for the portal display in the drop-down. One or more OUs can be selected.
Storage Destination
Section Visibility Note: The Storage Destination section only displays if the form selected for the task is not configured to include a storage destination. The storage destination can be configured on the Storage tab when creating the form in Manage Forms. Forms that are configured as applicant forms are not required to have a storage destination when the form is created.
The Storage Destination section displays on the second step of the form task creation process. This section allows administrators to select the folder in Universal Profile where the form will be automatically stored when submitted. This section is required to be completed.
To define the storage destination, select the Select Folder link. This opens the Select Folder pop-up. All folders that are available display in the Folder Name table.
Note: The folders that are available to select are defined by the administrator in Documents Preferences.
Note about Copying Forms: When copying form tasks from the Form Task Administration page, the folder selection in the Storage Destination section is not copied.
[image: ]
The following information displays in the pop-up:
· Folder Name Filter - Use this option to filter the list of folders by the folder name. The field accepts full or partial names. Click Search to update the list of folders.
· Folder Name Table - This table displays the folders that are available to select. The names of the folders are linked. Selecting the linked folder name closes the pop-up and populates the Storage Destination section with the folder name.
Selected Folder Options
Once the folder is selected, options are available in the options drop-down to edit and delete the selection.
Edit Folder Selection
To change the folder selection, select the Edit option from the options drop-down. This opens the Select Folder pop-up from which to select a different folder.
Delete Folder Selection
To delete the selected folder as the storage destination, select the Delete option from the options drop-down.
Save
Click Save to save the form task. If the form has not been published, a pop-up displays indicating that the form will be locked for edits.
Once the start date occurs for the task, the task is assigned to the users selected in the Availability section. The Form Assigned email is triggered, if the email is configured and active in Email Management. The task appears on the users' Actions tab in Universal Profile and can be launched from there. Once the form is submitted, the completed form can be found in the folder defined in the Storage Destination section.
Note: If the start date is the current date, then the form is assigned once the form is processed. Forms require a short processing time after they are saved.
Note: Launching form tasks can only be done from the Actions tab in Universal Profile. Therefore, Universal Profile must be enabled in the portal in order for users to complete forms.
Cancel/Back
Click Cancel to cancel creating the form task.
Click Back to return to the previous step in the form task.
[bookmark: _Ref1355048862]Form Task Snapshot
The Form Task Snapshot page enables administrators to track the progress of standard form tasks. Administrators can view general details about the form, such as the assigned and due dates, as well as view the completion percentage. Administrators can also view users' completed forms.
Note: The Form Task Snapshot page does not include Onboarding form tasks.
To access the Form Task Snapshot page, click the Snapshot link from the Options drop-down on the Form Task Administration page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Task Snapshot - Manage
	 Grants access to the Form Task Snapshot functionality within Form Task Administration. This permission cannot be constrained. This is an administrator permission.
	Forms Administration



	Form Task Administration - Manage
	Grants access to the Form Task Administration functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration
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Overview
The following information displays in the Overview section:
	Field/Feature
	Description

	Date Assigned
	This field displays the start date of the task.

	Due Date
	This field displays the due date of the task.

	Task Status
	This field displays the status of the task. The following are the possible statuses:
· Completed - This status indicates that all users have completed the task. Completing a task means that the user has completed all required fields on the form and has submitted the form.
· In Progress - This status indicates that the task has started but the due date has not yet passed. Note: The Form Task Snapshot page is only available once a task is in an In Progress status.

	Assignments
	This field displays the number of users to whom the task is assigned.

	Completed
	This field displays the number and percentage of users who have completed the task.

	Completion Progress Chart
	The pie chart displays the percentage of users who have completed the task.


Details
The following information displays in the Details section:
	Feature
	Description

	Search Filters
	Use the search filters to filter the results by task name, status, and start/due date. Click Search to update the results in the Details table.

	Details Table
	The following information displays in the table:
· Name - This column displays the user's name.
· Position - This column displays the user's Position organizational unit (OU).
· Division - This column displays the user's Division OU.
· Status - This column displays the user's status for the task. The possible statuses are Completed, In Progress, and Not Started.
· Submitted - This column displays the date on which the user submitted the form. If the form has not yet been submitted, then "N/A" displays.

	Options
	The following option is available in the Options drop-down:
· View - Click View to open the user's completed form. This option is only available once the user has submitted the form. Note: If custom fields are included on the form, then the custom fields are only visible to administrators who meet the availability criteria for the custom field.

	Back
	Click Back to return to the Form Task Administration page.


[bookmark: _Ref1937426634][bookmark: _Ref2062652826][bookmark: _Ref1673866718][bookmark: _Toc161996195]Manage Forms
The Form Management functionality provides a simple, intuitive process for creating and managing forms. From the Manage Forms page, administrators can view, create, edit, copy, and delete forms. The forms that are available to the administrator is determined by the following:
· Administrators can access the forms they created
· Administrators can access the forms for which they meet the form manager availability criteria as defined by the form creator
· Administrators can access the forms that are within the permission constraints for the manage forms permission
Forms are available to organizations that are using Onboarding or Cornerstone HR. For information on Training Forms, select the following link: See Training Forms Administration.
Note for Proxying as Another User: When using a form for Onboarding, the form cannot be edited when proxying as another user. The form will be read-only.
To manage forms, go to Admin > Tools > Core Functions > Form Management > Manage Forms.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration
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Create Form
Click the Create Form button to create a form. See Create Form Overview on page 98 for additional information.
Search Options
Use the Search feature to filter the results in the forms table. Enter a full or partial form title in the search field, and then click Search. The results in the table update to display matching forms.
Include Inactive
Select the Include Inactive option to display inactive forms.
Select All From This Page/Refresh Published Form(s)
Active and published forms can be refreshed to reflect custom field name and translation adjustments which were done after the form is published.
To refresh forms:
1. Select an option below:
· To select specific forms, select options in the Select column.
· To select all available forms, select Select all from this page. 
2. Select Refresh published forms.
3. Select Close on the confirmation message.
Note: When activating a deactivated form which is already in published status, please make sure to refresh it to reflect the newest custom field configuration.
After a refresh, if you move to another page, all of the selected options are unselected. 
The following custom field settings are excluded from the refresh action on user record custom fields:​
· Read-only​
· Required
Manage Forms Table
The following information displays in the table:
· Title - This column displays the title of the form. This column is sortable.
· Description - This column displays the description of the form. This column is not sortable.
· Created - This column displays the date on which the form was created. This column is sortable.
· Active - This column displays the active status of the form, either Yes or No. This column is not sortable.
· Published - This field indicates whether or not the form has been published, either Yes or No.
Options
The following options display in the Options drop-down:
· Edit - Forms can only be edited if they have not yet been published. Click Edit to edit the form. When editing a form, fields cannot be added or reordered. Only certain fields can be modified. See Create Form Overview on page 98 for additional information.
· Copy - Click Copy to copy the form. If an approval workflow has been configured for the form, then the approval workflow is copied. See Create Form Overview on page 98 for additional information.
Note: When copying forms that include encrypted short text box custom fields, the field is copied if the administrator meets the availability criteria defined for the custom field and if the custom field is active in Custom Field Administration.
Cornerstone HR - Reason for Change Note: For portals with Cornerstone HR enabled, when a form that includes a Reason for Change field is copied, the Reason for Change field is copied to the form, as well as the reasons selected for the field.
· Delete - Forms can only be deleted if they are not published. To delete a form, click Delete. This opens a confirmation pop-up. Click Yes to delete the form, or click No to cancel the delete action.
· Self-Service Form Submissions - This option is only available for published forms and only displays if the associated form is enabled for self service and the administrator has permission to manage form self service. The self service functionality allows administrators to enable a form to be available for users to search for, complete, and submit without the form being assigned to the user. Selecting the option opens the Self-Service Form Submissions page, from which administrators can configure the self service functionality. See Self-Service Form Submissions on page 149 for additional information.
Back
Click the Back button to return to the Form Management page.
Training Resources
· Onboarding Fundamentals - Visit the fundamentals curriculum for Onboarding, where you can learn about how forms can be used in onboarding employees.
· Forms - Feature Focus Playlist
[bookmark: _Ref-229915899]Create Form Overview
The form creation process allows administrators to design forms that can be used for a variety of purposes. Questions are pulled from the Questions Bank and system fields are available to build the basic structure of the form. Formatting options are also available, as well as including a signature field. Once the structure of the form is created, administrators define who can access the form and where the completed form will be stored in Universal Profile.
See the following topics for the steps in creating a form:
· Build Tab - Define General Information
· Build Tab - Define Fields
· Build Tab - Formatting
· Build Tab - Signature
· Access Tab
· Approval Tab
· Storage Tab
Pre-Step Note: Questions must first be created in the question bank in order to include them on forms.
To create a form, go to Admin > Tools > Core Functions > Form Management > Manage Forms. Then, from the Manage Forms page, select the Create Form button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration
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Create Form - Build Tab 
When creating a form, you can configure the form's title, API name, and enter a description. You can also define the Active status of the form and whether or not effective dated changes can be made using the form.
To create a form, go to Admin > Tools > Core Functions > Form Management > Manage Forms. Then, from the Manage Forms page, select the Create Form button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration


Title
 Enter the title, up to 100 characters. The title displays in the administrator's default language. This title automatically displays on the Settings page. This is a required field.
 If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
API Name
This is a required field that is used for third party integration purposes. The content in this field does not display for end users.
You can enter the name manually or let the system generate a name. The name must be unique.
· To manually enter - Enter a unique name. Maximum 40 characters.
· To generate automatically - Click the Generate button. This populates the field with the first 40 characters from the Title field. Spaces display as an underscore. If special characters are used in the Title field, the characters do not display in the Name field.
Once the name is automatically generated, it can be modified manually by entering changes in the field. If the name is deleted from the Name field, the name can be regenerated by clicking the Generate button.
Note: Changes made to the Title field are not automatically populated into the Name field.
Description
 Description for the form. This description is visible to form users. This is not a required field.
 If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
Active
Forms are active by default. Uncheck the Active box to inactivate the form. Inactive forms are not available for use in tasks.
Allow effective dating changes for this form
 The effective date is the date on which the changes from the form are implemented. The effective date can be a date in the future or in the past. This option is unselected by default. When editing a form that has been published, you cannot modify this option. 
Note: This option is only available if effective dating for forms is enabled via a backend setting.
When the Allow effective dating changes for this form option is selected, the following additional options are available that allow the administrator to limit the range of effective dates that may be selected when completing the form. These fields are optional, and values from 0-999 are accepted. The administrator can specify a number of days into the future or past that a user can select as an effective date when completing the form. When limits are specified, the limitations are displayed to the user within the form. 
· From launch, maximum number of days into the future
· From launch, maximum number of days into the past
When this option is selected the following fields appear:
· Effective Date - The Effective Date field cannot be moved, edited, or removed from the form as long as effective dating is enabled for the form. If effective dating is disabled for the form, then the Effective Date field is automatically removed from the top of the form.
· Non-Effective Dated Fields - If any fields are added to the form that cannot be effective dated, the Read-Only and Auto-fill Response options are automatically selected for all non-effective dated fields, and these options cannot be unselected. This also applies to Question Bank questions that are added.
Include Form in Reporting
By selecting this option, administrators can decide per form if the response fields used in a form are reportable. Disabling form fields that are not in use anymore ensures that the number of fields reportable across forms stay below the system limit and ensures that form data updates correctly in reporting. 
· If the response fields should be included in reporting, click the Include form in reporting check-box.
· If the responses for the User Record Custom, Standard and Question Bank fields from the form should not be reportable, uncheck the Include form in reporting check-box.
By default, form fields on all existing and new forms are reportable. 
[bookmark: _Ref-1763610431]Create Form - Build Tab - Define Fields
The Available Fields section on the Build tab enables administrators to add fields to the form. In addition, a few questions can be included from the question bank. Forms must include at least one user field, question, or rich text field.
Editing Note: When editing a form, fields cannot be added or reordered.
To create a form, go to Admin > Tools > Core Functions > Form Management > Manage Forms. Then, select the Create Form button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Completion - View and Edit OU and Employee Relation Fields
	Allow users to view and modify organizational unit (OU) and employee relation fields when completing a form that contains the fields. The constraints on this permission determine which fields the user can view and edit when completing a form. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User Subordinates. This is an end user permission.
	Core



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration



	Grades - View
	Grants ability to view the Grade Organizational Unit throughout the system, such as in availability drop down selectors, when editing users, etc. Those without this permission do not see the Grade OU on any screen. This is primarily an administrator permission, although organizational policy should determine whether the Grade OU should be visible to end users on reporting screens, etc.
	Core Administration
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System Fields
User Standard Fields
Standard fields can be added to forms. 
To add a field, drag and drop the field into the form or click the plus icon to the right of the field title. This adds the field to the form, and the field no longer appears in the User Standard Fields list.
Cornerstone HR - Reason for Change Field
For portals with Cornerstone HR enabled, a Reason for Change field can be added to forms. Only one Reason for Change field can be added to a form.
The Reason for Change field enables administrators to track the reason a change is made to the user record as a result of user data captured on forms, such as changing a user's last name. When users complete the form, they can be required to fill out the Reason for Change field and select the reason that there is a change to their user data. Once the form is submitted and approved (if approval is required), then the system automatically captures the reason for the change in the Modification History section on the User Record page.
Add Field Requirement: For portals with Cornerstone HR enabled, if a standard user field is added to a form, then the Reason for Change field must also be added in order to save the form.
Use Case
Situation
Gayashri has decided to change her name on her employee record to her married name. She needs to ensure that her name is updated in the organization’s system of record.
Process
1. The talent administrator creates an Employee Data Change Form. He includes all pertinent fields, such as First Name, Last Name, and address fields. Because he has added user fields to the form, he also needs to add the Reason for Change field to the form. For the drop-down options on this particular form, he selects the following reasons to be available for users to select: Data Correction, Employee Relocation, and Personal Data Change. He also makes sure to set the form as Self-Service for all employees so that they can easily access the form whenever it is needed. He sets up an approval workflow for the form so that Human Resources can confirm with the employee prior to approving the changes.
2. Gayashri searches for the Employee Data Change Form in Global Search. She fills out her updated Last Name on the form and selects Personal Data Change in the Reason for Change field. Then, she submits the form for approval.
3. Laura, a Human Resources Manager, receives a request for approval of Gayashri's Employee Data Change Form. She quickly confirms with Gayashri that she does indeed want to update her name, and then she approves the form.
4. Gayashri's user record is updated with her new last name. Her user record reflects the change in the Modification History section with Personal Data Change as the reason.
Settings - Select Reasons for Change
Once the Reason for Change field is added, the reasons that will be available to users to select must be defined for the field. To select the reasons:
1. Click the Settings icon [image: ] for the field. This enables the drop-down options to display below the field.
2. Check the box next to each option that you would like to be available for users to select in the drop-down. The options that are available are the active options defined for the field by the administrator in User Preferences. If a reason is inactivated, the reason only displays on published forms if the user has not yet submitted the form.
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User Type and Employment Status
This section is only available to organizations that have the User Type and Employment Status sections enabled in the User Record. In addition, forms with these fields are excluded from onboarding tasks and applicant workflows.
This section only contains one option, User Type and Employment Status. When this option is added to the form, all User Type and Employment Status fields are added to the form. This is because all User Type and Employment Status fields are related. Individual fields cannot be selectively added to the form. 
When a user is viewing the User Type and Employment Status fields within a form, only certain fields are visible depending on the values that are selected in the User Type and Employment Status. For example, the Eligible for Rehire field is only visible if the User Type field is set to Terminated, and the Leave Type field is only visible if the User Type field is set to On Leave.
These fields can be set to Required or Read-Only. Also, they can be set to auto-fill the user's latest response to the field.
User Custom Fields
The User Custom Fields section displays all User custom fields for which the administrator meets the availability requirements. Note: Branched Drop-down and Hierarchy custom fields are currently not supported for Form use.
To add a field, drag and drop the field into the form or click the plus icon to the right of the field title. This adds the field to the form, and the field no longer appears in the User Custom Fields list.
If the field is removed, and at a later time the administrator no longer meets the availability criteria for the field, then the field no longer displays in the User Custom Fields section for the administrator.
Add Field Requirement: For portals with Cornerstone HR enabled, if a custom user field is added to a form, then the Reason for Change field must also be added in order to save the form.
Encrypted Fields
For encrypted user custom fields, when users complete and submit the form, the information they enter into the field will be encrypted. Users can enter a maximum of 50 alphanumeric characters when filling in the field. Data can only be decrypted after the data has been exported via an outbound data feed, and then your private key is used to decrypt the exported data.
Use Case
Scenario
ACME Inc. is a consulting company with many international employees that travel around the globe to meet with clients. As part of their onboarding process, they ask for the new hire passport information so they can ensure they have it on file in the event of travel emergencies.
Enablement
ACME Inc. has contacted CSOD to create a Work Order to enable Encrypted Short Text Box for the User Record Custom Fields. ACME provides CSOD with the Public Encryption Certificate for CSOD to begin the enablement process. Once enablement has been completed, ACME Inc. is ready to start using Encrypted Short Text Box fields on the user record as well as in forms.
Administrator
1. Isadora is an admin at ACME Inc. She wants to ensure ACME can collect Passport Numbers from new hires. She first configures a new custom field for the User Record. She selects the Encrypted User Short Text Box type and names it Passport Number. She proceeds to create other custom fields needed to collect passport information and selects whether they can be regular fields or encrypted depending on the sensitivity of the information.
2. After all the fields that are required are created for the user record, Isadora can start creating the form that needs to be assigned to new hires. She goes to Manage Forms to create a Traveler Information form. She is able to see all the User Record fields she had previously created under the User Custom Fields section of Available Fields. She puts all the necessary User Custom Fields on her form, including Encrypted Fields like Passport Number.
3. Isadora can then configure the onboarding task in Form Task Administration so that she can include the Traveler Information form as a form task in the onboarding workflow that will be assigned to new hires when onboarding is launched.
New Hire
1. Roger is a newly hired consultant for whom onboarding has just been launched. Roger sees on his Actions tab in Universal Profile that he has a task to complete a Traveler Information form.
2. Roger launches the form task and starts to fill out his information. As he fills out the form, he can see the data he has entered for the encrypted user custom fields, such as the Passport Number, in clear text.
3. After Roger has completed the form, he submits it. The data that he has entered in the encrypted user custom fields is then encrypted using ACME's public encryption key.
4. When Roger opens his Snapshot Document folder where his completed Traveler Information form is saved, he can view the responses he has entered for the form he submitted. However, for Roger and any other user who may have access to Roger's Document folder, the responses entered in the Passport Number field and other encrypted user custom fields display as ***** in place of the data that was entered.
Administrator
1. Isadora needs to ensure that the encrypted data in the user record, which was collected via forms, makes it over to the company's HRIS system. She works with CSOD to have the data outputted via an outbound data feed (ODF). The ODF includes the encrypted fields.
2. ACME uses its private decryption key to decrypt the data feed before the data is inputted into the correct fields.
Organizational Units
This section contains all active OU types, including custom OUs. Groups cannot be added to a form. To add a field, drag and drop the field into the form or click the plus icon to the right of the field title. This adds the field to the form, and the field no longer appears in the list.
Once an OU is added to a form, the OU will remain on the form even if it is made inactive. As a result, users may view or provide information for inactive OUs on a form.
Employee Relationships
Employee relationship fields control which users are assigned to a particular role for a user. For example, the Manager employee relationship field controls who is assigned as a user's manager. If an employee relationship field is modified, then the corresponding field on the user's User Record is also updated.
Depending on the configuration of the employee relationship field, these fields can be added to a form to display a read-only view of the employee relationship or allow a user to update the employee relationship.
The following employee relationship fields may be available, and they are displayed in alphabetical order:
· Approver
· Manager
· Custom Relationships
Only active employee relationships are available. If an employee relationship is made inactive, the corresponding field remains on the form until it is removed from the form. At that point, the inactive field cannot be added to the form unless it is made active.
· When a user views a form, only active employee relationships are displayed. Any employee relationships that are inactive are not visible on the form.
Question Bank
If additional information is needed which is not available in the User Record, but is necessary to supplement the form, the Question Bank section enables administrators to configure questions from the Form Management Question Bank.
The Question Bank is organized by the question categories that are configured in the question bank. Each category displays all associated questions that are available to the administrator. The categories that display are the categories for which the administrator meets the availability criteria and that are within the permission constraints for the permission to manage the question bank. The categories for which the administrator does not meet the availability criteria and are not within the permission constraints do not display in the Questions section.
To add a question, click the category name. The questions associated with the category display below the category name. Click the plus icon to the right of the question to add it to the form, or drag and drop the field into the form. Once added, the question no longer appears in the list of questions for the category.
Note: Forms are not intended to be used as surveys to collect a large amount of data via Question Bank fields. The main purpose of Forms is to update User Record data via self-service. Using an extensive amount of Question Bank fields may lead into performance issues.
Reference Letter Forms
When creating a form that will be used to request reference letters, it is recommended that the form include a question that is a Text field question type. The text field allows referrers to copy and paste a reference letter into the field. The text field question may need to be created in the Question Bank by the administrator if the question has not already been created. Text field question types that are used for large amounts of data should be set up as multiline in the Advanced Options section, with character max set to 10,000.
Attachments
The following fields are available in the Attachments section:
· Form Attachment - Add this field to the form to attach a document to a form, which can then be downloaded by users who are completing the form. When this field is added to the form, you can then drag and drop a file into the field within the form builder to attach the document to the form.
· User Attachment - Add this field to the form to enable users to attach documents to the form as they complete the form. Each User Attachment field accepts up to three attachments. This field can be added to a form an unlimited number of times. This field cannot be configured to be auto-populated or read-only. When this field is added to a form, you can configure the following settings for the field:
· Required - Select this option to require users to attach at least one document to the form to complete the form. This option is selected by default.
· Title - Specify a title for the field that will be displayed to end users. This field is required and accepts up to 250 characters.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Description - Specify a description for the field that will be displayed to end users on the form below the field title. This field is optional and accepts up to 250 characters.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Preview [image: ] - When editing the field, select the Gear icon in the upper-right corner of the field to preview the field as it will appear on the form.
· Done - Select this button to save and preview the attachment field configuration.
Effective Dating Note: Attachments can be added to an effective dated form. However, the attachment data is not effective dated.
Reorder Fields
To change the position of the field in the form, click the field and drag and drop it anywhere within the form.
Additional Options
Once a field or question is added, the following options may display :
[image: ]
 
Settings
Click the Settings icon [image: ] to open the following options:
· Required - This option is selected by default. When selected, end users are required to complete the field. When unchecked, the field is not required to be completed. This option cannot be selected if the Read-Only option is selected.
· Read-Only - When this option is selected, the field is read-only and cannot be filled out by end users. This option cannot be selected if the Required option is selected. This option is not available for encrypted user custom fields.
· Auto-fill Response - When this option is selected, the field is auto-filled with the end user's current data. This option is selected by default.
[image: ]
Move Up/Down
Use the Up [image: ] and Down [image: ] arrows to move the fields to the desired location on the form. Fields can be moved above and below page breaks.
Remove
Click the Remove icon [image: ] to delete the field. Once removed, the field reappears in the User Fields or Question Bank list and can be added back to the form.
Cancel/Save/Save and Continue
Click Save and Continue to move to the next step of creating the form. The settings defined on the previous step are saved.
Click Save to save the form without publishing and return to the Manage Forms page. The form settings are saved, and the administrator can return to the form to add or change settings, and then publish the form.
Click Cancel to cancel creating the form.
Create Form - Build Tab - Formatting
When creating a form, administrators can define formatting options on the Build tab, which include adding page breaks, text fields, and attachments.
To create a form, go to Admin > Tools > Core Functions > Form Management > Manage Forms. Then, from the Manage Forms page, select the Create Form button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration
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Formatting
The Formatting section includes the following options:
· Page Break
· Rich Text
Page Breaks
Page breaks can be added by clicking the plus icon to the right of the Page Break option. Page breaks allow the administrator to turn the form into a series of pages. Each page break represents a single page in the form. 
When page breaks are added, they display at the bottom of the form. Use the Up [image: ] and Down [image: ] icons to move the page break to the desired location.
Click the Remove icon [image: ] to delete the page break. All fields within the page break are joined with the previous page.
Rich Text
Text fields can be added by clicking plus icon to the right of the Rich Text option. Text fields are text boxes in which administrators can enter text content. Basic formatting options are available for text fields, such as bold, italics, and underlining. There is no character limit for the field.
Note: The Rich Text field does not support HTML text. It is recommended that you enter the text into the Rich Text field directly or copy and paste the plain text into the rich text editor, and apply formatting using the available rich text formatting options.
· To check the spelling of the text box contents, click the ABC icon [image: ] in the text box toolbar. This opens the Spell Checker pop-up. 
· Once the text is added to the field, click Done or click Cancel to cancel the changes to the field. 
· Click the Settings icon [image: ] to edit the field. Use the Up [image: ] and Down [image: ] icons to position the field in the desired location. 
· Click the Remove icon [image: ] to delete the field.
Attachment
This section enables administrators to add file attachments to the form. The Attachment section includes a Select File field. When the Select File field is added to the form, administrators can drag and drop files to the form or upload files using the Select a file button. The Select File field can be added to the form multiple times.
Add Attachments - Select a File
To add attachments using the Select a file button:
1. Add the Select File field from the Attachment section. This adds an Attachments section to the form.
2. Click the Select a file button. This opens a file upload pop-up from your computer.
3. Search for and select a file, up to 30 MB. The file name cannot exceed 50 characters and cannot include invalid characters. Accepted file types are ARF, AVI, BMP, DOC, DOT, DOTX, FLV, GIF, JPEG, JPG, M4A, DOCX, M4V, MID, MOV, MPEG, MPG, MPP, MP3, MP4, PDF, PNG, PPS, PPSX, PPT, PPTX, RM, TXT, VSD, WAV, WMA, WMV, XLS, XLSX, and ZIP.
4. Once selected, the file is added to the Attachments section.
5. Click Done to add the section to the form.
6. Click Cancel to cancel adding the section to the form.
To add more attachments, repeat the steps above.
Add Attachments - Drag and Drop Files
Files can be dragged from anywhere on the administrator's computer and dropped into the Attachments section.
Collapse Attachments Section
To collapse the Attachments section, click the Options icon [image: ].
Move Attachments Section
To move the Attachments section, click the Up [image: ] or Down [image: ] arrow to place the section in a different location on the form.
Delete Attachments Section
To delete the Attachments section, click the Remove icon [image: ].
Next Step
Prior to moving to the next step of creating the form, at least one file must be uploaded when the Select File field is added to the form.
Create Form - Build Tab - Signature
The Signature section includes the E-Signature option, which can be added to forms to enable users to sign the form electronically.
Note: Forms that include the E-Signature option cannot be assigned to applicants (i.e., via the Assign Form action on the Manage Applicants page). This is because the applicant may not have the necessary username and password information that is necessary to properly e-sign a form.
To create a form, go to Admin > Tools > Core Functions > Form Management > Manage Forms. Then, from the Manage Forms page, select the Create Form button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration


[image: ]
Signature Section
The Signature section includes the Sign Button field. When added to forms, this field allows users to electronically sign the form. The Sign Button field can be viewed by clicking the drop-down in the E-Signature option.
Add Field
To add the Sign Button field to the form, select the plus icon to the right of the field name. When the form is launched, the sign button always displays at the bottom of the form. The name of the button on the form is Sign.
Manage Applicants Page - Reference Letter Forms Action
When creating a form that will be used to request reference letters, the form cannot include the Sign button. Forms that include an e-signature cannot be used for the Request Reference Letter action.
Manage Applicants Page - Assign Forms Action
When assigning forms to applicants on the Manage Applicants page, the form cannot include the Sign button. This is because the applicant may not have the necessary username and password information that is needed to properly e-sign a form.
Remove Field
The Sign Button field can be removed from the form by selecting the Remove icon [image: ].
Create Form - Access Tab
From the Access tab, administrators can modify the form title, as well as define the availability settings, enable self service, and access the self service form link.
The Self-service settings are only available to admins with Form Self-Service - Manage permission. Self-service functionality is only available to organizations using Cornerstone HR. See Self-Service Form Submissions on page 149 for additional information.
To create a form, go to Admin > Tools > Core Functions > Form Management > Manage Forms. Then, select the Create Form button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Proxy Completion - Manage
	Allows administrator to configure the Proxy Availability settings for a form. These settings determine which users can complete the form on behalf of other users and for which users they can complete the form. This permission can be constrained by OU, User's OU, User, and Employee Relationship. This is an administrator permission. 
	Forms Administration



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration


[image: ]
Title
The form title displays at the top of the page. The title can be modified.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
Form Manager Availability
This section enables administrators to define the users who have access to manage the form created by the administrator. Users who have access to manage the form can edit, copy, and delete the form.
This is a required field. When editing the form, this field can be modified.
To define the form manager availability:
1. Select the organizational unit (OU) from the Select OU Criteria drop-down.
2. Click the Select icon [image: ] to open the Select pop-up.
3. Select the OU and/or specific users from the pop-up. The selection appears below the drop-down. An unlimited number of OUs and users can be defined.
Availability
This section requires administrators to determine which users have the ability to assign the form and which users have the ability to complete the form by Self Service. 
Note: The ability to configure whether users have the ability to complete this form by Self-Service. Also, this ability is only available to administrators who have permission to manage self-service forms. 
Select an organizational unit (OU) from the Select OU Criteria drop-down, or define individual users to whom the form will be available. For users who do not meet the availability criteria, the form is not available for searching in Global Search. The constraints on the administrator's permission to manage forms determine which OUs are available to select.
The following options are available in the table for each OU or user that is added:
· Assign Task - This option is selected by default. When this option is selected, users who are in the selected criterion are able to assign the form to other users.
· Self Service - This option is only available to administrators who have permission to manage self-service forms, and it is selected by default. When this option is selected, users who are in the selected criterion are able to access this form on demand and complete the form for themselves or other users. The settings in the Proxy Availability section are used to configure the self-service functionality.
Proxy Availability
Form completion by proxy enables users to complete forms on behalf of other users. This section enables administrators to determine which users can complete the form and for which users they can complete the form.
This section is only available to administrators who have permission to manage form proxy completion.
Proxy Availability Sections
Proxy availability can be configured using multiple segments, which enables administrators to configure different proxy completion settings. For example, within the United States, you may allow managers or Human Resources Business Partners (HRBPs) to complete a Position Change form on behalf of a user. However, within France, you may only allow HRBPs to complete a Position Change form on behalf of a user.
Sections can be expanded or collapsed by clicking the section's arrow icon. This enables administrators to manage how much information is displayed on the page.
Add Section
To add an additional Proxy Availability section, click the Add Section button. A new section is added to the bottom of the page. 
When a new section is added, the section header displays "New Criteria." Once the page is saved, the section header displays the section's availability settings. Displaying a relevant section header enables administrators to quickly identify a section when editing the section.
Remove Section
To remove a Proxy Availability section, click the Remove icon [image: ] in the upper-right corner of the section.
Removing a section removes all availability and proxy completion settings within the section. Users who are affected by the change in availability and proxy completion settings will notice the change as soon as the page is saved. When Proxy Availability sections are removed, any completed forms are not affected.
Proxy Availability - Availability
The Availability settings determine for which users the self-service form can be completed.
If a form is available to an organizational unit (OU), this means that the self-service form can be completed on behalf of users in the selected OU. Availability, in this instance, does not dictate who can access the form; the ability to access the form for the set of users defined in the Availability section is defined in the Proxy Completion section. For more clarity, see the Use Case section below.
To add users to the form's availability, select the appropriate option from the drop-down menu. Then, click the Select icon [image: ] to select the appropriate organizational unit (OU), group, or user. Alternatively, administrators can also enter the OU, group, or user name in the field.
The constraints on the administrator's Form Manage Forms - Manage permission restrict which OUs, groups, and users are available to be selected. For example, if an administrator's permission is constrained by the West division and they select "All users in Corporation," then only the users in the West division are included in the selection. 
Select the Include Subordinates option to include any subordinate OUs, groups, or users in the availability.
To remove a selection from the Availability section, click the Remove icon [image: ] to the left of the selection.
Proxy Availability - Proxy Completion
The Proxy Completion settings determine which users are able to launch and submit self-service forms for the set of users who are selected in the Availability criteria for this section. Note: The proxy completion settings are always enforced, even if a link to a self-service form is shared with another user.
Proxy Completion can be configured by employee relationship (e.g., Manager, Indirect Manager, Subordinates) or OU criteria (i.e., OU, group, or user). From the drop-down menu, select whether you are selecting an employee relationship or an OU, group, or user.
· When selecting an employee relationship, click the Select icon [image: ] to select the appropriate relationship. Alternatively, administrators can also enter the relationship name in the field.
· When selecting an OU, group, or user, select the appropriate option from the drop-down menu. Then, click the Select icon [image: ] to select the appropriate OU, group, or user. Alternatively, administrators can also enter the OU, group, or user name in the field.
The constraints on the administrator's Form Manage Forms - Manage permission restrict which OUs, groups, and users are available to be selected. For example, if an administrator's permission is constrained by the West division and they select "All users in Corporation," then only the users in the West division are included in the selection. 
Select the Include Subordinates option to include any subordinate OUs, groups, or users in the criterion.
To remove a selection from the Proxy Completion section, click the Remove icon [image: ] to the left of the selection.
Availability and Proxy Completion Use Case
1. A Change of Address form is created. This form can be completed on behalf of all users in the system. Only managers should be able to complete this form on behalf of their direct reports.
2. The Availability can be set to All Employees.
3. The Manager employee relationship is added to the Proxy Completion section so that managers can access and complete the form on behalf of their direct reports in order to change their address.
Self Service Completion Link
This section displays the self service launch link for the form. The link only displays once the form is published. Once the link is appears, highlight and copy the link to use it for self service linking.
This section is only available to administrators who have permission to manage self-service forms.
Cancel/Save/Save and Continue
Click Save and Continue to move to the next step of creating the form. The settings defined on the previous step are saved.
Click Save to save the form without publishing and return to the Manage Forms page. The form settings are saved, and the administrator can return to the form to add or change settings, and then publish the form.
Click Cancel to cancel creating the form.
Create Form - Approval Tab
The Approval tab enables administrator to add an approval workflow to the form. Administrators can select a predefined approval workflow or create a workflow on the form.
To create a form, go to Admin > Tools > Core Functions > Form Management > Manage Forms. Then, from the Manage Forms page, select the Create Form button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration


[image: ]
Add Predefined Approval Workflow
To add a predefined approval workflow to a form:
1. Go to the Approval tab on the form.
2. Check the Approval Required box to require the form submitted by the user be approved before it is considered complete. The box is unselected by default. Note: The approval process is for forms that a user fills out and submits. The process is not for the actual form when it is created by the administrator.
3. Select the Use Existing Workflow option.
4. Click the Add Approval Workflow button. This opens the Select Approval Workflow pop-up.
5. Search for and select an approval workflow from the list.
6. Click Save or Save and Continue.
Create New Approval Workflow
To create a new approval workflow:
1. Go to the Approval tab on the form.
2. Check the Approval Required box to require that the form submitted by the user be approved before it is considered complete. The box is unselected by default. Note: The approval process is for forms that a user fills out and submits. The process is not for the actual form when it is created by the administrator.
3. Select the Create New Workflow option. This opens the options for adding an approval step.
[image: ]
4. Enter a title for the approval workflow in the Title field, up to 100 characters. This is a required field.
5. Click the Add Approval Step button. This opens the options for adding approvers.
[image: ]
6. Click the Select drop-down to choose the approver. You can select from individual users, employee relationships, or organizational units (OUs). At least one approver must be selected. All steps must have at least one approver.
a. Users - Click the Users option. Then, click the Select a user icon [image: ]. This opens the Select a user pop-up from which you can search for and select the approver.
b. Employee Relationships - Click the Employee Relationships option. Then, click the Select an employee relation icon [image: ]. This opens the Select Employee Relationship pop-up from which you can select the relationship from the list. The relationships that display are the standard and custom employee relationships. The user who is defined for the employee relationship is the user who will be the approver. Note: For onboarding users who were external applicants, the employee relationships is the relationship once the user reaches their start date.
c. Organizational Units - Click the Select OU Criteria, option and then select an OU type. Click the Search icon which appears beneath the drop-down. This opens the Select pop-up. Search for and select the specific OU or group you wish to add as an approver to the approval workflow step. For example, if you selected Group from the drop-down, you might search for and select the HR group from the Select Group window. Only one group or OU can be selected at a time. Note: The OU or group that you select in an approval step must already be created before creating the approval workflow.
7. Click the Add Approver button to add additional approvers to the step. When a step has more than one approver, decide if only one approver or all approvers must approve the form before the approval workflow can move to the next step.
a. Select AND to require that all approvers in the step must approve the form before the approval workflow can move to the next step.
b. Select OR to indicate that any of the approvers in the step can approve the form before the approval workflow can move to the next step.
To add approval steps, click the Add Approval Step button and repeat the steps above. Then, click Save to save the form as a draft, or click Save and Continue to move to the next step of creating the form.
Move Step Up/Down
Click the Move Up arrow to move the step up in the workflow.
Click the Move Down arrow to the move the step down in the workflow.
Remove Approver
For steps with multiple approvers, you can remove an approver by clicking the Remove Approver button.
Remove Step
Click the Remove icon [image: ] to delete the step from the workflow.
Copying Forms with Approval Workflows
When copying a form from the Manage Forms page, any approval workflow configurations are copied.
Create Form - Storage Tab
From the Storage tab, administrators define the Universal Profile > Snapshot > Documents storage destination for the completed form. Administrators can also modify the Title field from this page.
To create a form, go to Admin > Tools > Core Functions > Form Management > Manage Forms. Then, from the Manage Forms page, select the Create Form button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration
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This Form Is Used for Applicants
[bookmark: concept54]The This form is used for applicants field only displays for users with permission to assign recruiting forms. This field is unchecked by default. Checking the box means the form will be an applicant form, and completing the Storage Destination section is optional.
Storage Destination
The Storage Destination section allows administrators to select the folder in Universal Profile where the form will be automatically stored when submitted. This section is not required to be completed if the form is configured as an applicant form.
To define the storage destination:
1. Click the Select Folder button. This opens the Select Folder pop-up. All folders that are available display in the Folder Name table. The Folder Name filter can be used to filter the list of folders. Note: The folders that are available to select are defined by the administrator in Documents Preferences.
[image: ]
2. Click the desired folder from the Folder Name table. This closes the pop-up and populates the Storage Destination section with the folder name.
Selected Folder Options
Once the folder is selected, options are available in the options drop-down to change or delete the folder selection.
· Edit - To change the folder selection after the form is published, select the Edit option from the options drop-down. This opens the Select Folder pop-up from which to select a different folder.
· Delete - To delete the selected folder as the storage destination, select the Delete option from the options drop-down. This re-enables the Select Folder button.
[image: ]
Cancel/Save/Save and Publish
Click Save and Publish to save the form and make it available for use in tasks. This button only displays on the Storage tab. Clicking Save and Publish opens a confirmation pop-up. Click Yes to publish the form, or click No to cancel the publish action. Once the form is published, only certain fields can be modified.
Click Save to save the form without publishing and return to the Manage Forms page. The form settings are saved, and the administrator can return to the form to add or change settings, and then publish the form.
Click Cancel to cancel creating the form.
View Previous Tab
To view the Build or Access tab, click the tab name to view the contents.
[bookmark: _Ref1382645029][bookmark: _Toc161996196]Question Bank Overview (Forms)
From the Question Bank, administrators can create and manage questions for use in any form. In addition, administrators can create and manage question categories. By default, when accessing the question bank, the Questions tab displays.
See the following for details about the Questions and Categories tabs, as well as managing questions and categories:
· Question Bank - Questions Tab
· Question Bank - Create/Edit/Copy Question
· Question Bank - Categories Tab
· Question Bank - Create/Edit/Copy Category
Note: The Question Bank for Form Management is not the same as the Question Bank that is accessed from the Content tab. The Question Bank that is accessed from the Content tab is used for the Test Engine functionality. See Question Bank.
Note: The main purpose of Forms is to update User Record data via self-service. Forms are not intended to be used as surveys to collect a large amount of data via Question Bank fields. Using an extensive amount of Question Bank fields might cause performance issues.
Forms are available to organizations that are using Onboarding or Cornerstone HR. For information on Training Forms, select the following link: See Training Forms Administration.
To access the question bank, go to Admin > Tools > Core Functions > Form Management. Then, click the Question Bank link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration



	Question Bank - Manage
	 Grants access to the Question Bank functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Management Administration
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Question Bank (Forms) - Questions Tab
From the Questions tab in the Question Bank, administrators can view, create, and manage questions for use in forms. Questions created in the question bank can be used in any form. Questions can be edited, copied, and deleted.
The questions that display on the Questions tab in the in the Question Bank are the questions for which the administrator meets the availability criteria for the question category and that are within the permission constraints for the permission to manage the question bank. The questions for which the administrator does not meet the availability criteria and are not within the permission constraints do not display on the Questions tab.
Note: Questions can be added in bulk via a technical project. Contact Global Customer Support for more information.
To access the Questions tab, go to Admin > Tools > Core Functions > Form Management. Then, click the Question Bank link. The Questions tab opens by default. Note: The location of the Question Bank page may vary, depending on the configuration of the page in Navigation Tabs and Links.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Question Bank - Manage
	 Grants access to the Question Bank functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Management Administration


[image: ]
Create Question
Click the Create Question button to create a question. See Question Bank (Forms) - Create Question Overview on page 133 for additional information.
Search Filters
Use the search filters to search for questions by the words in the question, question ID, response type, or category. Select the Include Inactive option to include inactive questions in the search. These filters work together so that only the questions that match the criteria are displayed when Search is clicked.
Note: The Category filter only displays categories for which the administrator meets the availability criteria for the question category and that are within the permission constraints for the permission to manage the question bank.
Questions Table
	Column Name
	Description

	Question Text
	This column displays the question. Questions display in the user's language, if available. This column is sortable.

	Category
	This column displays the category defined for the question. This column is sortable.

	Response Type
	This column displays the type of response defined for the question. This column is sortable.

	Question ID
	This column displays the question ID defined for the question. The question ID is system-generated. This column is sortable.

	Active
	This column displays the active status of the question. The column displays "Yes" for active and "No" for inactive. Note: The Active status of a question is managed when creating, editing, or copying the question.

	Options
	The following options are available in the Options column drop-down:
· Edit - Click the Edit icon [image: ] to edit the question. See Question Bank (Forms) - Create Question Overview on page 133 for additional information.
· Copy - Click the Copy icon [image: ] to copy the question. When copying a question, the field type cannot be changed. See Question Bank (Forms) - Create Question Overview on page 133 for additional information.
· Delete - This option only displays for questions that have not been used in a form. Click the Delete icon [image: ] to delete the question. This opens a confirmation pop-up. Click Yes to delete, or click No to cancel the deletion.


Back
Click Back to return to the Form Management page. Note: If the Question Bank page is configured in Navigation Tabs and Links to display in a location that is separate from the Form Management page, then clicking the Back button returns the administrator to the previous page.
[bookmark: _Ref-1658840961]Question Bank (Forms) - Create Question Overview
When creating, editing, and copying questions in the Form Management question bank, administrators complete the following steps:
1. Define the field type.
2. Configure the question properties.
3. Configure the advanced options.
Pre-Step Note: At least one category must be created before creating a question. Selecting a category is required when creating a question. See Question Bank (Forms) - Categories Tab - Create Category on page 145 for additional information.
To access the question bank, go to Admin > Tools > Core Functions > Form Management. Then, click the Question Bank link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration



	Question Bank - Manage
	 Grants access to the Question Bank functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Management Administration


Question Bank (Forms) - Create Question - Select Field Type
The Select Field Type step enables administrators to define the type of question, either date, numeric, radio button, or text. Once the question is saved, the question type cannot be changed.
To access the question bank, go to Admin > Tools > Core Functions > Form Management. Then, click the Question Bank link.
[image: ]
The following question type options are available:
· Checkbox - The checkbox question type enables administrators to create a single-select checkbox question. When completing the form, users select a single checkbox response from the list of responses configured for the question.
· Date Picker - Select this option to create a date question type. Date question types provide a data selection as the answer option.
· Dropdown - The dropdown question type enables administrators to create a single-select dropdown question. When completing the form, users select a single option from the list of dropdown responses configured for the question.
· Numeric - Select this option to create a numeric question type. Numeric questions provide a numeric text box as the answer option.
· Radio Buttons - Select this option to create a radio button question type. Radio buttons provide a list of single-select radio button options as answer options.
· Text - This option is selected by default and creates a text question type. Text questions provide a text box that allows applicants to enter a text response.
Click Next to go to the next step of the question creation process. Or, click Cancel to return to the Question Bank page.
Question Bank (Forms) - Create Question- Question Properties
The Question Properties step enables administrators to define the details of the question. The options available are dependent upon the field type selected for the question.
Important Note: At least one category must be created before creating a question. Selecting a category is required when creating a question. See Question Bank (Forms) - Categories Tab - Create Category on page 145 for additional information.
To access the question bank, go to Admin > Tools > Core Functions > Form Management. Then, click the Question Bank link.
[image: ]
Question
This is a required field. Enter the question, up to 500 characters. Note: This field cannot be modified after the question is used in a form.
 If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
Name
This is a required field that is used for third party integration purposes. The content in this field does not display for end users. Editing Note: This field cannot be modified after the question is used in a form.
The name can be manually entered or automatically generated. The name must be unique. To view in-line instructions for this field, mouse over the tooltip icon [image: ]. The instructions display in a tooltip pop-up.
· To manually define the name, enter the name in the field, up to 40 characters.
· To generate the name automatically, click the Generate button. This populates the field with the first 40 characters from the Question field. Spaces display as an underscore. If special characters are used in the Question field, the characters do not display in the Name field.
Once the name is automatically generated, it can be modified manually by entering changes in the field. If the name is deleted from the Name field, the name can be regenerated by clicking the Generate button.
Note: Changes made to the Question field are not automatically populated into the Name field.
Response Options
This section only displays for Checkbox, Dropdown, and Radio Button field types. In this section, administrators define the content for each radio button response option.
Editing Note: This field cannot be modified after the question is used in a form.
Checkbox Questions
The following fields display on the Question Properties step for Checkbox questions:
	Field Name
	Description

	Question
	This is a required field. Enter the question, up to 250 characters.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
Editing Note: This field cannot be modified after the question is used in a form.

	Tag/API Name
	This is a required field that is used for third party integration purposes. The content in this field does not display for end users. Editing Note: This field cannot be modified after the question is used in a form.
The name can be manually entered or automatically generated. The name must be unique. To view in-line instructions for this field, mouse over the tooltip icon [image: ]. The instructions display in a tooltip pop-up.
· To manually define the name, enter the name in the field, up to 40 characters.
· To generate the name automatically, click the Generate button. This populates the field with the first 40 characters from the Question field. Spaces display as an underscore. If special characters are used in the Question field, the characters do not display in the API Name field.
Once the name is automatically generated, it can be modified manually by entering changes in the field. If the name is deleted from the API Name field, the name can be regenerated by clicking the Generate button.
Note: Changes made to the Question field are not automatically populated into the API Name field.

	Response Options
	This is a required field. Administrators can define a multiple checkbox response options for the field. Enter the response option, up to 250 characters. To add additional response options, click the Add icon [image: ] to the right of the response option box. When users complete the form, they can select one or more of the response options.
If multiple languages are enabled for the portal, click the Translate icon [image: ] to translate the field into other available languages.
Editing Note: This field cannot be modified after the question is used in a form.

	Category
	Select a category from the drop-down. This is a required field. If there are no categories in the drop-down, then at least one category must be created before a question can be created.
The categories that display in the drop-down are the categories for which the administrator meets the availability criteria and that are within the permission constraints for the permission to manage the question bank. The categories for which the administrator does not meet the availability criteria and are not within the permission constraints are not available to select in the drop-down.
Editing Note: This field can be modified, even if the question is being used in a form.

	Active
	The Active option defines the active status of the question. Questions are active by default. When the Active option is unchecked, the question is inactive and is not available for use in forms.
Editing Note: This field can be modified, even if the question is being used in a form.

	Advanced Options
	The following option is available:
· Description - This field enables administrators to create a tooltip, up to 250 characters. The tooltip appears as an icon that end users can mouse over to view. If multiple languages are enabled for the portal, click the Translate icon [image: ] to translate the field into other available languages. Editing Note: This field cannot be modified after the question is used in a form.


Dropdown/Radio Button Questions
The following fields display on the Question Properties step for checkbox questions:
	Field Name
	Description

	Question
	This is a required field. Enter the question, up to 250 characters.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
Editing Note: This field cannot be modified after the question is used in a form.

	Tag/API Name
	This is a required field that is used for third party integration purposes. The content in this field does not display for end users. Editing Note: This field cannot be modified after the question is used in a form.
The name can be manually entered or automatically generated. The name must be unique. To view in-line instructions for this field, mouse over the tooltip icon [image: ]. The instructions display in a tooltip pop-up.
· To manually define the name, enter the name in the field, up to 40 characters.
· To generate the name automatically, click the Generate button. This populates the field with the first 40 characters from the Question field. Spaces display as an underscore. If special characters are used in the Question field, the characters do not display in the API Name field.
Once the name is automatically generated, it can be modified manually by entering changes in the field. If the name is deleted from the API Name field, the name can be regenerated by clicking the Generate button.
Note: Changes made to the Question field are not automatically populated into the API Name field.

	Response Options
	In this section, administrators define the content for each response option. Three response option fields display by default. At least one response option must be defined.
To define the response options, enter the responses in the fields, up to 250 characters.
Editing Note: This field cannot be modified after the question is used in a form.
Add/Delete/Translate Responses
To add another response option field, click the Add icon [image: ]. This adds a blank box below the existing response option.
To delete a response option, click the Delete icon [image: ]. Note: The top level response option cannot be deleted.
If multiple languages are enabled for the portal, click the Translate icon [image: ] to translate the field into other available languages.
Reorder Responses
To change the order of the response options, drag and drop the text boxes to the desired location.

	Category
	Select a category from the drop-down. This is a required field. If there are no categories in the drop-down, then at least one category must be created before a question can be created.
Editing Note: This field can be modified, even if the question is being used in a form.

	Active
	The Active option defines the active status of the question. Questions are active by default. When the Active option is unchecked, the question is inactive and is not available for use in forms.
Editing Note: This field can be modified, even if the question is being used in a form.

	Advanced Options
	The following option is available:
· Dropdown Type - This option only displays for Drop-down question types. This option allows administrators to select whether or not users can select one option or multiple options when responding to the question.
· Single Select - This option is selected by default. When selected, users can only apply to one of the response options for the question.
· Multi Select - Select this option to allow users to select multiple options when responding to the question. Note: The Response Options section must have at least two options configured in order to use the Multi Select option in Advanced Options.
Editing Note: Once the question is used on a form, the option selected in the Dropdown Type field can no longer be changed for the question.
· Description - This field enables administrators to set a description for the field, up to 250 characters. The description appears below the field. If multiple languages are enabled for the portal, click the Translate icon [image: ] to translate the field into other available languages. Editing Note: This field cannot be modified after the question is used in a form.


Save/Cancel/Back
Click Save to save the question.
Click Cancel to return to the Question Bank page without saving the question.
Click Back to return to the Select Field Type step. This option does not appear when editing or copying questions. Important Note: Clicking the Back button deletes all currently configured question properties, as the question has not been saved.
Question Bank (Forms) - Create Question - Advanced Options
When creating, editing, and copying questions, advanced options are available for all field types. The options that display are dependent upon the field type selected.
To access the question bank, go to Admin > Tools > Core Functions > Form Management. Then, click the Question Bank link.
To view the advanced options for the field type, click the Show link in the Advanced Options section. To hide the advanced options, click the Hide link.
Date Picker
The following advanced options are available:
· Format - The Specific date option is selected by default and enables end users to select a specific date as their response. Select the Month/Year only option to display a month/year value as the response option. Only one option can be selected.
· Description - This field enables administrators to create a tooltip, up to 250 characters. The tooltip appears as an icon that end users can mouse over to view. Editing Note: This field cannot be modified after the question is used in a form.
[image: ]
Numeric
The following advanced options are available:
· Maximum Value - Enter the maximum value that can be entered by end users. The default value that displays in the field is 1,000,000. The maximum value that can be defined for this field is 999,999. If this field is blank, then the default value of 1,000,000 is the maximum value that can be entered by end users. Editing Note: This field cannot be modified after the question is used in a form.
· Description - This field enables administrators to create a tooltip, up to 250 characters. The tooltip appears as an icon that end users can mouse over to view. Editing Note: This field cannot be modified after the question is used in a form.
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Radio Button
The following advanced options are available:
· Order Responses - The As Displayed option is selected by default. When selected, the response options display in the order configured in the Response Options section. Select Randomized to display the responses in random order. Editing Note: This field cannot be modified after the question is used in a form.
· Description - This field enables administrators to create a tooltip, up to 250 characters. The tooltip appears as an icon that end users can mouse over to view. Editing Note: This field cannot be modified after the question is used in a form.
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Text
The following advanced options are available:
· Textbox Size - This option defines the size of the text box that displays for the response. Select Small, Medium, Large, or Multiline. The "Large" size is selected by default. Editing Note: This field cannot be modified after the question is used in a form.
· Character Max - Enter the maximum number of characters that can be provided in the response. The maximum number that can be defined is 999. For multiline textbox size questions, the character limit is 10,000. Editing Note: This field cannot be modified after the question is used in a form.
· Watermark - Enter the text that displays as a watermark in the response field. The character limits for the field are based on the text box size selected in the Field Display field. Depending on the text box size, the Watermark field is limited to the maximum characters allowed for the watermark. The following character limits apply:
· Small Text Box Size - The character limit for this field is 10.
· Medium Text Box Size - The character limit for this field is 20.
· Large Text Box Size - The character limit for this field is 45.
· Multiline Text Box Size - The character limit for this field is 200.
 If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
Editing Note: This field cannot be modified after the question is used in a form.
· Description - This field enables administrators to create a tooltip, up to 250 characters. The tooltip appears as an icon that end users can mouse over to view. Editing Note: This field cannot be modified after the question is used in a form.
Save/Cancel/Back
Click Save to save the question.
Click Cancel to return to the Question Bank page without saving the question.
Click Back to return to the Select Field Type step. This option does not appear when editing or copying questions. Important Note: Clicking the Back button deletes all currently configured question properties, as the question has not been saved.
Question Bank (Forms) - Categories Tab
The Categories tab displays the categories for which the administrator meets the availability criteria and that are within the permission constraints for the permission to manage the question bank. The categories for which the administrator does not meet the availability criteria and are not within the permission constraints do not display on the Categories tab.
From the Categories page, administrators can create, edit, and copy the categories to which questions are associated.
Note: Once a category is created, it cannot be deleted but can be inactivated.
To access the Categories tab, go to Admin > Tools > Core Functions > Form Management. Then, click the Question Bank link. The Questions tab opens by default. Click the Categories tab to manage categories. Note: The location of the Question Bank page may vary, depending on the configuration of the page in Navigation Tabs and Links.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Question Bank - Manage
	 Grants access to the Question Bank functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Management Administration
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Create Category
Click the Create Category button to create a category. See Question Bank (Forms) - Categories Tab - Create Category on page 145 for additional information.
Categories Table
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	Column Name
	Description

	Category
	This column displays the name of the category. By default, categories in the table are sorted in alphabetical order. This column is not sortable.

	Active
	This column displays the active status of the category. The column displays "Yes" for active and "No" for inactive. This column is not sortable.Note: The Active status of a category is managed when creating or editing the category.

	Options
	The following options are available in the Options column drop-down:
· Edit - Click Edit to edit the category. This opens the Edit Category pop-up. The category name and active status can be changed. See Question Bank (Forms) - Categories Tab - Create Category on page 145 for additional information.
· Translate - If multiple languages are enabled for the portal, click Translate to translate the category into other available languages.


Back
Click Back to return to the Form Management page. Note: If the Question Bank page is configured in Navigation Tabs and Links to display in a location that is separate from the Form Management page, then clicking the Back button returns the administrator to the previous page.
[bookmark: _Ref-646085965]Question Bank (Forms) - Categories Tab - Create Category
Categories for questions that are configured for the Form Management question bank are managed from the Categories tab on the Question Bank page.
To create categories, go to Admin > Tools > Core Functions > Form Management. From the Form Management page, click the Question Bank link. This opens the Question Bank page, and displays the Questions tab by default. Click the Categories tab to open the Categories tab. Then, click the Create Category button. Note: The location of the Question Bank page may vary, depending on the configuration of the page in Navigation Tabs and Links.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Question Bank - Manage
	 Grants access to the Question Bank functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Management Administration
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Category
Enter the name of the category, up to 50 characters. The name must be unique.
Active
Check or uncheck this option to activate or inactivate the category. The Active option is checked by default.
Availability
To define the availability, select an organization unit (OU) from the Select OU Criteria drop-down. All OUs that are available for the portal display in the drop-down. One or more OUs can be selected. At least one criteria must be defined.
The availability for the category can be modified, regardless of whether the category is active or inactive.
Save/Cancel
Click Save to save the category to the Categories table.
Click Cancel to cancel adding the category.
[bookmark: _Toc161996197]Self-Service Form Submissions
Use the Self-Service Form Submissions page to view and manage self service submissions of a form. In addition, administrators can access the Configure Availability page.
Note: This page does not display proxy self-service forms. For example, if a manager submits a self-service form on behalf of their subordinate, this proxy submission is not displayed on this page.
To access the Self-Service Form Submissions page, select the Self-Service Form Submissions option in the options drop-down for a form on the Manage Forms page. See Manage Forms on page 95 for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Self-Service - Manage
	Grants access to manage Form Self Service and Self-Service Submissions within Manage Forms. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration
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Configure Availability
Click the Configure availability link to open the Configure Availability page and define the availability settings. Administrators can also enable or disable the self service functionality from the Configure Availability page, and access the form's deep link. This option only displays if the availability settings are not yet defined for the form. The availability settings must be defined to make the form available for users to self-submit.
See Self Service Form Submissions - Configure Availability on page 151 for additional information.
Search 
Use the search filters to filter the submissions table by name and submission date. Enter a date in the From and/or To fields to search for forms submitted on or within the dates. Click Search to filter the form results.
Submitted Forms Table
The submitted forms table displays the users who ubmitted the form. The following information displays for each submission:
· Name - Displays the user who submitted the form. This column is sortable.
· Position - Displays the Position organizational unit (OU) of the user who submitted the form. This column is sortable.
· Division - Displays the Position organizational unit (OU) of the user who submitted the form. This column is sortable.
· Submitted - This column displays the date on which the form was submitted. This column is sortable.
· Options - The following option is available in the options drop-down:
· View Form - Click the View Form option to view the user's submitted form. The form displays as read-only.
Back
Click the Back button to return to the Manage Forms page.
[bookmark: _Ref2106348034][bookmark: _Ref443910390]Self-Service Form Submissions
Use the Self-Service Form Submissions page to view and manage self service submissions of a form. In addition, administrators can access the Configure Availability page.
Note: This page does not display proxy self-service forms. For example, if a manager submits a self-service form on behalf of their subordinate, this proxy submission is not displayed on this page.
To access the Self-Service Form Submissions page, select the Self-Service Form Submissions option in the options drop-down for a form on the Manage Forms page. See Manage Forms on page 95 for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Self-Service - Manage
	Grants access to manage Form Self Service and Self-Service Submissions within Manage Forms. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration
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Configure Availability
Click the Configure availability link to open the Configure Availability page and define the availability settings. Administrators can also enable or disable the self service functionality from the Configure Availability page, and access the form's deep link. This option only displays if the availability settings are not yet defined for the form. The availability settings must be defined to make the form available for users to self-submit.
See Self Service Form Submissions - Configure Availability on page 151 for additional information.
Search 
Use the search filters to filter the submissions table by name and submission date. Enter a date in the From and/or To fields to search for forms submitted on or within the dates. Click Search to filter the form results.
Submitted Forms Table
The submitted forms table displays the users who ubmitted the form. The following information displays for each submission:
· Name - Displays the user who submitted the form. This column is sortable.
· Position - Displays the Position organizational unit (OU) of the user who submitted the form. This column is sortable.
· Division - Displays the Position organizational unit (OU) of the user who submitted the form. This column is sortable.
· Submitted - This column displays the date on which the form was submitted. This column is sortable.
· Options - The following option is available in the options drop-down:
· View Form - Click the View Form option to view the user's submitted form. The form displays as read-only.
Back
Click the Back button to return to the Manage Forms page.
[bookmark: _Ref444998180][bookmark: _Ref103029144]Self Service Form Submissions - Configure Availability
The Configure Availability page allows administrators to enable or disable the self service functionality. In addition, administrators can configure the self service availability settings for the form, as well as access the form's deep link.
To access the Configure Availability page, click the Configure availability link on the Self-Service Form Submissions page. See Self-Service Form Submissions on page 149 for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Self-Service - Manage
	Grants access to manage Form Self Service and Self-Service Submissions within Manage Forms. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration
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Availability
This section requires administrators to define the availability settings for the form. Select an organizational unit (OU) from the Select OU Criteria drop-down, or define individual users to whom the form will be available. For users who do not meet the availability criteria, the form is not available for searching in Global Search.
Proxy Availability
Form completion by proxy allows users to fill out forms on behalf of other users. To enable this option, click Add Section, and select options in the Availability and Proxy Completion areas.
Self Service Completion Link
This section displays the deep link for the form. Highlight and copy the link to use the link for deep linking. The link location not available until the form is published.
Save/Save and Continue/Cancel
· Click Save to save the settings. 
· Click Save and Continue to move to the next step.
· Click Cancel to cancel changes to the settings.
[bookmark: concept77]Forms Deep Linking
For forms that are created through the Form Management functionality, a deep link is generated and can be accessed from the Self Service Form Submissions > Configure Availability page within the Manage Forms functionality. The deep link is generated automatically for the form.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Self-Service - Manage
	Grants access to manage Form Self Service and Self-Service Submissions within Manage Forms. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration
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To access and use a deep link for a form:
1. Navigate to the Configure Availability page for the form. See Self Service Form Submissions - Configure Availability on page 151 for additional information.
2. Highlight and copy the link that displays in the Launch Forms from Links section.
3. Paste the link into the desired deep linking feature, such as a Welcome Page custom widget.
[bookmark: _Toc161996198]Headcount Trend Report Homepage
The Headcount Trend Report is an interactive month-end headcount report for portals with Cornerstone HR enabled. The report allows organizations to explore the historical headcount, viewable by different organizational units (OU). Senior managers, executives, and human resources professionals are empowered by this report to explore their organization's historical headcount to spot trends.
The Headcount Trend Report homepage lists all existing Headcount Trend Reports. From this page, you can view existing reports and create new reports.
To access the Headcount Trend Report homepage, go to Reports > Standard Reports > System Reports.
Note: The Headcount Trend Report is only available in portals with Cornerstone HR enabled.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Headcount Trend Report Admin
	Allows users to query historical headcount aggregates and view by different organizational units (OU). This permission cannot be constrained.
	Reports - System


Use Case
Beth is the COO of a growing company with almost 2,000 employees. She knows the company has been accelerating its expansion, especially in certain Division and Location Organizational Units (OU). To study these trends, Beth used to have an analyst compute the aggregate headcount in different OUs using Excel.
Now, with the Headcount Trend Report and after a one-time data load of historical data, Beth can explore these trends over her entire company's history without an analyst's help. She can view the headcount in each standard OU, apply filters on what constitutes a “headcount” in her organization, and drill in and out of specific parts of the organization. This report facilitates resource planning and basic organizational management with Finance, Human Resources, and the rest of the executive team.
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Create Report
Click Create Report to create a new Headcount Trend Report. See Create Headcount Trend Report on page 159 for additional information.
Report List
The Headcount Trend Report homepage lists all existing Headcount Trend Reports. The following information displays for each report: 
· [bookmark: concept78]Report Name - The report name displays as a link. Click the link to view the report output.
· Date Created - The field displays the date on which the report was created.
· Start and End Dates - The field displays the date range selected for the report.
· Hierarchy - This field displays the organizational unit (OU) that was selected to group the headcount for viewing. If the OU has a hierarchical structure, then there may be multiple levels of groupings.
· User Type - The field displays the user types and subtypes selected for the report.
· Employment Status - This field displays the employment statuses and sub-statuses for report, as defined in the User Employment Status field when configuring the report.
[bookmark: _Toc161996199]Headcount Trend Report Homepage
The Headcount Trend Report is an interactive month-end headcount report for portals with Cornerstone HR enabled. The report allows organizations to explore the historical headcount, viewable by different organizational units (OU). Senior managers, executives, and human resources professionals are empowered by this report to explore their organization's historical headcount to spot trends.
The Headcount Trend Report homepage lists all existing Headcount Trend Reports. From this page, you can view existing reports and create new reports.
To access the Headcount Trend Report homepage, go to Reports > Standard Reports > System Reports.
Note: The Headcount Trend Report is only available in portals with Cornerstone HR enabled.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Headcount Trend Report Admin
	Allows users to query historical headcount aggregates and view by different organizational units (OU). This permission cannot be constrained.
	Reports - System


Use Case
Beth is the COO of a growing company with almost 2,000 employees. She knows the company has been accelerating its expansion, especially in certain Division and Location Organizational Units (OU). To study these trends, Beth used to have an analyst compute the aggregate headcount in different OUs using Excel.
Now, with the Headcount Trend Report and after a one-time data load of historical data, Beth can explore these trends over her entire company's history without an analyst's help. She can view the headcount in each standard OU, apply filters on what constitutes a “headcount” in her organization, and drill in and out of specific parts of the organization. This report facilitates resource planning and basic organizational management with Finance, Human Resources, and the rest of the executive team.
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Create Report
Click Create Report to create a new Headcount Trend Report. See Create Headcount Trend Report on page 159 for additional information.
Report List
The Headcount Trend Report homepage lists all existing Headcount Trend Reports. The following information displays for each report: 
· [bookmark: concept79]Report Name - The report name displays as a link. Click the link to view the report output.
· Date Created - The field displays the date on which the report was created.
· Start and End Dates - The field displays the date range selected for the report.
· Hierarchy - This field displays the organizational unit (OU) that was selected to group the headcount for viewing. If the OU has a hierarchical structure, then there may be multiple levels of groupings.
· User Type - The field displays the user types and subtypes selected for the report.
· Employment Status - This field displays the employment statuses and sub-statuses for report, as defined in the User Employment Status field when configuring the report.
[bookmark: _Ref1200755737][bookmark: _Toc161996200][bookmark: concept80]Create Headcount Trend Report
The Headcount Trend Report is an interactive month-end headcount report for portals with Cornerstone HR enabled. The report allows organizations to explore the historical headcount, viewable by different organizational units (OU).
To create a Headcount Trend Report, go to Reports > Standard Reports > System Reports. Then, click Headcount Trend Report.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Headcount Trend Report Admin
	Allows users to query historical headcount aggregates and view by different organizational units (OU). This permission cannot be constrained.
	Reports - System
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Name
Enter the name of the report, up to 100 characters.
Start/End Date
Select the start and date for the headcount period. Any date period can be selected, and the report will show those years in the output.
If there is no data for a date period or parts of the date period, then the report will be blank for the areas with no data.
Hierarchy
Select the organizational unit (OU) hierarchy. Only one hierarchy can be selected. The options available are the OUs that are configured for your portal, as well as manager/reporting hierarchy. Custom OUs are also available.
The OU that is selected determines how the headcount is grouped or aggregated and will be how you navigate through or interact with the report. While the User Type and User Employment Status fields define what constitutes a “headcount” for the report, the Hierarchy field defines how you see those headcount in the report.
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User Type
This section allows you to select one or more user types and subtypes that qualify as a headcount. The options that are available are the default options that are defined by the administrator in User Preferences.
Selecting a user types will filter all users in your portal into a narrower category of headcount. For example, if you select full-time employees and interns but do not select consultants, then the headcount is narrowed down to those groups and will not include consultants.
Note: The user type "Unmapped" means blank. The user type "Unspecified" means that the user type value is not specified.
User Employment Status
This section allows you to select one or more user statuses. The options that are available are the default options that are defined by the administrator in User Preferences.
Selecting a user type will filter all users in your portal into a narrower category of headcount. For example, if your headcount includes users with a status of "Working" and "On Leave" but not "Terminated," then the headcount is narrowed down to the users who are in those user statuses and would not include users in a "Terminated" status.
Generate
Once you have selected the report criteria, click Generate. This creates the report and directs you to the report output page. See Headcount Trend Report - Output on page 162 for additional information.
Note: The report processing time will vary based on the amount of data being generated.
[bookmark: _Ref1963289035][bookmark: _Toc161996201][bookmark: concept81]Headcount Trend Report - Output
The output page of the Headcount Trend Report displays the number of hires across the organization and organizational units (OU). From here, you can view headcount data, rename the report, and edit the criteria.
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Rename Report
Select o change the name of the report. The name can be changed at any time.
Edit Report
Click Edit Report to change the criteria selected for the report. The report can be edited at any time.
Editing the report opens the Edit Report flyout. This shows your existing criteria and allows you to change your selections. From here, you can also change the report name and date range.
[image: ]
Report Years
The year tabs above the chart are the time dimensions. Click a year to view the headcount trends for that year.
Chart
A stacked area chart appears above the output table to show the results as a graphic. It is fixed on the top node of your hierarchy, or the highest parent OU in the table below, and it reflects the year displayed in the table. Each color in the chart represents the child OUs of the highest parent OU.
OU Hierarchy Drop-Down
The OU Hierarchy drop-down allows you to chart a specific OU. Click the drop-down and select an OU to view the chart data for that specific OU.
Filters
The list of filters, which were selected when creating the report, display below the chart.
Report Output Section
The report data displays in the columns below the filters.
· Hierarchy - This column displays the hierarchy values, as defined in the field when configuring the report. The values will vary based on your hierarchy selection. You can click within the hierarchy to view headcount at different levels. Note: If the OU selected does not have a valid parent OU, then the selected OU will appear under the "Unmapped" section in the table.
· Month/Year - These columns display the number of headcount per month within the time period defined when configuring the report.
[bookmark: _Toc161996202][bookmark: concept82]Point-in-Time Headcount Details Report
The Point-in-Time Headcount report enables administrators to retrieve and view employee records on any specified date. By default, all active employee records for the specified date are exported to a .csv file in comma delimited or pipe delimited format. Inactive employees may be included in the export if desired. The employee’s status is based on the selected date. This is the preferred report for historical and trend reporting.
The output of the Point-In-Time Headcount report is limited to filtering by active status and is unconstrained. Filtering and analysis are meant to take place in the application where you downloaded the data.
The Point-In-Time Headcount report is built around effective dated fields. It returns all effective dated standard fields and all custom fields except Secure & Encrypted. The report also includes the most used non-effective dated fields. Click here to view a list of the effective and non-effective fields in the headcount report.
You can perform the following tasks:
· Create an export file
· Download the exported data to a .csv file
· Rerun an export file
To access the Point-in-Time Headcount page, go to Admin > Tools > Core Functions > Point-in-time headcount.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Point-in-Time Headcount - Manage
	Grants user permission to export the full employee record for a specified date. This permission is only available for organizations using Cornerstone for HR.
	Core Administration
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My Exports Table
The My Exports table displays the 20 most recent exports. The table displays the following information for each export:
· Date Created - The date and time the data was requested.
· Export Name - The name of the exported file. There may be several files listed. The format is: Employees_YYYY_MM_DD.
· Record Count - The number of exported user records.
· Job Status - The status of the export. Options are:
· Complete - The export job is done and can be downloaded or re-run.
· Estimated Time - The export is in progress. This job can be canceled if necessary.
· Failed - The export did not complete, and an error message may appear. This job can be re-run.
· Queued - The export is submitted but cannot begin until a previously submitted export is done. 
[bookmark: 418677029]Create an Export File
Use the Create Export button to export headcount details to a .csv file. If the records exceed 1 million rows, the files are separated into multiple files.
Note: If this is the very first export, the Point-in-Time Headcount page appears empty with only the Create Export button visible. 
Export headcount details
1. Click the Create Export button. The Create Export fly-out opens.
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2. In the Date of Employee Records field, select the appropriate date from which you want to view employee record data. No records will be returned for dates prior to when the effective date was turned on. 
3. In the Employee Status field, select the type of employees to include in the export. Options are:
· Active Employees Only - Click to export only active employees.
· Active and Inactive Employees - Click to export active and inactive employees.
4. In the File Format field, select the appropriate format for the report output file:
· CSV - Comma Delimited - Data is separated by a comma.
· CSV - Pipe Delimited - Data is separated by a pipe ( | ).
5. Click the Create button. When the export is done, the Job Status changes to Complete and the Re-Run and Download options appear on the main page.
[bookmark: -574989392]Download Exported Data
Click Download to download the exported .csv data to a location of your choiceSee Download Exported Data on page 167 for additional information.
The downloaded report includes effective dated fields and non-effective dated fields.
Effective Dated Fields
· First Name
· Middle Name
· Last Name
· Suffix
· Address Line 1
· Address Line 2
· City
· State
· Zip
· Country
· PhoneHome
· PhoneWork
· Fax
· PhoneMobile
· Email
· PersonalEmail
· Employee Relationships
· Custom Employee Relationships
· Standard OUs
· Custom OUs
· User Custom Fields
· User Type
· Leave Type
· Termination Date
· Eligible for Rehire
· Termination Reason
· User Subtype
· User Status
Non-effective Dated Fields
· Original Hire Date
· Last Hire Date
· Required (Training) Approvals
· Display Language
· Municipality
· Region
· Activation Date
· Deactivation Date
· Reason for Change
· IsRehiredEmployee
[bookmark: -901141878]Re-Run an Export File
Click Re-Run to export the data again. If you want to view the re-run files, click Download.
Cancel
Click Cancel to stop exports that are in Queued or Running status. 
[bookmark: _Toc161996203]Org Chart Page
Use the Org Chart page to view hierarchy levels within organizational units (OU), which helps users see the various employment channels within the organization.
You can view org charts in two views, batch-edit users in the org chart, export the org chart to .PDF, 
To access the Org Chart page, select the option from the navigation tab. The navigation tab location of the Org Chart page will differ depending on where the administrator configured the page to appear in the portal. Note: If there is no navigation link for the org chart in any of the navigation tabs, then the link may not have been added yet by the administrator. Contact your system administrator to add the link to a navigation tab.
This functionality is only available for organizations with Cornerstone HR, Succession, or View. The functionality is automatically enabled in those portals.
Note: To enable Cornerstone HR, Succession, or View, contact Global Customer Support.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Global Search - People
	Grants ability to search for people via Global Search. If this permission is constrained to a specific OU, then that constraint is automatically applied within Global Search, including search filters and search results. This is an end user permission. The availability of this permission is controlled by a backend setting.
Note: In Universal Profile > Bio > Career Preferences, this permission is required for users to search for jobs.
	Core



	Org Chart - View
	Grants access to the new Org Chart page for organizations with Cornerstone HR, Succession, or View. This permission can be constrained by OU, User’s OU, Users, User’s Self, User Self and Subordinates, User’s Manager, User’s Superiors, Employee Relationship, User’s Direct Subordinates, User's Subordinates.
	Core



	Org Chart by Organization - View
	Grants access to the Organization tab on the new Org Chart page. This permission cannot be constrained. This permission works in conjunction with the Org Chart - View permission. For users who do not have this permission, the Organization tab will not be available.
Note: This permission pertains to the new Org Chart functionality that is released with the February '17 release. The new Org Chart functionality is only available for organizations with Cornerstone HR, Succession, or View.
	Core



	Snapshot - Compensation
	Enables user to view the Compensation widget within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot - Reviews
	Enables user to view the Reviews widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Succession - View
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile
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Org Chart Views
Click the Org Chart drop-down to access views. There are two views for an Org Chart: 
· People - Displays the org chart in the organization's personnel hierarchy. The levels of hierarchy that display for you depend on where you are in the hierarchy. If there are direct reports below you, either your own or another user in the same OU, then you can view up to two levels down. You can also view up to two levels above you, if there are at least that many levels above you in the hierarchy.
· By default, when you access the org chart, there are three levels of hierarchy, if available. If you have direct reports, then the direct reports' level displays. If you have a manager, then your manager's level also displays.
· The additional levels that are available to display for you are also dependent upon the permissions you have to view other levels in the hierarchy. If you do not have permission to view levels above or below you, then the option to view them is disabled on the Org Chart page. For example, if there is a constraint on your permission that restricts you to viewing only users in your Division OU, then the org chart only displays users in your division. Note: The Org Chart page does not indicate your visibility level, such as explaining which OUs you can view based on your permission constraints. If there is a level that is not visible to you, then an option to view it will not display.
· Organization - Displays a Division Organizational Unit (OU) view. Each card shows the OU name and the number of active users in that OU.
· By default, when viewing the Organization tab, you may see up to three levels of hierarchy. Your division will be at the center of the chart, below will be any child division of your division, and above will be your parent division. The actual number of levels displayed will depend on the location of the division in the organization hierarchy.
· Note: The organization view is not constrained in permissions.
Note: When moving between the views, you are returned to the default state of the tab.
Search Users or OUs
Use the search bar at the top of the page to search for users or OUs in the org chart. You can search by user name, position, division, location, manager's name, or Division OUs. Predictive search items display below the search bar. Click an item from the search results to view the org chart hierarchy.
Options
The following options are available from the Options drop-down menu:
Batch Edit Users - Initiates a batch edit of user records. When this option is selected, check-boxes are added to each user card in the org chart. See Org Chart - Batch Edit Users on page 178 for additional information.
Export Org Chart - Enables chart data, user images, and the organizational layout on the People tab to export to PDF. If you select this option, the Export Org Chart flyout opens.
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The following applies to this functionality:
· You can export a hierarchy of up to 150 cards. 
· You can only export one org chart at a time.
· When printing the PDF, you may have a feature that allows you to print across pages by creating a poster version of the org chart. This will create a single printed page by combining the pages in the chart. This can be helpful when printing large org charts.
Configure the data to appear in the PDF: 
1. Complete the following fields:
· Include Today's Date - This option is selected by default. When selected, the date appears below the title.
· Include Photos - This option is selected by default. When selected, the user's photo appears on the user card. If an image is not available for a user, then a blank image appears.
· Card Size - You can select the size of the user card that that appears on the PDF. The card size determines the information that appears on the card.
· Small - This option displays the user's photo, name, and organizational units (OU) 1 and 2. However, the data does not wrap. If the user's information is longer than the space allows, the full data will not be visible in the card on the PDF.
· Medium - This option displays the user's photo, name, and organizational units (OU) 1 and 2. The data in the card does wrap, making the information fully visible.
· Large - This option shows up to five user details that are configured by the administrator in Org Chart Preferences. The details may include performance review rating and OU, Succession, and Compensation data.
2. Click Export to export the org chart to PDF.
· The Export Org Chart flyout remains open while the PDF is generated. If you refresh the page or navigate away, you must re-start the download.
· The name of the org chart PDF file will be: OrgChart_Date. If you download multiple copies, the copy number displays in parentheses after the name.
PDF Output
The PDF output looks the same as the user cards appear on the Org Chart page. If you included the date and photos, then the date appears below the title, and the photos appear in the user card for each user.
Inactivated user cards will appear on the PDF and will include the information icon that indicates a user is in an inactivated status (inactive, on leave, or no longer with the organization).
Full Screen Mode
· Click the Toggle Fullscreen Mode option [image: ] to view the page in full screen mode. When viewing in full screen, you can still access all features of the Org Chart page, but the page header and footer do not display.
· To exit full screen, click the Toggle Fullscreen Mode option or press the "esc" (escape) key on your keyboard.
Note: For portals with custom HTML configured for their header or footer, the full screen mode may behave differently. For example, the footer may not be hidden when viewing the org chart in full screen, or some elements of the header/footer might still appear when viewing full screen. These issues may not be resolvable due to the custom HTML.
Card Size
The toggle options display a basic user card and a more detailed large user card. To switch between the two layout options, click the toggle options on the right side of the page.
The number at the bottom of the card indicates the number of direct reports for a user. If there are no direct reports in an area of the hierarchy, then a number does not display in the small card and the small card will be blank.
· Medium User Card - Click the minus magnifier icon to view the medium user card. This view shows up to two OU details that are configured by the administrator in Org Chart Preferences.
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· Large User Card - Click the plus magnifier icon to view the large user card. This view shows up to five user details that are configured by the administrator in Org Chart Preferences. The details may include performance review rating and OU, Succession, and Compensation data.
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Note: The medium card view allows you to see more cards on the screen.
Active User Cards
The user cards display brief information about each user in the hierarchy. The information that displays depends on how the administrator configured the preferences. For example, the user's Position OU and Location OU may display.
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The following information displays for user cards: 
· User's Photograph - This is the image from the user record. If an image is not available, then a ghost image displays.
· User's Name - The user's name appears as [First Name] [Last Name].
· User ID - If the option to display the user ID instead of the user's name is selected, then the user ID displays in place of the user's name.
· User's OU 1 - Up to two OUs display in the user card, as defined by the administrator in Org Chart Preferences.
· User's OU 2 - Up to two OUs display in the user card, as defined by the administrator in Org Chart Preferences.
· Number of Direct Reports - If a user has at least one direct report, then the number of direct reports appears in a blue circle at the bottom-center of their user card. Clicking the blue circle expands the org chart for that user to show their direct reports. For users with more than 999 direct reports, the number displays as "999+." Clicking the blue circle again collapses the direct reports.
Inactive User Cards
Administrators can inactivate user cards for users who are inactive, on leave, or no longer with the organization. When inactivated, the user card appears as grayed out. Metrics may still be visible, depending on the administrator's settings in Org Chart Preferences.
Note: Administrators can make users inactive, place them on leave, or determine them to no longer be with the organization via settings on the User Record page. To inactivate a user, see the User Record - General Information topic. To set a user's employment status as On Leave or indicate that they are no longer with the organization (i.e., voluntary or involuntary termination), see the User Record - User Type and Employment Status topic.
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Inactive user cards appear as grayed out on the Org Chart page. The following information is still available in the card:
· Attributes, if configured in Org Chart Preferences.
· The clickable number of direct reports.
· The small/medium card toggle still displays both cards.
· The user's name can be selected to open the flyout.
Once the user no longer has active direct reports, the user's card no longer displays.
User Status Information Icon
An information icon [image: ] displays in the upper-left corner of the card. For users with permission to view user type and status, clicking or hovering over the icon shows the user's status, such as "On Leave."
Visibility of Metrics
The visibility of metrics for inactive user cards (i.e., Performance and Succession data), is controlled by a setting in Org Chart Preferences. If the setting is enabled, then metrics display in the large user card and on the flyout. If the setting is disabled, then the metrics do not display.
Batch Edit
Inactive cards are visible when batch editing. However, the cards cannot be selected.
Anonymized Users
For users who have been anonymized, the inactive user card does not display any identifiable information.
View Universal Profile
Each user card links to the Universal Profile. Click the card to open the user's Universal Profile. The page that opens depends on what the administrator configured as the default page that opens when accessing the Universal Profile.
Division OU Cards: 
The following information displays in the cards for Division OUs:
· Division Name - This is the name of the Division OU.
· Total Users - This displays the total numbers of active users rolling up to the division.
· Direct Users - This displays the number of active users that directly belong to a specific division.
· Number of Child Divisions - If a Division has at least one child division, then the number of child divisions appears in a circle at the bottom-center of the card. Click the blue circle to expand the org chart. Click the blue circle again to collapse the direct reports.
User Card Flyout
The user card flyout provides additional details that cannot fit into the large user card. The flyout provides a look at the user's must current performance review rating, as well as succession metrics and compensation data. The details may also include Organizational Unit and User Record custom fields data.
See User Card Flyout on page 180 for additional information.
[bookmark: _Ref897020632][bookmark: _Toc161996204]Org Chart - Batch Edit Users
Administrators can initiate a batch edit of users from the Org Chart page.
To access the Org Chart page, select the option from the navigation tab. The navigation tab location of the Org Chart page will differ depending on where the administrator configured the page to appear in the portal.
To initiate a batch edit of user records from the Org Chart page:
1. Select the Options drop-down menu. 
2. Select the Batch Edit Users option. When this option is selected, checkboxes are added to each user card in the org chart. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Batch Edit Users
	Grants ability to modify user records in bulk. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Org Chart - View
	Grants access to the new Org Chart page for organizations with Cornerstone HR, Succession, or View. This permission can be constrained by OU, User’s OU, Users, User’s Self, User Self and Subordinates, User’s Manager, User’s Superiors, Employee Relationship, User’s Direct Subordinates, User's Subordinates.
	Core



	Org Chart by Organization - View
	Grants access to the Organization tab on the new Org Chart page. This permission cannot be constrained. This permission works in conjunction with the Org Chart - View permission. For users who do not have this permission, the Organization tab will not be available.
Note: This permission pertains to the new Org Chart functionality that is released with the February '17 release. The new Org Chart functionality is only available for organizations with Cornerstone HR, Succession, or View.
	Core
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Batch Edit Users
To batch edit users:
1. Select the checkbox for all necessary users to include them in the batch edit. Note: The selected users remain selected as you navigate through different levels of the org chart.
2. After selecting the necessary users, select the Batch Edit button at the bottom of the page. 
3. A confirmation pop-up opens. Select Yes to proceed to the Batch Edit Users page with the selected users added to the Add Users for Batch Change section. See Batch Edit Users - Create Batch Edit on page 369 for additional information.
[bookmark: _Ref-2037276188][bookmark: _Toc161996205]User Card Flyout
The user card flyout provides additional details that cannot fit into the large user card. The flyout provides a look at the user's must current performance review rating, as well as succession metrics and compensation data. The details may also include Organizational Unit and User Record custom fields data.
To access the user card flyout, click the user's photo on their main user card in the following system areas; the flyout will appear on the left side of the page.
· Org Chart
· Succession Task:
· Current Organization step within a Manager task
· User Profile - Metric sub-step within a Manager or Assessor task
· Metric step within a Manager or Assessor task
· Succession Chart step within a Manager, Assessor, or Job Pool task
· Batch Rating step within a Manager or Assessor task
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot - Compensation
	Enables user to view the Compensation widget within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot - Reviews
	Enables user to view the Reviews widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Succession - View
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile
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Organizational Unit Attributes
The top section of the user card flyout displays the user's photo, name, and email address, as well as up to five organizational unit (OU) and/or user attributes. The combination of attributes is configured by the administrator in the Organizational Unit section in Org Chart Preferences. See Org Chart Preferences.
By default, the following information appears in this section prior to any preferences configured by the administrator:
· Name
· Position (OU 1)
· Division (OU 2)
· Phone Number
· Email Address
· My Team Profile Summary - For organizations that are using the My Team functionality and not the Universal Profile, assessors can select the Download Talent Profile (PDF) link to download the user's My Team Profile Summary.
Inactive User Cards
In addition to the above information that appears by default in the flyout, user cards that have been configured as inactive (via Org Chart Preferences) will also show an Employment Status field at the top of the flyout. The field displays an information icon [image: ] that indicates the user's current employment status, such as "On Leave." The visibility of a user's status is only available for users with permission to view user type and status.
For inactive user cards, metrics are still visible if enabled by the administrator in Org Chart Preferences.
User Details
The middle section of the user card flyout displays additional user attributes, as defined by the administrator in Org Chart Preferences. See Org Chart Preferences.
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The following types of information may appear, depending on the functionality that is configured for the portal:
· Compensation - This type of data is only available to display for portals with Compensation enabled.
· Organizational Unit Types
· Organizational Unit Custom Fields
· Performance - This type of data is only available to display for portals with Performance enabled.
· Succession - This type of data is only available to display for portals with Succession enabled.
· User Record Custom Fields
User Ratings - Compensation, Performance, Succession
The bottom section of the user card flyout displays succession, compensation, and performance data. The combination of information is configured by the administrator in Org Chart Preferences. See Org Chart Preferences.
Ratings data displays as progress bars. The color of the bar indicates the rating color, as defined by the administrator. The rating appears to the right of the progress bar.
The availability of this data is controlled by the corresponding Snapshot permissions. If the viewer does not have a particular Snapshot permission (Snapshot - Compensation), then the corresponding field is not displayed. If the viewer has the permission, but the user is not within their permission constraints, then the field is displayed, but the user's rating is not displayed.
Succession Log
Select this link to view a log of succession-related comments that have been added for the user from various locations in the system. See Succession Log.
Coloring for Succession Fields
If coloring has been configured for Rating Scale or Metric grid fields, the color will be displayed adjacent to the field label.
Access to Data in User Card and Flyout
	Access to
	required permission

	Compensation Data
	Snapshot - Compensation

	Performance Data
	Snapshot - Reviews

	Succession Data
	Snapshot - Succession-View


Considerations
· Constraining the above permission will limit whose data the viewer can see.
· If the viewer does not meet the availability requirement for a field, the field is not shown on the user card or flyout.
· If the viewer’s permission constraints do not allow for a field value to be displayed, then “N/A” displays in place of the value.
[bookmark: _Toc161996206]Permissions for Cornerstone HR
This page contains permissions that may apply to organizations using the Cornerstone HR solution.
Benchmark Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Benchmark Total Access
	This permission provides total access to the Benchmark metrics and functionality.
	Benchmark - Administration


Core Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Access FTP Account - View
	Grants access to the FTP account landing page where the available accounts are displayed. Currently, this permission cannot be constrained.
	Core Administration



	Access Partner Authorization - Manage
	Grants ability to manage partner authorized access to portal via Partner Access Administration. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Announcements - Post
	Grants ability to view, create and update/edit announcements that will appear to populations of users via the Welcome Page Inbox widget or Announcements page. This is an administrator permission.
	Core



	Announcements - View
	Grants ability to view announcements created by others, via the Welcome Page Inbox widget or the Announcements page. This is an end user permission.
	Core



	Authentication Preferences - Manage
	Grants ability to configure which credentials are used for authentication/re-authentication purposes throughout the system. This permission works in conjunction with the preferences that are set within each workflow that uses authentication/re-authentication. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	Available Languages - Modify
	Grants access to choose what languages to which learning objects may be associated when users search for training. This is an administrator permission.
	Core Administration



	Badge & Point Preferences - Manage
	Enables user to access and edit preferences on the Badge & Point Preferences page. The availability of this permission is controlled by a backend setting. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration.



	Batch Edit Users
	Grants ability to modify user records in bulk. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Bypass IP Security Controls
	Grants ability to bypass defined IP Security restrictions, allowing user to log in to the portal from IP addresses that are not authorized via the IP Whitelist screen. This is an administrator permission recommended only for system administrators.
	Core Administration



	Bypass Required Group Preview
	When the Group Preview functionality is enabled and the Require Preview Before Saving Edits toggle is enabled in Group Preferences, administrators with this permission can save edits to a Group or publish a draft without generating a preview. Administrators with this permission still have the option to generate a preview.
This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Capabilities - Capability Models Library - Edit
	Grants ability to access the Capability Models Library and create and edit Capability Models. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Capabilities - Capability Models Library - Manage
	Grants ability to access the Capability Models Library and create, edit, and deactivate Capability Models. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Capabilities - Skills Library Builder
	Grants ability to import relevant Cornerstone Skills Graph skills based on user profile data and generate skill suggestions via the Skills Library Builder page. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	Capabilities - Skills Quick Start Wizard - Manage
	Grants access to the Skills Quick Start Wizard administrator experience, which helps administrators configure and deploy skills within their organization. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Capability Categories
	Grants access to the Capability Categories functionality, where administrators can create and manage capability categories. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Capability Library - Edit
	Grants the ability to create, edit, and copy capabilities via the Capability Library. Administrators with this permission cannot delete capabilities or change the status of a capability. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Capability Library - Manage
	Grants the ability to create, edit, copy, delete, import, and approve capabilities via the Capability Library. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Capability Preferences - Manage
	Grants the ability to create and edit expertise levels and rating scales for capabilities via Capabilities Preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Care ? Community
	Grants access to the Success Center link in Navigation Tabs and Links. This page enables administrators to use Single Sign On (SSO) to access the Success Center directly from their portal. This is an administrator permission.
	Core Administration



	Change User Passwords - Administrator
	Grants ability to change the portal password of another user. This permission works in conjunction with the Users - View permission. This permission can be constrained by User's Corporation, OU, User's OU, User's Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Connect FTP Folders - Manage
	Grants ability to connect to an FTP folder from the FTP Account Access page. This permission can be constrained by FTP Account. When constraining this permission, administrators can select any FTP account that has been associated with the portal. The constraints on this permission determine to which FTP accounts the administrator can connect. This is an administrator permission.
	Core



	Copy Down - Cancel
	Allows administrator to access the Copy Down tool, view and cancel copy downs, and subscribe or unsubscribe to email notifications. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Core Features Activation
	Grants ability to manage Core Feature Activation Preferences in which administrators can enable and disable certain features. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Corporate Logo List - View
	Grants access to select header logo from the corporate list of images. User must also have Display Preference permission. This is an administrator permission.
	Core Administration



	Corporate Preferences - Manage
	Grants the ability to manage Corporate Preferences, which includes several portal-wide settings. This is an administrator permission.
	Core Administration



	Corporate Preferences: Lockout Preferences - Manage
	Grants ability to configure the Lockout Preferences on the Corporate Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Custom Login Page - Manage
	Grants the ability to create and edit custom login pages for the portal. Administrators with this permission can also enable or disable a custom login page and identify the default login page. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Custom Pages - Manage
	Grants access to create and edit custom pages for the portal. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Deep Link: Base URL Control
	Allows administrator to define the Base URL for all SSO module links. This is an administrator permission.
	Core Administration



	Deep Link: Base URL Control
	Allows administrator to define the Base URL for all SSO module links. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Deep Link: View Modules
	Allows administrator to view the deep links URLs. This is an administrator permission.
	Core Administration



	Define Fiscal Year
	Grants ability to set the fiscal year for aggregating annual training hours completed by users for display on the transcript page. This is an administrator permission.
	Core Administration



	Display Preferences - Manage
	Grants ability to configure Display Preferences, including Navigation Tab theme and settings and header logo displayed to end users. This is an administrator permission.
	Core Administration



	Display Preferences - Upload Logo
	Grants access to upload an image on the Display Preference Page. User must also have Display Preference permission. This is an administrator permission.
	Core Administration



	Duplicate User Management Preferences - Manage
	Grants ability to access and configure management of duplicate records, including parameters used to prevent duplicates. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Email - Edit From Address
	Grants ability to edit the "from" address when creating or modifying an email trigger. In addition, the Allow user to change email address option must be selected in Email Preferences. This permission works in conjunction with the Global Email Administration - Manage permission. This is an administrator permission.
	Core Administration



	Email Preferences - Manage
	Grants ability to manage Email Preferences, which includes defining end users' ability to change their email address and the associated email notifications when emails are changed. This is an administrator permission.
	Core Administration



	Employee Recognition Preferences - Manage
	Grants ability to create and edit employee recognition awards for use by end users. This is an administrator permission.
	Core Administration



	Form Completion - View and Edit OU and Employee Relation Fields
	Allow users to view and modify organizational unit (OU) and employee relation fields when completing a form that contains the fields. The constraints on this permission determine which fields the user can view and edit when completing a form. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User Subordinates. This is an end user permission.
	Core



	Global Email Administration - Manage
	Grants ability to manage email trigger templates across all active modules in the portal. Enables creating, editing and deleting email message templates for various system actions and workflows. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Global Email Administration - View
	Grants view only access to email templates/triggers and email logs at the global level for the portal. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Global Search - People
	Grants ability to search for people via Global Search. If this permission is constrained to a specific OU, then that constraint is automatically applied within Global Search, including search filters and search results. This is an end user permission. The availability of this permission is controlled by a backend setting.
Note: In Universal Profile > Bio > Career Preferences, this permission is required for users to search for jobs.
	Core



	Global Search Preferences - Manage
	Grants ability to configure Global Search Preferences. This is an administrator permission. The availability of this permission is controlled by a backend setting. This permission can be constrained by OU and User's OU. By default, this permission is constrained to the organization.
	Core Administration



	Grades - View
	Grants ability to view the Grade Organizational Unit throughout the system, such as in availability drop down selectors, when editing users, etc. Those without this permission do not see the Grade OU on any screen. This is primarily an administrator permission, although organizational policy should determine whether the Grade OU should be visible to end users on reporting screens, etc.
	Core Administration



	Grant Employee Recognition
	Enables users to grant recognition awards to others, using a predefined list of awards created by administrators. This is an end user permission.
	Core



	Group Preferences - Manage
	Grants the ability to access and modify the Group Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Help Link - Manager
	Provides access to view the User and Manager topics in online help. This is a manager permission.
	Core



	Help Link - System Administrator
	Provides access to view the User, Manager and System Administrator topics in online help. This is an administrator permission.
	Core



	Help Link - User
	Provides access to view the End User topics in online help. This is an end user permission.
	Core



	Insights Dashboard
	Allows user to access Insights Dashboard. This permission cannot be constrained.
	Core



	Language Preferences - Manage
	Grants ability to set default language for portal/OU and set whether end users may adjust their own portal display language. This is an administrator permission.
	Core Administration



	Log In Message - Manage
	Grants access to create a message that appears upon portal login to all users or a selected group/subset of users. This is an administrator permission. This permission can be constrained by OU and User's OU.
	Core Administration



	Marketing Email Templates - Manage
	Grants ability to create and save Marketing Email Templates, which can be reused to send future marketing email messages to users. This is an administrator permission.
	Core Administration



	Marketing Emails - Manage
	Grants ability to create and send ad hoc emails to populations of users based on their assigned org units, groups, or by user name. This is an administrator permission.
	Core Administration



	MFA - Admin - User Device - Manage
	Grants the ability to manage the user device information for Multi-factor Authentication. This permission works with the MFA - Admin - User Device - View permission. Administrators can delete devices for user records within their constraints. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	MFA - Admin - User Device - View
	Grants the ability to view the user device information for Multi-factor Authentication. Administrators can view the page for user records within their Users - View permission constraints, and additional constraints can be added to this permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	MFA - Administration - Manage
	Grants the ability to view and configure Multi-factor Authentication (MFA). This permission cannot be constrained. This is an administrator permission.
	Core Administration



	MFA - Administration - View
	Grants the ability to view the Multi-factor Authentication (MFA) configuration. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	My Account - Manage
	Allow users to view and modify their preferences on the My Account screen. The user must have this permission to access My Account. This permission cannot be constrained. This is an end user permission.
	Core



	My Account Devices - Manage
	Manage device registrations from My Account. This permission cannot be constrained. This is an end user permission.
	Core



	My Account Preferences - Manage
	Grants access to the My Account Preferences page, which allows selection of which custom fields display in My Account by OU. Define whether custom fields appear as read only or are editable, and whether entry is required. Also provides ability to customize the names of the tabs that appear in My Account. This is an administrator permission.
	Core Administration



	My Account Social - Manage
	Grants ability to view and manage third party profile connections on the Social page in My Account. This is an end user permission.
	Core



	MyTeam - Print
	Grants ability to configure and print out a My Team profile. Note: By design, for any My Team permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role. 
	Core



	MyTeam Comments - Manage
	Grants ability for manager (or others depending on constraints) to view Comments previously entered about their direct and indirect reports and also create new comments as well as attach files to comments. This permission can be constrained by OU, User's OU, User's Direct Reports, User, and User Self and Subordinates. The permission constraints determine for which users the Comments tab is available when viewing a user in My Team. Note: By design, for any My Team permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role. Note: If the user's permission is also constrained by User Self and Subordinates, then this overrides the User's Direct Reports constraint.
	Core



	MyTeam Search by OU
	Grants ability to allow users to search by division and position when viewing MyTeam. The constraints upon this permission determine the OUs that are available within the search. Note: By design, for any My Team permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role. 
	Core



	My Team/Talent Profile Preferences
	Grants ability to set display preferences for the My Team and Talent Profile screens. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Navigation Tabs and Links - Manage
	Grants ability to manage Navigation Tabs and Links for the portal. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration



	Organizational Unit Custom Fields - Manage
	Grant Access to create and edit custom fields for Org Units. This is an administrator permission.
	Core Administration



	Org Chart - Preferences
	Grants access to the Org Chart Preferences page. This permission cannot be constrained.
	Core



	Org Chart - View
	Grants access to the new Org Chart page for organizations with Cornerstone HR, Succession, or View. This permission can be constrained by OU, User’s OU, Users, User’s Self, User Self and Subordinates, User’s Manager, User’s Superiors, Employee Relationship, User’s Direct Subordinates, User's Subordinates.
	Core



	Org Chart by Organization - View
	Grants access to the Organization tab on the new Org Chart page. This permission cannot be constrained. This permission works in conjunction with the Org Chart - View permission. For users who do not have this permission, the Organization tab will not be available.
Note: This permission pertains to the new Org Chart functionality that is released with the February '17 release. The new Org Chart functionality is only available for organizations with Cornerstone HR, Succession, or View.
	Core



	OU Group - Manage
	Grants the ability to create, copy, and edit custom groups of users without allowing the ability to manage organizational units (OUs). This permission can be constrained by OU, User's OU, and Provider. This is an administrator permission.
	Core Administration



	OU Group - Update
	Grants access to edit existing custom groups of users. This permission can be constrained by OU, User's OU, and Provider. This is an administrator permission.
	Core Administration



	OU Group - View
	Grants access to view existing custom groups. This permission can be constrained by OU. This is an administrator permission.
	Core Administration



	OU Hierarchy - Manage
	Grants ability to create and update/edit organizational units. This permission grants access to all OU types, both standard and custom. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	Password Preferences - Manage
	Grants ability to manage Password Preferences, which includes specifying the settings for users to change their own password, or for the system to generate an anonymous password, set the specific password requirements and allowing users to reset password by answering security questions. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	People Matrix
	Grants access to the People Matrix functionality. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine which users are available in the People Matrix. This is a manager permission.
	Core Administration



	People Matrix - Manage Preferences
	This grants the ability to manage the People Matrix Settings. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Prevent Duplicate Users - Reconcile
	Grants ability to view user accounts that have been identified as potential duplicates. Administrators can only view pending user records that were created by administrators who are within the constraints on this permission. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	Proxy as User
	Grants ability to log in as another user via proxy, for purposes of troubleshooting user issues. This is an administrator permission. The users to which the administrator has access to log in as is controlled by the users to which the administrator has access on the Users page and by the constraints upon this permission. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. By default, this functionality is not available for any users, including administrators. To request this permission, contact Global Customer Support.
	Core Administration



	Report Delivery Preferences
	Provides access to report delivery preferences, which enables administrators to set the preferences related to custom report delivery. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	Reset Password and Public Keys - Manage
	Grants ability to manage FTP account login password and public keys when applicable. Currently, this permission cannot be constrained.
	Core Administration



	Security Administration - General Constraints
	Grants access to apply general constraints to permissions when creating/editing a security role. This permission works in conjunction with the Security Administration - Manager permission. This is an administrator permission.
	Core Administration



	Security Administration - Manage
	Grants ability to create, modify and constrain security roles within the portal, and assign users to those security roles. This permission can be constrained by OU, User's OU, User, and User Self and Subordinates. This is an administrator permission.
	Core Administration



	Security Health Check - Edit Security Issues
	Grants ability to edit security issue settings in the Security Health Check tool and set them to Cornerstone's recommended value. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Security Health Check - View
	Grants ability to view the Security Health Check tool. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Self Registration Groups - Manage
	Grants ability to create and update/edit self-registration groups, which are configured to make a self-registration page available to people who are not added to the portal via user feed. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration



	Self Registration Groups - View
	Grants ability to view Self Registration Groups when selecting Availability (for Training, Tasks, learning assignments, etc.) or User Criteria (for Learning Assignments). This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	Self-Registration and User Record Custom Fields - Manage
	Grants access to manage custom fields for user Self Registration and the user record in Custom Field Administration. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	Share Manager/Approver Permissions
	Enables managers and approvers to delegate certain types of approvals and MyTeam viewing permissions to others. This permission is only relevant to managers and approvers.
	Core



	Single Sign On - CSOD Certificate
	Grants ability to view, manage, and upgrade SSO certificates and configurations. This is an administrator permission. This permission cannot be constrained.
	Core Administration



	Skills Profile - Critical Skills - View
	Grants the ability to view the Critical Skills table for any user. This permission cannot be constrained. This is an administrator permission.
Administrators must also have permission to access the user's Skills Profile.
	Core Administration



	SSO Link to Cornerstone Success Center
	Grants access to an in-portal link to the Cornerstone Success Center sign in page. This is an administrator permission that should be limited to authorized client users of the Cornerstone Success Center.
	Core Administration



	Support Information - Manage
	Grants ability to manage Support Information, which includes specifying an email address and phone number for end users to contact for portal support. This permission works in conjunction with the Corporate Preferences permission. This is an administrator permission.
	Core Administration



	Task - View
	Grants ability to view assigned tasks via Scheduled Tasks screen and Welcome Page My Tasks widget. This is an end user permission.
	Core



	Time Zone Preferences - Manage
	Grants ability to set default time zone for portal/OU and set whether end users may adjust their own portal time zone. This is an administrator permission.
	Core Administration



	Training Data Merge - Manage
	Grants ability to merge the training records of multiple existing accounts and deactivate one of the accounts, if necessary. The availability of this permission is controlled by a backend setting. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. The applied constraints limit the users that are available to be merged and that are displayed in the History section. This is an administrator permission.
	Core Administration



	Training Data Merge - View
	Grants ability to view past training record merges. The availability of this permission is controlled by a backend setting. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. Which records are displayed in the History section is dependent on creator constraints. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Create Users
	Grants ability to access the User Record Administration page and to create new users in the system. When creating a new user, this permission grants the ability to add general information, which includes first name, last name, username, assigned OUs, and custom relationships. The administrator must have additional permissions to add any additional fields. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Universal Profile - User Record - View Users
	Grants ability to view user records in the system. Administrators can view the Modification History page for user records within their constraints. The administrator must have additional permissions to view specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	User - Edit Absent Status on My Account Page
	Allows user to change absent status on My Account page. This is an end user permission.
	Core



	User Permission and Constraint Details - View
	Grants ability to access the Permissions Constraints Details page for a user. This permission also grants ability to see the Permissions Constraints Details link on the Permissions page. This permission can be constrained by OU, User's OU, User, and User Self and Subordinates. This is an administrator permission.
	Core Administration



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Leave Types: Manage
	Grants ability to manage Leave Types on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Reasons for Change: Manage
	Grants ability to define and configure Reasons for Change on the User Preferences administrator page, which may be used when modifying the user record. The administrator must also have the User Preferences - Core Information: View permission to access the User Preferences page.
This permission is also required to view and set the Reason for Change field when editing a user record.
This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Termination Reasons: Manage
	Grants ability to manage Termination Reasons on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - User Statuses: Manage
	Grants ability to manage User Statuses on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - User Types and Subtypes: Manage
	Grants ability to manage User Types and Subtypes on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Rating Scales - Manage
	Grants ability to manage rating scales for capabilities. This permission cannot be constrained. This is an administrator permission.
This permission only works when used in conjunction with the User Rating permission.
	Core Administration



	User Rating Templates - Manage
	Grants ability to manage feedback templates for capabilities. This permission cannot be constrained. This is an administrator permission.
This permission only works when used in conjunction with the User Rating permission.
	Core Administration



	User Ratings - Feedback Assignment
	Grants ability to assign a feedback request to a specific user. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, User's Self, and User's Direct Subordinates. The constraints on this permission determine which users can be selected in the feedback assignment.
	Core Administration



	User Ratings - Feedback on specific person
	Grants ability to request 360 feedback about a specific user. This permission is intended for administrators, managers, or other leadership roles. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates.
It is recommended to constrain this permission. Managers should be constrained to "User's Direct Reports." Administrators can constrain themselves or others to a diverse pool of potential raters.
	Core Administration



	User Ratings - Request Others to Provide Feedback on Themselves
	Grants ability to request that someone rate themself. This permission is intended for administrators, managers, or other leadership roles. This permission cannot be constrained.
	Core Administration



	User Ratings - View All Shared Ratings
	Grants the ability to view all ratings shared with others in addition to the rater. This permission applies anywhere the ratings are displayed, such as the People Matrix and Skills Profile. This permission is intended for indirect managers or non-managers to view rating data for users over whom they have no oversight. This permission grants access to all OU types, both standard and custom. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine whose shared ratings the person can view. This is a manager permission.
	Core Administration



	User Ratings - View Ratings and Feedback about Other User
	Grants ability to view ratings history and rating details about other people regardless of the visibility settings on the ratings. Grants ability to view the My Feedback Requests page. Administrators with this permission can view all ratings and feedback about all other users, regardless of the visibility settings of the ratings. This permission cannot be constrained.
This permission does not bypass visibility ratings about yourself, which means users cannot use this permission to view ratings provided about themselves that are otherwise not visible to them. 
This permission is intended for an administrator or talent partner who needs broad access to all ratings occurring within the portal. 
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration



	User Record Custom Field Configurable Validations - Manage
	Grants ability to manage the configurable validations for user record custom fields within Custom Field Administration. This permission cannot be constrained. This is an administrator permission. This permission is only available to organizations that are using Cornerstone HR.
	Core Administration



	User Upload Photo
	Enables users to upload their photo to their user record, via the My Account screen. This is an end user permission.
	Core



	Users - Edit Bypass User Purging
	Grants ability to set individual users to bypass user purging on the Edit Users page. This permission only works when used in conjunction with the Users - View and Users - Edit permissions. This permission cannot be constrained. This is an administrator permission. The availability of this permission is controlled by a backend setting. To enable this functionality, contact Global Customer Support.
	Core Administration



	Users - Edit Core Information
	Grants ability to add users and edit core information on a user record, including first name, last name, username, assigned OUs, and custom relationships. This permission works in conjunction with the Users - View and Users - View Core and Edit Custom Fields permissions. This permission cannot be constrained. This is an administrator permission.
Note: When the User Record Redesign is enabled in a portal, this permission is disabled. Administrators who previously had this permission are automatically assigned the following permissions:
· Universal Profile - User Record - Create Users
· Users - Edit General Information
This permission is obsolete following the retirement of the legacy User Record in the May '17 release.
	Core Administration



	Users – Edit Custom Field Information
	Grants ability to view and edit the custom fields on a user record. Administrators are only able to edit a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users – Edit General Information
	Grants ability to edit the general fields on a user record, including first name, last name, username, assigned OUs, and custom relationships. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - Edit Local System ID
	Enables administrator to modify the Local System ID for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View and Users - Edit permissions. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Users - Edit Middle Name
	Grants ability to modify the middle name for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Mobile Phone
	Grants ability to modify the Mobile Phone number for a user via the Admin/Users screen. The availability of this permission is controlled by a backend setting. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Personal Email Address
	Enables administrator to edit the Personal Email Address for a user via the admin/users screen. This permission cannot be constrained. This is an administrator permission. By default, this permission is included in the System Administrator security role and parent roles of System Administrator.
	Core Administration



	Users - Edit Prefix
	Grants ability to modify the prefix for a user's name via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Secure User Custom Fields - Unmasked
	Grants the ability to edit secure user custom field info unmasked. This permission can be constrained by OU, Restrict to User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, Employee Relationship. This is an administrator permission.
	Core Administration



	Users - Manage OU Based Applicability
	Grants access to manage OU-based Applicability for user record custom fields. This permission cannot be restrained. This is an administrator permission.
	Core Administration



	Users - Manage Secure User Custom Fields
	Grants the ability to manage the setting secure user custom fields. This permission can be restrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, Employee Relationship. This is an administrator permission.
	Core Administration



	Users - View Secure User Custom Fields - Masked
	Grants the ability to view secure user custom field info masked. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, Employee Relationship. This is an administrator permission.
	Core Administration



	Users - Edit Sensitive Information: Unmasked
	Grants ability to view and edit unmasked Sensitive Personally Identifiable Information (SPII) fields on the user record. Administrators with this permission have the option to view and edit the actual data on the user record. This permission can be constrained by OU, User's OU, User's Self, User's Subordinates, User's Direct Subordinates, User, and Employee Relationship. This is an administrator permission.
	Core Administration



	Users - Edit Signature
	Grants ability to modify the signature font for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Suffix
	Grants ability to modify the suffix for a user's name via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit User ID
	Enables administrator to modify the User ID for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Absent Status
	Enables administrator to modify the Absent status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Active Status
	Enables administrator to modify the Active status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Address
	Enables administrator to modify the address for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Approver
	Enables administrator to modify the specified Approver for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Email
	Enables administrator to modify the Email Address for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Fax
	Enables administrator to modify the Fax number for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Language
	Enables administrator to modify the portal display language for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Last Hire Date
	Enables administrator to modify the Last Hire Date for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Manager
	Enables administrator to modify the assigned Manager for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Original Hire Date
	Enables administrator to modify the Original Hire Date for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Phone
	Enables administrator to modify the Phone number for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Photo
	Enables administrator to upload a photo for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Reconciliation
	Enables administrator to modify the Reconciliation status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Required Approvals
	Enables administrator to modify the number of required training approvals for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Time Zone
	Enables administrator to modify the portal time zone for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Type and Status
	Enables administrator to view and modify the type and status information for a user via the User Record. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users – Effective Dating: Manage
	Enables administrator to make effective dated changes to the user record. This permission only works when used in conjunction with the Users - Edit General Information permission. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Users - Manage OU Based Regex
	Grants access to manage OU-based Regex patterns for user custom fields. This permission cannot be restrained. This is an administrator permission.
	Core Administration



	Users - Unlock Accounts
	Grants ability to unlock user accounts that are currently locked. This permission can be constrained by OU, User's OU, User's Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - View Approver Search
	Enables those who can search for and view users via the Admin/User screen to search by users' assigned approver. This permission only works when assigned in conjunction with the Users - View permission.
	Core Administration



	Users - View Core and Edit Custom Fields
	Grants ability to view core information on a user record, including first name, last name, username, assigned OUs, custom relationships, and custom fields. This permission also includes the ability to edit any custom fields that are visible to the administrator. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. This is an administrator permission.
Note: When the User Record Redesign is enabled in a portal, this permission is disabled. Administrators who previously had this permission are automatically assigned the following permissions:
· Universal Profile - User Record - Edit Users
· Universal Profile - User Record - View Users
· Users - Edit Custom Field Information
· Users - View Custom Field Information
· Users - View General Information
This permission is obsolete following the retirement of the legacy User Record in the May '17 release.
	Core Administration



	Users - View Criteria Search
	Enables those who can search for and view users via the Admin/User screen to search by OU and Group criteria. This permission only works when assigned in conjunction with the Users - View permission.
	Core Administration



	Users – View Custom Field Information
	Grants ability to view the custom fields on a user record. Administrators are only able to view a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users – View General Information
	Grants ability to view the general fields on a user record, including first name, last name, username, assigned OUs, and custom relationships. This permission works in conjunction with the Universal Profile - User Record - View Users permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - View Local System ID
	Enables administrator to view the Local System ID for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View and Users - Edit permissions. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Users - View Manager Search
	Enables those who can search for and view users via the Admin/User screen to search by users' assigned manager. This permission only works when assigned in conjunction with the Users - View permission.
	Core Administration



	Users - View Middle Name
	Grants ability to view the middle name for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users and Users - View General Information permissions. This is an administrator permission.
	Core Administration



	Users - View Mobile Phone
	Grants ability to view the Mobile Phone number for a user via the Admin/Users screen. The availability of this permission is controlled by a backend setting. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - View Modification Details
	Grants ability to view the Modification Details on the User Record and view User Audits fields when creating a Reporting 2.0 report. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - View Personal Email Address
	Enables administrator to view the Personal Email Address for a user via the admin/users screen. This permission cannot be constrained. This is an administrator permission. By default, this permission is included in the System Administrator security role and parent roles of System Administrator.
	Core Administration



	Users - View Prefix
	Grants ability to view the prefix for a user's name via the Admin/User screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users and Users - View General Information permissions. This is an administrator permission.
	Core Administration



	Users - View Sensitive Information: Masked
	Grants ability to view masked Sensitive Personally Identifiable Information (SPII) fields on the user record. Administrators with this permission cannot view the actual data. This permission can be constrained by OU, User's OU, User's Self, User's Subordinates, User's Direct Subordinates, User, and Employee Relationship. This is an administrator permission.
	Core Administration



	Users - View Sensitive Information: Unmasked
	Grants ability to view unmasked Sensitive Personally Identifiable Information (SPII) fields on the user record. Administrators with this permission have the option to view the actual data on the user record. This permission can be constrained by OU, User's OU, User's Self, User's Subordinates, User's Direct Subordinates, User, and Employee Relationship. This is an administrator permission.
	Core Administration



	Users - View Signature
	Grants ability to view the signature font for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission. This is an administrator permission.
	Core Administration



	Users - View Suffix
	Grants ability to view the suffix for a user's name via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View User ID
	Enables administrator to view the User ID for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Absent Status
	Enables administrator to view the Absent status for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Active Status
	Enables administrator to view the Active status for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Address
	Enables administrator to view the address for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Approver
	Enables administrator to view the specified Approver for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Email
	Enables administrator to view the Email Address for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Fax
	Enables administrator to view the Fax number for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Language
	Enables administrator to view the portal display language for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Last Hire Date
	Enables administrator to view the Last Hire Date for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Manager
	Enables administrator to view the assigned Manager for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Original Hire Date
	Enables administrator to view the Original Hire Date for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Phone
	Enables administrator to view the Phone number for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Photo
	Enables administrator to view a photo for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Reconciliation
	Enables administrator to view the Reconciliation status for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Required Approvals
	Enables administrator to view the number of required training approvals for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Time Zone
	Enables administrator to view the portal time zone for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Type and Status
	 Grants ability to view user type and status information on the User Record. This permission cannot be constrained. This permission only works when used in conjunction with the Users - View and Users - Edit permissions.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration



	Welcome Page - View
	Grants access to view Welcome Page. This permission cannot be constrained. This is an end user permission.
	Core



	Welcome Page Preferences - Manage
	Grants ability to configure the look and feel of the Welcome Page that users see upon logging in to the portal. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	Work Force Planning - Administrator
	Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.
	Core Administration



	Work Force Planning - Cost Model Manager
	Allows user to upload and manage costing files and exchange rates for Planning.
	Core Administration



	Work Force Planning - Owner
	Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Reporting Analyst
	Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Subplanner
	Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.
	Core Administration



	Writing Tools - Manage
	Grants ability to activate or deactivate spell checker and inappropriate language filter by module, and create/manage categories for Comment Assistant used in performance tasks. This is an administrator permission.
	Core Administration


Forms Management and Administration Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Proxy Completion - Manage
	Allows administrator to configure the Proxy Availability settings for a form. These settings determine which users can complete the form on behalf of other users and for which users they can complete the form. This permission can be constrained by OU, User's OU, User, and Employee Relationship. This is an administrator permission. 
	Forms Administration



	Form Self-Service - Manage
	Grants access to manage Form Self Service and Self-Service Submissions within Manage Forms. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration



	Form Task Snapshot - Manage
	 Grants access to the Form Task Snapshot functionality within Form Task Administration. This permission cannot be constrained. This is an administrator permission.
	Forms Administration



	Form Task Administration - Manage
	Grants access to the Form Task Administration functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Administration



	Manage Forms - Manage
	Grants access to the Manage Forms functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
Note: This permission enables access to the Form Management functionality that is part of Cornerstone HR functionality and the Onboarding module. This permission does not grant access to the Training Forms Management functionality.
	Forms Management Administration



	Question Bank - Manage
	 Grants access to the Question Bank functionality. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Forms Management Administration


Universal Profile Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile



	Action Items - Forms
	Grants ability to view Form actions via the Universal Profile - Actions page or the Welcome/Custom page Actions widget. This permission cannot be constrained.
	Universal Profile



	Action Items - LMS
	Grants ability to view and take action upon Learning (LMS) items on the Action Items page. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile



	Action Items - View
	Grants ability to view action items on the Action Items page and in the Your Action Items widget. Users without this permission cannot access the Action Items page. This permission can be constrained by Employee Relationship, OU, User's OU, User's Self and Subordinates, and User's Self. This is an end user permission.
	Universal Profile



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	Bio About Preferences - Manage
	Enables administrator to access and edit the Bio About Preferences page. The availability of this permission is controlled by a backend setting. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Universal Profile



	Bio Career Preferences - View
	Grants ability to view the Bio - Career Preferences page for users within the permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User's Direct Reports, User's Self, and User.
	Universal Profile



	Bio Resume - View
	Enables user to view the Bio - Resume page for users within their permission constraints. If a user does not have permission to view the Bio - Resume page, then the Resume tab is not available. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User's Direct Reports, User's Self, and User.
	Universal Profile



	Documents - Delete
	Enables user to delete a file that has been uploaded to the Snapshot - Documents page. The constraints on this permission determine which documents the user can delete. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, Self and Direct Reports, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports.
	Universal Profile



	Feedback - Delete
	Enables user to delete a feedback post or comment on a user's page. The user can delete feedback from the Feedback page of any user who is within the permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User's Self. The permission constraints apply to the creator of the post or comment, not the target user.
	Universal Profile



	Feedback - Request
	Enables user to request feedback from the Feedback page of their Universal Profile. Users can only request feedback from other users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User's Self. This is an end user permission.
Note: This permission should not be constrained by Employee Relationship, as this constraint would not be effective and does not stop the user from requesting feedback from users outside of Employee Relationship constraint if applied.
Note: This permission should not be constrained by Restrict to Employee Relationship because the User Picker is unable to evaluate this constraint.
	Universal Profile



	Feedback - View and Post
	Enables user to view the Feedback page of the Universal Profile and to post feedback. Users can only view the Feedback page for users within their permission constraints. Similarly, users can only post feedback for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User's Self, and Employee Relationship. This is an end user permission.
	Universal Profile



	Feedback Details - View
	Enables user to view the Feedback Details page and provide feedback when they are requested to provide feedback. This permission cannot be constrained. This is an end user permission.
	Universal Profile



	Feedback Preferences - Manage
	Enables administrator to access and edit the Feedback Preferences page. From this page, administrators can configure which options are available when users are requesting and providing feedback within the Universal Profile: Feedback page. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Universal Profile



	Feedback - Request for other users
	Enables user to request feedback on behalf of other users from their Feedback page. This permission can be constrained by User's Subordinates, Direct Reports, and Custom Relationship.
	Universal Profile



	Snapshot - Badges
	Enables user to view the Badges widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. Any user with this permission will always be able to view their own Badges widget when the widget is enabled. This permission also allows end users to view the Badges field on the Learner Home page.
This permission works in conjunction with the Snapshot Main - View permission. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot - Compensation
	Enables user to view the Compensation widget within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot - Competencies
	Enables user to view the Competencies widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot - Development Plans
	Enables user to view the Development Plans widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Goals - Manage
	Enables user to manage their own goals, and others public goals, using the Goals widget and subpage within the Universal Profile - Snapshot page, for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. 
Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Goals - View
	Enables user to view their own goals, and others’ public goals, using the Goals widget and subpage within the Universal Profile - Snapshot page, for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports.
Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
Note: Managers can assign this permission to select subordinates when they are away from the office for an extended period.
	Universal Profile



	Snapshot - Leaderboard
	Enables user to view the Leaderboard widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission works in conjunction with the Snapshot Main - View permission. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Any user with this permission will always be able to view their own Leaderboard widget when the widget is enabled. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot - Peers
	Grants ability to view the Peers widget within the Universal Profile - Snapshot page. This permission can be constrained by OU, User's OU, User's Self and Subordinates, User, User's Self, User's Subordinates, and User's Direct Reports. This is an end user permission.
	Universal Profile



	Snapshot - Reviews
	Enables user to view the Reviews widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Documents - View
	Grants ability to view the Documents widget and subpage within the Universal Profile - Snapshot page. This permission can be constrained by Employee Relationship, OU, User's OU, User's Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. This is an end user permission.
	Universal Profile



	Snapshot Folder Preferences - Manage
	Enables administrator to view the Folder Preferences Admin page and manage folder creation, access, and deletion for the Documents page within Universal Profile: Snapshot. This permission cannot be constrained. This is an administrator permission.
	Universal Profile



	Snapshot Main - View
	Enables user to view the Snapshot page for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Preferences – Manage
	Enables administrator to access and edit the Snapshot Preferences page. This permission can be constrained by Employee Relationship, OU, and User's OU. This is an administrator permission.
	Universal Profile



	Snapshot Succession – Manage
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view and manage successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. 
	Universal Profile



	Snapshot Succession - View
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Universal Profile Preferences - Manage
	Enables administrator to access and edit the Universal Profile General Preferences page. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Universal Profile


Workflow Engine Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflows - Global Settings
	Grants access to manage Global Workflow Settings.
	Workflow Engine



	Workflow Engine - Initiate Workflows
	Grants ability to initiate the first step of a workflow. 
	Workflow Engine



	Workflow Executions - Manage
	Grants access to manage Workflow Executions.
	Workflow Engine



	Workflow - Management Page
	Grants access to manage their Workflows, Global Workflow Settings, and view Workflow Executions. 
	Workflow Engine



	Workflow - Mass Enrollment
	Grants access to the mass enrollment functionality. This permission cannot be constrained. 
	Workflow Engine



	Workflow Engine - Workflow Library - Manage
	Grants access to view, edit, and publish workflows in the Workflow Library. This is an administrator permission. 
	Workflow Engine


View Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	View Data: Preferences
	Grants access View Data Preferences. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Subordinates, User's Direct Subordinates, and User's Corporation.
	View



	View Data: View
	Grants access to View Data. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Subordinates, User's Direct Subordinates, and User's Corporation.
	View



	View People Preferences Page
	Grants access to the View People Preferences page, which allows administrators to configure the View People page according to their needs per organizational unit (OU). This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User's Subordinates.
	View



	View People: Share
	Grants access to open View People to view shared lists. Can dynamically grant access to users to only view the lists that have been shared with the user. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Direct Reports, and User's Subordinates.
	View



	View People: View
	Grants access to open View People to see results and share lists. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User's Subordinates.
	View


Edge and Data Load Permissions
Data Load Wizard Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Data Load Wizard - Compensation
	Enables administrator to load compensation data via the Data Load Wizard. This permission also enables administrators to track data loads and manage data load templates. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Competency Bank
	Enables administrator to load competency bank data via the Data Load Wizard. This permission also enables administrators to track data loads and manage data load templates. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Data Load Queue
	Enables administrator to access the Data Load Queue screen, which displays all data loads, including current and past loads. Constraints can be applied to this permission. However, these constraints do not impact which data loads are visible to the administrator. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Feed Configuration: Compensation – Create
	Enables administrator to access the Feed Summary page in order to create and edit compensation data feeds. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Feed Configuration: Compensation – Run Feed
	Enables administrator to access the Feed Summary page in order to manually run a compensation data feed once it has been created. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Feed Configuration: Compensation - Save
	Enables administrator to access the Feed Summary page in order to view and edit compensation data feeds. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Group Data Load
	Enables administrator to load group data via the Data Load Wizard. This permission also enables administrators to track data loads and manage data load templates. This permission cannot be constrained. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Manage Templates
	Enables administrator to access the Manage Templates page within the Data Load Wizard. From the Manage Templates page, administrators can view, download, and archive templates. This permission cannot be constrained. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - OUs
	Enables administrator to load OUs. This permission also enables administrators to track data loads and manage data load templates. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Resume
	Enables administrator to load resume data via the Data Load Wizard. This permission also enables administrators to track data loads and manage data load templates. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Set User Password
	Enables administrator to set a default password for new users when loading users. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Track Data Loads
	Enables administrator to access the Track Data Loads page within the Data Load Wizard. From the Track Data Loads page, administrators can print and download error and archive logs. This permission cannot be constrained. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Users
	Enables administrator to load users. This permission also enables administrators to track data loads and manage data load templates. This is an administrator permission.
	Data Load Wizard



	Data Load Wizard - Enable User GUID
	Enables the GUID in the Data Load Wizard User Load and mapping template. This enables organizations to include the GUID as the primary key for user data loads. This permission cannot be constrained. 
	Data Load Wizard


Edge Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Access Edge Bulk API History
	Grants access to the Bulk API History page, which displays all the loads that have been performed using the Bulk API. Administrators can select a load to view additional details of the load, including the results. This permission cannot be constrained. This is an administrator permission.
	Edge



	Access Edge Bulk API
	Grants ability to access and utilize the Bulk API. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge



	Bulk API - Cost Center OU
	Grants ability to use the Bulk API to load cost center organizational unit (OU) data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge



	Bulk API - Custom OU
	Grants ability to use the Bulk API to load custom organizational unit (OU) data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge



	Bulk API - Division OU
	Grants ability to use the Bulk API to load division organizational unit (OU) data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge



	Bulk API - Employee
	Grants ability to use the Bulk API to load employee data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge



	Bulk API - Grade OU
	Grants ability to use the Bulk API to load grade organizational unit (OU) data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge



	Bulk API - Legal Entity OU
	Grants ability to use the Bulk API to load legal entity organizational unit (OU) data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge



	Bulk API - Location OU
	Grants ability to use the Bulk API to load location organizational unit (OU) data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge



	Bulk API - Position OU
	Grants ability to use the Bulk API to load position organizational unit (OU) data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge



	Download Reports Access when portal opts-in for Restrict reports access - Edge Import
	Grants ability to download Edge Import load details reports for loads performed by others. 
Users who do not have this permission cannot download load import results for loads performed by others. In addition, users without this permission cannot load data for someone who has previously only validated their data.
This permission cannot be constrained. This is an administrator permission.
This permission is only available and applicable when the portal has enabled the restriction for Edge Import load details report access.
	Edge



	Edge APIs - Manage
	Grants ability to manage Edge APIs on the API Management page. 
	Edge



	Edge Develop - API Explorer
	Grants access to the API Explorer, which provides access to help documentation for various API applications.
	Edge



	Edge Endpoints - Create Secret
	Grants access to create the secret key for Edge Endpoints used with Webhooks. This permission can be constrained by OU and User. This is an administrator permission.
	Edge



	Edge Endpoints - Manage
	Grants access to view, create, edit, and verify Edge Endpoints used with Webhooks. This permission can be constrained by OU and User. This is an administrator permission.
	Edge



	Edge Integrations - Manage
	Grants access to the Integrations service for Edge Integrate, where the administrator can configure, enable, and disable their third-party integrations used within the Cornerstone system. This permission cannot be constrained. This is an administrator permission.
	Edge



	Edge Marketplace - Manage
	Grants access to the Marketplace service for Edge Integrate, where the administrator can browse integrations that can be used to extend the Cornerstone system. This permission cannot be constrained. This is an administrator permission.
	Edge



	Edge Webhooks - Manage
	Grants access to view, create, and edit Edge Webhooks. This permission can be constrained by OU and User. This is an administrator permission.
	Edge



	Edge Webhooks - Start/Stop
	Grants access to start and stop Edge Webhooks. This permission can be constrained by OU and User. This is an administrator permission.
	Edge



	Edge Webhooks - View
	Grants access to view Edge Webhooks. This permission can be constrained by OU and User. This is an administrator permission.
	Edge



	Employee API - Edit
	Grants ability to use the Employee API v2 to create and update users. This permission can be constrained by OU and User's OU. The constraints on this permission limit what data is accessible via the Employee API v2. This is an administrator permission.
This permission is only available when the Employee API v2 is enabled via Edge Marketplace.
	Edge



	Employee API - View - Constrained
	Grants ability to use the Employee API v2 to view employee data with constraints. This permission can be constrained by User, OU, and User's OU. The constraints on this permission limit what data is accessible via the Employee API v2. This is an administrator permission.
This permission is only available when the Employee API v2 is enabled via Edge Marketplace.
	Edge



	Employee API - View
	Grants ability to use the Employee API v2 to view employee data. This permission can be constrained by OU, and User's OU. The constraints on this permission limit what data is accessible via the Employee API v2. This is an administrator permission.
This permission is only available when the Employee API v2 is enabled via Edge Marketplace.
	Edge



	External Job Application API: Manage
	Grants access to manage the Job Application API. This permission is automatically enabled upon enabling either the Cornerstone API bundle or the One-Click Apply with Stepstone integration. Only available if enabled by a backend setting.
	Edge


Edge Import Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Access Bulk API - LMS - Curriculum Transcripts
	Grants ability to use the Bulk API to load curriculum transcript data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Curriculum
	Grants ability to use the Bulk API to load curriculum learning object and structure data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Events
	Grants ability to use the Bulk API to load event learning object data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Event Transcript Update
	Grants ability to use the Bulk API to load event transcript update data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - External Training Transcripts
	Grants ability to use the Bulk API to load external training transcript data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - ILT Instructors
	Grants ability to use the Bulk API to load ILT instructor data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - ILT Transcripts
	Grants ability to use the Bulk API to load instructor-led training (ILT) transcript data, session transcript custom fields data, and event transcript custom fields data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - LO Availability
	Grants access to the LO Availability load in the Bulk API. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access Bulk API - LMS - Material Transcripts
	Grants ability to use the Bulk API to load material transcript data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Material
	Grants ability to use the Bulk API to load material learning object data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Online Course
	Grants ability to use the Bulk API to load online course learning object data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Online Transcripts
	Grants ability to use the Bulk API to load online transcripts data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Session Parts
	Grants ability to use the Bulk API to load session parts data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Sessions
	Grants ability to use the Bulk API to load event session data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Subjects
	Grants ability to use the Bulk API to load subject data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Test Mapping
	Grants ability to use the Bulk API to load test mapping data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Test Transcripts
	Grants ability to use the Bulk API to load test transcript data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Test
	Grants ability to use the Bulk API to load test learning object data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Video Transcripts
	Grants ability to use the Bulk API to load video transcript data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access Bulk API - LMS - Video
	Grants ability to use the Bulk API to load video learning object data. This permission cannot be constrained. This is an administrator permission.
This permission is only available when the Bulk API is enabled via Edge Marketplace.
	Edge Import



	Access CHR - Employee Load
	Grants access to the Cornerstone HR (CHR) employee data load via Edge Import. This permission and data load type are only available to organizations using CHR. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access Edge Import
	Grants access to the Edge Import tool, which enables administrators to load data into their portal. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access Edge Import Workflow - Cost Center
	Grants access to the Cost Center organizational unit data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access Edge Import Workflow - Custom OU
	Grants access to the Custom organizational unit data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access Edge Import Workflow - Division
	Grants access to the Division organizational unit data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access Edge Import Workflow - Grade
	Grants access to the Grade organizational unit data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access Edge Import Workflow - Group
	Grants access to the Group organizational unit and Group Membership data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access Edge Import Workflow - Legal Entity
	Grants access to the Legal Entity organizational unit data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access Edge Import Workflow - Location
	Grants access to the Location organizational unit data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access Edge Import Workflow - Position
	Grants access to the Position organizational unit data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Curriculum Load
	Grants ability to access load reports and perform Curriculum load and Curriculum Structure loads via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Curriculum Transcripts Load
	Grants access to the Curriculum Transcripts data load via Edge Import. This permission can be constrained by OU and Provider. This is an administrator permission.
	Edge Import



	Access LMS - Certification Transcript Update Load
	Grants access to the Certification Transcript Update data load via Edge Import. This permission can be constrained by OU. This is an administrator permission.
	Edge Import



	Access LMS - Evaluation Question Bank Load
	Grants access to the Evaluation Question Bank data load via Edge Import. This load type allows customers to create new evaluation questions and update existing evaluation questions, which can be used in Evaluation Administration when creating evaluations. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Event Transcript Update Feed
	Grants access to the Event Transcript Update data feed via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Event Transcript Update Load
	Grants access to the Event Transcript Update data load via Edge Import. This permission can be constrained by OU and Provider. This is an administrator permission.
	Edge Import



	Access LMS - Events Load
	Grants access to the Events data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - External Training Load
	Grants access to the External Training data load via Edge Import. This permission can be constrained by OU. This is an administrator permission.
	Edge Import



	Access LMS - Facilities Load
	Grants access to the Facilities data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - ILT Instructors Feed
	Grants access to the ILT Instructors data feed via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - ILT Instructors Load
	Grants access to the ILT Instructors data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - ILT Transcripts Load
	Grants access to the ILT Transcripts data load via Edge Import. This permission can be constrained by OU and Provider. This is an administrator permission.
	Edge Import



	Access LMS - Learning Object Equivalencies Load
	Grants access to the Learning Object (LO) Equivalencies data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - LO Availability Feed
	Grants access to the LO (Learning Object) Availability data feed via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - LO Availability Load
	Grants access to the LO (Learning Object) Availability data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - LO Catalog Update Load
	Grants access to the LO Catalog Update data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Material Transcripts Load
	Grants access to the Material Transcripts data load via Edge Import. This permission can be constrained by OU and Provider. This is an administrator permission.
	Edge Import



	Access LMS - OLCO Metadata Feed
	Grants access to the Online Content Metadata data feed via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - OLCO Metadata Load
	Grants access to the Online Content Metadata data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - OLCO Transcript Feed
	Grants access to the Online Content Transcript and Online Content Transcript Custom Field data feed via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - OLCO Transcript Load
	Grants access to the Online Content Transcript and Online Content Transcript Custom Field data load via Edge Import. This permission can be constrained by OU and Provider. This is an administrator permission.
	Edge Import



	Access LMS - Online Course Assets Feed
	Grants access to the Online Course Assets data feed via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Online Course Assets Load
	Grants access to the Online Course Assets data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Online Course Metadata Load
	Grants access to the Online Course Metadata data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Online Transcripts Load
	Grants access to the Online Transcripts data load via Edge Import. This permission can be constrained by OU and Provider. This is an administrator permission.
	Edge Import



	Access LMS - Providers Load
	Grants access to the Providers data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Question Category Load
	Grants access to the Question Category data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Question Load
	Grants access to the Question data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Session Parts Load
	Grants access to the Session Parts data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Sessions Load
	Grants access to the Sessions data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Subjects Feed
	Grants access to the Subjects data feed via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Subjects Load
	Grants access to the Subjects data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Test Mapping Load
	Grants access to the Test Mapping data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Test Transcripts Load
	Grants access to the Test Transcripts data load via Edge Import. This permission can be constrained by OU and Provider. This is an administrator permission.
	Edge Import



	Access LMS - Tests Load
	Grants access to the Tests data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access LMS - Video Transcripts Load
	Grants access to the Video Transcripts data load via Edge Import. This permission can be constrained by OU and Provider. This is an administrator permission.
	Edge Import



	Access LMS - Videos Load
	Grants access to the Videos data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Access REC - Requisition Template Load
	Grants access to the Requisition Template load for Recruiting via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Create/Update Configurations
	Grants ability to create and update Edge Import configurations. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Delete Configurations
	Grants ability to delete Edge Import configurations. Users with this permission can delete configurations created by anyone for all types of data imports. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Delete Feeds
	Grants ability to delete disabled Edge Import feeds. Users with this permission can delete disabled feeds created by anyone for all types of data feeds. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Disable Data Load Wizard
	Grants access to the Disable DLW tab within the DLW Migration tool. From the Disable DLW tab, administrators can disable Data Load Wizard for the portal. This permission cannot be constrained. This is an administrator permission.
Important: Disabling a DLW type is a permanent action, and it cannot be undone. It is important to only disable a DLW type once you have fully migrated to the corresponding loads and feeds in Edge Import.
	Edge Import



	Edge Import - Competency Bank Load
	This permission enables administrators to load competency data via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Edge Import - Employee Load Constrained
	This permission enables organizations to constrain an administrator's ability to load employee data. Administrators can only load employee data if the employee is within the constraints on this permission. This permission can be constrained by OU. This is an administrator permission.
	Edge Import



	Edge Import - Load Employee Salary
	Grants access to the employee salary data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Edge Import - Load Individual Target
	Grants access to the individual target load for Compensation via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Edge Import - Load Review Scores
	Grants access to upload or override the rating score for reviewees via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Edge Import - Load Review Scores and PDFs
	Grants access to load performance review scores and PDFs via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Edge Import - Load Salary Structures
	Grants access to the salary structure load for Compensation via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Edge Import - User Goal Load
	Grants access to the User Goal Load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Edge Import Learning - Modify Training Creator
	Grants the ability to modify the "created by" value for training in the LO Catalog Update data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import



	Edge Import Learning - Modify Training ID
	Grants the ability to modify the "Training ID" value for training in the LO Catalog Update data load via Edge Import. This permission cannot be constrained. This is an administrator permission.
	Edge Import


Reporting Permissions
Reporting 2.0 Permissions
The granular model uses the Reporting 2.0 permissions to allow you to create more specific reports by report field. For this reason, permissions are at more of a granular level with this functionality.
The permissions are broken down by the main product level permission, section level, and then at the field level. For example, if you wanted to report on Instructor Led Training (ILT) in the system, you would need:
· The Reporting - Manage permission to create reports.
· The Reporting - View permission to preview reports and view reports.
· The top-level product specific permission to create reports related to that product.
· e.g. Reporting - Learning - Manage
· The section specific permission to create reports for that feature within the product.
· e.g. Reporting - Learning - ILT - Manage
· The field level permissions to be able to create reports with the specific fields for that feature within the product.
· e.g. Reporting - Learning - ILT - ILT Facility - Manage
If a user does not have each level of permission, then they may not have access to the report builder, or the section may not be visible, or the fields within the section may not be visible. Also, if a user does not have the top-level product permission, then none of the fields for that product will be visible, such as the fields for LMS reports.
The power of this granularity of permissions is that you can give access to as many or as few fields as necessary for your users. For example, you may give users access to the User section but not give them access to the User Identifier section if that contains sensitive data for your portal.
If a user has all relevant permissions, but the backend setting for a particular area is set to FALSE, any fields related to that section will still appear blank in a report. An example where this could occur is SCORM 2004 quiz data.
Note: When a user has a top-level, section, or field level permission, it is not necessary to also assign the Reporting - Manage or Reporting - View permissions since the more granular product specific permissions will give the user access to Reporting 2.0.
Note: Due to sensitivity, users who need to report on Gender, Ethnicity and Grade information, would need the following permissions in addition to the reporting permissions:
· For Gender: User Upload - Gender
· For Ethnicity: User Upload - Ethnicity
· For Grades: View Grades
List of Permissions
For the full list of permissions and their relationships, see the permissions spreadsheet.
Apply Owner Constraints Permission
The Reporting - Apply Owner Constraints permission grants the ability to turn on the Apply Owner Constraints setting for reports in the Report Properties panel. This setting affects shared users, delivery, and reports published to dashboards.
When the setting is enabled, the report owner's constraints are applied to the report, and users that run the report will see the report with the report owner's constraints instead of their own. For reports published to dashboards the owner constraints are only applied if the underlying report is also shared with the user. If just the dashboard is shared, but not the report itself, the users own constraints are applied even though the toggle is set to apply owner constraints.
Due to the possibility of unintended user data becoming visible to a user viewing a report with the report owner's constraints, it is recommended that filters be added to the report to restrict data visibility. It is also recommended that the report owner test the report prior to sharing to ensure the data visibility is appropriate and intended.
Download Permission
The Reporting - Download permission grants users the ability to download Reporting 2.0 reports. This permission cannot be constrained; however, when users download a report, any Reporting - View constraints are applied. Users with the permission see the download option on the Report Home and the Report Viewer.
For clients that have already opted in and previously activated Reporting 2.0, this new permission is added automatically to the System Administrator role and to any security role that currently has at least one Reporting - View permission.
For clients that are opting in and activating Reporting 2.0 for the first time with the August ’18 Release, this new permission is available to administrators in the System Administrator role who can then add the permission to other roles at their discretion. Users without this permission will not see any download options in the Report Home or the while Viewing Reporting 2.0 reports.
Email Delivery Permission
The Reporting - Email Delivery permission grants the ability to deliver reports in Reporting 2.0. Users must also have permission to view reports. The permission can be used in conjunction with the various product, section, and field level permissions. Users must have permission to view Reporting 2.0 in order to have access to a report that is delivered to them. If they do not have view access, then the Reporting 2.0 navigation sublink will not display for them.
Users who have permission to manage Reporting 2.0 can edit a report that is delivered to them. They can also copy the delivered report.
The following constraints are available for this permission:
· OU
· User’s OU
· User Self and Subordinates
· User
· User's Self
· User's Manager
· User's Superiors
· User’s Subordinates
· User’s Direct Subordinates
· Employee Relationship
FTP Delivery Permission
The Reporting - FTP Delivery permission grants the ability to schedule delivery of Reporting 2.0 reports to an FTP directory. This permission cannot be constrained.
This permission is used in conjunction with the view permission for Reporting 2.0 and can also be used in conjunction with the various product, section, and field level permissions. Users must have permission to view Reporting 2.0 in order to have access to a report that is delivered to them. If they do not have view access, then the Reporting 2.0 navigation sublink will not display for them.
Users who have permission to manage Reporting 2.0 can edit a report that is delivered to them. They can also copy the delivered report.
Global Calculated Fields Permission
The Reporting - Manage Global Calculated Fields permission grants the ability to publish calculated fields to all users. This permission cannot be constrained.
Note: Calculated fields can be created by all users who have permission to create reports in Reporting 2.0. However, in order to publish the calculated field globally, a user needs permission to manage global calculated fields.
Manage Custom Recruiting Integrations Permission
The Reporting - Recruiting - Custom Integrations - Manage permission grants access to build and manage reports in the Custom Integrations section. This permission cannot be constrained.
View Custom Recruiting Integrations Permission
The Reporting - Recruiting - Custom Integrations - View permission grants access to view the Custom Integrations section in reporting. This permission cannot be constrained.
Share Reports Permission
The option for sharing reports is only visible to users who have the Reporting - Share permission. Users without the permission can still receive shared reports, but constraints (for other permissions, such as Reporting - Core permissions) will be respected. For example, if you share a report that contains data around Location A and the user receiving the report is constrained to only see data for Location B, the report would not contain any records.
The following constraints are available for this permission:
· OU
· User’s OU
· User Self and Subordinates
· User’s Direct Report
· User
· User's Self
· User's Manager
· User's Superiors
· User’s Subordinates
· User’s Direct Subordinates
· Relationship
System Templates Permission
The Reporting - System Templates permission grants users the ability to use all system templates. System templates are available for generating certain Learning, Core, and Performance data.
This permission works in conjunction with other Reporting 2.0 permissions. For example, users without the Reporting - Learning - View permission will not see any templates for Learning.
This permission is automatically added to the Cornerstone Administrator and System Administrator security roles in all portals that have self-enabled Reporting 2.0.
Sharing Reports Created with a System Template
When you share a report that was created using a template, the shared users will be able to view the report without needing to be granted the Reporting - System Templates permission. The permission is only needed for administrators who should distribute templates to their users.
Permission Constraints
Constraints exist at the section level for permissions. The following constraints are available:
· OU
· User’s OU
· User Self and Subordinates
· User’s Direct Report
· User
· Learning-specific constraints:
· Provider
· Training Item
· Training Type
· Requisition-specific constraints:
· User's Division
· User's Position
· User's Location
· Division
· Position
· Location
Note: Constraints are applied differently for Recruiting reports. Multiple criteria for the same OU type use the OR logic (e.g., only constraints for Location OU), while inter-OU type criteria use AND logic (e.g., a constraint for Location OU and a constraint for Division OU).
For all other reports, the regular constraint logic is applied. See this Knowledge Article for more details about the general constraint logic: https://cornerstoneondemand.my.site.com/s/articles/Several-constraints-added-to-permission-work-as-OR-statements.
Reports - Dashboards Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Dashboard - Create
	Grants the ability to create a dashboard of one or more graphical standard reports and/or charts that can be saved and refreshed at-will to update the results on an ongoing basis. User must also have permission for at least one of the standard reports that are designated for use in dashboards, or for a Reporting 2.0 report with chart that has been published to Dashboards. If a user does not have permission to view a report type, the user cannot add that report type to the dashboard.
	Reports - Dashboards



	Dashboard - Share
	Grants the ability to share a dashboard created by self with other users within the portal who may then view and refresh the results of the dashboard at-will. This permission works in conjunction with the Create Dashboard permission.
	Reports - Dashboards



	Dashboard - View
	Grants the ability to view dashboards created by self or shared by others. User must also have permission to view the standard, custom or Reporting 2.0 reports that are included in any shared dashboards. If a user does not have permission to view a report type, the user cannot view that report type within the dashboard. This is an end user permission.
	Reports - Dashboards


Reports - System (Standard Reports) Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Dashboards Details Report
	Grants access to view the Dashboards Details Report, which displays details related to the dashboards in their portal, such as the dashboard creator and with whom the dashboard is shared. This permission cannot be constrained. This is an administrator permission.
	Reports - System



	Groups Criteria Report
	Grants access to the Group Criteria Report, which enables organizations to retrieve the criteria defined for one or more groups in their portal. This permission cannot be constrained.
	Reports - System



	Login Report
	Grants access to the Login Report, which enables organizations to report which users have logged in to the portal and when. This permission cannot be constrained.
	Reports - System



	OU Audit Report
	Grants access to OU Audit report, which displays audit information for changes made to organizational units. This permission can be constrained by OU, User's OU, and User's Corporation.
	Reports - System



	OU Hierarchy Report
	Grants access to OU Hierarchy Report, which displays details of each organizational unit for a selected OU type.
	Reports - System



	Proxy as User Report
	Grants access to the Proxy as User Report, which enables organizations to report on which users have logged in to the portal and when. This permission cannot be constrained.
	Reports - System



	Reporting 2.0 Delivery Log
	Grants access to view the Reporting 2.0 Delivery Log, which displays user-level information about deliveries for your Reporting 2.0 Reports.
	Reports - System



	Reporting 2.0 Report Details
	Grants access to view the Reporting 2.0 Report Details, which displays information about the Reporting 2.0 reports created and ran.
The Reporting 2.0 Report Details permission can be constrained by OU and User constraints. The constraints apply to the recipient user. 
The Reporting 2.0 Report Details permission will be assigned to the Cornerstone Administrator and System Administrator roles by default.
	Reports - System



	Security Role Report
	Grants access to view the User Roles, Permission and Constraints Report, which displays user level information about roles, permissions and constraints. This permission cannot be constrained.
	Reports - System



	Security Role - Audit Report
	Grants access to the Security Role - Audit Report, which enables organizations to report on which users have been assigned to which security roles and the security role modification history. This permission cannot be constrained.
	Reports - System



	Security Role - User Permission Report
	Grants access to the Security Role - User Permission Report, which enables organizations to report on the roles assigned to a user and the permissions and constraints associated with those roles. This permission cannot be constrained.
	Reports - System



	User Audit Report - Detailed
	Grants access to the User Audit standard report, which displays detailed changes to user data. Users with this permission must also have permission to view user fields in other areas of the system. The users and fields available in this report are controlled by additional permissions. This permission can be constrained by OU, User's OU, User's Subordinates, User's Direct Subordinates, User's Self, User Self and Subordinates, User, and Employee Relationship. The constraints on this permission limit the users and OUs that are available when running the report. This is an administrator permission.
	Reports - System



	User Record as of a Date
	Grants access to run the User Record as of a Date report, which displays user data as of a specified effective date. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. The constraints on this permission limit the users and OUs that are available when running the report. Also, the constraints are based on the data as of the effective date of the report. This is an administrator permission.
	Reports - System



	User Record Audit Report
	Grants access to User Record Audit report, which displays user record modification history. The selected constraints function independently and are then combined to determine the availability for this report.
	Reports - System



	User's OUs and Groups Report
	Grants access to User's OUs & Groups Report, which lists all of the OUs and Groups to which a user belongs, and can include OUs and Groups to which a user has belonged in the past.
	Reports - System


Reports - Track Employee (Standard Reports) Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Employee Transcripts - Manager/Approver Access
	Grants access to transcript (training record) screen of those for whom user is designated manager, approver or cost center approver. System administrators can access all user transcripts from this page. Link to this screen appears under Standard Reports/Track Employees. This is a manager/approver permission. This permission can be constrained by Employee Relationship and User's Direct Subordinates.
Note: The Employee Relationship constraint allows administrators to constrain the permission to a user’s custom employee relationship. For example, an administrator can select to restrict the Matrix Manager relationship to viewing user data for users who have that Matrix Manager indicated on their user record.
Note: The User's Direct Subordinates constraint allows administrators to constrain the data that a user can view to only the data for their direct reports. The user will not be able to view their own data with this constraint.
Note: By design, for any Track Employees report permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role.
	Reports - Track Employee



	Form Management Status Report
	Grants access to Form Management Status report, which displays form task status summary by user. Note: By design, for any Track Employees report permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role. 
	Reports - Track Employee



	ILT No Show Report - Manager Version
	Grants access to manager version of the ILT No Show Report, which displays attendance summaries and lists of subordinates who were registered for but did not attend any parts of instructor led training sessions. Note: By design, for any Track Employees report permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role.
	Reports - Track Employee



	ILT Session Withdrawal Report - Manager Version
	Grants access to Session Withdrawal report for subordinates of the user. The report displays subordinates who registered and later withdrew their registration, including reasons for withdrawal. This is a manager report. This permission can be constrained by Employee Relationship and User's Direct Subordinates.
Note: The Employee Relationship constraint allows administrators to constrain the permission to a user’s custom employee relationship. For example, an administrator can select to restrict the Matrix Manager relationship to viewing user data for users who have that Matrix Manager indicated on their user record.
Note: The User's Direct Subordinates constraint allows administrators to constrain the data that a user can view to only the data for their direct reports. The user will not be able to view their own data with this constraint.
Note: By design, for any Track Employees report permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role.
	Reports - Track Employee



	Past Training Requests Report
	Grants access to Past Requests, an interactive report that displays training requests the user has already approved, deferred, or denied. The user may change the approval decision for training that an employee has not yet registered for. This is an approver permission.
Note: By design, for any Track Employees report permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role.
	Reports - Track Employee



	Track Employees - Employee Records
	Grants access to Employee Records, enabling manager to view basic user and transcript data for a single direct or indirect report. This is a manager permission. This permission can be constrained by User's Direct Subordinates.
Note: The User's Direct Subordinates constraint allows administrators to constrain the data that a user can view to only the data for their direct reports. The user will not be able to view their own data with this constraint.
Note: By design, for any Track Employees report permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role.
	Reports - Track Employee



	Track Employees - Past Due Report
	Grants access to Employee Past Due report, which displays past due training for subordinate employees (system administrators see all employees). This is a manager report. Note: By design, for any Track Employees report permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role.
	Reports - Track Employee



	Track Employees - Training Progress Pie Chart
	Grants access to Employee Training Progress Summary Report, a pie chart report that displays transcript status on a single learning object for a manager's direct reports. This is a manager permission. This permission can be constrained by Employee Relationship and User's Direct Subordinates.
Note: The Employee Relationship constraint allows administrators to constrain the permission to a user’s custom employee relationship. For example, an administrator can select to restrict the Matrix Manager relationship to viewing user data for users who have that Matrix Manager indicated on their user record.
Note: The User's Direct Subordinates constraint allows administrators to constrain the data that a user can view to only the data for their direct reports. The user will not be able to view their own data with this constraint.
Note: By design, for any Track Employees report permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role.
	Reports - Track Employee



	Track Employees - Training Status Summary Report
	Grants access to Employee Training Status Summary Report, which displays transcript status of all training for a manager's direct reports, and allows the manager to view the transcript details for any learning object listed on the report. This is a manager permission. This permission can be constrained by Employee Relationship and User's Direct Subordinates.
Note: The Employee Relationship constraint allows administrators to constrain the permission to a user’s custom employee relationship. For example, an administrator can select to restrict the Matrix Manager relationship to viewing user data for users who have that Matrix Manager indicated on their user record.
Note: The User's Direct Subordinates constraint allows administrators to constrain the data that a user can view to only the data for their direct reports. The user will not be able to view their own data with this constraint.
Note: By design, for any Track Employees report permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role.
	Reports - Track Employee


Additional Permissions
A full list of all permissions is also available. See Security Permissions.
[bookmark: _Toc161996207]Planning Overview
[bookmark: _Toc161996208][bookmark: concept84]Headcount Planning - Overview
Headcount Planning enables efficient, enterprise-wide collaboration to identify the number and mix of employees that will be needed to achieve the organization’s business objectives in the future. Headcount Planning controls access to sensitive information, includes built-in versioning and error tracking, and provides a seamless approval and consolidation workflow. The interface is designed specifically for the headcount planning process, rather than having to use a generalized spreadsheet.
Headcount Planning utilizes Position Management and requires accurate position instance data about the organization, including all active position instances and any relationships between those position instances, as well as all position instance attributes and any relationships between those attributes. This data will represent the baseline on which plans are created. Any changes to position instance data can be updated via a scheduled data feed or a data load.
The Subplanning functionality of Workflow Planning enables large-scale collaboration on headcount planning in an orderly and efficient way. Planning headcount for an organization requires input from many people in order to be accurate, but collaborating can be a logistical difficulty. In the Planning tool today, Human Resources leaders would have to create multiple smaller plans for each area of the organization, and then combine them at the very end in order to create a comprehensive, organization-wide plan.
With Subplanning, you can break up very large headcount plans into smaller plans for managers at lower levels, complete with a streamlined workflow from assignment to approval. You can then consolidate the smaller plans back into the larger plan. This allows you to have contributions from frontline managers, which creates a more accurate and realistic headcount plan.
All Headcount Planning pages display in the language defined in the Display Language field on the user's user record.
Note: This functionality is available by request at an additional cost. Contact your Client Executive for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Work Force Planning - Administrator
	Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.
	Core Administration



	Work Force Planning - Owner
	Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Reporting Analyst
	Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Subplanner
	Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.
	Core Administration


[bookmark: concept85]Headcount Planning Page - Overview
The Headcount Planning page is a dashboard that allows you to view a snapshot of headcount plans that are in progress or completed. You can also create new plans from this page.
To access the Headcount Planning page, go to Planning > Headcount Planning.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Work Force Planning - Administrator
	Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.
	Core Administration



	Work Force Planning - Owner
	Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Reporting Analyst
	Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Subplanner
	Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.
	Core Administration
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Create New Plan
Click Create New Plan to create a new headcount plan. This opens the Create a Plan page. 
Note: The Create New Plan option is only available for users with permission to be plan administrators.
Convert Users to Positions
Click CONVERT USERS TO POSITIONS to import active users from the Cornerstone database and create position instances for each user. This import is the basis for which an organization conducts its planning. After conducting the import and creating a plan, the planner can see the users (with their respective positions) in the planning interface. Only standard OUs are imported, which become attributes of the newly created positions.
 Note: This conversion requires that cost model files be loaded to the Cost Model Manager.
Active Plans
This section displays headcount plans and subplans that are currently active. If you have more than two active plans, you can scroll to the right to view additional plans.
The subplans that display in the Active Plans section will be in an Assigned or In Progress status.
The following information displays for each plan:
· Plan Name - This displays the title of the plan, which is defined when the plan is created.
· Area - This displays the area of the organization chosen for the particular plan. It also displays the title of the manager that sits at the top of that area.
· Primary Planner - This displays the name of the user who is designated by the plan creator to be the primary planner. For the user that is the primary planner, the name of the primary planner will be clickable and can be edited. Co-planners will not be able to click and edit the primary planner.
· Co-Planners - This displays the name of the co-planner. Primary planner can click the name to edit it. Co-plannerscannot edit co-planners.
· Plan Horizon - This displays the amount of time that is being planned.
· Headcount  - This displays the total headcount value in your organization at the time of plan creation. This number is a baseline and does not change when you add or subtract headcount in the plan itself.
· Subplans - This field allows you to track the progress of bulk-assigned subplans. The Subplans field displays the number of subplans have been assigned out of the total number of subplans. To refresh the field, click the refresh arrows to the left of the bulk assignment. This updates the Subplans field to show the latest subplan assignment information (Note: This field will disappear after the bulk-assignment of subplans is complete.).
· Due Date - This displays the date on which your plan is due. This date is for informational purposes only, and the plan will not be rescinded or closed automatically when this date is reached.
· Actions - This drop-down menus allows you to perform different actions, including downloading two different .csv reports, delete the plan, update the costs within the plan, or update the plan with a new snapshot of your organization.
· Position Details - This is a .csv download containing all position instances in the plan period with all of their respective Attributes (and Attribute hierarchies if applicable).
· Position Timeline - This is a .csv download containing each position’s FTE over the span of the plan period.
· Delete Plan - This allows you to permanently remove the plan from your portal. This requires you type the name of the plan to validate this irreversible step.
· Update Costs - This allows you to apply a new cost model file that you uploaded to Cost Model Manager to this specific plan.
· Plan Update - This allows you to import a new snapshot of your organization, which will appear alongside the previous snap and plan that you had up until that point. You will be required to ‘reconcile’ differences in position instances between these snapshots.
· Version History - This allows you to view a history of changes to the plan.
· Go to Plan - This opens to plan details. See Headcount - Planning Page on page 252 for additional information.
Completed Plans
This section displays details about your completed headcount plans and subplans. Plans are sorted by default by the date completed, with the most recently completed at the top.
The subplans that display in the Completed Plans section will be in an Accepted, Canceled, Submitted status.
The following information displays for completed plans:
· Name - This displays the title of the plan.
· Area - This displays the area related to the plan. 
· Date Completed - This displays the date on which the plan was completed.
· Primary Planner - This displays the primary planner of the plan.
· Plan Horizon - This displays the plan horizon period in years.
· Headcount - This displays the total headcount value in your plan.
· Review - Click Review to open a brief summary of the submitted plan. The summary displays the primary planner and the total headcount in the plan.
· Actions - The following actions are available:
· Position Details - This is a .csv download containing all position instances in the plan period with all of their respective Attributes (and Attribute hierarchies if applicable).
· Position Timeline - This is a .csv download containing each position’s FTE over the span of the plan period.
· Delete Plan - This allows you to permanently remove the plan from your portal. This requires you type the name of the plan to validate this irreversible step.
· Update Costs - This allows you to apply a new cost model file that you uploaded to Cost Model Manager to this specific plan.
· Restore - This allows you to change the state of the plan from Completed to Active. Then you can choose to re-open the plan for further planning or Update Plan with a new snapshot of your organization.
[bookmark: _Ref400784563][bookmark: _Ref-140893966][bookmark: _Ref-838760104][bookmark: concept86]Headcount - Planning Page
Use the Headcount Planning page to create and modify your headcount plan by forecasting headcount needs for the plan period.
To access the planning page, click Start Planning from the Create a Plan page or click Go to Plan from the Headcount Planning page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Work Force Planning - Administrator
	Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.
	Core Administration



	Work Force Planning - Owner
	Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Reporting Analyst
	Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Subplanner
	Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.
	Core Administration
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Plan Name
The name of the plan. 
Details
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Click Details to view a pop-up that displays the plan due date and plan period.
Due Date
The plan due date. "Due Date Not Specified" displays if no date is configured.
Subplans
Click SUBPLANS to assign and manage subplanners working on smaller sections of the plan. See Assign Subplans on page 272 for additional information.
Submit Plan
Click Submit to move the plan from the active status to completed status. The plan now displays in the Completed Plans section on the Headcount Planning page. You cannot re-open or modify a submitted plan. 
Summary/Year Tabs
The time horizon is separated into the following tabs that display headcount, FTE, and cost for the selected year: 
· Summary tab - Displays all years in the plan.
· A tab for each year in the plan. 
· Current Year tab - If the plan creator extended the plan to a period before the plan’s start date, an additional Current Year Tab appears which allows managers to update their near-term headcount projections for the remainder of the year (before Year 1, etc.).
Show Targets
If the plan creator enabled the Targets feature, Show Targets, displays a scorecard of how the plan compares to the targets.
Headcount Graphic
A graph showing headcount for the time period of the selected tab appears above the grid. Click Hide Graphs to hide the graph.
Chart View of Plan
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Plans appear as a real-time chart in addition to the grid format. The chart can make it easier to quickly spot patterns, trends, or other anomalies.
Hover over the various colors in the chart to view the area of hierarchy represented by the color.
The X axis represents the timeline displayed in the grid. Each color in the chart represents the child organizational units (OU) under the top level of the plan hierarchy.
Plan Table
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The plan table display information that allows you to forecast each position instance over the plan period. The information that appears is based on the Show options you select.
Show Options
The Show options define what appears in the plan table. The following options are available:
· Views
· Headcount - Displays the projected headcount view for each position instance. You cannot edit Headcount as it is derived from FTE; any FTE greater than 0 means Headcount is 1.
· FTE - View and edit FTE values for each position instance for any position in any time increment. Edits automatically carry into future periods.
· Cost - View the cost associated with a position or position instance. The cost fields cannot be modified directly in the table. Cost is adjusted based on changes to FTE, or if Cost Override is enabled, the user can edit within the Position Details side panel. The FTE cost is calculated by multiplying the cost of a full-time position. For example, if FTE is changed to 0.5, then cost is halved.
· Currency - The selected currency. If the positions in the specific area of organization include multiple currencies, then all positions will be converted automatically to the Base Currency outlined in the Exchanges Rates file in Cost Model Manager. If all the positions have the same Local Currency, the user can choose to display the costs in either that single Local Currency or the Base Currency.
· Filter - Filter the positions in the table by type. Options are:
· Position Hierarchy - Display all positions, along with the Manager hierarchy. This is the default view.
· Incomplete Positions – Display positions that are missing "Required" attributes in cases where a "Required" attribute is also "Restricted,". Restricted means that only users in the Plan Administrator or Plan Owner roles can complete them. This is commonly used by organizations that want to control position costs centrally instead of letting planners define costs.
· New Positions - Display positions created in the plan, as opposed to positions that existed in the organization when the plan was created.
· Becoming Manager - Display positions that existed in the organization at the time the plan was created and that have been assigned subordinate positions within the plan.
· New Managers - Display new positions created within the plan and also have subordinate positions.
· Incumbent - Display the incumbent (user) in the show results.
Primary planners and co-planners see all position instances within the area of the organization in the plan that was assigned to them or in the plan they created themselves.
By default, all values in the starting increment are assumed to carry forward to all future increments in the plan.
Each time the plan is opened, the table displays the top level position instance, with the first level below expanded.
Any values in the "Entire Organization" and "Direct Reports" rows cannot be modified. Any value in a row with the word "Reports" in it cannot be changed. FTE can only be changed for a specific position instance.
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Org/Position
This section displays the hierarchy of the position instance. The direct reports are the group of positions that report directly to the position above it. Indirect reports display below direct report grouping and are considered direct and indirect reports of a direct report. You cannot edit values in the rows for "Direct Reports" or "Indirect Reports."
Position Instances - FTE
When viewing FTE from the Show option, the table displays each segment of the time horizon as a separate column. You can only edit the position instance rows. These rows are colored in red or green. The values in the "Direct Reports" or "Indirect Reports" rows cannot be modified.
To modify the FTE value:
1. Click the desired cell in the corresponding FTE row and time horizon column.
2. Delete the value or backspace over the value.
3. Enter the new value. The acceptable values are 0 and 1 and any value in between within two decimal points. Decimal points round up. To enter a decimal, enter 0.[decimal number]. The value and color of the current and all subsequent cells in the row changes to green if the value is 0.01 or greater, and it changes to red if the value is 0.
4. Click away from the cell to automatically update the table with the new value.
Positions Added to Plan Indicator
An asterisk symbol displays in the position row to indicate that the position was added to the plan and was not a position that existed in the snapshot when the plan task was created.
Position Options Drop-Down
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A drop-down option displays to the right of the position title in the left-side column to enable you to take the following actions:
Add Subordinate/Copy Position
Select Add Subordinate to create a new position with the selected position as manager. This opens the New Headcount panel to the right of the plan table.
Select Copy Position to create one new position with the same position attributes as the selected position. You will have the option to change any of those details copied from the selected position, including attributes and Position Title, Start Date, and FTE.
When adding a subordinate or copying a position, you need to provide additional information to complete the action. The following fields are required or optional, depending on how the plan was configured:
· Job Title - You can select a job title from the drop-down. The options that are available are the Position OUs in the portal or the options that were defined during implementation of Headcount Planning. This is a required field.
· Start Date - By default, the start date is the first month in the planning period. You can select a different date as the start date. This is a required field.
· FTE - Enter the FTE value. This is a required field. The acceptable values are 0 and 1 and any value in between within two decimal points. Decimal points round up. To enter a decimal, enter 0.[decimal number].
· Headcount - Enter the headcount value, either 1 or 0. This is a required field.
· Location - Select the location from the drop-down. The options that are available are the Location OUs in the portal or the options that were defined during implementation of Headcount Planning.
· Division - Select the division from the drop-down. The options that are available are the Division OUs in the portal or the options that were defined during implementation of Headcount Planning.
· Cost Center - Select the cost center from the drop-down. The options that are available are the Cost Center OUs in the portal or the options that were defined during implementation of Headcount Planning.
· Grade - Select the grade from the drop-down. The options that are available are the Grade OUs in the portal or the options that were defined during implementation of Headcount Planning.
· Manager - Select the position that will be the manager for the position. The options that are available are the Position OUs in the portal or the options that were defined during implementation of Headcount Planning.
Clone Multiple
Choose Clone Multiple to create multiple positions with the same details as the selected position. This will open a modal window requiring you to choose how many new positions that you’d like to create.
Click SAVE to add the position instance to the plan. The new position instance will appear in the plan under the Direct Reports section for the option selected in the Manager field.
View Incumbent and Division OU
You can hover over an item in the Hierarchy column to view the incumbent (user) and the Division Organizational Unit (OU).
Annual Cost
This column displays the sum of the cost of the position instances for all increments in the year displayed. The cost will adjust based on changes to headcount and FTE or other position attributes as defined by the costing model that you uploaded. For example, if you change the headcount from 1 to 0 for a position instance, then the cost will decrease (likely to 0 but is dependent upon how costing is configured) based on the removal of headcount.
Viewing and Editing Position (Instance) Attributes
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If you click a cell within the Plan Years for a given position, a small button will appear next to the cell, which opens the Position Details panel. This panel displays details of the position at that time increment. Some of the position details are read-only (i.e., Position Title, Incumbent, Job Title, etc), while others are always editable (i.e., FTE) or possibly editable depending on the configuration of the particular plan.
The position title and place in the time horizon displays at the top of the panel. The following additional fields and information displays for existing position instances:
· FTE - The FTE value is the percentage of full-time that each position instance requires. This is a required field. The acceptable values are 0 and 1 and any value in between within two decimal points. Decimal points round up. To enter a decimal, enter 0.[decimal number].
· Headcount - Enter a value of 1 or 0. You cannot edit the headcount as it is derived from FTE: any FTE greater than 0 means that the headcount is 1.
· Location - If this is enabled as editble by the plan creator, you can typethe criteria into the predictive search field. Matching values display in a drop-down below the field. Click a matching value to select it and add it as the attribute. The values that are available are the Location OUs in the portal or the options that were defined during implementation of Headcount Planning. The selected location will apply to the selected increment and all subsequent position increments in the plan. For example, if you change the location to Los Angeles in the second month of a 2-year plan, then months 2-24 will have the location of Los Angeles.
· Division - If this is enabled as editble by the plan creator, you can typethe criteria into the predictive search field. Matching values display in a drop-down below the field. Click a matching value to select it and add it as the attribute. The options that are available are the Division OUs in the portal or the options that were defined during implementation of Headcount Planning.
· Cost Center - If this is enabled as editble by the plan creator, you can typethe criteria into the predictive search field. Matching values display in a drop-down below the field. Click a matching value to select it and add it as the attribute. The options that are available are the Cost Center OUs in the portal or the options that were defined during implementation of Headcount Planning.
· Grade - If this is enabled as editble by the plan creator, you can typethe criteria into the predictive search field. Matching values display in a drop-down below the field. Click a matching value to select it and add it as the attribute. The options that are available are the Grade OUs in the portal or the options that were defined during implementation of Headcount Planning.
· Cost - This must be enabled as editable by the plan creator. This displays the cost value for the position instance or FTE. The cost will adjust based on changes to headcount and FTE. For example, if you change the headcount from 1 to 0 for a position instance, then the cost will decrease (likely to 0 but is dependent upon how costing is configured) based on the removal of headcount.
Targets
If the Targets feature was enabled at plan creation, you can click TARGETS to assign and manage Targets for you subplanners. See Headcount Plan - Targets on page 269 for additional information.
Position Costing
For portals that enable cost override, the cost of a position can be configured in the plan. See Headcount Plan - Position Costing on page 266 for additional information.
Edit Plan
Planners can edit their entire plans, even while they have subordinate managers working on subplans, as though everyone is working off of the exact same plan. This allows the senior planner to be able to edit any area of the plan, regardless if there is a subplan assigned.
Use Case
The Chief Technology Officer (CFO) is responsible for an organization of over 600 employees. During the headcount planning process, she assigns subplans to four subordinate managers while continuing to meet with senior executives to discuss the areas to which they want to expand and add headcount. Instead of waiting for her subordinate managers to finish their subplans, the CFO can go into her plan and add the positions that were requested by the senior executives.
Concurrent Editing of Plan
When more than one planner is editing a plan, the most recently saved updates overwrite any existing value.
[bookmark: concept87]Headcount Plan - Create a Plan 
The Create a Plan page is the first step in creating a headcount plan. From this page, you will define general information about the plan, such as the name and due date. You will also define the scope, position attributes, cost, and assign the plan. 
To access the Create New Plan page, go to Planning > Headcount Planning  and click the Create New Plan button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Work Force Planning - Administrator
	Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.
	Core Administration



	Work Force Planning - Owner
	Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Reporting Analyst
	Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Subplanner
	Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.
	Core Administration
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General
· Name of your Plan - Enter the plan name. There is no character limit.
· Area - Select the level and area of your organization that you'd like to plan for. The hierarchy displayed is the Reporting/Manager hierarchy.
· Targets - This option allows planners to access a Targets page from the plan and enter an annual cost budget for the plan. To enable the Targets option, toggle the slider to the right. When enabled, "On" displays to the right of the toggle. The Targets option is disabled by default.
Show Advanced Settings
The Instructions, Description, and BC Notifications To fields are visible in the Advanced Settings section but do not currently have functionality for the plan. The functionality may be available in a future release.
Scope
· What is the Time Horizon of this plan in years? - The time horizon is the total period of time for which the user intends to plan. Select one of the time horizon options. The options are in yearly increments, with 0.5 being six months.
· On what Time Increment are you planning? - This defines how the time horizon is broken up or segmented for planning purposes. Currently, the time increment is automatically defined as monthly. 
· What is the Start Date of the plan period? - This field allows you to define the start date of the time horizon. Click the Select a Date field to enter a start date. The date can be a current, future, or past date. For example, you select three years in the Time Horizon field. Then, you set the start date of the time horizon for June 2017. This would mean that the headcount plan would run from June 2017 to May 2020. When choosing the date range, keep in mind the date ranges that are included in your Cost Model file so that accurate costs are applied to the positions in your plan.
· If you want to include a period of time before your official plan year, you can extend the plan earlier to update that period, i.e., the current year.
Position Attributes
In this section, you can manage changes to the Main Attributes and the Optional Attributes in the planning configuration.
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Main Attributes
This section displays the fixed attributes of Position and Manager. These attributes cannot be removed and their order cannot be changed.
The following options are available in this section:
· Editable for complete - Check the box to enable the given position attribute to be editable once all required attributes have been populated.
· Editable for incomplete - Check the box to enable the given position attribute to be editable before all required attributes have been populated.
Optional Attributes
Optional attributes can be removed from a plan and their order can be changed.
The following options are available for each position attribute in this section:
· Editable for complete - This option is enabled by default. Check the box to enable the given position attribute to be editable once all required attributes have been populated.
· Editable for incomplete - This option is enabled by default. Check the box to enable the given position attribute to be editable before all required attributes have been populated.
· Effective dating - This option is disabled by default. When disabled, any changes to an attribute apply to the entire planning period. When enabled, any changes to an attribute apply to the selected time increment and all subsequent increments in the planning period.
· Inherited - This option is disabled by default. Inherited refers to inherited from the parent. When enabled, for new positions, this attribute will be populated to the same value as the parent (a.k.a., manager) position's attribute.
· Required - This option is disabled by default. This is an attribute that is required for a position to be Complete, except when an attribute is both Required and Restricted. In that case, when creating a new position, the planner could still save the position without the Required attribute.
· Restricted - This option is disabled by default. When enabled, the attribute can only be edited by the administrator or the owner of the plan. Whether enabled or disabled, the attribute is visible to all planners. This is often used for Costing information, which some organizations want to keep centrally controlled.
· Delete - Click the Delete icon [image: ] to delete the attribute from the plan. Planners will not see (nor be able to edit) this position attribute in the given plan. The position attribute will also not appear when exporting plan. Note: To add an attribute back to the plan, click the plus icon next to the deleted attribute.
Use Case
1. Kim is the Vice President of Human Resources at a company with 3,000 employees.
2. She is starting their annual headcount planning exercise and wants to limit which decisions can be made by planners during their planning. For example
1. She only wants them to see Location but not be able to edit Location.
2. She wants Costing of new positions to be done centrally by her Talent team as opposed to letting the clients enter costs directly.
3. She can now configure the scope of the plan for each individual plan, rather than make those changes portal-wide through an adjustment to a data feed.
Cost
In this section, planners can enable a Cost Override setting, which will allow planners to manually edit the cost components of any position within Planning. New cost components cannot be added at this point; the components available will be the same components that are in the original cost file.
The Cost Override setting is disabled by default. When enabled, planners will be able to edit costs on the plan. This decentralizes the control of costing from a Human Resources/Administrator team to all planners for their respective areas.
For information about manually editing cost components, see the Create Plan - Planning Page - Position Costing topic in Online Help.
Assignment
The following fields display in the Assignment section:
· Primary Planner - Select the primary planner from the users in the drop-down, which include the plan creator, the user who occupies the top most position instance in the plan, and possibly position instances at that highest level, depending on configuration. There can only be one primary planner per plan. This field is required and by default is the plan creator.
· Co-Planners - You can select any user in the portal. Select the user from the drop-down, and then click the plus icon to add the user as a co-planner. There can be unlimited co-planners per plan. This field is not required and, by default, there are no co-planners assigned.
· Due Date - Click the Select a Date field to enter a due date. The due date is not recognized as a date that will trigger any actions, such as closing the plan. This field is not required.
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Start Planning/Cancel
Click Start Planning to create your headcount plan. This saves the plan to the Active Plans section on the Headcount Planning homepage and opens the planning page. 
Important Note: Only click the Start Planning button once. If you click it more than once, you will create a new plan each time you click the button.
Click Cancel to cancel creating the plan.
[bookmark: _Ref276693450][bookmark: _Ref152682182]Headcount Plan - Position Costing
For portals that enable cost override, the cost of a position can be configured in the plan. The cost appears as a link in the right-side position details panel. Position costing gives plan owners control over costing of new positions that are added in a plan. New positions are queued for plan owners to assign costs, which provides more centralized control and visibility costing. Plan owners can also manually override any existing cost on each position.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Work Force Planning - Administrator
	Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.
	Core Administration



	Work Force Planning - Owner
	Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Reporting Analyst
	Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Subplanner
	Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.
	Core Administration
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Click the cost link to open the Cost Element pop-up. This pop-up allows you to override the existing cost assigned to the position. The monthly cost displays, as well as options to changethe cost. The fields you can modify depend on the cost components enabled for the portal.
Once you make the cost changes, click Save to save the changes, or click Restore Original to return the cost settings to their previous values.
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Use Case
Kim is in charge of the annual headcount planning for her entire company. She works closely with Finance and division managers to estimate the cost of each position. To make the process simpler, Kim and Finance have created cost groups for similar types of positions.
As planners are filling in their plans, she gets to see each new position (location, title, etc.) and decide how to apply the cost groups to the new positions. She goes to one central queue where all new positions from all plans are automatically added.
If she wants to edit a position's cost manually anytime, she can also go into the plan, find the position, and manually override the position's cost. She can override any part of the total cost, whether that is base salary, bonus, or medical benefit.
[bookmark: _Ref-2050439860][bookmark: concept89]Headcount Plan - Targets
From the Targets page, planners can provide a target annual cost budget within the plan by entering the budget targets on the Targets page. Providing subplanners with budget targets helps them to create plans that better fit within the organization's headcount goals.
To access the Targets page, go to Planning > Headcount Planning. On the Headcount Planning page, click the Go to Plan button for the appropriate plan. Click the Targets button. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Work Force Planning - Administrator
	Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.
	Core Administration



	Work Force Planning - Owner
	Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Reporting Analyst
	Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Subplanner
	Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.
	Core Administration
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Target Scorecard Boxes
For multi-year plans, a series of boxes appears above the plan table. The boxes display the Assigned by You and Assigned to You targets. The bottom number represents the difference between the target values.
A bar chart also displays, showing each year of the plan displayed with the At Target, In Plan, and Baseline values.
Plan Table - Baseline
The Baseline column reflects the organization as it existed at the time of the snapshot (i.e., when the plan was created). The monthly cost of those existing positions is multiplied by 12 to get a projected annual cost if nothing were to change in the plan.
You cannot manually change these values.
Plan Table - Plan Years
The additional columns display each year of the plan. In each column, you can enter the annual budget cost target by clicking into the column.
Once changes are made, they are immediately visible by the subplanners.
When entering target values, the value can be greater or less than the total annual target.
Use Case
Adam is the head of a company with 1,500 employees. After a series of strategy planning sessions, he wants to flush out a new direction with a headcount plan for the next two years. He wants to convey the new direction through the headcount planning workflow to his senior executives and the rest of his organization.
The direction is growing some areas of the company and plateauing other areas. Working with his finance team, he identifies how much people budget he can allocate to these different areas. With the Targets functionality, he can enter these budgets for each of his senior executives to deal with. In some areas, Adam can actually go further into the division and allocate to specific teams. The senior executives overseeing that area can also adjust Adam's specific targets for his team based on what Adam was able to communicate through the Target setting.
If it is a prolonged planning process, circumstances might change and require adjustments to targets, which is possible because they are not assigned in a final form.
As planners fill out their plans, they can see the targets set for them by their senior managers. This reduces the back-and-forth and saves everyone time.
[bookmark: _Ref1916096716]Assign Subplans
Use the Assign Subplans page, to assign and manage subplans for the headcount plan assigned to you. You can also view basic details about your overall headcount plan, such as the planners, due date, and plan period.
To access the Assign Subplans page select one of the following options:
· Click Start Planning from the Create a Plan page. 
· Click the Subplans button from the Planning page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Work Force Planning - Administrator
	Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.
	Core Administration



	Work Force Planning - Owner
	Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Reporting Analyst
	Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Subplanner
	Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.
	Core Administration
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Plan Name
The plan name displays at the top of the page. The plan name displays as "[Name of Plan] - [Area of the organization that is assigned in the subplan]."
Details
[bookmark: concept90]The Details link displays to the right of the headcount plan name. Click Details to open a pop-up that displays the planners, due date, and plan period. The pop-up also displays the area of the organization to which the headcount plan applies.
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Due Date
The due date of the overall plan displays in the upper-right corner of the page.
Bulk Assign
The Bulk Assign option allows plan owners to assign subplans to multiple users at different levels throughout the organization. Click Bulk Assign to open the Bulk Subplan Assignment page. See Assign Subplans - Bulk Assign on page 277 for additional information.
Go To Planning
Click Go To Planning to open the overall headcount plan. See Headcount - Planning Page on page 252 for additional information.
Subplan Status Export
Click Subplan Status Export to save the subplan to a .csv file. 
Assign Subplans Table
The Assign Subplans table displays the subplans and child subplans that are associated to a main headcount plan. The following information displays in the table:
· Hierarchy - This column displays the top level of the plan, encompassing the entire planning responsibility of the user. This column also displays the next two levels down the hierarchy, which are the direct reports and the reports of those direct reports.
· Entire Organization - This row represents the top level of the plan. The status for this row is always N/A, and there are no actions available.
· Direct Reports - This row represents the direct reports of the position to which the main plan rolls up (in example above the position is "VP, Operations"). The status for this row is always N/A, and there are no actions available.
· Next Level Down Direct Reports - This represents the direct reports of the reports in the Direct Reports row. The Primary Planner, Co-Planner, and Due Date columns will be blank for this row until a subplan is assigned. The status for this row is Not Assigned until a subplan is assigned.
· Headcount - This column displays the baseline headcount value, which is the value at the beginning of the plan (the moment of the snapshot). This value is for informational purposes only and can help the planner decide whether an area (the area within the organization to which the plan applies) is large and might require a subplan.
· Primary Planner - This column displays the name of the primary planner.
· Co-Planner - This column displays the name of the co-planner, if a co-planner is assigned.
· Due Date - This column displays the due date of the overall plan or the subplan.
· Subplan Status - This column displays the status of the subplan. The following are the possible statuses:
· Not Assigned - This status indicates that the subplan has not been assigned. Once a subplan is assigned, it will not return to this status.
· Assigned - This status indicates that the subplan is assigned but has not been started by the subplanner.
· In Progress - This status indicates that the subplan has been received. A subplan can return to this status after it was previously submitted but rejected by the senior planner.
· Submitted - This status indicates that the subplan has been submitted but has not been approved/rejected by the senior planner.
· Approved - This status indicates that the subplan was submitted, approved, and consolidated into its parent plan. The senior planner can edit the subplan area in this status (the subplanner no longer can edit the area).
· N/A - This displays for rows that are not editable (i.e., the subplan cannot be assigned). This always displays in the row for the main headcount plan.
Actions
The following actions display in the Actions column:
Note: No actions are available for the main headcount plan.
Assign Subplan
Subplans that are in the Not Assigned status can be assigned. To assign a subplan:
1. Click Assign from the Actions column. This opens the Assignment pop-up. The area within the organization to which the subplan applies displays in the Area field.
2. Select a primary planner from the Primary Planner drop-down. The options that are available are the direct reports of the position to which the main report rolls up.
3. Select a co-planner from the Co-Planner drop-down. You can select any user in the portal who was an active user at the time the headcount plan was created.
4. Enter a due date in the Due Date of your Plan field.
5. Click OK. This assigns the subplan to the primary planner and any co-planners that you have selected.
Once a subplan is assigned, the subplanner can manage the subplan in the same way that the planner manages the main headcount plan. The subplanner can access the plan from the main Headcount Planning page. For more information aboutthe Planning page of a headcount plan, see the Create Plan - Planning Page topic in Online Help.
Locked Headcount Planning Section
Once the subplan is assigned, the section of the main headcount plan that has been assigned is not editable on the headcount planning page. A lock symbol displays for that section of the plan until the subplan is completed by the subplanner. The user can still view that section of the plan but the user cannot edit any section of that plan. The values in that section of the plan reflect the point at which the subplan was assigned, not any changes made by the subplanner while the subplan was in the In Progress status.
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Edit Subplan
Click Edit to edit the subplan assignment. This opens the Assignment pop-up.The Primary Planner, Co-Planner, and Due Date are editable fields.
Note: Planners can edit their entire plans, even while they have subordinate managers working on subplans, as though everyone is working off of the exact same plan. This allows the senior planner to be able to edit any area of the plan, regardless if there is a subplan assigned.
Re-Assign
Click Re-Assign to reassign the subplan. You can re-assign to the same primary planner that previously completed the subplan, or change to another primary planner.
Cancel
This action displays for subplans that are in an Assigned or In Progress status. Click Cancel to merge the subplan with the main headcount plan, discarding any changes made by the subplanner and returning the subplan to the version that was assigned. This action cannot be changed once the subplan is merged with the main headcount plan.
Note: Cancelling a subplan does not automatically cancel its child subplans. Edits and submissions of those child subplans will not be merged with the main headcount plan.
Review
Click Review to review the subplan. This opens the subplan page, which displays the planning table and the details of the subplan. This is similar to the Planning page for the main headcount plan.
From the subplan page for subplans that are in a Submitted status, you can click Accept to accept the plan, or click Reject to reject the plan, which will return the subplan to the primary planner and co-planners for further edits.
For more information about the Planning page of a headcount plan, see the Create Plan - Planning Page topic in Online Help.
[bookmark: _Ref-1518104982]Assign Subplans - Bulk Assign
Plan owners can assign subplans to multiple users at different levels throughout the organization by using the Bulk Assign option on the Assign Subplans page. Bulk assignment helps ensure that subplans are assigned in a timely and efficient way, as far down the hierarchy as the administrator would like.
After the bulk assignment, individual planners and administrators can still assign new subplans or cancel subplans that were part of the bulk assignment.
Use Case
The senior planner wants to do a detailed headcount plan for 2017 and has only two weeks to get it done. To get the detail she needs, she wants input from managers four levels down the organization, which means about 105 managers, so it will require moving through the workflow quickly.
Using the Bulk Subplan assignment, she can provide the subplans to all of the managers right away, rather than assigning each subplan one manager level at a time. The first step is to set the criteria for the managers to receive a subplan, such as the minimum number of employees in their organizations levels of management from the top of the plan.
After entering the criteria, she downloads the list of relevant managers and realizes that it includes too many front-line managers. She scales back the criteria one level closer to the top level executive and gets a list that looks just right. She assigns the plan, and each manager can begin their work immediately.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Work Force Planning - Administrator
	Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.
	Core Administration



	Work Force Planning - Owner
	Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Reporting Analyst
	Grants reporting analyst-level access to plans. Users with this permission cannot create plans or edit plan metadata. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Subplanner
	Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.
	Core Administration
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Bulk Assign Subplans
To bulk assign subplans:
1. Click the Bulk Assign button on the Assign Subplans page. This opens the Bulk Subplan Assignment page.
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2. Configure the following information on the Bulk Subplan Assignment page:
1. Minimum reports in manager's organization - Enter the number of direct/indirect reports for the manager to whom you are assigning the subplan. By default, the value in this field is "50." There is no character limit or maximum number of reports that can be entered. However, the higher the number in this field, the less likely it is that there will be managers in the organization with that meet the criteria of having many direct/indirect reports.
2. Maximum levels from the top of the organization - Enter the number of manager levels you want to go down from the top of the plan. This allows you to limit the planning to senior/middle managers. You could also have a more comprehensive process by involving more levels of management. There is no character limit or maximum number of levels that can be entered. Note: If you create a plan for entire company, the number of levels will reference to the top most position of the organization in this level count. But, if you create a plan for a given Division Organizational Unit (OU), then the top most position in that division will be the reference point for this levels count, not the top level position in the organization.
3. List of Positions and Users fitting the above criteria (csv) - This feature allows you to download an Excel file that lists the manager positions that fit the criteria defined in the Criteria section of the Bulk Subplan Assignment page. You can review and analyze your potential subplan assignment using this file. This step is optional.
4. Due Date - Enter a date in the numeric text box or use the calendar to select a date. This is not a required field.
3. Click Assign. This assigns the subplans. The users who are assigned the subplan are notified via email. Note: The email is hard-coded and cannot be modified. The text indicates that the user has been assigned the plan and states the area of the plan for which the user is responsible.
Frequently Asked Questions
How many times can I bulk assign subplans in a plan?
You can only bulk assign once per plan.
Can I bulk assign subplans if I am assigned the subplan?
No. Only the user who created the subplan (i.e., the plan owner) can bulk assign subplans.
How do I know which of my bulk assigned plans have been executed and which are still in progress?
Use the progress tracker on the Planning home page to track subplan progress.
How do I undo the bulk assignment?
The bulk assignment cannot be undone in bulk. The only way to remove the assignment from a user is to do so manually by canceling the plan for each individual user.
Cost Model Manager
The Cost Model page enables you to upload Cost Model and Exchange Rate files. You can also view existing uploads.
This functionality is controlled by a backend setting that is disabled by default. To enable this functionality, contact Global Customer Support.
[bookmark: concept92]To access the Cost Model page, go to Admin > Cost Model Manager. Note: The Cost Model sublink will be added automatically to the Admin tab once the Cost Model Manager functionality is enabled in the portal, and provided that the user has the permission for Cost Model Manager.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Work Force Planning - Cost Model Manager
	Allows user to upload and manage costing files and exchange rates for Planning.
	Core Administration
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General Information
There can be multiple versions of cost uploads at any time, but new plans are always created from the most recently uploaded version. The most recently uploaded version replaces the existing file and applies to all plans created from that point thereafter (until another file upload replaces it).
Previously created plans are not automatically affected by uploaded cost files. To update cost for previous plans with a new cost file, go to the Planning homepage, then click the Actions drop-down for the specific plan and select Update Costs.
Both the Cost Model file and the foreign exchange rate file are required to create a plan, even if you do not want costs applied. By default, a cost model with blank values will be applied to all new plans until new cost files are uploaded.
For uploading a Cost Model and applying it to plans, the following is the recommended order:
New Plans
1. Upload foreign exchange rate file.
2. Upload Cost Model file.
3. Convert Users.
4. Create Plan.
Existing Plans
1. Upload an updated Cost Model or foreign exchange rate file, changing only the component values not the components or OUs.
2. Go to the existing plan on the homepage.
3. Click the Actions drop-down on the plan card and select Update Costs.
Upload Exchange Rates
Click the Upload Exchange rates button to upload an exchange rate file.
Important Note: The foreign exchange rate file must be loaded before the Cost Model file.
· The file must be comma-delimited.
· The file’s first row must contain the following two columns (case sensitive, in this order):
· Currency
· Exchange Rate
· The first row must be the base currency for the exchange rates. The base currency will be displayed by default and in cases where positions displayed are costed in different local currencies. All other currencies (if used) are converted to the base currency.
· The first row’s exchange rate must be 1.
· Even if you do not use multiple currencies, you must still upload this file. If you only want one currency, then define your currency as you want it displayed and put the value as 1. 
· Example: USD=1.
· If you use multiple currencies, you will provide additional rows defining those currencies as converted to the base currency at the top row.
· The file load does not require ISO currencies; there is no validation for this.
· If duplicate currencies are loaded, it will be noted as a validation error.
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Upload Cost Model
Click the Upload Cost Model button to upload a cost model file.
Important Note: The foreign exchange rate file must be loaded before the Cost Model file.
· The file must be comma-delimited.
· The file’s first row must contain the following columns (case sensitive, in this order):
· (Name of Attribute)
· Currency
· Year
· (Cost Items)
· This file determines the costs assigned to each position(seat) in Planning.
· Choose one organizational unit (OU) type as the basis for costing, and then define which OU values from that OU type have different costs. These appear as rows. For example, if you use Location OU type, you can decide the different costs of positions based on your associated Location OUs, showing each location on a different row.
· It is required to have one row that has OU value blank for each year. This acts as a catchall for any position (seat) that is associated with an OU not explicitly defined in the Cost Model file.
· The Cost Item Ref column (e.g., Location OU) must reference ou_id from dbo.ou table
· There is no validation for duplicate rows, but duplicate rows do not break costing.
· Provide cost components for the cost, such as base salary, bonus, and taxes paid by the employer. These components appear as columns with headers that you define.
· There is no limit to the number of cost components.
· In the main Planning interface, these components will be displayed in aggregate as a Total Cost.
· Provide currency per OU. The currency appears as a column.
· Provide different costs per year. The year appears as a column.
· If a plan is subsequently created for years not defined in the Cost Model file, the closest defined year will apply. For plans with years preceding, the application will take the earliest year available. For plans with years following, it will take latest year available.
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[bookmark: _Toc161996209]Position Management – Overview 
Position Management helps organizations organize their workforce more efficiently by defining Positions as unique roles within the organization, categorizing them by Jobs and job-related functions, and structuring them by Organizational Units (OUs). This is achieved by moving from a user-centric structure to a position-centric structure that establishes a new hierarchical framework that streamlines talent processes and reporting. 
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As a part of the Cornerstone HR product suite, Position Management in CSX provides an additional option to define, consolidate and map organizational data structures to meet the next levels of demand and flexibility. 
This is the first building block towards a position-centered foundation that empowers administrators to structure their organization around positions.
Key Features
Position Management's key features are as follows:
· Manage Positions - Manage complex organizational scenarios and simplify recurring changes by using a position-based organizational structure
· Manage Jobs - Collect or group several Positions together in a Job and setup a functional job structure
· Position Hierarchy - Specify the parent Position for each Position and to setup a Position based hierarchy representable in a Company Chart.​
· Multiple assignments - One Employee can be assigned to multiple Positions and one Position can be assigned to multiple employees.
· Organizational Unit Assignments - Manage the Organizational Hierarchy and assign Organization Units to Positions.​
· Identify Vacancies - The new relationship structure between Positions and Employees allows to identify and manage Vacancies.​
· Full Time Equivalent (FTE) Management - The ability to maintain and track the utilization of an Employee or Position to identify over-utilization and under-utilization.
· Effective Date of Assignments - Schedule future changes and keep all historic assignments in the organization. 
Essential Concepts
Position Management applies the following essential concepts:
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· User - An employee in the organization with a unique ID and assigned Positions, referred to as Incumbencies.
·  Each Employee has at least one Position, but can also have several Positions.
· Although an Employee can have multiple incumbencies, they normally have only one Position per Employee.
·  An Employee can be assigned to multiple Positions, but only one primary Position incumbency.
·  A Position can be assigned to multiple Employees, but only one primary Employee (Primary incumbent).
· Reporting Relationships (Manager & Subordinates), general Job information and the Standard Organization Unit assignments are derived from the (primary) Position assignments.
· Position - A role or responsibility in the organization or one specific "seat" with a multilingual title, a unique ID, and an assigned Job.
· Positions in a company are to be filled by individual holders - Employees or Users.
· Although a Position can have multiple incumbents, it normally has only one single incumbent. 
· An Employee can be assigned to multiple Positions, but only one primary Position. 
· A Position can be assigned to multiple Employees, but only one primary Employee. 
· The Position remains, even when the Employee leaves the Position.
· Each Position must be assigned to a Job. It is not possible to assign a Position to multiple Jobs.
· Reporting relationships (Manager & Subordinates) and assignments to different types of Organization Units can be defined for each Position.
· Job - A collection or grouping of multiple Positions with a multilingual title, a unique ID, and may have a collection of Positions assigned to it. 
· The Job describes a number of different Positions which are engaged in similar work.
· A Job is not concrete but rather the basis for the creation of various Positions with similar tasks and characteristics.
· Jobs are used to group several related Positions together so that certain types of information and general characteristics can be defined at the Job level and then inherited by all assigned Positions.
· A Position must always be related to a Job; Jobs serve as the layer for attributes that apply to all associated Positions.
· Employees are not directly assigned to Jobs. The Job information can be pushed to Users through Position assignments.
· A functional structure can be defined for each Job.
· Function - Each Job has an OU assignment with a connection between the Organizational Data and Jobs.
· Assignment to a functional type of Organization Units can be defined for each Job.​
· The Organization Unit memberships of a User are derived from the assigned Jobs of all Position assignments.​
· The Unit Assignment remain, even when a Position changes the Job.​
· Job Unit Assignment can be defined for a Functional organizational hierarchical structure.​
In practice, the Position Management structure appears as follows:
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[bookmark: _Toc161996210]Position Management - Home Page
When you open the Position Management Home page, you can select which area you want to view or manage. 
Options are:
· Positions - View and manage positions, including employee, job and unit assignments.
· Jobs - View and manage jobs, including position and function assignments.
· Organizational Units - View and manage the hierarchy of organizational units.
· Company Chart - View the position hierarchy of your company in an organizational chart. 
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You can select one of the tabs or boxes to access the area you want to view or manage.
 
 
[bookmark: _Toc161996211]Position Management - View Positions
Use the Positions tab to view Positions in Position Management. 
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Search Fields
You can search for Positions by:
· Title
· Position ID
· All current incumbents
You can filter search results by:
· Only Vacant Positions
· Include Inactive Positions
· Only Unbalanced FTE
Search results appear in the Positions table.
Add Position Button
Click Add Position to add a new Position Management position. 
Position Table
The Positions table contains the following information:
· Position Title - The assigned position title. Select a Position Title to view or edit position details.
· Assigned Job - The current assigned job of this position. 
· Position ID - The unique identifier for this Position.
· Status - The current status of this position. Options are Active or Inactive.
· FTE - Full-time equivalent (FTE) of position. Decimal value between 0.00000 and 1.00000.
· Primary Incumbent - The primary incumbent of this position. 
 
Position Management - View Positions
Use the Positions tab to view Positions in Position Management. 
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Search Fields
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Search results appear in the Positions table.
Add Position Button
Click Add Position to add a new Position Management position. 
Position Table
The Positions table contains the following information:
· Position Title - The assigned position title. Select a Position Title to view or edit position details.
· Assigned Job - The current assigned job of this position. 
· Position ID - The unique identifier for this Position.
· Status - The current status of this position. Options are Active or Inactive.
· FTE - Full-time equivalent (FTE) of position. Decimal value between 0.00000 and 1.00000.
· Primary Incumbent - The primary incumbent of this position. 
 
Position Management - View Position Details
Once you create a Position, you can edit or delete its details. 
You can view the following details for each Position:
· General Information
· Advanced Data (Custom Fields)
· Position Status and FTE Information
· Employee Assignment
· Organizational Structure
· Capabilities
To view position details:
1. Click the Positions tab and select a position in the Position Title column.
2. Review the options below to continue. 
Position General Information Section
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This section displays the following general information:
· Title - Title of the position.
· Description: Description details for this position. 
· Position ID - Position identification number
· Multiple Incumbents Allowed - Whether more than one incumbent user is allowed for this position.
· Utilization Control - Whether over-utilization is allowed for this position.
· Description - Short description details for this position.
You can edit position details or delete a position. 
Position Status and FTE Information Section
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This section displays the following status and FTE information: 
· Position Status tab - View, add, edit, and delete past, current, and future status information for this position. Each position must have a current status value.
· Position FTE Overview tab - View the Current FTE utilization for this position. This information is read-only.
Employee Assignment Section
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This section displays the following information about employees assigned to a position:
· Overview area - Displays information for employee assignments divided by Assigned Employees (Current), Planned Assignments (Future), and Incumbent History (Past). 
· Employee Assignment table - View, edit, unassign, or delete employee assignments. 
Note: If there are no employees assigned to this position, a Vacant Position message displays.
Organizational Structure Section
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This section displays the following information about Organizational Structure: 
· Overview tab- Job and Organizational Unit (OU) information for this position, including Job name, Parent Position, Division, Grade, Staff. Cost Center, and Location. This tab is read-only.
· Job Assignment tab - View, add, edit, and delete job assignments for this position. 
· Hierarchy tab - View the current Parent Position and Subordinate positions. This tab is read-only.
· Relationships tab - View, add, edit, and delete Parent Positions and view Subordinate Positions. 
· Organizational Units tab - View, add, edit, and delete standard and custom OU assignments. 
 Capabilities
See Position Management – Capabilities on page 353 for additional information.
 
Position Management - Manage Positions
Use the Positions tab to add a Position. 
You can perform the following Position management tasks:
· Add a Position
· Edit a Position
· Delete a Position
Add a Position
You can add new Positions at any time.
To add a Position:
1. Click the Positions tab. 
2. Click Add Position.
3. In the Details section, complete the following fields: 
· Title - The position title. This is a required field.
· Position ID - The unique identifier for this position. This is a required field.
· Description -The description of this position, if necessary.
4.  In the Status section, complete the following fields:
· Effective Date - The effective date for the position status.This is a required field that applies to all assignments.
· Active - The status of the Position. Select if this position is active. 
· Multiple Incumbents Allowed - Select this box if this position allows multiple people in this position at the same time; clear the box if this position does not allow multiple incumbents. 
· FTE - The Full Time Equivalent (FTE) value for this position. The default value is 1.00000. 
5. In the Job Assignment section, search for and select a Job related to this position. A position must be assigned to a job. 
6.  In the Organizational Units section, search for and select the appropriate options:
· Division - The Division for this position. 
· Grade - The Grade OU for this position. 
· Location - The location for this position.
· Cost Center - The Cost Center for this position. 
7. Click Save. The new position is saved and is listed on the Positions tab. 
Edit a Position
To edit a position
1. In the Position Title column, select the position you want to edit. 
2. Select Edit Position Details and make the appropriate changes
Delete a Position
You can delete any active position. 
Note: You cannot delete a Position that is currently or will be assigned to an Employee. All current and future Employee assignments must be removed before you can delete the Position.
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To delete a position:
1. In the Position Title column, select the position you want to delete. 
2. Select Delete Position. The selected position and all related information is deleted and no longer appears in the Positions table.
Position Management -View Position Advanced Data
Use the Advanced Data section to view and manage the custom fields information for a selected Position 
To view advanced data:
1. On the Positions tab, select the appropriate Position.
2. Locate the Advanced Data section.
· If there are any Position custom fields, these fields appear below the Advanced Position Data section. It is also possible to view the custom fields information for a current assigned Job, Standard or Custom Position OU.
· If there are any custom fields, these fields appear in the Advanced Job Data or Advanced Unit Data section.
Position Management - View Position Status and FTE Information
Use the Position Status and FTE Information section to view and manage status information of a selected Position. 
Position Status tab
[bookmark: 449462333] To access the Position Status tab:
1. Select the Positions tab.
2. In the Position Status and FTE Information section, select the Position Status tab:
Position Status Overview Section
The Position Status overview section provides an overview of status information for the selected Position, including the effective date, current status, and FTE value. Notes appear if available.
Add Position Status Button
Select Add Position Status to add a new position status to the selected Position. 
Position Status Table
The Position Status table contains the following fields:
· Effective Date - The effective date of the position status.
· Assignment Type: The status of the assignment based on the Effective Date. Options are History, Current, or Planned.
· Status - The position status. Changing the position status to inactive deactivates the selected position. 
·  FTE - The full-time equivalent (FTE) value for the position.
· Edit link - Edit the position status.
· Delete link - Delete the position status. You cannot delete an item if it is the only item in the table. 
Position FTE Overview Tab
The Position FTE Overview tab displays the FTE values for the selected Position. This information is read-only.
This tab also displays information for unbalanced FTE. The Position FTE Overview identifies over- and underutilization for the selected Position and displays information for unbalanced FTE. The Position is currently under- or overutilized if calculated "Remaining FTE In This Position” in not 0.
Edit/Delete Position Status
· The Edit link lets you edit position status details. 
· The Delete link lets you delete a position status. You cannot delete an item if it is the only item in the table or the Assignment Type is Current.
Position Management - Manage Position Status
Use the Position Status and FTE Information section to manage Position Status and view FTE information. 
You can perform the following tasks:
· Add Position Status
· Edit Position Status
· Delete Position status
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Manage Position Status
1. Select the Positions tab and search for or select the appropriate position. 
2. In the Position Status and FTE Information section, Select the Position Status tab.
Add Position Status 
To add Position status:
1. Select Add Position Status.
2. Complete the following fields:
· Effective Date - The effective date of the position status.
· Active - The status. If checked, this position is active; if unchecked, this position is deactivated. 
· FTE - The Full-Time Equivalent (FTE) value.
· Notes - Additional information related to this status. Notes information only appears in the overview section. 
3. Select Add. The position status information is visible in the overview area and the Position Status table.
Edit Position Status
Select the Edit link, make the appropriate changes, and select Save.
Delete Position Status
Select the Delete link. You cannot delete a position status with a Current status type or if it is the only item in the table. 
Position Management - View Employee Assignment
Use the Employee Assignment section to view and assign an active user to a Position. 
To view employee assignments:
1. On the Positions tab, select the appropriate Position.
2. Locate the Employee Assignment section.
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Overview Area
The overview area displays information for employee assignments divided by Assigned Employees (Current), Planned Assignments (Future), and Incumbent History (Past). Select an arrow to see specific details.
Add Employee Assignment Button
Select Add Employee Assignment to add new assignments. 
Employee Assignment Table
The Employee Assignment table contains the following information:
· Effective Date - The Effective Date of position-employee assignment.
· End date - The unassign date of the position-employee assignment.
· Incumbent - The name of the assigned employee.
· Current Status - The current status of the assigned employee. Options are Active or Inactive.
·  Primary Incumbent -Whether this is the primary incumbency of this position. Options are Yes or No.
· Primary Position - Whether this is the primary incumbency of the employee. Options are Yes or No.
· FTE Utilized By Employee In This Position - Full-time equivalent (FTE) of position-employee assignment. Decimal value between 0.00000 and 1.00000. Default value is 1.00000.
· Notes - Notes on the position-employee assignment.
 Position Management - Manage Employee Assignment
Use the Employee Assignment section to add, edit, unassign, and delete an employee assignment.
You can perform the following tasks:
· Assign an employee to a position
· Edit an employee assignment
· Unassign an employee
· Delete an employee assignment
 
Add an Employee to a Position
You can assign any active user to a Position. 
To assign an employee to a Position:
1. Select the Positions tab and select the appropriate Position.
2. In the Employee Assignment section, select Add Employee Assignment.
3. Complete the following:
· Effective Date - The date for this assignment. This date can be in the past, present, or future. 
· Primary Incumbent - Whether this employee is currently in the position.
· Primary Position - Whether this is the employee's primary position. 
· FTE Utilized by Employee in this Position - The FTE for this employee for this position. Options are 0 and 1 and any value in between within two decimal points. Decimal points round up. 
· Incumbent - The assigned employee.
· Notes - Additional information. 
4. Click Add. The assignment information is saved to the Employee Assignment section in the appropriate overview area and the details table. 
Edit an Employee Assignment
To edit an employee assignment, select Edit for the appropriate item, make the necessary changes, and select Save.
Delete an Employee Assignment
To delete an employee assignment, select Delete for the appropriate assignment, then select OK on the confirmation message. The selected employee assignment is removed from the table. 
Note: You cannot delete a current employee-position assignment. The employee must be unassigned from the position first before the employee-position assignment can be deleted.
Position Management - Unassign an Employee Assignment
Use the Employee Assignment section to unassign an employee from a Position. You can unassign an employee assignment at any time. The unassign date can be in the past, present, or future. 
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To unassign an employee assignment:
1. Select the Positions tab.
2. In the Position Title column, select the appropriate position.
3. In the Employee Assignment section, click Unassign for the appropriate assignment.
4. In the Unassign Date field, select the appropriate date.
5. Select Unassign.
The selected assignment displays appropriately in the overview area and the Employee Assignment table.
· If the unassign date is today or a future date – The employee is not directly unassigned from the position. An end date is entered and the employee is unassigned on the selected date.
· If the unassign date is today - The employee is unassigned on next day.
· If the unassign date is a past date – The employee is immediatly unassigned from the position
Position Management - Change Assignment Start Date
You can change an Employee Assignment start date to a past, current, or future date.
Note: You cannot change a future date to a current or past date. 
To change an employee assignment start date:
1. Click the Positions tab.
2. In the Position Title column, select the appropriate position.
3.  In the Employee Assignment section, select Edit for the employee assignment start date you want to change. 
4. In the Effective Date field, select the appropriate date.
The change displays in the overview section and the Employee Assignment table. 
Position Management - Manage Primary Incumbent
For each position-employee assignment you must define the primary incumbent and the primary position.
When unassigning the current primary incumbent of the position, the second incumbent is automatically entered as the new primary incumbent of the position and vice-versa. When unassigning the current primary position of the employee the second position is automatically entered as the new primary position of the employee.
This automatic change is not executed if it is not possible to clearly identify the new primary incumbent of the position or the new primary position of the employee. This occurs in particular for more than 2 active position-employee assignments.
Note: For past records, it is not possible to keep the “Primary Incumbent” or “Primary Position” information.
Note: Typically, a primary incumbency is designated when an employee assignment is added. 
To add or change Primary Incumbency:
1. Click the Positions tab.
2. In the Position Title column, select the appropriate position.
3. In the Employee Assignment section, click Edit for the appropriate employee assignment. 
4. In the Primary Incumbent box, check or clear the check-box. 
5. Click SAVE.
Position Management - View Organizational Structure
The Organization Structure section provides the current Organizational Structure information of a selected Position.
To access Organizational Structure section:
1. Select the Positions tab.
2. Select the appropriate Position Title.
3. Navigate to the Organizational Structure section. 
Overview tab
The Overview tab displays the current organizational structure of the selected Position. 
The following information displays:
· Job
· Parent Position (Direct) 
· Parent Position (Functional)
· Division
· Grade
· Cost Center
· Location
· Function
Job Assignment tab
View, add, edit, and delete job assignments for this position. Each Position must have a current assigned Job. 
Hierarchy tab
 View the current Parent Position and Subordinate positions for the direct or functional reporting line. This tab is read-only.
The Hierarchy tab contains the following information:
· Position Relation - Displays the selected reporting line. Options are Direct or Functional.
· Overview section - Displays overview Parent Position and Positions Reporting to specific Positions. 
Relationships tab
View, add, edit, and delete Parent Positions and Subordinate Positions. See ???
Organizational Units tab
View, add, edit, and delete OU assignments.
 
Position Management - View Organizational Unit Assignments
With Position Management essential organizational information is maintained and controlled in Position Management and certain organizational unit types are no longer directly connected to the User record.
Use the Organizational Units tab to view the organizational structure of a Position.
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To view organizational units:
1. Click the Positions tab and select a position in the Position Title column.
2. In the Organizational Structure section, select the Organizational Units tab.
Organizational Unit Type
Select the type of Organizational Unit (OU) you want to manage. Options are:
· Cost Center
· Division
· Grade
· Location
· Custom Position OU Types
Overview Area
The overview area displays information for organizational units, such as the Effective date, Division, Unit Name, Unit Status, and Notes, if available.
Add Unit Assignment Button
Select Add unit assignment to provide the assignment of a Position to an Organizational Unit for different OU Types.
Note: When creating a new Position-Unit Assignment, it is not possible to select Units that are currently inactive
Organizational Units Table
The Organizational Units table contains the following information:
· Effective Date - The Effective Date of position-unit assignment. 
· End date - The unassign date of the position-unit assignment.
· Position-Unit Assignment Type - Assignment type based on the Effective Date. Options are History, Current, or Planned.
· Unit - The assigned unit.
· Unit ID - The unique identifier for the assigned unit.
Edit/Delete Links
· Select Edit to edit the position-unit assignment.
· Select Delete to delete the position-unit assignment.
Position Management - Manage Organizational Unit Assignments
Use the Organizational Units tab to add, edit, and delete organizational units assignments for a Position.
To access the Organizational Units tab:
1. Select the Positions tab.
2. Select the appropriate Position Title.
3. In the Organizational Structure section, select the Organizational Units tab.
Add an Organizational Unit Assignment
To add an organizational unit assignment:
1. Select Add unit Assignment.
2. On the Add Unit Assignment screen, complete the following:
· Effective Date - The date the position-unit assignment starts.
· Unassign Date - The end date of the position-unit assignment assignment.
· Unit - The name of the organizational unit for this position.
· Notes - Additional information. Notes appear in the overview section.
3. Select Add. The unit assignment is added to the Position and appears in the table. 
Edit a Unit Assignment
To edit an organizational unit, select Edit for the appropriate unit assignment, edit the appropriate fields, and select Save. 
Delete a Unit Assignment
To delete an organizational unit assignment, select Delete for the appropriate unit assignment, and select Confirm on the confirmation panel. 
 
Position Management - View Job Assignments
Use the Job Assignments tab to view the Job information for a selected Position. Each Position must have a current assigned job.
To access the Job Assignment tab:
To access Organizational Structure section:
1. Select the Positions tab.
2. Select the appropriate Position Title.
3. Navigate to the Organizational Structure section and select the Job Assignment tab.
Position Status Overview Section
The Position Status overview section provides an overview of information for the selected job assignment, including the job and Job ID, Job Status, Function, and Notes.
Add Job Assignment Button
Select the Add Job Assignment Button to add a new job assignment. See ???
Job Assignment Table
The Job Assignment table contains the following fields:
· Effective Date - Effective date of this Position's job assignment.
· Position - Job Assignment Type - Assignment type based on the Effective Date. Options are History, Current, or Planned.
· Job - Assigned job title.
Edit/Delete Links
· Select Edit to edit a job assignment.
· Select Delete to delete a job assignment. 
 
. 
 
Position Management - Manage Job Assignments
Use the Job Assignments tab to add, edit, and delete job assignments for a Position.
To access the Position Status tab:
1. Select the Positions tab.
2. Select the appropriate Position Title.
3. In the Organizational Structure section, select the Job Assignment tab.
Add a Job Assignment
To add a job assignment:
1. Select Add Job Assignment.
2. On the Add Job Assignment screen, complete the following:
· Effective Date - The date the job assignment starts.
· Job - The title of the job.
· Notes - Additional information. Notes appear in the overview section.
3. Select Add. The job assignment is added. 
Edit a Job Assignment
To edit a job assignment, select Edit for the appropriate assignment, edit the appropriate fields, and select Save. 
Delete a Job Assignment
To delete a job assignment, select Delete for the appropriate assignment and select Confirm on the confirmation panel. Note:Each Position must always have a current assigned Job.
 
Position Management - View Parent and Subordinate Relationships 
Use the Relationships tab to view Parent and Subordinate relationships to a Position. 
 To access the Relationships tab:
1. Select the Positions tab.
2. Select the appropriate Position.
3. Navigate to the Organizational Structure section and select the Relationships tab.
Position Relation
The Position Relation lets you select the Position reporting hierarchy. Options are Direct or Functional. 
Parent Position Overview Section
The Parent Position overview section provides an overview of information for the selected parent position, including the effective date, name of the parent position, the primary incumbent, other incumbents, and Notes, if available.
Add Parent Position Button
Select to add a new Parent Position. 
Position Status Table
The Position Status table contains the following fields:
· Effective Date - The effective date of the parent position assignment.
· End date - The unassign date of the parent position assignment.
· Parent Position - The assigned parent position title.
· Primary Incumbent - The assigned primary employee for this parent position. 
· Edit link - Select to edit the parent position.
· Delete link - Select to delete the parent position. 
 
 
Position Management - Manage Parent Position
Use the Relationships tab in the Organizational Structure section to perform the following Parent Position tasks: 
· Add a Parent Position
· Edit a Parent Position
· Delete a Parent Position
A Parent Position assigns a parent position to a position through the reporting structure as follows:
· Direct - Direct solid-line reporting structure (Position Reporting Relationship). 
· Functional - Indirect dotted-line position reporting structure (Position Reporting Relationship). 
You can specify a Parent Position for each Position, but it is not mandatory. 
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Add a Parent Position
To add a parent position:
1. Select the Positions tab and select the appropriate position. 
2. Scroll down to the Organizational Structure section and select the Relationships tab.
3. In the Position Relation drop-down:
· Select Direct if this position is a direct report to this Parent Position.
· Select Functional if this position is a dotted line report to this Parent Position.
4. Select Add Parent Position.
5. Complete the following fields:
· Effective Date - Select the date this Parent Position assignment becomes active. This is mandatory. 
· Unassign Date - Select the end date for this Parent Position assignment. 
· Parent Position - Search for and select the appropriate Parent Position. This is mandatory.
· Notes - Enter any additional information. Notes only appear in the overview section. 
6. Select Add. The new Parent Position assignment is created and is visible in the table in the Organizational Structure table and the appropriate overview area.
Note: The current primary incumbent of the current assigned parent position (Direct Relationship) of User’s current primary assigned position identifies the Manager for the User.
Edit a Parent Position
1. On the Relationships tab, select Edit for the appropriate Parent Position.
2. Edit the appropriate fields.
3. Select Save.
Delete a Parent Position
On the Relationships tab, select Delete for the appropriate Parent Position. The Parent Position assignment is deleted.
 
Position Management - View Hierarchy
The Hierarchy tab displays the current Parent Position and current Subordinate positions of a selected position for the direct or functional reporting line. 
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You can view hierarchy by direct or functional reporting structure. 
[bookmark: _Toc161996212]Position Management - View Jobs
Use the Jobs tab to view jobs. 
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Search Fields
You can search for Jobs by:
· Title
· Job ID
You can filter search results by:
· Only Jobs Without Position
· Include Inactive Jobs
Search results appear in the Positions table.
Add Job Button
Select Add Job to add a new Job. 
Jobs Table
The Jobs table contains the following information:
· Job Title - The assigned job title. Select a Job to view or edit job details.
· Number of Assigned Positions - The number of Positions assigned to this job. 
· Job ID - The unique identifier for thisJob.
· Status - The current status of this job. Options are Active or Inactive.
Position Management - View Jobs
Use the Jobs tab to view jobs. 
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Search Fields
You can search for Jobs by:
· Title
· Job ID
You can filter search results by:
· Only Jobs Without Position
· Include Inactive Jobs
Search results appear in the Positions table.
Add Job Button
Select Add Job to add a new Job. 
Jobs Table
The Jobs table contains the following information:
· Job Title - The assigned job title. Select a Job to view or edit job details.
· Number of Assigned Positions - The number of Positions assigned to this job. 
· Job ID - The unique identifier for thisJob.
· Status - The current status of this job. Options are Active or Inactive.
Position Management - View Job Details
Once you create a job, you can view and edit its details. 
You can view the following details for each Job:
· General Information
· Advanced Data (Custom Fields)
· Job Status and FTE Information
· Job Organizational Structure
· Capabilities
To view job details:
1. Click the Jobs tab and select a job in the Job Title column.
2. Review the options below to continue. 
Job General Information Section
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This section displays the following general information:
· Title - Title of the job.
· Job ID - Job identification number. 
· Description - Short description details for this job.
You can also delete a job and edit general information for a job. 
Job Status and FTE Information Section
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This section displays the following status and FTE information: 
· Overview section - View brief details for the selected Job status. 
· Job Status tab - View, add, edit, and delete past, current, and future job status information for this position. Each job must have a current status value.
· Job FTE Overview tab - View the job FTE utilization for this position. This information is read-only.
Job Organizational Structure Section
This section displays the following information about the job organizational structure: 
· Position Assignment tab - View information about the position assignment associated with this job.
· Function tab - View information about the function associated with this job. 
 Capabilities
See Position Management – Capabilities on page 353 for additional information.
 
 
Position Management - Manage Jobs
You can add, edit, and delete jobs.
To access jobs, select the Jobs tab.
Add a Job
To add a job:
1. Select Add Job.
2. In the Details section, complete the following fields: 
· Title - The job title. This is a required field.
· Job ID - The unique identifier for this job. This is a required field.
· Description -The short description for this job, if necessary.
3.  In the Status section, complete the following fields:
· Effective Date - The effective date for the job.This is a required field that applies to all assignments.
· Active - The status of the Job. Select if this job is active; clear the checkbox if this position is not active.
4. In the Function section, assign an active existing Function to the job.
5. Select Save. The new job is saved and is listed on theJobs tab. 
Edit a Job
To edit general information for a job:
1. In the Job Title column, select the job you want to edit. 
2. Select Edit Job Details and make the appropriate changes.
3. Select Save.
Delete a Job
To delete a job:
1. In the Job Title column, select the job you want to delete. 
2. Select Delete Job. The selected position and all related information is deleted and no longer appears in the Jobs table.
Note: It is not possible to delete a Job that is currently or will be assigned to a Position. All current and future Position assignments must be removed before the Job can be deleted.
 
Position Management -View Job Advanced Data
Use the Advanced Data section to view and manage the custom fields information for a selected Job.
To view advanced data:
1. On the Jobs tab, select the appropriate Job.
2. Locate the Advanced Data section.
· If there are any Job custom fields, these fields appear below the Advanced Job Data section. It is also possible to view the custom fields information for a current assigned Function or Custom Job OU.
· If there are any custom fields, these fields appear in the Advanced Function Data or Advanced Unit Data section.
Position Management - View Job Status and FTE Information
Use the Position Job Status and FTE Information section to view and manage status information of a selected Job.
Job Status tab
[bookmark: -1024304543]To access the Job Status tab:
1. Select the Jobs tab.
2. In the Job Status and FTE Information section, select the Job Status tab.
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Job Status Overview Section
The Job Status overview section provides an overview of status information for the selected Job, including the effective date and current status. Notes appear if available.
Add Job Status Button
Select Add Job Status to add a new job status to the selected job.
Job Status Table
The Job Status table contains the following fields:
· Effective Date - The effective date of the job.
· Job Status Type - The job status type based on the Effective Date. Options are History, Current, or Planned.
· Edit link - Select to edit the job status.
· Delete link - Select to delete the job status. You cannot delete an item if it is the only item in the table. 
Job FTE Overview Tab
The Job FTE Overview tab displays the FTE values for the selected Job. This information is read-only.
Edit/Delete Job Status
· The Edit link lets you edit job status details. 
· The Delete link lets you delete job status. You cannot delete an item if it is the only item in the table or the Assignment Type is Current.
Position Management - Manage Job Status
Use the Position Status and FTE Information section to manage Job Status and view FTE information. 
You can perform the following tasks:
· Add Job status
· Edit Job status
· Delete Job status
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Manage Job Status
1. Select the Jobs tab and search for or select the appropriate job. 
2. In the Job Status and FTE Information section, select the Job Status tab.
Add Job Status 
To add Job status:
1. Select Add Job Status.
2. Complete the following fields:
· Effective Date - The effective date of the job status.
· Active - The status. If checked, this Job is active; if unchecked, this Job is deactivated. 
· Notes: Additional information related to this status. 
3. Select Add. The job status information is visible in the overview area and theJob Status table.
Edit Job Status
Select the Edit link, make the appropriate changes, and select Save.
Delete Job Status
Select the Delete link. You cannot delete a job status with a Current status type or if it is the only item in the table. 
[bookmark: _Toc161996213]Position Management- Company Chart
The Company Chart tab displays a position-based hierarchical view of all parent position relationships that show the structure of the organization. The Company Chart is always a full reflection of the Position Hierarchy and always shows all available Positions, including inactive and vacant Positions.
Note: Positions that have no hierarchical relationship No Parent And No Subordinate Position) are automatically excluded and not displayed in the chart view.
To access the Company Chart, open Position Management and select the Company Chart tab.
[image: ]
Search
You can search for a Position or Incumbent. Enter a date to view the position hierarchy for a selected effective date.
Direct/Functional Tabs
· The Direct tab displays the Position Hierarchy for the direct position reporting.
· The Function tab displays the Position Hierarchy for the functional position reporting.
Hierarchy Chart
Administrators can select a box that opens a flyout that displays position details for the selected position. Selecting a specific Position Incumbent, displays the Employee details. 
Position Management- Company Chart
The Company Chart tab displays a position-based hierarchical view of all parent position relationships that show the structure of the organization. The Company Chart is always a full reflection of the Position Hierarchy and always shows all available Positions, including inactive and vacant Positions.
Note: Positions that have no hierarchical relationship No Parent And No Subordinate Position) are automatically excluded and not displayed in the chart view.
To access the Company Chart, open Position Management and select the Company Chart tab.
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Search
You can search for a Position or Incumbent. Enter a date to view the position hierarchy for a selected effective date.
Direct/Functional Tabs
· The Direct tab displays the Position Hierarchy for the direct position reporting.
· The Function tab displays the Position Hierarchy for the functional position reporting.
Hierarchy Chart
Administrators can select a box that opens a flyout that displays position details for the selected position. Selecting a specific Position Incumbent, displays the Employee details. 
[bookmark: _Toc161996214]Position Management - View Organizational Unit Details
Once you create a Organizational Units (OU), you can edit or delete its details. 
You can view the following details for each Unit:
· General Information
· Unit Status and FTE Information
· Parent Unit
· Capabilities
To view OU details:
1. Select the Organizational Unit tab and select an Organizational Unit Type and Effective Date.
2. Review the options below to continue. 
OU General Information Section
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This section displays the following general information:
· Name - Unit name. This is a required field.
· Unit ID - Identifier for this unit. This is a required field.
· Description - Description details for this unit. 
· Owner - Employee assigned to this unit.
· Approver - Employee assigned as approver for the cost center. This only appears for the Cost Center Unit Type.
· Default Culture - Default unit language.
The following fields display for the Location OU type:
· Facility Type - Pre-defined list of facility type values for the location. This is a required field.
· Country - Pre-defined list of country values for the location.
· Address #1 -First line of the facility's address.
· Address #2 - Second line of the facility's address.
· City - The city in which the facility is located.
· Postal Code - The postal code that corresponds with the facility's location.
· Time Zone - Pre-defined list of time zone values for the location. This field is required.
· Contact - Assigned employee name who serves as the contact for the facility.
· Phone - The contact employee's phone number.
· Fax - The contact employee's fax number.
· Email - The contact employee's email address.
· Occupancy - The maximum number of users who can safely occupy the room during a training
· session.
· Approval Required - Unit setting to define if approval is required from the location owner for sessions
· scheduled at this location (Yes or No).
· On Site - Unit setting to distinguish which facilities are on or off-site based on the company's definition of an on or off-site course (Yes or No).
You can edit position details or delete a position. 
Advanced Data Section
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If there are any unit custom fields, these fields types below the Advanced Data section.
Unit Status and FTE Information Section
[image: ]
This section displays the following status and FTE information: 
· Unit Status tab - View, add, edit, and delete past, current, and future status information for this unit. Each unit must have a current status value.
· Unit FTE Overview tab - View the Current FTE utilization for this unit. This information is read-only.
Parent Unit
View and manage the Parent Unit information for a unit. You can add, edit, and delete a Parent Unit.
Changing the parent unit will move the selected unit and all dependent child units. Changing the parent unit will not change any parent unit for a child unit.
This section displays the following information:
· Effective Date - Effective date of the parent unit assignment. 
· End Date - End date (Unassign Date) of the parent unit assignment.
· Parent Unit - Assigned parent unit name.
· Notes - Notes on the parent unit assignment.
Capabilities
See See Position Management – Capabilities on page 353 for additional information.
Position Management - View Organizational Units 
Organizational Units support multiple hierarchies of Organizational Unit (OU)types and units that reflect the organizational structure.
The organization structure tree presents a hierarchical view of information. For each unit, a master OU tree displays and the details for the currently selected Unit to support different levels of the organizational structure. All OU types can be managed in a hierarchical structure by defining parent and child associations. Each Unit can have a parent unit and a number of child units.
To access Organizational Units, select the Organizational Units tab. 
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Organizational Unit Types
Select an OU type to view the configured hierarchy for the selected OU type.
The following are OU types for Positions:
· Cost Center
· Division
· Grade
· Location
· Custom Position OU Types
Available OU Types for Jobs:
· Function
· Custom Job OU Types
See See Position Management – Add Custom OU Types on page 340 for additional information.
Effective Date 
View the configured organizational hierarchy for the selected date. 
Search Units
Search for a specific unit by name or ID.
All Units
Displays all units created for the selected Organizational Unit Type on the specified Effective Date.
Selecting the > next to a unit displays unit details. 
Position Management - View Organizational Unit Details
Once you create a Organizational Units (OU), you can edit or delete its details. 
You can view the following details for each Unit:
· General Information
· Unit Status and FTE Information
· Parent Unit
· Capabilities
To view OU details:
1. Select the Organizational Unit tab and select an Organizational Unit Type and Effective Date.
2. Review the options below to continue. 
OU General Information Section
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This section displays the following general information:
· Name - Unit name. This is a required field.
· Unit ID - Identifier for this unit. This is a required field.
· Description - Description details for this unit. 
· Owner - Employee assigned to this unit.
· Approver - Employee assigned as approver for the cost center. This only appears for the Cost Center Unit Type.
· Default Culture - Default unit language.
The following fields display for the Location OU type:
· Facility Type - Pre-defined list of facility type values for the location. This is a required field.
· Country - Pre-defined list of country values for the location.
· Address #1 -First line of the facility's address.
· Address #2 - Second line of the facility's address.
· City - The city in which the facility is located.
· Postal Code - The postal code that corresponds with the facility's location.
· Time Zone - Pre-defined list of time zone values for the location. This field is required.
· Contact - Assigned employee name who serves as the contact for the facility.
· Phone - The contact employee's phone number.
· Fax - The contact employee's fax number.
· Email - The contact employee's email address.
· Occupancy - The maximum number of users who can safely occupy the room during a training
· session.
· Approval Required - Unit setting to define if approval is required from the location owner for sessions
· scheduled at this location (Yes or No).
· On Site - Unit setting to distinguish which facilities are on or off-site based on the company's definition of an on or off-site course (Yes or No).
You can edit position details or delete a position. 
Advanced Data Section
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If there are any unit custom fields, these fields types below the Advanced Data section.
Unit Status and FTE Information Section
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This section displays the following status and FTE information: 
· Unit Status tab - View, add, edit, and delete past, current, and future status information for this unit. Each unit must have a current status value.
· Unit FTE Overview tab - View the Current FTE utilization for this unit. This information is read-only.
Parent Unit
View and manage the Parent Unit information for a unit. You can add, edit, and delete a Parent Unit.
Changing the parent unit will move the selected unit and all dependent child units. Changing the parent unit will not change any parent unit for a child unit.
This section displays the following information:
· Effective Date - Effective date of the parent unit assignment. 
· End Date - End date (Unassign Date) of the parent unit assignment.
· Parent Unit - Assigned parent unit name.
· Notes - Notes on the parent unit assignment.
Capabilities
See See Position Management – Capabilities on page 353 for additional information.
Position Management - Manage Organizational Units
You can add, edit, and delete units.
To access Organizational Units, in Position Management, select the Organizational Units tab.
Add a Unit
To add a unit:
1. Select an Organizational Unit Type and Effective Date.
2. Select Add Unit.
3. In the Parent Unit section, select the appropriate Parent Unit, if applicable.
4.  In the General section, complete the following:
· Name - The name of the unit. This is a required field.
· Unit ID - The identifier for this unit. This is a required field.
· Description - A short description of this unit.
· Owner - The owner of this unit.
· Approver - The approver for this unit. Applies to Cost Center only.
5. In the Status section, complete the following:
· Effective Date - The effective date for the Unit. By default, this date is the first month in the planning period. You can select a different date. 
· Active - The status of the Unit. Select if this unit is active; clear the checkbox if this unit is not active.
6. In the Advanced Data section, enter the required custom fields.
7. Select Save.
Edit a Unit
To edit general information for a unit:
1. Search for or select the appropriate unit.
2. Select Edit General Information and make the appropriate changes. 
3. Select Save.
Delete a Unit
You cannot delete a Unit that is currently or will be assigned to a Position. All current and future Position assignments must be removed before the Unit can be deleted.
You cannot delete a Unit that is currently or will be assigned as a Parent Unit to a Unit. All current and future Parent Unit assignments must be removed before the Unit can be deleted.
To delete a unit:
1. Select the appropriate unit.
2. Select Delete Unit.
Position Management - Manage Unit Status
Use the Unit Status and FTE Information section to manage Position Status and view FTE information. 
You can perform the following tasks:
· Add Unit Status
· Edit Unit Status
· Delete Unit Status
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Manage Unit Status
1. Select the Organizational Units tab and search for or select the appropriate unit. 
2. In the Unit Status and FTE Information section, select the Unit Status tab.
Add Unit Status 
To add Unit status:
1. Select Add Unit Status.
2. Complete the following fields:
· Effective Date - The effective date of the unit status. This is a required field.
· Active - The current status. If checked, this unit is active; if unchecked, this Unit is deactivated.
3. Select Add. The unit status information is visible in the Unit Status table.
Edit Unit Status
Select the Edit link, make the appropriate changes, and select Save.
Delete Unit Status
Select the Delete link. You cannot delete a Unit status with a Current status type or if it is the only item in the table. 
 
 
 
 
Position Management - Manage OU Parent Unit Assignment
Use the Parent Unit section to manage Parent Unit information.
You can perform the following tasks:
· Add Parent Unit
· Edit Parent Unit
· Delete Parent Unit.
Manage Parent Unit 
1. Select the Organizational Units tab and search for or select the appropriate unit. 
2. Go to the Parent Unit section to continue.
Add Parent Unit 
To add a Parent Unit:
1. Select Add Parent Unit.
2. Complete the following fields:
· Effective Date - The effective date of the Parent Unit. This is a required field.
· End Date - The End Date (Unassign Date) of the parent unit assignment.
· Active - The current status. If checked, this Unit is active; if unchecked, this Unit is deactivated.
· Notes: Additional information related to this status.
3. Select Add. The unit status information is visible in the Unit Status table.
Edit Parent Unit 
Select the Edit link, make the appropriate changes, and select Save. Note: Changing the parent unit will reorganize (move) the selected unit and all
Delete Parent Unit
Select the Delete link. You cannot delete a Parent Unit status with a Current status type or if it is the only item in the table. 
 
[bookmark: _Ref-887866205]Position Management – Add Custom OU Types 
In Position Management, users can add custom OU Types to the Position and Job. User’s custom OU memberships can be identified for all current Position assignments.
Note: Once Position Management is activated, standard and custom Organizational Units for Positions and Jobs are managed within Position Management and not within the existing OU administration pages.
Custom OU Types
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Custom OU Types are managed in the Organizational Unit Type Management. 
When creating a new custom OU Type, a field Selections that impact the assignment is available to tie the custom OU to the Position or the Job.
This new field has the following options:
· User –The custom OU is defined at the user record level.​
· Positions – Ties the custom OU to the Position.​
· Jobs –Ties the custom OU to the Job.
If the Positions or Jobs option is selected, users cannot update the value of this custom OU at the user record level. Users can create several custom OU types for Positions and Jobs. 
To access Organizational Unit Type Management, go to ADMIN > TOOLS > CORE FUNCTIONS > ORGANIZATIONAL UNITS. Then, select the Manage Organizational Unit Types link.
Custom OU Hierarchy
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If Positions or Jobs is selected from the Selections that impact the assignment drop-down, the hierarchy is managed in Position Management. 
Organizational Unit Types can be managed in a hierarchical structure by defining parent and child associations. After selecting an Organizational Unit, the following information can be viewed and managed:​
· General Information
· Advanced Data (Custom Fields) ​
· Unit Status (Active/Inactive) (Effective Dated)​
· Unit FTE Overview
· Assigned Parent Unit (Effective Dated)​
· Capabilities
To access this functionality, go to Position Management and select the Organizational Units tab. Select a custom Position OY Type or custom Job OU Type in the drop-down. 
If Users is selected from the Selections that impact the assignment drop-down, the hierarchy management is not managed in Position Management. 
Assign Custom OUs to Positions and Jobs
Position Manager displays information about past, current, and future Units. Users can schedule future changes to keep all historic assignments in the organization. 
Positions Organizational Units
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Assigning custom OUs to Positions for all the custom OU types is done at the Position level. 
To access this page, go to Position Management, select the Position tab, and then select a Position. On the details page, locate the Organizational Structure section and select the Organizational Units tab. 
Jobs Organizational Units
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Assigning custom OUs to Jobs for all the custom OU types associated is done at the Job level. 
To access this page, go to Position Management, select the Jobs tab, and then select a Job. On the details page, locate the Job Organizational Structure section and select the Organizational Units tab. 
User's Custom OUs
A user's custom Position and Job OU memberships of are derived from all current Position and Job assignments, allowing users to have multiple assigned custom OUs. All current assigned custom OUs to User’s Positions and Job are displayed on the user record. 
As a result, all changes must be made in the Position Management environment through a valid Position assignment. It is not possible to update the information directly on the User record when creating or editing a user.
The Standard Organizational Units from an employee’s primary position will be synchronized to the user record (Division, Location, Grade and Cost center). An employee would have only one Division, Location, Grade and Cost center, even if they are assigned to multiple position with different Divisions, Locations, Grades and Cost Centers.​​
Considerations
· For custom fields, custom Edge Import Loads and reporting capabilities are not available. 
· Custom Position OUs and custom Job OUs are available in Position Management constraints.​
Implementation
To enable this functionality, contact Global Customer Support.
[bookmark: _Toc161996215]Position Management - Users
The User record determines which Organizational Unit the user is associated with, such as Position, Job, Function, Cost Center, Division, Grade, Location or custom OU Types.
With Position Management, the organization is maintained and controlled via a Position structure and essential organizational information of the User is derived from the current Position assignments. The connection between the organizational data and the employee data is now established by assigning users to positions. Reporting Relationships (Manager and Subordinates), and the Organization Structure memberships are derived from User’s current Position assignments.
To access the User Records Administration page, go to ADMIN > TOOLS > CORE FUNCTIONS > USERS.
The following User record information is now derived from all current Position assignments:
· User’s Positions - All assigned Positions.
· User’s Jobs - All assigned Jobs (Across all current assigned Positions).
· User’s Functions - All assigned Functions (Across all current assigned Positions).
· User’s custom Position OUs - All assigned custom units (Across all current assigned Positions).
· User’s custom Job OUs - All assigned custom units (Across all current assigned Positions).
The following User record information is now derived from current primary Position assignment:
· User’s (Legacy) Position* - Assigned primary Position.
· User’s Manager - Primary incumbent of parent position (Direct Relationship) of assigned primary Position.
· User’s Cost Center - Assigned Cost Center unit of assigned primary Position.
· User’s Division - Assigned Division unit of assigned primary Position.
· User’s Grade - Assigned Grade unit of assigned primary Position. 
· User’s Location - Assigned Location unit of assigned primary Position.
Position Management - Users
The User record determines which Organizational Unit the user is associated with, such as Position, Job, Function, Cost Center, Division, Grade, Location or custom OU Types.
With Position Management, the organization is maintained and controlled via a Position structure and essential organizational information of the User is derived from the current Position assignments. The connection between the organizational data and the employee data is now established by assigning users to positions. Reporting Relationships (Manager and Subordinates), and the Organization Structure memberships are derived from User’s current Position assignments.
To access the User Records Administration page, go to ADMIN > TOOLS > CORE FUNCTIONS > USERS.
The following User record information is now derived from all current Position assignments:
· User’s Positions - All assigned Positions.
· User’s Jobs - All assigned Jobs (Across all current assigned Positions).
· User’s Functions - All assigned Functions (Across all current assigned Positions).
· User’s custom Position OUs - All assigned custom units (Across all current assigned Positions).
· User’s custom Job OUs - All assigned custom units (Across all current assigned Positions).
The following User record information is now derived from current primary Position assignment:
· User’s (Legacy) Position* - Assigned primary Position.
· User’s Manager - Primary incumbent of parent position (Direct Relationship) of assigned primary Position.
· User’s Cost Center - Assigned Cost Center unit of assigned primary Position.
· User’s Division - Assigned Division unit of assigned primary Position.
· User’s Grade - Assigned Grade unit of assigned primary Position. 
· User’s Location - Assigned Location unit of assigned primary Position.
[bookmark: _Toc161996216]Position Management – Capabilities
A Capabilities section displays details from a capability model for: ​
· Positions​
· Jobs​
· Functions​
· Standard Position OU Types (Division, Location, Cost Center & Grade)​
· Custom OU Types for Position and Jobs
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Capabilities relies and focuses only on surfacing/displaying details from capability models configured within Capability Management. If a modification is made at the capability model level, it is dynamically reflected in Position Management.
Capability Views
There are two views in PM capability management:
· Tags View
· Table View
Additionally, users can search for capabilities by Target Level, Category, Source, and Capability Model.
Tags View
The Tags view has the following features:
· Assigned capabilities listed in alphabetical order.
· A counter that displays the number of current assignments/occurrences.
Selecting a capability opens a flyout that displays Target Level, Audience, and Capability Model. 
Table View
· Assigned capabilities listed in alphabetical order.
· Information about ID, Capability, Target Level, Category, source, and Capability Model.
Capabilities for Positions
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Capabilities for a Position are displayed using multiple sources, because Positions can be associated with different Jobs, Functions, and Organizational Units (OUs).​
Any capability associated to a Position or can be derived from a Job, Function or an Org Unit assigned to the Position will be displayed on the Position.​
Capabilities for Jobs
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Capabilities for a Job are displayed using multiple sources because a Job can be associated to a Function and Custom Job OUs .​
Any capability associated with a capability model where the audience is set to a Job or can be derived from a Function or Custom Job OU associated to the Job is displayed on the Job. ​
Capabilities for Functions
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Capabilities for a Function display for capability models set to a Function as a source.​
Any capability associated to a capability model where the audience has been set to a Function is displayed on the Function.​
Capabilities for Organizational Units
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Capabilities for a Function display for capability models which are set to a Function as a source.​
Any capability associated to a capability model where the audience has been set to a Function is displayed on the Function.
​​
Implementation
To enable this functionality, contact Global Customer Support.
[bookmark: _Ref-711970241]Position Management – Capabilities
A Capabilities section displays details from a capability model for: ​
· Positions​
· Jobs​
· Functions​
· Standard Position OU Types (Division, Location, Cost Center & Grade)​
· Custom OU Types for Position and Jobs
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Capabilities relies and focuses only on surfacing/displaying details from capability models configured within Capability Management. If a modification is made at the capability model level, it is dynamically reflected in Position Management.
Capability Views
There are two views in PM capability management:
· Tags View
· Table View
Additionally, users can search for capabilities by Target Level, Category, Source, and Capability Model.
Tags View
The Tags view has the following features:
· Assigned capabilities listed in alphabetical order.
· A counter that displays the number of current assignments/occurrences.
Selecting a capability opens a flyout that displays Target Level, Audience, and Capability Model. 
Table View
· Assigned capabilities listed in alphabetical order.
· Information about ID, Capability, Target Level, Category, source, and Capability Model.
Capabilities for Positions
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Capabilities for a Position are displayed using multiple sources, because Positions can be associated with different Jobs, Functions, and Organizational Units (OUs).​
Any capability associated to a Position or can be derived from a Job, Function or an Org Unit assigned to the Position will be displayed on the Position.​
Capabilities for Jobs
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Capabilities for a Job are displayed using multiple sources because a Job can be associated to a Function and Custom Job OUs .​
Any capability associated with a capability model where the audience is set to a Job or can be derived from a Function or Custom Job OU associated to the Job is displayed on the Job. ​
Capabilities for Functions
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Capabilities for a Function display for capability models set to a Function as a source.​
Any capability associated to a capability model where the audience has been set to a Function is displayed on the Function.​
Capabilities for Organizational Units
[image: ]
Capabilities for a Function display for capability models which are set to a Function as a source.​
Any capability associated to a capability model where the audience has been set to a Function is displayed on the Function.
​​
Implementation
To enable this functionality, contact Global Customer Support.
[bookmark: _Toc161996217]Permissions - Position Management
This page contains permissions that may apply to organizations using Position Management.
Position Management
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Company Chart - View
	Grants users the ability to access the Position Management Company Chart. This permission cannot be constrained.
	Position Management



	Jobs: Job - Add
	Grants users the ability to add jobs. This permission cannot be constrained.
	Position Management



	Jobs: Job - Delete
	Grants users the ability to delete jobs. This permission can be constrained by Standard OUs, Positions, Jobs, and Functions.
	Position Management



	Jobs: Job Basic Information - Manage
	Grants users the ability to manage general information of jobs. This permission can be constrained by Standard OUs, Positions, Jobs, and Functions.
	Position Management



	Jobs: Jobs - View
	Grants users the ability to view jobs. This permission can be constrained by Standard OUs, Positions, Jobs, and Functions.
	Position Management



	Jobs: Organizational Units - Manage
	Grants users the ability to assign Functions to jobs. This permission can be constrained by Standard OUs, Positions, Jobs, and Functions.
	Position Management



	Jobs: Search Unit
	Grants users the ability to view Functions when assigning Functions to jobs. This permission can be constrained by Functions.
	Position Management



	Organizational Units: Basic Information - Manage
	Grants users the ability to manage general information of standard organizational units and Functions. This permission can be constrained by Standard OUs and Functions.
	Position Management



	Organizational Units: Basic Information - Search User
	Grants users the ability to set the owner on standard organizational units and Functions. This permission can be constrained by User’s Corporation​User’s Standard OUs, Custom OUs, Positions, Jobs, Functions,​ and User​Standard OUs.
	Position Management



	Organizational Units: Organizational Units - View
	Grants users the ability to view standard organizational units and Functions, including full visibility of the hierarchy of the organizational unit. This permission can be constrained by Standard OUs and Functions.
	Position Management



	Organizational Units: Parent Unit - Manage
	Grants users the ability to manage parent unit assignments of standard organizational units and Functions. This permission can be constrained by Standard OUs and Functions.​
	Position Management



	Organizational Units: Parent Unit - Search Parent Unit​
	Grants users the ability to view standard organizational units and Functions when assigning the parent. This permission can be constrained by Standard OUs and Functions.
	Position Management



	Organizational Units: Unit - Add
	Grants users the ability to add standard organizational units and Functions. This permission cannot be constrained.
	Position Management



	Organizational Units: Unit - Delete
	Grants users the ability to delete standard organizational units and Functions. This permission can be constrained by Standard OUs and Functions.
	Position Management



	Position Management - Manage
	Grants users the ability to access Position Management. This permission cannot be constrained.
	Position Management



	Positions: Position - Add​ ​
	​Grants users the ability to add positions. This permission cannot be constrained.
	Position Management



	Positions: Basic Information - Manage
	Grants users the ability to manage general information of positions.​
	Position Management



	Positions: Employee Assignments - Manage
	Grants users the ability to manage user assignments to positions.​This permission can be constrained by Standard OUs, Positions, Jobs, and Functions.
	Position Management



	Positions: Employee Assignments - Search User
	Grants users the ability to view users when assigning them to positions. This permission can be constrained by User’s Corporation, User’s Standard OUs, Custom OUs, Positions, Jobs, and Functions​.
	Position Management



	Positions: Job Assignments - Manage
	Permission that allows users to manage job assignments to positions. This permission can be constrained by Standard OUs, Positions, Jobs, and Functions.
	Position Management



	Positions: Job Assignments - Search Job
	Grants users the ability to view jobs when assigning jobs to positions. This permission can be constrained by Standard OUs, Positions, Jobs, and Functions.
	Position Management



	Positions: Organizational Units - Manage
	Grants users the ability to manage standard organizational units and Functions assignments to positions. This permission can be constrained by Standard OUs, Positions, Jobs, and Functions.
	Position Management



	Positions: Position - Add
	Grants users the ability to add positions. This permission cannot be constrained.
	Position Management



	Positions: Position - Delete
	Grants users the ability to delete positions. This permission can be constrained by Standard OUs, Positions, Jobs, and Functions.
	Position Management



	Positions: Positions - View
	Grants users the ability to view positions. This permission can be constrained by Standard OUs, Positions, Jobs, and Functions.
	Position Management



	Positions: Relationships - Manage
	Grants users the ability to manage parent position assignments to positions. This permission can be constrained by Standard OUs, Positions, Jobs, and Functions.
	Position Management



	Position: Relationships - Search Parent Position​
	Grants users the ability to view positions when assigning the parent.
	Position Management



	Positions: Search Unit
	Grants users the ability to view standard organizational units and Functions when assigning the parent.
	Position Management


[bookmark: _Toc161996218]User Record Overview
User Records represent the complete profile of each user in the system, including each user's unique identifiers. Often, all user information is loaded and updated via a data feed from your organization's Human Resource Information System (HRIS). In this case, administrators rarely update user information manually through the system. However, the user record serves as a critical source of baseline information for each user.
[bookmark: _Toc161996219]User Record Auditing
With User Record Auditing, administrators can audit all modifications to employee data. This provides administrators complete insight into what fields have been modified, when they were modified, what they were modified from and to, and the user who made the modification.
User Record Auditing is intended to enable organizations to track changes to user records more easily.
[bookmark: concept94]User Record Auditing is a feature that is included with Cornerstone HR.
User Record Modifications
Changes to the user record that are made from the following areas of the system are tracked and audited:
· User Record
· My Account
· Self Registration
· Old Forms
· New Forms
· Data Load Wizard
Considerations
· Any changes that are made to the user record from areas not listed in the User Record Modifications section above are not audited.
· Users must have permission to view the user record field in order to view the changes in the Modification History section.
· The field must be available to the user in order to view the changes in the Modification History section.
· When User Record Auditing is enabled, the Modification History section displays all audited changes to the user record. However, if the Changed From and Changed To values are not available, then "Not tracked" is displayed in these columns.
Implementation
When Cornerstone HR is enabled for a portal, then this functionality is also enabled.
The availability of the User Record Auditing functionality is controlled by a backend setting, which is disabled by default.
Enabling Cornerstone HR requires data migration. Because of this, Cornerstone HR can only be activated by submitting a case to Global Customer Support.
User Record - User Record Auditing
When User Record Auditing is not enabled, the Modification History table displays each time the User Record page is edited for a user. This includes the name and username of the user who modified the page and the date and time at which it was edited. However, the Modification History table does not display details for each field that was modified. This makes it difficult to audit which fields have been modified and the field's previous value.
When User Record Auditing is enabled, the Modification History table displays a detailed record of each successfully completed and scheduled modification to the User Record page for a user. In addition, administrators can search modifications by field name and filter modifications by field type.
Note: Administrators can only search modifications when using the old User Record page.
See User Record - Modification History on page 389 for additional information.
Not all fields on the User Record are audited. See User Record - Audited Fields on page 365 for additional information.
[bookmark: _Ref806028920][bookmark: _Ref1503247890]User Record - Audited Fields
When User Record Auditing is enabled, only certain fields on the User Record are audited.
If a field does not appear to an administrator on the user record, then the field cannot be audited by the administrator. For example, inactive fields, organizations unit (OU) types and custom fields that are not configured to appear on the user record, and fields the administrator does not have permission to edit do not appear to the administrator on the user record.
When Effective Dating is enabled and the user record effective date is set to a future or past date, administrators can only edit fields that are audited and which they have permission to edit. If a field is not audited, it appears inactive and cannot be edited.
The below fields can be audited. As a result, these fields can be edited when the user record effective date is set to a future or past date.
General User Information
The following fields in the General User Information section can be audited:
· Prefix
· First Name
· Middle Name
· Last Name
· Suffix
· Time Zone
· User Status - Only the Active setting is audited.
· Absent 
· Allow Reconciliation 
Contact Information
The following fields in the Contact Information section can be audited:
· Address Line 1
· Address Line 2
· City
· State
· Zip
· Country
· Phone
· Fax
· Mobile Phone
· Email Address
E-Commerce Information
No fields in the E-Commerce Information section can be audited.
Organizational Structure
The following fields in the Organizational Structure section can be audited if they are available on the User Record:
· Manager
· Approver
· Employee Custom Relationship
· Division
· Position
· Grade
· Cost Center
· Location
· Custom OUs
User Status Information
The following fields in the User Status Information section can be audited if they are available on the User Record:
· User Type
· User Subtype
· User Status
· Leave Type
· Termination Type
· Eligible for Rehire
· Termination Reason
The User Status Information section is only available to organizations that are using Cornerstone HR and have User Types and Employment Statuses enabled.
User Custom Fields
All fields in the User Custom Fields section can be audited.
[bookmark: _Toc161996220][bookmark: concept97]Batch Edit Users Administration
The Batch Edit administration page enables administrators to view, manage, and create bulk edits to user records.
This functionality is only available for organizations using Cornerstone HR.
To access the Batch Edit Administration page, go to Admin > Tools > Core Functions > Batch Edit users.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Batch Edit Users
	Grants ability to modify user records in bulk. This permission cannot be constrained. This is an administrator permission.
	Core Administration


[image: ]
Create New Batch Edit
To create a new batch edit, select the Create New button. See Batch Edit Users - Create Batch Edit on page 369 for additional information.
Filter by Status
To filter batch edits by status, select the appropriate batch edit status from the drop-down menu.
Search Batch Edits
To search for an existing batch edit, enter search terms in the Search field and select the Search button. This field enables administrators to search by batch edit title or creator.
Batch Edits Table
By default, the batch edits are displayed in the order in which they are created with the most recently created batch edits displayed first. However, the table can be sorted by any table column.
The following information is displayed for each existing batch edit:
· Effective Date
· Title
· Created by - This displays the name of the administrator who created or last edited the batch edit.
· Status - The following statuses are available:
· Draft - This indicates that the batch edit was saved as a draft, and it has not yet been submitted.
· Processing - This indicates that the batch edit is currently in the process of being validated.
· Completed - This indicates that the batch edit has been validated, and any future dated changes have been scheduled.
· Completed with Errors - This indicates that the batch edit was completed, but errors occurred. Not all changes have been implemented.
Batch Edit Options
The following options may be available from the Options drop-down menu:
· Delete - Select this option to cancel the batch edits. This option is only available if the status is Draft.
· Edit - Select this option to edit the batch edit settings. This option is only available if the status is Draft. See Batch Edit Users - Create Batch Edit on page 369 for additional information.
· View Results - Select this option to view the results of the batch edit, including any error messages. This option is only available if the status is Completed or Completed with Errors. See Batch Edit Users - View Results on page 372 for additional information.
· Copy - Select this option to copy the settings of this batch edit to a new batch edit. This option is only available if the status is Draft, Completed, or Completed with Errors. See Batch Edit Users - Create Batch Edit on page 369 for additional information.
[bookmark: _Ref975537451][bookmark: concept98]Batch Edit Users - Create Batch Edit
The Batch Edit Users page enables administrators to define the criteria and settings in order to edit user records in bulk.
This functionality is only available for organizations using Cornerstone HR.
To batch edit users, go to Admin > Tools > Core Functions > Batch Edit users. Then, select the Create New button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Batch Edit Users
	Grants ability to modify user records in bulk. This permission cannot be constrained. This is an administrator permission.
	Core Administration


[image: ]
General Settings
Define the basic settings for the batch change:
· Batch Change Name - Enter a descriptive name for the batch edit. This enables administrators to easily identify the batch edit from the Batch Edit Administration page. This field is required. 
· Reason for Change - From the drop-down menu, select the reason for modifying the user records. This option is only available if Effective Dating and Reason for Change are enabled for the portal. Administrators can configure the available options and whether this field is required in User Preferences. See User Preferences on page 415 for additional information.
· When user records are modified, the Reason for Change value is stored in the Modification History.
Effective Date
Select the date on which the changes are effective:
· Effective today - Select this option to have the changes be effective on the date the changes are submitted.
· Effective Date - This option is only available when Effective Dating is enabled. Select this option to have the changes be effective on a specific date and time in the past or in the future. Select the appropriate effective date using the date picker.
· Note: The Effective Date can be any date in the past that is on or after January 1, 1901. However, the Effective Date cannot be set to a date in the past for a user within an In Progress compensation task, either as an employee or a compensation manager.
Note: The Effective Date is based on the UTC time of the administrator who created the batch edit. Future dated changes take place at midnight on the selected date.
Add Users for Batch Change
This section enables administrators to select which users are included in the batch edit. Administrators can include users by organizational unit (OU) or select individual users. Note: When a batch edit is initiated from the Org Chart, only users can be selected. OUs cannot be selected.
To add users to the batch change, select the appropriate OU type from the drop-down menu. Then, select the pop-up icon to select the appropriate OU or user. The selected OUs or users appear in this section. 
Select the Include Subordinates option to include the OU or user's subordinates in the batch change. 
The maximum number of users that can be selected is 100. If more than 100 users are selected, then the batch edit cannot be submitted.
Add Change Criteria
This section enables administrators to select which fields are modified and their new value. 
To select a field to modify, follow these steps:
1. Select the desired field type from the drop-down menu. The available options are:
1. Organizational Unit Types
2. Employee Relationships
2. Select the appropriate value from the Select Criteria drop-down menu. The drop-down menu displays all available options for the selected field type. Note: When selecting an employee relationship, the options are limited to Manager, Approver, and Custom.
3. Either enter the new value in the field, or select the pop-up icon [image: ] and select the new value from the pop-up.
When a change criterion is selected, it is added to the Change Criteria table.
To remove a change criterion, select the Remove icon [image: ] to the right of the criterion.
Save Draft / Cancel
Select the Cancel button to cancel the batch edit action. A confirmation pop-up opens.
Select the Save Draft button to save the batch edit settings to be completed another time. No user record modifications are implemented. A batch edit can only be saved if a Batch Change Name and Reason for Change are provided. The draft is available to be resumed from the Batch Edit Administration page.
Select the Submit button to submit the batch edit. This option is only available if User Criteria and Change Criteria are defined. A confirmation pop-up opens. Once the bulk changes are submitted, they are added to a queue to be processed. The status is Queued. The processing time depends on the effective date of the changes:
· Today - If the effective date is set to Today, then each modification is added to the user's Modification History and a new record is added to the Effective Dated Records timeline. Each individual modification is also applied to all future effective dated records that do not specify a modification to the same field.
· Past Date - If the effective date is set to a date in the past, then each modification is added to the user's Modification History and a new record is added to the Effective Dated Records timeline. Each individual modification is also applied to the current user record and all future effective dated records that do not specify a modification to the same field.
· Future Date - If the effective date is set to a date in the past, then a new record is added to the Effective Dated Records timeline. Each modification is not added to the user's Modification History until the effective date of the record is reached and the modifications are processed successfully. Each individual modification is applied to all effective dated records that have an effective date that is beyond the selected effective date so long as the effective dated records do not specify a modification to the same field.
[bookmark: _Ref-406397091][bookmark: concept99]Batch Edit Users - View Results
The Batch Edit Results page enables administrators to view the results of a submitted and processed batch edit.
This functionality is only available for organizations using Cornerstone HR.
To view the results of a submitted batch edit, go to Admin > Tools > Core Functions > Batch Edit users. Then, select the Options drop-down menu for the appropriate batch edit, and select the View Results option.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Batch Edit Users
	Grants ability to modify user records in bulk. This permission cannot be constrained. This is an administrator permission.
	Core Administration
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Collapse / Expand Sections
Sections on this page can be collapsed or expanded by selecting the arrow icon [image: ] to the right of the section heading.
Status: Error (XX)
This section displays each of the user records that experienced errors and were not edited. The section heading displays the number of user records that experienced an error. If the batch edit contains errors, then this section is expanded by default when the page loads. This enables the administrator to quickly view which users experienced issues and why. 
The following information is displayed:
· Username - This column displays the first name, last name, and username of the user record that experienced an error during the batch edit.
· Notes - This column displays the validation errors that occurred with the user. If more than one error occurred with the user record, then each error is displayed in a separate row.
Status: Complete (XX)
This section displays each of the user records that were successfully edited during the batch edit. The section heading displays the number of user records that were successfully edited.
The following information is displayed:
· Username - This column displays the first name, last name, and username of the user record that was successfully edited during the batch edit.
Change Criteria
This section displays the User Criteria and the Change Criteria for the batch edit.
[bookmark: _Toc161996221]Duplicate User Prevention
When an organization using Cornerstone HR creates new users, the system can be configured to evaluate whether the new users are similar to existing user records. This is done in order to prevent the same user from being added to the system more than once. 
If configured, the system evaluates whether new users are duplicates of existing users when new users are added to the system from the Admin > Users page and the Data Load Wizard.
By ensuring duplicate records are not created, user record management is simpler and more effective.
The Duplicate User Management Preferences page enables administrators to configure which standard and custom fields are used to identify potential duplicate users. The system uses the selected fields to compare the user being added to all existing users. See Duplicate User Management Preferences.
The Pending User Records page enables administrators to view all of the pending user records that have been identified as likely duplicates of existing user records. These records have not yet been created in the system. For each pending user record, administrators can view each of the existing user records that are similar to the pending user record.  See Pending User Records on page 394 for additional information.
When adding users via the Admin > Users page, the system identifies potential duplicate users. Administrators are alerted when a potential duplicate user is identified:
· See Users - Potential Duplicate User on page 375 for additional information.
Best Practice
When performing your initial load of users, be sure duplicate prevention is off.
Use Cases
1. An organization has multiple HRIS systems feeding data into the Cornerstone system. All employees in United States are managed in one HRIS system, and all employees in France are managed in another HRIS system.
2. Sally moves to a new position in the organization which causes her to move from New York, US to Paris, France.
3. As a result of Sally's move, her information is now managed in a second HRIS system.
4. When Sally's information is fed into the Cornerstone system from the second HRIS system, Cornerstone's duplicate prevention engine identifies Sally's user record as potentially being the same as an existing user record.
5. The administrator views Sally's pending record and determines whether it is the same user as an existing user record or if Sally is a unique new user.
Implementation
This functionality is only available to organizations using Cornerstone HR. This functionality is controlled by a backend setting, which is disabled by default.
[bookmark: _Ref1066302942]Users - Potential Duplicate User
When an organization using Cornerstone HR creates new users, the system can be configured to evaluate whether the new users are similar to existing user records. This is done in order to prevent the same user from being added to the system more than once. If similar records do not exist, the new users will be created normally. However, if similar records do exist, the record creation is prevented. A message is displayed to alert administrators that a potential duplicate user has been identified.
Administrators who have the Prevent Duplicate Records - Reconcile permission can click the link within the message to view and manage pending user records. See Pending User Records on page 394 for additional information.
To access the User Records Administration page, go to Admin > Tools > Core Functions > Users.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Prevent Duplicate Users - Reconcile
	Grants ability to view user accounts that have been identified as potential duplicates. Administrators can only view pending user records that were created by administrators who are within the constraints on this permission. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration
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[bookmark: _Toc161996222]Effective Dating
Without Effective Dating, the system only tracks and maintains current employee data. For example, the current Name, Position, and Manager of the employee are stored in the system. However, the system does not maintain what the Name, Position, and Manager of the employee were last year.
With Effective Dating, administrators can modify and store user record data at effective dates. This enables administrators to make changes to a user record that are effective immediately, at a date in the past, or at a date in the future. Administrators can also view user records as of specific effective dates.
Effective Dating is intended to enable organizations to manage their employee data more easily.
[bookmark: concept100]Effective Dating is a feature that is included with Cornerstone HR.
Considerations
General Considerations
Not all fields are available for effective dating. 
Administrators can only apply effective dated changes to fields which they have permission to edit for the user.
If Effective Dating is disabled after it has been enabled, any changes that are set to be effective in the future are lost.
Standard Tasks
Standard tasks that are already assigned to organizational units (OUs) or groups are not impacted by any effective dated changes that are effective at any point after the task is created and assigned.
· Example 1: A performance review task is created and assigned to the Sales division on 2014/01/01 and is due 2014/04/01. On 2014/03/01, James's division is changed from Development to Sales, and this change is effective on 2013/12/31. James is not assigned the performance review task.
· Example 2: A form task is created and assigned to the Sales division on 2014/01/01 and is due 2014/04/01. On 2014/03/01, James's division is changed from Development to Sales, and this change is effective on 2014/02/01. James is not assigned the form task.
· Example 3: A competency assessment task is created and assigned to the Sales division on 2014/01/01 and is due 2014/04/01. On 2014/03/01, Dara's division is changed from Sales to Consulting, and this change is effective on 2013/12/31. Dara remains assigned to the competency assessment task.
Dynamic Tasks
Dynamic tasks that are already assigned to OUs or groups are impacted by any effective dated changes that are made during the dynamic assignment period.
· Example 1: A dynamic learning assignment is created and assigned to the Sales division from 2014/01/01 to 2014/04/01. On 2014/03/01, Paul's division is changed from Development to Sales, and this change is effective on 2014/02/01. Paul is assigned the training.
· Example 2: A dynamic learning assignment is created and assigned to the Consulting division from 2014/01/01 to 2014/04/01. On 2014/03/01, Jeff's division is changed from Consulting to Sales, and this change is effective on 2014/02/01. Jeff is assigned the training, but the training is removed when the change is processed.
Dynamic tasks that are already assigned to OUs or groups are not impacted by any effective dated changes that are made after the dynamic assignment period.
· Example 1: A dynamic learning assignment is created and assigned to the Sales division from 2014/01/01 to 2014/04/01. On 2014/05/01, Paul's division is changed from Development to Sales, and this change is effective on 2014/02/01. Paul is not assigned the training.
· Example 2: A dynamic learning assignment is created and assigned to the Consulting division from 2014/01/01 to 2014/04/01. On 2014/05/01, Jeff's division is changed from Consulting to Sales, and this change is effective on 2014/02/01. Jeff is assigned the training, and the training is not removed when the change is processed.
Compensation Tasks
Organizations with Effective Dating enabled cannot extend compensation tasks.
The Effective Date cannot be set to a date in the past for a user within an In Progress compensation task, either as an employee or a compensation manager. However, the Effective Date can always be set to a date in the future. 
If a user's manager is set to change at a future effective date, which is during a compensation task, then the user's manager is changed during the compensation task. As a result, the initial manager can view the user in the compensation task before the effective dated change occurs and cannot view the user in the task after the effective dated change occurs. Similarly, the final manager may or may not be able to view the user in the task following the effective dated change, depending on whether the final manager is assigned the compensation task.
If a user's position is set to change at a future effective date, which is during a compensation task that is prorated by position, then the user's manager would not see proration in the compensation task before the effective dated change occurs. After the effective dated change occurs, the proration percentage would appear in the compensation task.
See Use Cases - Effective Dating on page 384 for additional information.
Implementation
When Cornerstone HR is enabled for a portal, then this functionality is also enabled.
The availability of the User Record effective dating functionality is controlled by a backend setting, which is disabled by default.
User Record - As Of - Effective Date
The As Of date for a user record indicates the effective date and time of the record that is currently displayed. If the administrator edits the user record, then the modifications are effective as of the selected effective date. This value is displayed in the time zone of the user whose user record is being viewed.
When editing a user record, the As Of date and time is displayed to the right of the page heading. This enables administrators to quickly view the effective date of the information they are viewing.
This value is only displayed if Cornerstone HR and Effective Dating are enabled. Also, this value is only displayed if the administrator has permission to manage effective dating. This value does not display when creating a user record.
Add User to Group as of Now
CHR administrators can add users to groups "as of now," meaning the date and time the user was added to the group is recorded as the date and time the user added them to the group. It is NOT possible to add users to a group as of a specific date in the past or future.
See User Record - Effective Dating.
User Record - Reason for Change
The Reason for Change option enables administrators to specify why employee data is being modified. This option is only available on the User Record page when editing a user record. Also, this option is only available to organizations using Effective Dating.
See User Record - Effective Dating.
User Record - Effective Dated Records
Effective Dating enables administrators to associate an effective date with changes that are made to the user record. In addition, administrators can view and make modifications to a user's User Record page as of a particular date in the past, present, or future. It is important to note that all effective dates are displayed and applied in the time zone of the user whose user record is being modified.
Effective Dating is only available to organizations that are using Cornerstone HR and that have Effective Dating enabled.
See User Record - Effective Dating.
User Preferences - Effective Dating
The User Preferences page enables administrators to manage preferences for the User Record. Administrators can configure which Reasons for Change, User Types, User Subtypes, User Statuses, On Leave Types, and Termination Reasons are available when modifying the User Record.
The Reason for Change functionality is only available if Effective Dating is enabled for the portal.
See User Preferences on page 415 for additional information.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Reasons for Change: Manage
	Grants ability to define and configure Reasons for Change on the User Preferences administrator page, which may be used when modifying the user record. The administrator must also have the User Preferences - Core Information: View permission to access the User Preferences page.
This permission is also required to view and set the Reason for Change field when editing a user record.
This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration


User Resume - Effective Dating
[bookmark: concept104]When Cornerstone HR is enabled and a user's organizational units (OUs) are modified with an effective date that is set to a past date, the user's resume reflects the OU changes. This may impact the following pages:
· Universal Profile > Bio > Resume tab
· My Team > Profile tab > Resume
· Career Center > Career Profile
The Internal Positions section of the Resume captures OU data for each of the user's previous internal positions, and this Resume section can be configured to create a new position entry whenever a change is made to specific OU types. If a change is made to one of the selected OU types with an effective date that is in the past, then this creates a new entry in the Internal Positions section that reflects the new OU setting.
For the new entry in the Internal Positions section, the Start Date is set to the effective date of the OU modification. If the OU modification affects the current record, then the End Date of the new entry is set to today's date. Otherwise, the End Date of the new entry is set to the Start Date of the next Internal Positions entry.
For the entry prior to the new entry, the End Date is updated to the Start Date of the new entry.
For the entry subsequent to the new entry, the Start Date is updated to the End Date of the new entry.
Attributes
If there are any attributes associated with an internal position's OU or time period, and that OU or time period is modified, then the associated attributes are removed.
User Record as of a Date Report
When Effective Dating is enabled, the User Record as of a Date report is available as a standard report.
The User Record as of a Date report displays user data as of a specified effective date. This enables administrators to view user information as of a date in the past or in the future. The report can also be configured to display user standard and custom field data. For example, this report can be configured to display all users in the Sales division as of June 1, 2012. Important: The Grade field is only available to users who have permission to view grades. However, all other fields are not limited by the user record permissions.
See User Record as of a Date Report for additional information.
CSX “User Record as of a Date" Standard Report Deprecation
The "User Record as of a Date" Standard Report is deprecated with the March ’23 Release. Customers are encouraged to use alternative reporting options that are currently available today.
· Customers who have Cornerstone HR CSX enabled in their portal, using the effective dating feature or the aggregate audit feature, are encouraged to use the "Point-in-time Headcount Details" report instead. This report will provide a list of user records for a specific date at any point in time.
· Customers who do not have Cornerstone HR CSX enabled are encouraged to use Reporting 2.0 instead. For customers who do not use Cornerstone HR CSX, this report did not respect any past/future point in time relations/data values. It always generated results based on an "as of now" dataset which is why Reporting 2.0 is a viable alternative.
[bookmark: _Ref1816521230]Use Cases - Effective Dating
Creating a new user record will generate an effective dated timeline of the user which enables administrators to make changes that are effective on a past date or a future date. When creating a new user record or initializing an existing user's timeline, the system will apply default values for fields that have no values.
· Past Effective Date - When a user record change has a past effective date, the change is effective within the system as of the specified date in the past. For example, an employee is moved to the Sales division on 2014/03/01. The change is not made in the system until 2014/06/01, but the administrator sets the effective date for the change to 2014/03/01. The user record reflects that the employee has been in the Sales division since 2014/03/01.
· Future Effective Date - When a user record change has a future effective date, the change is effective within the system as of the specified date in the future. For example, an employee is given a promotion on 2014/06/01, but the promotion will not be effective until 2014/07/01. The administrator modifies the user's record on 2014/06/01 and sets the effective date for the change to 2014/07/01. The user record will reflect the user's non-promoted position until the effective date of 2014/07/01, at which point it will reflect the user's new position.
Use Case 1: Backdated Change
On 2015/03/01, Kyle Sherman modifies Colin's Position and Location, and the changes are effective as of 2014/10/01.
The following table shows the historical data on the user record and the effective date of the data prior to the change:
	First Name
	Division
	Location
	Effective Date

	Colin
	Sales
	France
	2014/09/01

	Colin
	Sales
	United States
	2014/11/01

	Colin
	Product
	United States
	2014/12/01


The following table shows the historical data on the user record and the effective date of the data after the change:
	First Name
	Division
	Location
	Effective Date

	Colin
	Sales
	France
	2014/09/01

	Colin
	Service
	London
	2014/10/01

	Colin
	Service
	London
	2014/11/01

	Colin
	Product
	London
	2014/12/01


The following table displays the entries that are added to the user's Modification History section:
	Effective Date
	Change Date
	Field Modified
	Field Type
	Changed From
	Changed To
	Changed By

	2014/10/01
	2015/03/01
	Division
	User standard field
	Sales
	Service
	Sherman, Kyle

	2014/10/01
	2015/03/01
	Location
	User standard field
	France
	London
	Sherman, Kyle


The following table displays the entries that are available in the user's Effective Dated Records section:
	Date Effective
	Status
	Changed By
	Options

	2014/09/01
	Complete
	Rob Mullen
	Edit

	2014/10/01
	Complete
	Kyle Sherman
	Edit

	2014/11/01
	Complete
	Rob Mullen
	Edit

	2014/12/01
	Complete
	Rob Mullen
	Edit


Use Case 2: Future Effective Change
On 2015/03/01, Frank Jones modifies Colin's Location, and the changes are effective as of 2015/08/01.
The following table shows the historical data on the user record and the effective date of the data prior to the change:
	First Name
	Division
	Location
	Effective Date

	Colin
	Sales
	France
	2014/09/01

	Colin
	Sales
	United States
	2014/11/01

	Colin
	Product
	United States
	2014/12/01


The following table shows the historical data on the user record and the effective date of the data after the change:
	First Name
	Division
	Location
	Effective Date

	Colin
	Sales
	France
	2014/09/01

	Colin
	Sales
	United States
	2014/11/01

	Colin
	Product
	United States
	2014/12/01

	Colin
	Product
	Australia
	2015/08/01


The following table displays the entries that are added to the user's Modification History section:
	Effective Date
	Change Date
	Field Modified
	Field Type
	Changed From
	Changed To
	Changed By

	2015/08/01
	2015/03/01
	Location
	User standard field
	United States
	Australia
	Jones, Frank


The following table displays the entries that are available in the user's Effective Dated Records section:
	Date Effective
	Status
	Changed By
	Options

	2014/09/01
	Complete
	Rob Mullen
	Edit

	2014/11/01
	Complete
	Rob Mullen
	Edit

	2014/12/01
	Complete
	Rob Mullen
	Edit

	2015/08/01
	Scheduled
	Frank Jones
	Edit, Cancel


Use Case 3: Effective Record is Modified
On 2015/03/01, Jim Tillman modifies Colin's effective dated record from 2014/11/01.
The following table shows the historical data on the user record and the effective date of the data prior to the change:
	First Name
	Division
	Location
	Effective Date

	Colin
	Sales
	France
	2014/09/01

	Colin
	Sales
	United States
	2014/11/01

	Colin
	Product
	United States
	2014/12/01


The following table shows the historical data on the user record and the effective date of the data after the change:
	First Name
	Division
	Location
	Effective Date

	Colin
	Sales
	France
	2014/09/01

	Colin
	Marketing
	Canada
	2014/11/01

	Colin
	Product
	Canada
	2014/12/01


The following table displays the entries that are added to the user's Modification History section:
	Effective Date
	Change Date
	Field Modified
	Field Type
	Changed From
	Changed To
	Changed By

	2014/11/01
	2015/03/01
	Division
	User standard field
	Sales
	Marketing
	Tillman, Jim

	2014/11/01
	2015/03/01
	Location
	User standard field
	United States
	Canada
	Tillman, Jim


The following table displays the entries that are available in the user's Effective Dated Records section:
	Date Effective
	Status
	Changed By
	Options

	2014/09/01
	Complete
	Rob Mullen
	Edit

	2014/11/01
	Complete
	Rob Mullen, Jim Tillman
	Edit

	2014/12/01
	Complete
	Rob Mullen
	Edit


Use Case 4: Scheduled Effective Change is Cancelled
On 2015/03/01, Frank Jones modifies Colin's Location, and the changes are effective as of 2015/08/01.
On 2015/03/06, Rose Tutor cancels Colin's future effective change that was scheduled for 2015/08/01.
The following table shows the historical data on the user record and the effective date of the data prior to the change:
	First Name
	Division
	Location
	Effective Date

	Colin
	Sales
	France
	2014/09/01

	Colin
	Sales
	United States
	2014/11/01

	Colin
	Product
	United States
	2014/12/01

	Colin
	Product
	Australia
	2015/08/01


The following table shows the historical data on the user record and the effective date of the data after the change:
	First Name
	Division
	Location
	Effective Date

	Colin
	Sales
	France
	2014/09/01

	Colin
	Sales
	United States
	2014/11/01

	Colin
	Product
	United States
	2014/12/01


The following table displays the entries that are added to the user's Modification History section. Frank Jones' modification remains in the section, and Rose Tutor's cancellation of the change is added, which effectively reverses Frank Jones' modification.
	Effective Date
	Change Date
	Field Modified
	Field Type
	Changed From
	Changed To
	Changed By

	2015/08/01
	2015/03/01
	Location
	User standard field
	United States
	Australia
	Jones, Frank

	2015/08/01
	2015/03/06
	Location
	User standard field
	Australia
	United States
	Tutor, Rose


The following table displays the entries that are available in the user's Effective Dated Records section. Frank Jones' future effective dated record is removed.
	Date Effective
	Status
	Changed By
	Options

	2014/09/01
	Complete
	Rob Mullen
	Edit

	2014/11/01
	Complete
	Rob Mullen
	Edit

	2014/12/01
	Complete
	Rob Mullen
	Edit


Use Case 5: User's First Effective Record is Modified
On 2015/03/01, Kyle Sherman modifies Colin's first effective dated record, and the changes are effective as of the original creation date.
The following table shows the historical data on the user record and the effective date of the data prior to the change:
	First Name
	Division
	Location
	Effective Date

	Colin
	Sales
	France
	2014/09/01


The following table shows the historical data on the user record and the effective date of the data after the change:
	First Name
	Division
	Location
	Effective Date

	Matt
	Sales
	France
	2014/09/01


The following table displays the entries that are added to the user's Modification History section:
	Effective Date
	Change Date
	Field Modified
	Field Type
	Changed From
	Changed To
	Changed By

	2014/09/01
	2015/03/01
	First Name
	User standard field
	Colin
	Matt
	Sherman, Kyle


The following table displays the entries that are available in the user's Effective Dated Records section:
	Date Effective
	Status
	Changed By
	Options

	2014/09/01
	Complete
	Rob Mullen, Kyle Sherman
	Edit


[bookmark: _Ref-616608916][bookmark: _Toc161996223]User Record - Modification History
The Modification History page displays each time the User Record page is edited for a user. The Modification History section is only displayed if the administrator has permission to view modification details for a user.
When User Record Auditing is not enabled, the Modification History page includes the name and username of the user who modified the page and the date and time at which it was edited. However, the Modification History section does not display details for each field that was modified.
When User Record Auditing is enabled, the Modification History section displays a detailed record of each successfully completed and scheduled modification to the User Record page for a user. User Record Auditing is only available to organizations that are using Cornerstone HR. Important: User Record Auditing should only be enabled by submitting a case to Global Customer Support.
A user's record can be viewed in the following manners:
· Go to Admin > Tools > Core Functions > Users. Then, select the name of the user in the search results.
· Select the user's photograph from any page within Universal Profile or from Global Search. Then, select the User Record tab.
To view the Modification History page, select the Modification History option from the Options drop-down menu.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Universal Profile - User Record - Create Users
	Grants ability to access the User Record Administration page and to create new users in the system. When creating a new user, this permission grants the ability to add general information, which includes first name, last name, username, assigned OUs, and custom relationships. The administrator must have additional permissions to add any additional fields. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Users – Edit Custom Field Information
	Grants ability to view and edit the custom fields on a user record. Administrators are only able to edit a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users – Effective Dating: Manage
	Enables administrator to make effective dated changes to the user record. This permission only works when used in conjunction with the Users - Edit General Information permission. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration



	Users – View Custom Field Information
	Grants ability to view the custom fields on a user record. Administrators are only able to view a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - View Modification Details
	Grants ability to view the Modification Details on the User Record and view User Audits fields when creating a Reporting 2.0 report. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration


Additional permissions are required to view and edit the various fields on the user record. See User Record Permissions for additional information.
Permissions
Administrators must have the appropriate permissions to view the modification history for a field. For example, administrators must have either the Users - View General Information or Users - Edit General Information permission to view the modification history for the First Name, Last Name, Username, Standard OU, Custom OU, and Custom Relationship fields. Administrators can only view the modification history of user custom fields that are available to them.
Modification History - User Record Auditing
When User Record Auditing is enabled, the system enables administrators to audit all modifications to employee data via the Modification History page. User Record Auditing is only available to organizations that are using Cornerstone HR. Important: User Record Auditing should only be enabled by submitting a case to Global Customer Support.
Not all fields on the User Record are audited. See User Record - Audited Fields on page 365 for additional information.
Generate Audit PDF
The Generate Audit PDF link lets you export data from the Modification History into .pdf format. This link is only visible under the following conditions:
· User Record Audit Feature is enabled
· User has the appropriate permissions (Users - View Modification Details)
· User is not the user who's User Record is being viewed
The .pdf displays the results of the search the user has set. It also takes into account all Search, Filter and Sort modifications which are done in the Modification History table.
The .pdf has the following columns: 
· Change Date
· Field Changed
· Field Type
· Changed From
· Changed To
· Changed By
Search Modifications
To search for modifications to a specific field, enter the field name in the Search by field changed field, and select the Search button. The page is updated to display any available modifications to the specified User Record field. If the search matches multiple fields, then modifications to all matching fields are displayed. 
This functionality is only available when User Record Auditing is enabled.
Filter Modifications
The following filter options are available and can be used in conjunction with the Search functionality:
· Field Type - Use this filter to view changes to specific types of fields. The following options are available:
· User Standard Field
· Organizational Unit
· Employee Relationship
· User Custom Field
· Reason for Change - Use this filter to view changes with a specific reason for change. All available reasons for change are available in the drop-down menu. This functionality is only available when Reason for Change is enabled and there is at least one reason for change enabled in User Preferences. See User Preferences - Reasons for Change on page 418 for additional information.
· Include Scheduled Changes - Select this option to include modifications that have an effective date that is in the future. This option is only available when Effective Dating is enabled.
This functionality is only available when User Record Auditing is enabled.
Sort Modifications
The following columns within the Modification History table can be sorted by selecting the column heading:
· Effective Date
· Change Date
This functionality is only available when User Record Auditing is enabled.
Modifications Table
The following information is displayed for each modification:
· Effective Date - This column displays the date and time at which the change is effective. The date and time are displayed in the timezone of the administrator who is viewing the page. Modifications are only displayed if they have successfully completed and have an effective date that is in the past. Note: This column is only available if Effective Dating is enabled.
· Change Date - This column displays the date and time at which the modification was saved.
· Field Changed - This column displays the field that was modified.
· Field Type - This column displays the type of field that was modified (e.g., User standard field, Organizational Unit).
· Changed From - This column displays the value from which the field was modified. This is the old value of the field. If the modified field is an encrypted field, then the field value is displayed as asterisks. If there was no value for the field (i.e., the field was empty), then the column is blank for the field.
· Changed To - This column displays the value to which the field was modified. This is the new value of the field. If the modified field is an encrypted field, then the field value is displayed as asterisks. If there is no value for the field (i.e., the value is removed), then the column is blank for the field.
· Changed By - This column displays the name and username of the administrator who modified the field.
· Reason for Change - This column displays the reason for change that was selected when the modification was made. This column is only available if Effective Dating is enabled.
· If the modification was made through a self-service location such as My Account, then the self-service location is displayed in this column. 
· If no reason was selected for the modification, then "None" is displayed. 
· If the reason for change for an effective dated record is modified, then any new modifications are associated with the newly selected reason for change, and any unaffected modifications remain associated with the previous reason for change.
· For user record changes made via a form, the Reason column displays the reason that is selected in the Reason for Change field on the form. See Create Form - Build Tab - Define Fields on page 102 for additional information.
By default, modifications are sorted chronologically by effective date and can also be sorted by Change Date. Click the Effective Date or Change Date column heading to sort the table using the column data. Clicking the column heading a second time changes the sort order of the table.
If User Record Auditing and Effective Dating are both enabled, then when the User Record page is saved, all current, past, and future modifications are captured in the Modification History section.
The following special cases may occur:
· New User Record - When a user record is created, the detailed field changes are not tracked in the Modification History section. See the Inserted by section below for additional information.
· New Custom Fields - When a new custom field is created and appears on a user record, this addition is not tracked in the Modification History section. This applies even if a default value is defined for the custom field.
· Password Changes - Password changes are tracked in the Modification History section. However, the original and new values are not tracked. As a result "Not tracked" is displayed in the Changed To and Changed From column for the entry.
· Single-select Checkbox Fields - For single-select checkbox fields, the values are "Selected" or "Unselected."
· Multiple-select Checkbox Fields - For multiple-select checkbox fields, each option that is selected or unselected is tracked as an individual modification and they appear as separate entries in the table.
Inserted by
When a user record is created, the detailed field changes are not tracked in the Modification History section. Instead, "Inserted by" is displayed at the bottom of the table with the name of the administrator who created the user record and the date and time at which the user record was created (e.g., "Inserted by Lori Mullen (lmullen) on 9/2/2011 11:00:05 AM").
Sensitive Personally Identifiable Information (SPII) Fields
When SPII values are modified, the details of the modification, that is the Changed From values and the Changed To values, are not currently displayed in the Modification History.
SPII fields are only available on the User Record when Encrypted Sensitive Information is enabled in the portal, and this functionality is only available to organizations using Cornerstone HR
[bookmark: _Ref2077450803][bookmark: _Toc161996224]Pending User Records
When an organization using Cornerstone HR creates new users, the system can be configured to evaluate whether the new users are similar to existing user records. This is done in order to prevent the same user from being added to the system more than once. 
The Pending User Records page enables administrators to view all of the pending user records that have been identified as likely duplicates of existing user records. These records have not yet been created in the system. For each pending user record, administrators can view each of the existing user records that are similar to the pending user record.  
This functionality is only available to organizations using Cornerstone HR.
To manage Pending User Records, go to Admin > Tools > Core Functions > Pending User Records.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Prevent Duplicate Users - Reconcile
	Grants ability to view user accounts that have been identified as potential duplicates. Administrators can only view pending user records that were created by administrators who are within the constraints on this permission. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration


[image: ]
Pending User Records
This section displays the user records that have been identified as likely duplicates of existing user records. The system only displays pending user records that were created by administrators who are within the administrator's permission constraints. For example, if an administrator is constrained to the Technology division, then the administrator can only view pending user records that were created by administrators in the Technology division.
By default, user records are displayed in the order in which they were created with the most recently created user record displayed first.
The following information is displayed for each pending user record:
· Name
· Created - This displays the date on which the pending user record was created.
· Created By - This displays the name of the administrator who created the pending user record.
· Number of Matches - This displays the number of existing user records that have been identified as a potential match to the pending user record.
Search Users
Using the Search fields, administrators are able to search pending duplicate user records by a user's First Name and Last Name. This search functionality uses AND Boolean logic, so if a first name and a last name are provided, then the search returns users who have a matching first name and last name.
Administrators must select the Search button to initiate the search.
Sort Users
The following sort options are available:
· Create Date: Newest - This option sorts potential duplicate users by the date on which the user record was created, with the most recently created user record displayed first. This option is selected by default.
· Create Date: Oldest - This option sorts potential duplicate users by the date on which the user record was created, with the most recently created user record displayed last.
· Creator Last Name: A to Z - This option sorts potential duplicate users by the last name of the administrator who created the user record. Creator's last names are displayed in alphabetical order.
· Creator Last Name: Z to A - This option sorts potential duplicate users by the last name of the administrator who created the user record. Creator's last names are displayed in reverse alphabetical order.
· Pending User Last Name: A to Z - This option sorts potential duplicate users by the pending user's last name. Pending user's last names are displayed in alphabetical order.
· Pending User Last Name: Z to A - This option sorts potential duplicate users by the pending user's last name. Pending user's last names are displayed in reverse alphabetical order.
View Similar Records
To view the existing user records that are similar to the pending user record, select the View Similar Records button to the right of the pending user record. All records that are matches with the pending user record, above the duplicate matching threshold, are displayed. The similar record that most closely matches the pending user record is displayed first. The following information is displayed for each similar record:
· Name
· Matching Points - This displays the sum of the points associated with all of the fields that match the pending user record, as of the time when the attempted creation of pending user record occurred. This number is used to indicate how closely the existing record matches the pending user record. The higher the total matching points, the more likely it is that the pending user record is the same user as the existing user record.
· Created - This displays the date on which the user record was created.
· Created By - This displays the name of the administrator who created the user record.
· Status - This displays the status of the user record.
· Similar Fields - This displays all of the fields that were similar between the pending user record and the user record.
Hide Similar Records
To hide the existing user records that are similar to the pending user record, select the Hide Similar Records button to the right of the pending user record.
Delete Pending Record
If the pending user should be deleted from the ‘pending’ state, then click the Delete button. After this button is clicked, no further action can be taken with the user.
Create Pending Record as New
If the pending user record is a valid new user, click the Create Pending as New button.
· Any password previously defined for the user is not copied to the new user record.
· If there is a top-level corporate password defined in the preferences, this password will be set for the new user.
· If there is not a top-level corporate password, and the organization does not use SSO, there are two options for setting the password: 
· Upon attempting to log in, the user should go through the “Forgot Password” workflow to define a password for themselves.
· If desired, the administrator can take action by manually resetting the password on the Admin > Users page.
Overwrite Selected Record with Pending Record
To overwrite the selected existing user record with the corresponding pending user record, select the Overwrite radio button to the left of the appropriate existing user record. Then, click the Overwrite button.
When this button is clicked, the selected existing user record is updated with the information from the pending user record. The effective date for all updated data is the date on which two user records were reconciled. Also, the user record reflects that the fields were changed by the administrator who reconciled the user records.
Done
Select this button to return to the previous page.
[bookmark: _Toc161996225]System Generated User ID
The System Generated User ID functionality enables the system to automatically generate a unique ID for users who are created within the system. This enables organizations to create users without either manually defining a unique user ID for each user or relying on a 3rd party CoreHR (HRIS) system to generate unique user IDs for users.
When this functionality is enabled, a user ID is automatically generated for any user who is created within the system. User IDs can still be fed in to the system from 3rd party HRIS systems. That is, some users may be created in other systems and then fed in to the Cornerstone system, while other users are created within the Cornerstone system with a system generated ID.
[bookmark: concept109]The System Generated User ID functionality is included with Cornerstone HR.
Considerations
· When this functionality is enabled, existing users are not assigned User IDs. This functionality only impacts newly created users.
· If the administrator who is creating the user has permission to edit the User ID field for the user on the user record, then the administrator can edit the system-generated User ID. As a best practice, the User ID value should not be edited after it is generated. In order to control this, administrators should only be granted permission to view the User ID field for users. This enables them to view the value, but they cannot edit the value.
· Self-registration groups can be configured to utilize this functionality. If this functionality must be disabled, then all self-registration groups should be configured so that they are not utilizing this functionality prior to it being disabled.
Implementation
When Cornerstone HR is enabled for a portal, then this functionality is also enabled.
The System Generated User ID functionality is only available when using Cornerstone HR and is controlled by a backend setting, which is disabled by default. 
[bookmark: _Ref-1222656809]User ID Generation Rules
[bookmark: concept110]When Cornerstone HR and the System Generated User ID functionality are enabled, a User ID is automatically generated when a user is added to the system. The User ID value is generated according to the configuration of backend settings.
A User ID is automatically set for a new user in the following scenarios:
· A user is created via the Add User page. See User Record - Add.
· A user self-registers in the system where the self-registration group is configured so that User IDs are generated by the system.
· A user is created via the Data Load Wizard using the User Load. See Cornerstone HR - Load User Data - Overview on page 72 for additional information.
· A user is created via Onboarding workflow. See Start Onboarding Page.
Each User ID must be unique. Because of this, once a User ID value is generated, that value is permanently reserved and cannot be reused.
User ID Prefix
The prefix that appears at the beginning of all User ID values is determined by a backend setting, which is set during implementation.
User ID Length
The number of characters contained in the User ID is determined by a backend setting, which is set during implementation. The minimum length is six characters, and the maximum length is eight characters.
User Record - User ID
When Cornerstone HR and the System Generated User ID functionality are enabled, a User ID is automatically generated when a user is added to the system. The system-generated User ID value is entered in the User ID field for the new user. Once a User ID value is generated, that value is permanently reserved and cannot be reused.
· If the administrator does not have permission to view or edit the User ID field, the User ID is generated and stored, but the User ID field and value are not displayed on the page.
· If the administrator has permission to view the User ID field, the User ID is displayed on the page, but the administrator cannot modify the value.
· If the administrator who is creating the user has permission to edit the User ID field for the user, then the administrator can edit the system-generated User ID. As a best practice, the User ID value should not be edited after it is generated. In order to control this, administrators should only be granted permission to view the User ID field for users. This enables them to view the value, but they cannot edit the value.
The User ID value is generated according to the User ID Generation Rules. See User ID Generation Rules on page 398 for additional information.
Self-Registration Group - User ID
When Cornerstone HR and the System Generated User ID functionality are enabled, administrators have an additional User ID configuration option when creating or editing a self-registration group. When this option is selected, the system automatically generates a User ID for the user. If this option is selected, the User ID field must be in the Hidden column. User IDs are created based on the User ID Generation Rules. See User ID Generation Rules on page 398 for additional information.
See Registration Group - Create - Step 3 - Order for additional information.
[bookmark: _Toc161996226]User Record Custom Fields Overview
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User Record and Self Registration Custom Fields
The User Record and Self Registration Custom Fields page enables administrators to manage the custom fields that may appear on a User Record, on My Account pages, and during the self-registration process.
To manage User Record and Self Registration custom fields, go to Admin > Tools > Core Functions > Custom Field Administration. Then select the User Record tab on the left.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Self-Registration and User Record Custom Fields - Manage
	Grants access to manage custom fields for user Self Registration and the user record in Custom Field Administration. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	User Record Custom Field Configurable Validations - Manage
	Grants ability to manage the configurable validations for user record custom fields within Custom Field Administration. This permission cannot be constrained. This is an administrator permission. This permission is only available to organizations that are using Cornerstone HR.
	Core Administration


[image: ]
Search for a Field
Administrators can search for a user record custom field using the following search fields:
· Name - This field enables administrators to search for a field by title.
· Field Type - Select a custom field type from the drop-down to view only fields of a specific type. The search parameter "All Types" displays by default.
· Field Category - Select a custom field category from the drop-down to view only fields in a specific category. The search parameter "All Categories" displays by default.
· Include Inactive - Select this checkbox to display inactive custom fields in the search results.
Select the Search button to return your search results. 
Manage Categories and Display Order
Select this link to group custom fields into categories and define the order in which the fields are displayed in each category. The custom fields will appear in the selected categories and in the selected order on the User Record. See Categories and Display Order - Manage on page 411 for additional information.
Add Fields
Select the Add Fields icon [image: ] to navigate to the Add Custom Fields page on which you can add custom fields. See User Record Custom Field - Add/Edit on page 404 for additional information.
The recommended maximum number of user record custom fields is 1,000. If more than 1,000 user record fields are created, this may impact system and reporting performance.
Fields Table
The following fields display on the User Record and Self Registration Custom Fields page:
· Title
· Type
· Category
· Created By - This displays the name of the user who created the category by last name, first name. A Created By name does not display for the User Record Custom Field category, even if the category name is changed.
· Active - This option controls the custom field's active status. Unselecting the box makes the field unavailable in all areas.
· All Users - This option controls whether the field is included on a user's record for a user who is not created via self registration. If this option is selected, the field is available on the user record, in self registration, as a field in custom reports, and as a criteria option when creating a group. If this option is not selected, the field is only available in self registration.
Field Options
The following actions are available under the Options column:
· Edit - Select this option to edit the details of the custom field. The Field Type cannot be edited. See User Record Custom Field - Add/Edit on page 404 for additional information.
· Delete - Select this option to remove the custom field. This option is only available if the custom field has not been used. If the custom field value has been set on at least one user record, this option is not available.
Recruiting Module Considerations
For portals with the Recruiting module enabled, User Record can be used to store data for applicants in the Applicant Tracking System. User Record custom fields that are created in Custom Field Administration can be added by the administrator to the Applicant Custom Fields section in Requisition Preferences.
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[bookmark: _Ref593857550][bookmark: _Ref-1108829025]User Record Custom Field - Add/Edit
User Record custom fields may be made available for User records, forms, My Account, Self-registration and the Data Load Wizard. 
The recommended maximum number of user record custom fields is 1,000. If more than 1,000 user record fields are created, this may impact system and reporting performance.
To manage User Record and Self Registration custom fields, go to Admin > Tools > Core Functions > Custom Field Administration and select the User Record tab on the left.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Self-Registration and User Record Custom Fields - Manage
	Grants access to manage custom fields for user Self Registration and the user record in Custom Field Administration. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	User Record Custom Field Configurable Validations - Manage
	Grants ability to manage the configurable validations for user record custom fields within Custom Field Administration. This permission cannot be constrained. This is an administrator permission. This permission is only available to organizations that are using Cornerstone HR.
	Core Administration



	Required User Custom Fields - Manage
	Grants the ability to manage the Required setting for user record custom fields. This permission cannot be constrained. This is an administrator permission. This permission is only available for organizations using Cornerstone for HR.
	 Core Administration



	Users - Edit Secure User Custom Fields - Unmasked
	Grants the ability to edit secure user custom field info unmasked. This permission can be constrained by OU, Restrict to User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, Employee Relationship. This is an administrator permission.
	Core Administration



	Users - Manage Secure User Custom Fields
	Grants the ability to manage the setting secure user custom fields. This permission can be restrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, Employee Relationship. This is an administrator permission.
	Core Administration



	Users - View Secure User Custom Fields - Masked
	Grants the ability to view secure user custom field info masked. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, Employee Relationship. This is an administrator permission.
	Core Administration



	Users - View Secure User Custom Fields - Unmasked
	Grants the ability to view secure user custom field info unmasked. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, Employee Relationship. This is an administrator permission.
	Core Administration



	Users - Manage OU Based Regex
	Grants access to manage OU-based Regex patterns for user custom fields. This permission cannot be restrained. This is an administrator permission.
	Core Administration



	Users - Manage OU Based Applicability
	Grants access to manage OU-based Applicability for user record custom fields. This permission cannot be restrained. This is an administrator permission.
	Core Administration
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Create User Record
Enter the following information for the custom field:
· Name - Enter name of custom field that will be visible to end user, up to 100 characters.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Category - Select the category under which to associate the field. All categories available to the administrator display, in addition to a default Select option. Categories display in the order in which they are defined on the User Record Categories page. Note: Populating the Category field with "Select" results in a "Missing Required Field" error. When editing the name of a custom field, by default the field is defined under the default User Record Custom Field category.
· Email Tag - Enter the name for the email tag to be associated with this field, and use it to retrieve the value of this field in email communications. The tag must be written in capital letters without spaces. Periods (.) can be used instead of spaces. For example, PROFIT.NET is an acceptable email tag.
· Custom tags are prefixed with the word CUSTOM. For example, for a custom field called Profit Net, the administrator can create the tag, PROFIT.NET, and the system will convert this to CUSTOM.PROFIT.NET.
· Type - From the drop-down list, select the type of field you are creating. The following options are available. See Custom Field Admin - Custom Field Type Options for additional information.
· Date field
· Drop down
· Hierarchy
· Multiple Checkbox
· Numeric field
· Radio button
· Scrolling text box
· Short text box
· Active - This option controls the custom field's active status. Unselecting the box makes the field unavailable in all areas.
· All Users - This option controls whether the field is included on a user's record for a user who is not created via self registration. If this option is selected, the field is available on the user record, in self registration, as a field in custom reports, and as a criteria option when creating a group. If this option is not selected, the field is only available in self registration.
· Read Only - If this option is selected, then the user record custom field cannot be edited by anyone, including administrators. A read-only user record custom field can only be updated by the data feed. Note: Self-registration custom fields are always editable by the user, regardless of the read-only setting.
· Required -This option is only available when Cornerstone HR is enabled. If this option is selected, this user record custom field is required and must be completed before the record is saved. Note: You cannot use this option with checkbox type custom fields.
· Secure - If this option is selected, newly created short text, scrolling text, date, and numeric user custom fields can be configured to appear as secure fields on the user record. Secure custom fields function like Sensitive Personally Identifiable Information (SPII) fields and can be maintained and viewed if the administrator’s IP is part of the IP safe list. The following considerations apply to this option:
· This option is only available to organizations using Cornerstone HR.
· If selected, the All Users and Active options must be selected. 
· Required custom fields cannot be set to secure.
· Secure custom fields cannot be added to My Account.
· Secure custom fields cannot be maintained via the Data Load Wizard.
· Secure custom fields cannot be maintained or exposed via the Employee Public API.
· Secure custom fields cannot be maintained via Forms.
Note: The culture of the administrator will be set as the default culture for the custom field label when creating a new custom field.
Configure Field Validation
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This section is only available to organizations using Cornerstone HR, and it is only available if the administrator has permission to manage user record custom field validations. This section is only available when creating or editing short text box or scrolling text box user record custom fields.
This section enables administrators to define a required format for the custom field. When a required format is defined, any data entered into the custom field must match the required format. This enables organizations to ensure that data is entered into the custom field in the proper format. The required format is defined using a regex pattern.
Enter the following information for the field:
· Regex Pattern - Enter the regular expression that defines the format in which data must be entered in the field. If no regex pattern is entered, then the system does not enforce any additional field validations. The character limit for this field is 4,000. When the custom field is saved, the system validates that the Regex pattern is a valid expression. See the Regex Assistance section below for resources to assist in writing regex expressions. Note: Cornerstone Global Customer Support does not troubleshoot regex issues.
· Regex pattern based on OU - Select an option in the Criteria drop-down to configure custom field validation setup that allows you to define multiple regex patterns based on OU values. Options are Division, Location, Legal Entity, or Cost Center types. The following rules apply:
· You can configure up to 10 OU-based regex patterns per User Custom field.
· Each custom field must have a default regex pattern as a fallback if User's OU values don't match any of the remaining OU criteria. 
· OU-based regex patterns can be created for both Required or Secure custom fields for Short text or Scrolling text and only for Active custom fields with "All Users" checked. 
·  Changes to OU values on the User Record triggers validations for matching regex patterns. 
· Format Example - Enter text to explain or demonstrate the correct format for the field so that users who complete the field understand the proper way to enter information in the field. This text will appear below the user record custom field when a user is completing the field. The character limit for this field is 250.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. Note: Formatting rules are enforced in the My Account and Self Registration pages but the formatting example is not visible on those pages.
· Error Message - Enter an error message that will display when a user does not enter data in the correct format. This message should help guide the user to correctly enter the data. The character limit for this field is 250.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. Note: When creating a new regex format, the culture of the administrator will be set as the default culture for the error message.
If a valid regex Pattern is entered, then the Format Example and Error Message are required. 
Configure Field Applicability
Configure applicability for each individual custom field. Administrators can define the OU criteria for each custom field that specifies which custom fields are applicable to a given user. Administrators can define applicability using a combination of the following OUs:
· Cost Center
· Division
· Legal Entity
· Location
Only one criterion can be set per OU type. If several criteria are selected, the OR condition applies. 
The applicability setting applies to the User record, Universal profile, the user’s My Account Preference page and Forms. Only the applicable custom fields based on the defined OU type values of the target user display. When the setting is adjusted in the custom field administration page, it is immediately reflected on the appropriate pages.
Availability
Define which users have the ability to view and access the custom field. See Setting Availability Overview for additional information. The administrator must set the availability of the field if the field is to appear for other administrators and end users in the application. If availability is not set, then the field will not appear in administrator and end user areas of the application.
Save
Click Save to create or save the custom field.
Configure Field Validation Considerations and Resources
The Configurable Field Validation section is only available to organizations using Cornerstone HR, and it is only available if the administrator has permission to manage user record custom field validations. This section is only available when creating or editing short text box or scrolling text box user record custom fields.
Regex Assistance
The resources in this section may be used to learn about writing regular expressions, find common regular expressions, and test your regular expressions.
Education / Getting Started
The following resources may help you learn how to write your own regular expressions:
· Microsoft - https://docs.microsoft.com/en-us/dotnet/standard/base-types/regular-expressions
· RegExr - http://regexr.com/
Common Expressions
The following resource allows you to search for common regular expressions that have already been defined for you:
· RegExLib (Regular Expression Library) - http://www.regexlib.com/
Regular Expression Validator
The following resource helps you validate your regular expression before implementing it in the system:
· Regular Expressions 101 - https://regex101.com/
Data Preparation for Configure Field Validations
Configurable field validations are only applied to data that is entered after the custom field validations are applied. Existing data that was entered prior to configuring the field validations is not validated until the existing data is edited.
Cornerstone recommends that organizations use configurable field validations with custom fields that are created following this enhancement. This ensures that all data within the custom field complies with the format defined for that field. However, if an organization wishes to configure field validations for existing user record custom fields, it is best practice to review and clean up all data within the existing custom field BEFORE configuring a validation. The easiest way to ensure all user data for a single field is in the correct format prior to implementing a validation is to extract user data through a report, correctly format all user data for that field, and then upload the correctly formatted data through the Data Load Wizard. After this exercise is complete and all user data for that field is of the same format, then it is safe to configure a field validation.
Considerations for Configure Field Validations
If an organization has a data feed for user record information, then if the organization implements or changes a field validation and any user data in the feed does not pass the validation for the field, then the data feed will not feed any data into the system. Therefore, it is very important that organizations review and clean up all existing data in a user record custom field if a field validation is being added to the field.
Configurable field validations are only available for User Record custom fields that are of the type short text box and scrolling text box.
If a user record custom field with field validations is included in the self-registration process or in My Account, the format example is not displayed.
Cornerstone HR: 
Cornerstone HR: Cornerstone HR Overview
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[bookmark: _Ref703425857][bookmark: concept121][bookmark: concept120][bookmark: concept119][bookmark: concept118][bookmark: concept117][bookmark: concept116]Categories and Display Order - Manage
The User Record Categories page enables administrators to create and edit categories in which to organize custom fields. Administrators can also delete and translate existing categories, as well as manage the order in which categories display on the User Record page.
To access the User Record Categories page, go to Admin > Tools > Custom Field Administration. Then, click User Record from the left navigation panel. In the User Record and Self Registration Custom Fields table, click the Manage Categories and Display Order link.
Administrators can change the category with which a field is associated. See User Record Custom Field - Add/Edit on page 404 for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Self-Registration and User Record Custom Fields - Manage
	Grants access to manage custom fields for user Self Registration and the user record in Custom Field Administration. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration
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The following fields display on the User Record Categories page:
	Feature
	Description

	Hide Inactive Categories
	When checked, only active categories display on the User Record Categories page. Unchecking the box displays both active and inactive categories. The box is checked by default.

	Add User Record Category
	Allows you to add a new category.

	Categories and Custom Fields
	Lists the custom field categories and the custom fields within the categories. Custom fields are indented under the category name.

	User Record Custom Field
	The default user record category. All fields are defined under this category unless configured to be defined under a different category. If no additional categories are configured on the Manage Categories and Display Order page, all fields display under the default category on the User Record page.

	Created By
	Displays the name of the user who created the category by last name, first name. A Created By name does not display for the User Record Custom Field category, even if the category name is changed.

	Active
	Indicates the category's active status. The box is checked by default when a new category is added. Unchecking the box inactivates the category, hiding it on the User Record and Self Registration Custom Fields page. If you inactivate a category that contains at least one custom field, the fields contained within the category will then be associated with the User Record Custom Field default category.

	Options
	The following actions are available under the Options column:
· Edit - Allows you to change the name of the category.
· Translate - If multiple languages are enabled for the portal, you can localize the category name for any of the languages enabled, using the Standard Text Translation pop-up. The language in which the category is created cannot be deleted once saved.
· Delete - Removes the category. Note: The Delete icon does not display for the User Record Custom Field category, as it is a default category that cannot be removed. Also, this option is only available if the category has no custom fields associated with it.

	Save
	Saves any changes made to the category or custom field order, the Active column, or the deletion of a category. Upon saving, the user is returned to the User Record and Self Registration Custom Fields page. If the user does not click Save, any changes made to these areas will not be saved.

	Back
	Returns the user to the User Record and Self Registration Custom Fields page.


Add New Category
To add a category:
1. Click the Add User Record Category link.
2. The Add User Record Category pop-up opens. Enter the category name in the Name field (character limit of 50).
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3. Click Save to save the category.
4. Click Cancel to cancel the action.
Edit Category
1. Click the Edit icon.
2. The Edit User Record Category pop-up opens, displaying the current name. Edit the name in the Name field (character limit of 50).
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3. Click Add to save the changes.
4. Click Cancel to cancel the edit action.
Reorder Categories
Categories can be placed in any order. To reorder a category:
1. Hover over the row. The mouse changes to a compass view.
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2. Drag and drop the row to the desired position. Note: All fields within a category move with it.
Reorder Fields within a Category
Custom fields within a category can be placed in any order. To reorder custom fields within a category:
1. Hover over the name of the custom field. The mouse changes to a compass view.
2. Drag and drop the field to the desired position. Note: A field can only be reordered within its respective category. A field cannot be moved into a different category by dragging and dropping.
[bookmark: _Ref856133392][bookmark: _Ref1941617517][bookmark: _Toc161996227]User Preferences
The User Preferences page enables administrators to manage preferences for the User Record. Administrators can configure which Reasons for Change, User Types, User Subtypes, User Statuses, On Leave Types, and Termination Reasons are available when modifying the User Record.
The Reason for Change functionality is only available if Effective Dating is enabled for the portal.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Leave Types: Manage
	Grants ability to manage Leave Types on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Reasons for Change: Manage
	Grants ability to define and configure Reasons for Change on the User Preferences administrator page, which may be used when modifying the user record. The administrator must also have the User Preferences - Core Information: View permission to access the User Preferences page.
This permission is also required to view and set the Reason for Change field when editing a user record.
This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Termination Reasons: Manage
	Grants ability to manage Termination Reasons on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - User Statuses: Manage
	Grants ability to manage User Statuses on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - User Types and Subtypes: Manage
	Grants ability to manage User Types and Subtypes on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration


Reasons for Change
Reasons for change enable organizations to track the reasons that can be selected when modifications are made to employee data. These are intended to provide an explanation as to why a change was made. Reasons for change are pre-defined with default names and types so that specific functionality can be associated with reasons within the system. Although the system uses pre-defined reasons for change, administrators can configure the reasons for change names to match their organization's terminology. See User Preferences - Reasons for Change on page 418 for additional information.
User Types
User types enable organizations to designate different types of workers within their organization. All user types are pre-defined with default names and categories so that specific functionality can be associated with user types within the system. Additional user types cannot be created. Although the system uses pre-defined user types, administrators can configure the user type names to match their organization's terminology. See User Preferences - User Types on page 423 for additional information.
User Subtypes
User types enable organizations to designate different types of workers within their organization. All user types are pre-defined with default names and categories so that specific functionality can be associated with user types within the system. Additional user types cannot be created. Although the system uses pre-defined user types, administrators can configure the user type names to match their organization's terminology. See User Preferences - User Subtypes on page 427 for additional information.
User Statuses
User statuses enable organizations to track an employee through different employment life-cycle statuses. All user statuses are pre-defined with default names and categories so that specific functionality can be associated with user statuses within the system. Additional user statuses cannot be created. Although the system uses pre-defined user statuses, administrators can configure the user status names to match their organization's terminology. See User Preferences - User Statuses on page 431 for additional information.
Termination Reasons
Termination reasons enable organizations to track the reasons why employees are terminated, including whether the employee left the organization voluntarily or involuntarily. Termination reasons are pre-defined with default names and categories so that specific functionality can be associated with termination reasons within the system. Although the system uses pre-defined termination reasons, administrators can configure the termination reason names to match their organization's terminology. See User Preferences - Termination Reasons on page 435 for additional information.
On Leave Types
On leave types enable organizations to track when employees are excused from work or duty and the reason for their leave. All leave types are pre-defined with default names and categories so that specific functionality can be associated with on leave types within the system. Although the system uses pre-defined on leave types, administrators can configure the on leave type names to match their organization's terminology.  See User Preferences - On Leave Types on page 440 for additional information.
Done
Click Done to save any changes to the User Preferences and return to the Core Preferences page.
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[bookmark: _Ref112684895]User Preferences - Reasons for Change
Reasons for change enable organizations to track the reasons that can be selected when modifications are made to employee data. These are intended to provide an explanation as to why a change was made. Reasons for change are pre-defined with default names and types so that specific functionality can be associated with reasons within the system. Although the system uses pre-defined reasons for change, administrators can configure the reasons for change names to match their organization's terminology.
The Reason for Change functionality is only available if User Preferences and Effective Dating are enabled for the portal.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences. Select the arrow [image: ] to the right of a section name to expand the section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Reasons for Change: Manage
	Grants ability to define and configure Reasons for Change on the User Preferences administrator page, which may be used when modifying the user record. The administrator must also have the User Preferences - Core Information: View permission to access the User Preferences page.
This permission is also required to view and set the Reason for Change field when editing a user record.
This permission cannot be constrained. This is an administrator permission.
	Core Administration


Reason for Change - Add
To create a new reason for change, click the add button. This opens the Add Reason for Change pop-up. See Reason for Change - Create/Edit on page 421 for additional information.
Reasons for Change Table
The following information is displayed for each existing reason for change:
· Reason - Reasons are sorted alphabetically.
· Reason Type
· ID
· Active - When a reason for change is active, it can be selected as a reason for change when modifying user data on the User Record page. When a reason for change is inactive, the reason cannot be selected. However, the reason remains associated with any existing modifications.
The following options may be available from the Options drop-down menu:
· Edit - Select this option to edit the reason. System defined reasons cannot be edited. See Reason for Change - Create/Edit on page 421 for additional information.
· Translate - If multiple languages are enabled for your portal, select this option to translate the Reason field into other available languages. 
· Delete - Select this option to delete the reason. This option is not available if the reason is a system-defined reason or if it has been used in the system. A confirmation pop-up opens to confirm the deletion.
· Info - Select this option to view a description of the system-defined reason. This option is only available for system-defined reasons. 
Reasons for Change - Default Reasons
System-defined reasons for change cannot be edited or deleted, and they cannot be selected when making modifications to user record data. Default reasons for change can be edited or deleted.
The following system-defined reasons for change are available:
· Record Creation - This reason for change is automatically selected when a user record is created.
· Rehired - The Rehired reason for change indicates that the user was previously with the company and has been rehired.
· Self-service - This reason for change is automatically selected when a user modifies their user record data in a self-service area, such as My Account.
· Termination - The Termination reason for change indicates that a user is no longer with the company because their employment has been terminated.
The following default reasons for change are available:
· Cancelled - This reason for change is automatically selected when a future effective date is cancelled.
· Data Correction
· Demotion
· Initial Record Updated - This reason for change is automatically selected when a client schedules a backdated effective dated change before the initial effective dated record.
· Personal Data Change
· Promotion
· Reorganization
· Scheduled Change -This reason for change is automatically selected to capture change in employee record when a future dated effective dated record becomes current.
· Transfer
· User Deactivation -This reason for change is automatically selected when user reconciliation process deactivates an user.
· User Status/Type Change
Important Note: The "User Status/Type Change" reason for change must be active for Onboarding so that hire dates can properly process on their hire date.
Require reason for change when modifying the user record
When this option is selected, administrators must select a reason for change when making modifications on the User Record page. This option can only be selected when there is at least one active reason for change.
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[bookmark: _Ref-920134059][bookmark: concept127][bookmark: concept126]Reason for Change - Create/Edit
If Effective Dating is enabled, when editing the User Record, administrators may provide a Reason for Change which is intended to explain why the employee data is being modified. Reasons for change must be predefined via User Preferences.
Reasons for change can be created and edited from the Reason for Change section of the User Preferences page. See User Preferences on page 415 for additional information.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences.
· To create a new reason for change, click the add button in the Reasons for Change section. This opens the Add Reason for Change pop-up.
· To edit a reason for change, select Edit from the Options drop-down menu. System defined reasons cannot be edited. 
Enter the following information for the reason for change: 
· Reason - Enter the reason name, up to 40 characters. This should clearly describe a reason why an administrator may change a field on the User Record. This is required.
· ID - Enter a unique ID for the reason, up to 10 characters. This is optional, but it must be unique if it is provided. The ID cannot contain any spaces. When editing a reason for change, this value cannot be edited if it has been used in the system.
· Reason Type - Select one of the system-defined reason types from the drop-down menu. This enables organizations to categorize their reasons for change. This is required. When editing a reason for change, this value cannot be edited if it has been used in the system.
· Active - When this option is selected, the reason for change is active and can be selected when modifying the User Record. If a reason is deactivated, the reason continues to display for existing modifications. However, inactive reasons cannot be selected for new modifications.
Note: If multiple languages are enabled for a portal, the Reason field can be translated. However, this is done by selecting the Translate option from the Options drop-down on the User Preferences page. 
Save or Cancel
Click Save to save the reason for change and return to the User Preferences page. Or, click Cancel to discard any unsaved changes.
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[bookmark: _Ref2045097111]User Preferences - User Types
User types enable organizations to designate different types of workers within their organization. All user types are pre-defined with default names and categories so that specific functionality can be associated with user types within the system. Additional user types cannot be created. Although the system uses pre-defined user types, administrators can configure the user type names to match their organization's terminology.
The availability of this section is controlled by a backend setting. In addition, the User Types section is only available to administrators who have permission to manage user types and subtypes within User Preferences.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences. Select the arrow [image: ] to the right of a section name to expand the section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - User Types and Subtypes: Manage
	Grants ability to manage User Types and Subtypes on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration


Default User Types
The following default user types are available:
· Employee
· Temporary
· Intern
· Contractor
· Consumer
· External User
· Unspecified
User Type Table
The following information is displayed for each user type:
· User Type - User types are sorted alphabetically. If the type name has been modified, then the modified type name is displayed in this column. This is the type name that is displayed on the User Record.
· User Type Category - This displays the system-defined category that cannot be modified.
· Active - When a user type is active, it can be selected when creating or editing a user. If a user type is deactivated, the user type continues to be associated with the user. However, inactive user types cannot be selected when creating or editing a user.
The following option may be available from the Options drop-down menu:
· Edit - Select this option to edit the user type. See User Preferences - User Type - Edit on page 425 for additional information.
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[bookmark: _Ref-1490619947]User Preferences - User Type - Edit
User types enable organizations to designate different types of workers within their organization. All user types are pre-defined with default names and categories so that specific functionality can be associated with user types within the system. Additional user types cannot be created. Although the system uses pre-defined user types, administrators can configure the user type names to match their organization's terminology.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences.
· To edit a user type, select Edit from the Options drop-down menu.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - User Types and Subtypes: Manage
	Grants ability to manage User Types and Subtypes on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration


Enter the following information for the user type:
· User Type - Enter the user type name, up to 100 characters. This should clearly describe the type of users who are associated with the user type. This is required.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· User Type Category - This displays the system-defined category for the user type. This value cannot be modified.
· Active - When a user type is active, it can be selected when creating or editing a user. If a user type is deactivated, the user type continues to be associated with the user. However, inactive user types cannot be selected when creating or editing a user.
· Note: The Unspecified user type cannot be set as inactive.
Save or Cancel
Click Save to save the user type and return to the User Preferences page. Or, click Cancel to discard any unsaved changes.
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[bookmark: _Ref1404315323]User Preferences - User Subtypes
User types enable organizations to designate different types of workers within their organization. All user types are pre-defined with default names and categories so that specific functionality can be associated with user types within the system. Additional user types cannot be created. Although the system uses pre-defined user types, administrators can configure the user type names to match their organization's terminology.
For Employee, Contractor, Temporary, and Intern user types, administrators can create subtypes. This enables organizations to further designate different types of workers within their organization. 
The availability of this section is controlled by a backend setting. In addition, the User Subtypes section is only available to administrators who have permission to manage user types and subtypes within User Preferences.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences. Select the arrow [image: ] to the right of a section name to expand the section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - User Types and Subtypes: Manage
	Grants ability to manage User Types and Subtypes on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration


User Subtype - Add
To add a new user subtype, click the Add button. This opens the Add User Subtype pop-up. See User Preferences - User Subtypes - Add/Edit on page 429 for additional information.
User Subtype Table
The following information is displayed for each user subtype:
· User Subtype - User subtypes are sorted alphabetically. If the subtype name has been modified, then the modified subtype name is displayed in this column. This is the subtype name that is displayed on the User Record.
· User Subtype Category - This displays the system-defined category that cannot be modified.
· Active - When a user type is active, it can be selected when creating or editing a user. If a user type is deactivated, the user type continues to be associated with the user. However, inactive user types cannot be selected when creating or editing a user.
The following options may be available from the Options drop-down menu:
· Edit - Select this option to edit the user subtype. See User Preferences - User Subtypes - Add/Edit on page 429 for additional information.
· Delete - Select this option to delete the subtype. This option is not available if the subtype has been associated with a user. A confirmation pop-up opens to confirm the deletion.
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[bookmark: _Ref-236318357]User Preferences - User Subtypes - Add/Edit
User types enable organizations to designate different types of workers within their organization. All user types are pre-defined with default names and categories so that specific functionality can be associated with user types within the system. Additional user types cannot be created. Although the system uses pre-defined user types, administrators can configure the user type names to match their organization's terminology.
For Employee, Contractor, Temporary, and Intern user types, administrators can create subtypes. This enables organizations to further designate different types of workers within their organization. 
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences.
· To create a new user subtype, click the Add button in the User Subtypes section. This opens the Add User Subtype pop-up.
· To edit a user subtype, select Edit from the Options drop-down menu.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - User Types and Subtypes: Manage
	Grants ability to manage User Types and Subtypes on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration


Enter the following information for the user subtype:
· User Subtype - Enter the user subtype name, up to 100 characters. This should clearly describe the type of users who are associated with the user subtype. This is required.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· User Type Category - From the drop-down, select the type associated with the subtype. For example, select Contractor when creating a contractor subtype. If the subtype has been associated with a user, then this field can no longer be modified. The ability to create a user subtype is only available for the following user types: Employee, Contractor, Temporary, and Intern.
· Active - When a user type is active, it can be selected when creating or editing a user. If a user type is deactivated, the user type continues to be associated with the user. However, inactive user types cannot be selected when creating or editing a user.
Save or Cancel
Click Save to save the user subtype and return to the User Preferences page. Or, click Cancel to discard any unsaved changes.
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[bookmark: _Ref1731906168]User Preferences - User Statuses
User statuses enable organizations to track an employee through different employment life-cycle statuses. All user statuses are pre-defined with default names and categories so that specific functionality can be associated with user statuses within the system. Additional user statuses cannot be created. Although the system uses pre-defined user statuses, administrators can configure the user status names to match their organization's terminology.
User statuses can only be selected for a user when their user type is set to Employee, Temporary, Intern, or Contractor.
The availability of this section is controlled by a backend setting. In addition, the User Statuses section is only available to administrators who have permission to manage user statuses within User Preferences.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences. Select the arrow [image: ] to the right of a section name to expand the section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - User Statuses: Manage
	Grants ability to manage User Statuses on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration


Default User Statuses
The following default user statuses are available:
· Onboarding
· Working
· On Leave
· Terminated
User Status Table
The following information is displayed for each user status:
· User Status - User statuses are sorted alphabetically. If the status name has been modified, then the modified status name is displayed in this column. This is the status name that is displayed on the User Record.
· User Status Category - This displays the system-defined category that cannot be modified.
· Active - When a user status is active, it can be selected when creating or editing a user. If a user status is deactivated, the user status continues to be associated with the user. However, inactive user statuses cannot be selected when creating or editing a user.
The following option may be available from the Options drop-down menu:
· Edit - Select this option to edit the user status. See User Preferences - User Status - Edit on page 433 for additional information.
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[bookmark: _Ref5753585]User Preferences - User Status - Edit
User statuses enable organizations to track an employee through different employment life-cycle statuses. All user statuses are pre-defined with default names and categories so that specific functionality can be associated with user statuses within the system. Additional user statuses cannot be created. Although the system uses pre-defined user statuses, administrators can configure the user status names to match their organization's terminology.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences.
· To edit a user status, select Edit from the Options drop-down menu.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - User Statuses: Manage
	Grants ability to manage User Statuses on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration


Enter the following information for the user status:
· User Status - Enter the user status name, up to 100 characters. This should clearly describe the employment life-cycle status associated with the user status. This is required.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Status Category - This displays the system-defined category for the user status. This value cannot be modified.
· Active - When a user status is active, it can be selected when creating or editing a user. If a user status is deactivated, the user status continues to be associated with the user. However, inactive user statuses cannot be selected when creating or editing a user.
Save or Cancel
Click Save to save the user status and return to the User Preferences page. Or, click Cancel to discard any unsaved changes.
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[bookmark: _Ref265044376]User Preferences - Termination Reasons
Termination reasons enable organizations to track the reasons why employees are terminated, including whether the employee left the organization voluntarily or involuntarily. Termination reasons are pre-defined with default names and categories so that specific functionality can be associated with termination reasons within the system. Although the system uses pre-defined termination reasons, administrators can configure the termination reason names to match their organization's terminology.
Termination reasons can only be selected for a user when their user status is set to Terminated.
The availability of this section is controlled by a backend setting. In addition, the Termination Reasons section is only available to administrators who have permission to manage termination reasons within User Preferences.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences. Select the arrow [image: ] to the right of a section name to expand the section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Termination Reasons: Manage
	Grants ability to manage Termination Reasons on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration


Termination Reason - Add
To add a new termination reason, click the Add button. This opens the Add Termination Reason pop-up. See User Preferences - Termination Reason - Add/Edit on page 438 for additional information.
Default Involuntary Termination Reasons
The following involuntary termination reasons are available:
· Conviction of a Crime
· Deceased
· Dishonesty/Falsification/Theft
· End of casual employment
· End of Contract
· Forced retirement
· Negligence
· Offshoring
· Policy violation
· Poor attendance
· Reduction in force/Layoff
· Redundancy
· Transfer
· Unsatisfactory performance
Default Voluntary Termination Reasons
The following voluntary termination reasons are available:
· Better Opportunity
· Career Change
· Company leadership
· Declined offer
· Education
· Employee-job fit
· Fail to return from leave
· Inadequate Benefits
· Inadequate Compensation
· Job abandonment
· Lack of Career Growth
· Lack of Training/Development
· Legally ineligible
· Manager dissatisfaction
· Medical
· Move/relocation
· Retired
· Transfer
· Work Location
· Work Schedule
Termination Reason Table
The following information is displayed for each termination reason:
· Termination Reason - Termination reasons are sorted alphabetically. If the reason name has been modified, then the modified reason name is displayed in this column. This is the termination reason name that is displayed on the User Record.
· Termination Reason Category - This displays the system-defined category that cannot be modified.
· Active - When a termination reason is active, it can be selected when creating or editing a user. If a termination reason is deactivated, the termination reason continues to be associated with the user. However, inactive termination reasons cannot be selected when creating or editing a user.
The following options may be available from the Options drop-down menu:
· Edit - Select this option to edit the termination reason. See User Preferences - Termination Reason - Add/Edit on page 438 for additional information.
· Delete - Select this option to delete the termination reason. This option is not available if the termination reason has been associated with a user. A confirmation pop-up opens to confirm the deletion.
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[bookmark: _Ref-1117226971]User Preferences - Termination Reason - Add/Edit
Termination reasons enable organizations to track the reasons why employees are terminated, including whether the employee left the organization voluntarily or involuntarily. Termination reasons are pre-defined with default names and categories so that specific functionality can be associated with termination reasons within the system. Although the system uses pre-defined termination reasons, administrators can configure the termination reason names to match their organization's terminology.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences.
· To create a new termination reason, click the Add button in the Termination Reasons section. This opens the Add Termination Reason pop-up.
· To edit a termination reason, select Edit from the Options drop-down menu.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Termination Reasons: Manage
	Grants ability to manage Termination Reasons on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration


Enter the following information for the termination reason:
· Termination Reason - Enter the termination reason name, up to 100 characters. This should clearly describe the general reason associated with termination. This is required.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Termination Type - Select whether the termination reason is voluntary or involuntary. If the termination reason has been associated with a user, then this field can no longer be modified. This selection determines which options are available in the Termination Reason Category field.
· Voluntary indicates that the employee chose to leave their position.
· Involuntary indicates that the organization forced the employee to leave their position. 
· Termination Reason Category - From the drop-down, select the general reason associated with the new termination reason. The Termination Type selection determines which options are available. For example, if Voluntary is selected, then only Voluntary termination reason categories are available. Only a default termination reason can be selected. For example, organizations may create multiple types of negligence termination reasons, and these termination reasons should be associated with the Negligence termination reason category. If the termination reason has been associated with a user, then this field can no longer be modified.
· Active - When a termination reason is active, it can be selected when creating or editing a user. If a termination reason is deactivated, the termination reason continues to be associated with the user. However, inactive termination reasons cannot be selected when creating or editing a user.
Save or Cancel
Click Save to save the termination reason and return to the User Preferences page. Or, click Cancel to discard any unsaved changes.
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[bookmark: _Ref-725560870]User Preferences - On Leave Types
On leave types enable organizations to track when employees are excused from work or duty and the reason for their leave. All leave types are pre-defined with default names and categories so that specific functionality can be associated with on leave types within the system. Although the system uses pre-defined on leave types, administrators can configure the on leave type names to match their organization's terminology. 
Leave types can only be selected for a user when their user status is set to On Leave.
The availability of this section is controlled by a backend setting. In addition, the On Leave Types section is only available to administrators who have permission to manage leave types within User Preferences.
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences. Select the arrow [image: ] to the right of a section name to expand the section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Leave Types: Manage
	Grants ability to manage Leave Types on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration


On Leave Type - Add
To add a new on leave type, click the Add button. This opens the Add On Leave Type pop-up. See User Preferences - On Leave Type - Add/Edit on page 442 for additional information.
Default On Leave Types
The following default on leave types are available:
· Sabbatical
· Parental
· Medical
· Compassionate
· Force Majeure
· Military
· Jury Service
· Education
· Administrative
· Suspension
· Disability
· Temporary commission
On Leave Type Table
The following information is displayed for each on leave type:
· On Leave Type - On leave types are sorted alphabetically. If the type name has been modified, then the modified type name is displayed in this column. This is the on leave type name that is displayed on the User Record.
· Leave Type Category - This displays the system-defined category that cannot be modified.
· Active - When an on leave type is active, it can be selected when creating or editing a user. If an on leave type is deactivated, the on leave type continues to be associated with the user. However, inactive on leave types cannot be selected when creating or editing a user.
The following options may be available from the Options drop-down menu:
· Edit - Select this option to edit the on leave type. See User Preferences - On Leave Type - Add/Edit on page 442 for additional information.
· Delete - Select this option to delete the on leave type. This option is not available if the on leave type has been associated with a user. A confirmation pop-up opens to confirm the deletion.
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[bookmark: _Ref-1083419153]User Preferences - On Leave Type - Add/Edit
On leave types enable organizations to track when employees are excused from work or duty and the reason for their leave. All leave types are pre-defined with default names and categories so that specific functionality can be associated with on leave types within the system. Although the system uses pre-defined on leave types, administrators can configure the on leave type names to match their organization's terminology. 
To access the User Preferences page, go to Admin > Tools > Core Functions > Core Preferences > User Preferences.
· To create a new on leave type, click the Add button in the On Leave Type section. This opens the Add On Leave Type pop-up.
· To edit an on leave type, select Edit from the Options drop-down menu.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User Preferences - Core Information: View
	Grants ability to view the User Preferences administrator page. This permission does not allow administrators to modify the preferences. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Leave Types: Manage
	Grants ability to manage Leave Types on the User Preferences administrator page. Administrators must also have the User Preferences - Core Information: View permission to access the User Preferences page. This permission cannot be constrained. This is an administrator permission.
	Core Administration


Enter the following information for the on leave type:
· On Leave Type - Enter the on leave type name, up to 40 characters. This should clearly describe the general reason associated with the type of leave. This is required.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Leave Type Category - From the drop-down, select the type associated with the new on leave type. Only a default leave type can be selected. For example, organizations may create a Maternal leave type and a Paternal leave type, and both of these leave types should be associated with the Parental leave type. If the on leave type has been associated with a user, then this field can no longer be modified.
· Active - When an on leave type is active, it can be selected when creating or editing a user. If an on leave type is deactivated, the on leave type continues to be associated with the user. However, inactive on leave types cannot be selected when creating or editing a user.
Save or Cancel
Click Save to save the on leave type and return to the User Preferences page. Or, click Cancel to discard any unsaved changes.
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[bookmark: _Toc161996228]View Overview
[bookmark: _Toc161996229]View Data - Overview
View Data enables organizations to interact with their talent data. Beyond simple tables and static visualizations, View Data combines data from multiple product modules and uses advanced visualizations to deliver not only an overview of the data but also a means to filter it down to the individual. View Data encompasses data from Performance, Succession, and Compensation.
To access View Data, go to View > View Data.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	View Data: Preferences
	Grants access View Data Preferences. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Subordinates, User's Direct Subordinates, and User's Corporation.
	View



	View Data: View
	Grants access to View Data. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Subordinates, User's Direct Subordinates, and User's Corporation.
	View


Implementation
This functionality is available by request at an additional cost. Contact your Client Executive for additional information.
[bookmark: concept148]View Data Navigation Sublink
The View Data sublink must be added to a navigation tab, such as the View tab, in order for users to be able to access View Data. The tab is added from Navigation Tabs and Links Preferences.
Use Case
Silvia is the Chief Executive Officer of Dev Inc., a United States based company with 10,000 employees spread across 12 divisions. Silvia needs a visualization tool that enables her to get in touch with her organization’s talent data beyond tables and fixed charts. She is currently focused on Performance vs. Compensation.
Areas of Focus
· Big Picture - At a company and division level
· Detailed View - Employee level details
Objectives
· Identify employees with Low Compa-Ratio vs. High Performance
· Identify employees with High Compa-Ratio vs. Low Performance
· Identify pockets of Performance or Compensation on which to focus.
· Explore trends by organizational unit (OU): Location, Position, Division
· Examine and compare how key groupings differ from each other
View Data - Overview
View Data enables organizations to interact with their talent data. Beyond simple tables and static visualizations, View Data combines data from multiple product modules and uses advanced visualizations to deliver not only an overview of the data but also a means to filter it down to the individual. View Data encompasses data from Performance, Succession, and Compensation.
To access View Data, go to View > View Data.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	View Data: Preferences
	Grants access View Data Preferences. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Subordinates, User's Direct Subordinates, and User's Corporation.
	View



	View Data: View
	Grants access to View Data. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Subordinates, User's Direct Subordinates, and User's Corporation.
	View


Implementation
This functionality is available by request at an additional cost. Contact your Client Executive for additional information.
[bookmark: concept149]View Data Navigation Sublink
The View Data sublink must be added to a navigation tab, such as the View tab, in order for users to be able to access View Data. The tab is added from Navigation Tabs and Links Preferences.
Use Case
Silvia is the Chief Executive Officer of Dev Inc., a United States based company with 10,000 employees spread across 12 divisions. Silvia needs a visualization tool that enables her to get in touch with her organization’s talent data beyond tables and fixed charts. She is currently focused on Performance vs. Compensation.
Areas of Focus
· Big Picture - At a company and division level
· Detailed View - Employee level details
Objectives
· Identify employees with Low Compa-Ratio vs. High Performance
· Identify employees with High Compa-Ratio vs. Low Performance
· Identify pockets of Performance or Compensation on which to focus.
· Explore trends by organizational unit (OU): Location, Position, Division
· Examine and compare how key groupings differ from each other
[bookmark: _Ref289033638][bookmark: concept150]View Data Preferences
Use the View Data Preferences to configure the following preferences for View Data:
· Define organizational unit (OU) filters
· Define succession metrics filters
· Define employee tooltips
To access View Data Preferences, go to Admin > Preferences > View data preferences.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	View Data: Preferences
	Grants access View Data Preferences. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Subordinates, User's Direct Subordinates, and User's Corporation.
	View
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Organization Filters
Select the OU options that will display in the Organization filter. By default, up to five system OUs display in the Organization filter on the View Data page: Division, Position, Grade, Cost Center, and Location. You can use the Organization Filters section in View Data Preferences to determine if you would like different or additional OUs to display, such as custom OUs.
To define the OU filter options:
1. Click Add OU Type. This opens the Select OU Type to Add pop-up.
2. Select an OU from the drop-down. The OUs that display are the active system and custom OUs for the portal. Group OUs and multi-type OUs are not available to select.
3. Click Add. This adds the OU to the list of filters.
You can add more OUs by repeating the steps. You can add up to seven OUs. 
Delete OUs
Delete an OU by clicking Delete from the drop-down in the Options column.
Reorder OUs
Change the order in which the OUs appear in the filter by clicking Move Up or Move Down from the drop-down in the Options column.
Metric Filters
Note: Tenure and Merit Increase (%) are added automatically if available and are not user configurable.
Configure Succession metrics to see how they align with Compa-ratio and Performance.
By default, there are no metrics selected to display in the Metrics filter on the View Data page. The metrics must be added in this section in order to appear as filters. The allowable metric types are rating scale, metric grid, formula metrics, and numeric fields. 
Add Metrics
To add succession metrics:
1. Click the Add Metric button. This opens the Select Succession Metric to Add pop-up.
2. Select a metric from the Metric drop-down.
3. Click Add. This adds the metric to the list of filters.
You can add more metrics by repeating the steps. Up to five metrics can be added.
Metrics Table
Succession metricsdisplay in a table as follows:
· Order - Order in which the metrics display in the Metrics filter.
· Metric Title - Name of the metric.
· Metric Type - Type of metric field.
· Options - The following options display in the options drop-down:
· Delete - Delete the metric from the filter.
· Move Up - Move the metric up one position.
· Move Down - Move the metric down one position.
Employee Tooltip Configuration
Select the OUs that areincluded in the tooltip that displays in the scatter graph when a plot point on the graph is hovered over or tapped on a mobile device. By default, the tooltip displays the user's name, as well as the variable on the X and Y axes of the graph. You can add up to two OUs to appear in the tooltip.
If OUs are not added, then the default display in View Data will be Division OU and Position OU.
To configure the tooltip OUs, add one or more OUs in the Organization Filters section of the preferences page.
· The most recently added OU in the OUs list will appear in the first drop-down in the Employee Tooltip Configuration section.
· The second most recently added OU in the OUs list will appear in the second drop-down. Note: The order in which the OUs appear in the OUs table in the Organization Filters section does not determine which OU appears in the drop-downs in the tooltip section.
· If three or more OUs are added to the OUs section, then the drop-downs in the tooltip section allow you to select a different OU for the tooltip.
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Save Preferences
Click Save preferences to save the preference settings.
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
[bookmark: concept151]View Data Page
Use the View Data page to compare performance ratings and compa-ratio across the organization. For portals with Succession, you can also compare Succession metrics. The graph can also be colorized to provide a better visual of the various data points.
By default, when accessing the page, the performance ratings and compa-ratio data displays in the scatter graph. This allows you to quickly drill down to the desired data selections, using the filters and colorization tool.
View Data is limited to display up to 5,000 users at any one time. For portals with more than 5,000 users in their data base, only a partial set is displayed. The end user can use filters to see specific segments, as needed.
To access View Data, go to View > View Data.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	View Data: View
	Grants access to View Data. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, User's Subordinates, User's Direct Subordinates, and User's Corporation.
	View
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Filters
Refine the list of results. The filter options that are available are configured by the administrator in View Data Preferences.
· Open/Close Filters Panel - The Filters panel is expanded by default. To close the panel, click the X in the upper-right corner. To expand the panel, click Open filters panel button [image: ].
· Home Button - The Home icon [image: ] in the upper-left corner of the panel returns you to the root level of the filters. Clicking the icon does not reset/clear the filters.
The following filters are available:
Organization Filter
Filter by up to seven different parent organizational units (OU) and child OUs. The OUs that are available are configured by the administrator in View Data Preferences.
To filter by OU:
1. Click the Organization filter. This opens the list of parent OUs.
2. Click the parent OU to view the child OUs.
3. Select one of the following options:
· Check the box to the left of the child OU name to select the child OU as a filter.
· Click the child OU to view the additional child OUs. Then, click the name of the additional child OU to set it as a filter.
The graph updates automatically to display matching employees. Repeat these steps to set additional filters. The selected filters display at the bottom of the Filters panel.
Metrics Filter
Note: Tenure and Merit Increase (%) are added automatically if available and are not user configurable.
This filter allows you to filter by up to five different succession metrics in addition to Tenure and Merit Increase (%). The metrics that are available are configured by the administrator in View Data Preferences.
To filter by succession metric:
1. Click the Metrics filter. This opens the list of succession metrics.
2. Click a metric to view the available ratings.
3. Click a rating to select it as a filter.
Tenure/Metric Increase % Filters
[image: ]
Adjust the tenure and merit increase values for the graph by sliding the bar to the left or right from either side. This updates the graph based on the selected value.
Note: The percent merit increase = compensation increase/base salary (prior to the increase) * 100.
Chart Range Filters
[image: ]
[image: ]
The Chart Range Filters correspond to your X and Y axis selection. By default, the Chart Y Range filters allow you to adjust the compa-ratio and performance rating by sliding the bar to the left or right from either side. This updates the graph based on the selected value. For Succession Metrics, the range filters change to a drop-down.
The range of the slider is determined by the Min and Max range of the population.
Applied Filters
[image: ]
The Applied Filters section only displays after at least one filter is added. This section displays at the bottom of the Filters panel and shows you which filters you have applied to the data.
Clear All Filters
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Click Clear All to remove all the filters that you have selected in the Filters panel. There is no undo option for this action.
Delete Filter
You can remove an individual filter by clicking the X to the right of the filter.
Clear Filters Group
You can remove all filters in a group by clicking Clear. Note: To remove all the filters that you have set, you can click Clear All at the top of the Applied Filters section.
My Favorites
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The My Favorites section displays at the bottom of the Filters panel. This section allows you to add up to 20 searches as favorites and view your saved searches.
Add Searches to Favorites
To add a search as a favorite, click the Add option and name the search, up to 45 characters. This saves the search with all of the filters you have selected in the Filters panel.
View Saved Searches
To view your favorite searches, click My Favorites. This opens a pop-up that allows you to see a list of your favorites and select the search that you would like to view. You can modify the filters you selected for the saved search, and then save the search again or save it with a different name.
View Data Graph
The scatter graph for View Data displays the interactive visualization of your data based on the selected filters. Up to 5000 employees display.
You can define the X and Y axes, as well as define a colorization for the plot points based on compa-ration, performance rating, or one of the available Succession metrics.
X-Axis
By default, compa-ratio displays as the X axis. In addition to compa-ratio, users will be able to select Tenure and Merit increase (%). For portals with Succession enabled, you can change the X axis to a Succession metric by selecting a metric from the axis drop-down. The graph will update automatically to display the new axis.
Y-Axis
By default, performance rating as the Y axis. In addition to Performance ratings, users will be able to select Tenure and Merit increase (%). For portals with Succession enabled, you can change the Y axis to a Succession metric by selecting a metric from the axis drop-down. The graph will update automatically to display the new axis.
Flip Axes
Click the Flip button [image: ] to flip the values for the X and Y axes.
Color By
You can define a colorization for the graph to provide a better visual of the data point variations. By default, you can select Compa-Ratio, Performance Rating, Tenure, or Merit Increase % from the Color by drop-down. For portals with Succession, you can also color by the available Succession metrics.
Color Legend
When using a color option, a legend displays to the right of the graph. The legend identifies the value for each color. You can also use the legend as a filter by clicking or unclicking a value on the legend to display or hide the value in the graph.
Discrete/Numeric
Up to nine segments are allowable for discrete values. Numeric values are divided into five equal segments.
Legend Segments
With the exception of Compa-ratio, all non-Succession metrics are uniformly broken up into five segments. The size of the segment is determined by the minimum and maximum range of the entire data set. The size of the segment cannot be configured by the user.
Example of Tenure Segments
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· Minimum Tenure = 0.1
· Maximum Tenure= 21
· Segment Size = (21-0)/5 = 4.2
· Green is always assigned the lowest value, and purple is always assigned the highest value.
Compa-Ratio Segment
[image: ]
For compa-ration, the breaks are fixed at the following:
Succession Metrics
[image: ][image: ]
For Succession Metrics, the number of segments is based on metric type. Up to nine segments may be displayed. The color assigned is determined by the points assigned to the metric. Red is always assigned the lowest point rating, and green is assigned to the highest point rating.
Tooltip
Hover over/tap a plot point to view the details for the particular employee. If the employee in focus shares the same X and Y values with other employees (a complete overlap), the tooltip displays the values for the X and Y axes and a count of the complete overlaps. For all others, the tooltip will always display the user's name and the variable on the X and Y axes for non. The tooltip may also display OU data, if configured by the administrator in View Data Preferences.
Tool Tip - Details for Individuals
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Tool Tip - Details for Multiple Individuals with the Same X and Y Values
[image: ]
The OU details for a data point are only displayed for non-overlapping data points. If you have overlapping points, View Data only shows the X and Y value, as well as a count of how many points are on the same spot.
Number of Results
The total number of results on the graph displays in the upper-left corner above the graph. The results will not exceed 5,000 data points.
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Performance Rating with Multiple Scales
[image: ]
For portals with performance data with multiple scales, (i.e 5/5 and 10/10), the data is automatically normalized to allow for comparisons. The slider maximum and chart axis are set to between 0 and 100. Normalization is achieved by dividing performance rating score received by the maximum achievable score. This setting is not configurable by the user.
The tooltip displays the current rating and the maximum rating next to the normalized score (e.g., 50 [2.5/5.0]).
Options
[image: ]
From the Options drop-down, you can click Export to Excel to export the graph to an Excel spreadsheet. This provides a detailed view of the users and their performance, compa-ratio, or Succession data. The filter fields that display on the Excel spread sheet match the fields displayed on the tooltip.
[bookmark: _Toc161996230]View People Page - Overview
The View People page is a dashboard that allows managers and executives to use employee attributes, such as performance and succession metrics, to identify high-value assets while on the go. View People is available from mobile and desktop devices to provide immediate access to key employee data.
[bookmark: concept152]To access the View People page, go to the associated navigation tab and click View People. The location of the View People link is based on the configuration by the administrator.
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Implementation
This functionality is available by request at an additional cost. Contact your Client Executive for additional information.
View People Features
The following features are available on the View People page: 
· View People Page - Actions Bar - See View People Page - Actions Bar on page 473 for additional information. 
· View People Page - Search Results Panel See View People Page - Results List Panel on page 496 for additional information.
· View People Page - Filters See View People Page - Filters on page 478 for additional information.
· View People Page - Selected Employees Page See View People Page - Selected Page on page 498 for additional information.
· View People Page - View Employee Details See View People Page - View Employee Profile on page 475 for additional information.
· View People Page - My Lists See View People Page - My Lists on page 489 for additional information.
View People Page - Overview
The View People page is a dashboard that allows managers and executives to use employee attributes, such as performance and succession metrics, to identify high-value assets while on the go. View People is available from mobile and desktop devices to provide immediate access to key employee data.
[bookmark: concept153]To access the View People page, go to the associated navigation tab and click View People. The location of the View People link is based on the configuration by the administrator.
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Implementation
This functionality is available by request at an additional cost. Contact your Client Executive for additional information.
View People Features
The following features are available on the View People page: 
· View People Page - Actions Bar - See View People Page - Actions Bar on page 473 for additional information. 
· View People Page - Search Results Panel See View People Page - Results List Panel on page 496 for additional information.
· View People Page - Filters See View People Page - Filters on page 478 for additional information.
· View People Page - Selected Employees Page See View People Page - Selected Page on page 498 for additional information.
· View People Page - View Employee Details See View People Page - View Employee Profile on page 475 for additional information.
· View People Page - My Lists See View People Page - My Lists on page 489 for additional information.
[bookmark: _Ref-1669626146][bookmark: concept154]View People Preferences
The View People Preferences page allows you to configure the following preferences for View People:
· Organizational unit (OU) filters
· OU custom field filters
· Succession metrics filters
· Employee attributes filters
· User Record custom field filters
· Define the OUs that will display for each user in their employee card
· Determine whether or not permission constraints should apply for users when viewing a shared list
To access View People Preferences, go to Admin > Preferences > View People.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	View People Preferences Page
	Grants access to the View People Preferences page, which allows administrators to configure the View People page according to their needs per organizational unit (OU). This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User's Subordinates.
	View
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Organization Filters
This section allows you to select the OU types and OU custom fields that will display in the Organization filter.
Use Case
1. Claire is the head of Human Resources for a multi-national company with 10,000 employees.
2. Her company tracks critical roles as a custom Position organizational unit (OU) field, and also tracks Division OUs that are working on key initiatives for the current fiscal year.
3. Claire uses View People to identify employees that are in key roles and review their compensation vs. performance status.
4. She can review their succession metrics and take initiative to assign training or move them into talent pools.
5. She can also review the performance of Division OUs that are tied to key initiatives and review their existing skill set and progress toward year end goals.
Organizational Unit Type Filter
By default, up to 15 system OUs display in the Organization filter on the View People page: Division, Position, Grade, Cost Center, and Location. You can use the Organization Filters section in View People Preferences to determine if you would like different or additional OUs to display, such as custom OUs.
To define the OU filter options:
1. Click Add OU Type. This opens the Select OU Type to Add pop-up.
2. Select an OU from the drop-down. The OUs that display are the active system and custom OUs for the portal. Group OUs and multi-type OUs are not available to select.
3. Click Add. This adds the OU to the list of filters.
You can add more OUs by repeating the steps. Up to seven OUs can be added. 
Reorder OU Position
You can change the order in which the OUs appear in the filter by clicking Move Up or Move Down from the drop-down in the Options column.
Organizational Unit Custom Field Filter
You can add up to 10 OU custom fields to this section. The fields that you add will appear in the OU Fields filter in the Organization section of the Filters panel on the View People page.
The following custom field types can be added:
· Checkbox
· Dropdown
· Formula Metric
· Metric Grid
· Multiple Checkbox
· Numeric
· Radio Button
· Rating Scaling Metric
To add OU custom fields:
1. Click the Add OU Field button. This opens the Select OU Custom Field to Add pop-up.
2. Click the Please Select drop-down.
3. Select an OU custom field.
4. Click Add. This adds the field to the OU custom fields table on the View People Preferences page.
OU Custom Fields Table
The following information displays for each OU custom field in the table:
· Order - This column displays the order in which the custom field displays in the filter.
· Custom Field - This column displays the name of the custom field.
· OU Type - This column displays the type of OU that is defined for the custom field.
· Field Type - This column displays the type of custom field.
· Option - The following options are available in the options drop-down:
· Delete - Click this option to delete the custom field as a filter.
· Move Down - Click this option to move the custom field down one position.
· Move Up - Click this option to move the custom field up one position.
Performance Filters
Note: This section only displays for portals with Performance or Succession.
This section allows you to configure Performance and Succession metrics. Up to 15 metrics can be added.
Succession Metrics
By default, the Performance filter on the View People page displays the first five allowable succession metrics. You can modify the metrics that display by adding metrics in this section. The allowable metric types are checkbox, radio button, rating scale, metric grid, formula metrics, numeric, and dropdown fields. There are no metrics selected by default to display in the Performance filter on the View People page. The metrics must be added in this section in order to appear as filters.
To add succession metrics:
1. Click the Add SMP Metric button. This opens the Select Succession Metric to Add pop-up.
2. Select an SMP metric from the SMP Metric drop-down. The metrics that display are the active system and custom OUs for the portal. Group OUs and multi-type OUs are not available to select.
3. Click Add. This adds the OU to the list of filters.
You can add more metrics by repeating the steps. Up to 15 metrics can be added.
Once succession metrics are added, they display in a table below the metrics. The following information displays in the table:
· Order - This column displays the order in which the metrics display in the Performance filter.
· Succession Metric Title - This column displays the name of the metric.
· Metric Type - This column displays the type of metric field.
· Color Assignment - This column indicates whether or not colors have been assigned to the ratings to aid in comparison. The following values display:
· Complete
· Incomplete
· Not Assigned
· Options - The following options display in the options drop-down:
· Delete - Click this option to delete the metric from the filter.
· Move Up - Click this option to move the metric up one position.
· Move Down - Click this option to move the metric down one position.
Performance Options
The Display Overall Ratings option allows you to hide the Overall Performance filter on the View People page. Check the box to hide the filter. Uncheck the box to show the filter.
Attribute Filters
Note: This section only displays for portals with Compensation or Succession.
This section allows you to add Resume, Career Preferences, and User Record custom field filters. You can also define compensation filter options.
Resume
If the resume section of Universal Profile is enabled, then the Resume Filters section allows you to select up to five employee attributes that will display as filters.
To add attributes:
1. Click the Add Resume attribute button. This opens the Select Resume Attribute to Add pop-up.
2. Select an attribute from the Resume Attributes drop-down. The field types that can be added are Attribute List, Numeric, Checkbox, Short Text Box, or Dropdown.
3. Click Add. This adds the attribute to the list of filters.
You can add more attributes by repeating the steps. Up to 10 attributes can be added.
Resume Attributes Metrics Table
Once attributes are added, they display in the table. The following information displays in the table:
· Order - This column displays the order in which the metrics display in the filter.
· Resume Attribute - This column displays the name of the attribute.
· Field Type - This column displays the type of attribute field.
· Options - The following options display in the options drop-down:
· Delete - Click this option to delete the metric from the filter.
· Move Up - Click this option to move the metric up one position.
· Move Down - Click this option to move the metric down one position.
Career Preferences
This section enables you to add questions that are active in the Career Preferences section of Bio Resume and Career Preferences. The questions that are added are available as Attributes filters on the View People page.
To add career preferences attributes:
1. Click the Add Career Preferences Attribute button. This opens the Select Career Preferences Attribute to Add pop-up.
2. Click the Please Select drop-down.
3. Select a career preferences question from the drop-down.
4. Click Add. This adds the question to the Career Preferences Attribute section.
To add more questions, repeat the steps above. Up to 10 questions can be added.
Career Preferences Attributes Metrics Table
Once career preferences attributes are added, they display in the table. The following information displays in the table:
· Order - This column displays the order in which the metrics display in the filter.
· Career Preferences Attribute - This column displays the career preferences question.
· Field Type - This column displays the type of attribute field.
· Options - The following options display in the options drop-down:
· Delete - Click this option to delete the metric from the filter.
· Move Up - Click this option to move the metric up one position.
· Move Down - Click this option to move the metric down one position.
User Custom Fields
 You can add up to 10 User Record custom fields to this section. The fields that you add will appear in the User Fields filter in the Attributes section of the Filters panel on the View People page.
To add User Record custom fields:
1. Click the Add User Field button. This opens the Select User Custom Field to Add pop-up.
2. Click the Please Select drop-down.
3. Select an User Record custom field.
4. Click Add. This adds the field to the User Record custom fields table on the View People Preferences page.
Note: User Record custom date fields cannot be added.
User Record Custom Fields Table
The following information displays for each User Record custom field in the table:
· Order - This column displays the order in which the custom field displays in the filter.
· Custom Field - This column displays the name of the custom field.
· Category - This column displays the type of category that is defined for the custom field.
· Field Type - This column displays the type of custom field.
· Option - The following options are available in the options drop-down:
· Delete - Click this option to delete the custom field as a filter.
· Move Down - Click this option to move the custom field down one position.
· Move Up - Click this option to move the custom field up one position.
Compensation Options
Note: This section only displays for portals with Compensation.
You can configure the following compensation filter options:
· Display Compensation - This option is only available for portals with a single currency. When this option is selected, it displays a sliding Compensation filter in the Attributes section of the Performance filter, which allows users to filter by a compensation range.
· Display Compa-Ratio - Including this option displays a sliding Compa-Ratio filter in the Attributes section of the Performance filter, which allows users to filter by a compa-ratio range.
· Display Tenure - Including this option displays a sliding Tenure filter in the Attributes section of the Performance filter, which allows users to filter by a tenure range.
Employee Card Configuration
This section allows you to define the OUs that will appear in a user's employee card on the View People page. By default, the Position OU and Location OU display for each user on the View People page. If the Position OU and/or Location OU are inactive, then an active system OU displays for users on the View People page.
You can select up to two OUs that will appear in the small card and six that will appear in the large expanded card.
Small Card
The OU options that are available to select are dependent on the OUs that you added in the Organization Filters section. If there are no OUs added to the Organization Filters section, then no OU options will be available to select in the drop-downs in the Employee Card Configuration section.
To select the OUs:
1. Click the drop-down below the user name "John Doe."
2. Select the OU from the drop-down. The options that are available to select are dependent on the OUs that you added in the Organization Filters section.
Large Card
For the large card, you can configure up to six additional organizational units (OU), OU custom fields, User Record custom fields, and Performance and Succession metrics, including any career preferences that are selected in the Career Preferences Attributes section. The fields and metrics will appear on the expanded user cards on the View People page.
Use Case
A Human Resources executive is in the process of completing the company’s annual planning. Weeks have been spent on annual reviews and succession and compensation plans, but the process is not over until they close the loop and take action on the findings.
To close the loop, they will need to use the results from the succession planning and employee skills and experience to identify the best candidates to lead the upcoming initiatives. Because there will be multiple matches, they are going to need a way to do side by side comparisons. In past years, this process resulted in hundreds of print outs and stacks of paper.
Using View People, they use the built-in filters to find the best matches based on the latest succession/performance ratings. When multiple matches are found, the expanded user cards allow a side by side comparison based on up to six key metrics. The best matches are added to the annual "best bets" list.
The final list is shared across the organization via View people, and decisions are finalized. In the upcoming week, the company’s best bets will be invited to meet with department heads.
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To add fields and metrics:
1. Click the drop-down for the field. This opens a list of OU types and metrics.
2. Click the desired OU type or metric.
Set Click Behavior for Employee Card
This option lets you set the click behavior of the employee (user) card on the View People page.
To set the click behavior of the user card, select one of the following options from the drop-down:
· View Employee Profile - This opens the employee's profile page within View People. This is the default click behavior of the user card.
· Universal Profile > Bio - This will open the Universal Profile > Bio page in a new tab. This option does not display if the Bio page is not available in your portal.
· Universal Profile > Snapshot - This will open the Universal Profile > Snapshot page in a new tab. This option does not display if the Snapshot page is not available in your portal.
· Universal Profile > User Record - This will open the Universal Profile > User Record page in a new tab.
Share List Settings
The following options are available in the Share List Settings section:
Send shared notifications from the system default email address
When this option is selected, shared lists are sent from the system "Default From Address," rather than the email address for the user who shared the list. The address that will display in the From field for email notifications for shared lists will be the default from address that is configured for the system, provided that a default address has already been set up.
If a "Default From Address" is not yet configured for your portal, you can submit a case to Global Customer Support to have the backend setting configured. Setting up a default address is an optional feature.
Information Icon - Hover over the information icon to view your portal's "Default From Address." If your portal does not have a default address created, then no information displays when hovering over the icon.
Note: If the "Default From Address" is removed from the system, then the value in the From: field on the email will be the email address of the user who shared the list.
Delegate constraints for shared lists
When this option is selected, the system dynamically manages permissions to ensure all recipients of a shared list will see the contents in full, just as the sender would. If you disable this feature, user constraints could prevent the recipient from seeing the full list.
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Save Preferences
Click Save to save the preferences settings.
[bookmark: _Ref1230983547][bookmark: concept155]View People Page - Actions Bar
The action bar displays above the list of results and enables users to order the employee results, switch between the available views, and take actions on the results.
To access the View People page, go to the associated navigation tab and click View People. The location of the View People link is based on the configuration by the administrator. 
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The following features are available on the actions bar:
· Filters - Open the Filters panel. The panel opens to the left of the employee results.
· Filters Mode - [image: ] Open the Filters panel. 
· List Mode - [image: ] View your lists. 
· Selected Employees Thumbnails - Displays employee thumbnail pictures. If you select more than four employees, the additional number displays to the right of the fourth image. The thumbnails update to display the most recently selected employees. Click any image to view the Selected page, which displays only the employees you have selected. You can remove a thumbnail by deselecting the employee in the results.
· Add to List - Add the selected employees to a list. You can create a new list or select an existing list if there is at least one list created. For new lists, you can name the list up to 100 characters. Click Save to add the employees to the list. This option is only enabled when at least one employee is selected. 
· Number of Results - Number of employees in the search displays in the upper-left corner of the results page. The number changes depending on whether or not you are viewing all employees in the results, a selected number of employees, or the employees in a list.
· Sort By - Sort the list by last name or first name. If tenure is enabled by the administrator in View People Preferences, then you can also sort by tenure. The list is sorted by last name by default.
· Order Ascending/Descending - Sort the list in ascending or descending order. The order is based on the Sort By option you have selected. For example, if Last Name is selected, then the list is sorted in ascending or descending order by last name.
· Color by - For portals with Succession, Identify employees by a succession metric. The metrics that display are the default metrics defined by the administrator in View People Preferences. When a metric is selected, the results are colorized to identify each employee by their rating for the metric. If the selected metric does not have any colors assigned to it, then the metric will appear grayed out and not selectable. If an employee is not rated, then they display with gray diagonal stripes in the color bar.
Custom Field Availability Note: The custom fields that display are based on a user's availability to view the field and its value. If a user at any point does not meet the availability criteria for a custom field, then the field and value will not appear.
Succession Metrics Colors Note: As with existing functionality, the colors for succession metrics are defined in Custom Field Administration when configuring the Succession custom field.
· Color Legend - The legend displays to the right of the Color by filter. The legend identifies the ratings and their assigned colors that are associated with the selected metric. If there are more than three ratings for the metric, then you can click the ellipses to view the additional ratings and colors.
[bookmark: _Ref-754094451][bookmark: concept156]View People Page - View Employee Profile
The employee's card displays employee profile. 
From the profile page, you can do the following:
· View succession metric ratings
· View overall current performance rating
· View the employee's team organization, such as their manager's name and position
· Add the employee to a talent pool
· Add the employee to another list
· Create a new list and add the employee to the new list
To access the View People page, go to the associated navigation tab and click View People. Click an employee's card. The location of the View People link is based on the configuration by the administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Talent Pools - Manage
	Grants ability to create and manage Talent Pools. This permission also grants access the ability to add candidates to a job requisition. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Talent/Succession - Administration
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General Employee Details
This section displays the following information from the employee card:
· Photo - Photograph of the employee.
· Name - Employee name.
· [Organizational Unit 1] - Displays if an organizational unit (OU) is configured to display by the administrator in View People Preferences. The OU will be an active OU for the portal.
· [Organizational Unit 2] - Displays if an organizational unit (OU) is configured to display by the administrator in View People Preferences. The OU will be an active OU for the portal.
Options
The Options drop-down allows you to add the employee to a talent pool or to a list.
Add to Talent Pool
This option allows you to add the employee to a talent pool. You must have permission to manage talent pools in order to add employees to a talent pool.
To add to a talent pool:
1. Click Add to Talent Pool. This opens the Add to Talent Pool pop-up.
2. Select one of the following options:
· Select an existing talent pool from the Select Talent Pool drop-down, if there is at least one talent pool created.
· Click Create New Talent Pool to create a new talent pool. Enter a title for your talent pool in the title text box, up to 100 characters.
3. Click Save to add the employee to the talent pool.
Note: Once a talent pool is created or the user is added to a talent pool, you can view the talent pool from the Manage Talent Pools page. This page can be accessed from the associated navigation tab, which is configured by an administrator.
Add to List
Click Add to List to add the employee to a list. This opens the Add to List pop-up. You can create a new list or select an existing list if there is at least one list created. For new lists, you can name the list up to 100 characters. Click Save to add the employee to the list.
Succession 
Displays the employee's data from the succession metric filters, if available. The metric rating displays to the right of a color-coded circle. The color of the circle is determined by the value of the metric rating.
Overall Performance 
Displays the employee's most current performance review rating, as well as the second most recent review rating.
Team Details
Displays the team hierarchy for the employee. This information is obtained from the Universal Profile > Bio > About page.
[bookmark: _Ref-711399904][bookmark: concept157]View People Page - Filters
The filter options allow you to refine the list of results. The filter options that are available are configured by the administrator in View People Preferences.
To access the View People page, go to the associated navigation tab and click View People. 
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Open/Close Filters Panel
· To view the filters, click Filters in the actions bar. This opens the Filters panel.
· To close the filters, click the X in the upper-right corner of the panel.
Home Button
The Home icon [image: ] returns you to the root level of the filters. Clicking the icon does not reset the filters.
Organization
This filter allows you to filter by up to seven different parent organizational units (OU) and child OUs, as well as OU custom fields.
Filter by Organizational Unit Type
The OUs that are available are configured by the administrator in View People Preferences.
To filter by OU:
1. Click the Organization filter. This opens the list of parent OUs.
2. Click the parent OU to view the child OUs.
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3. Check the box to the left of the child OU name to select the child OU as a filter.
4. Or, click the child OU to view the additional child OUs. Then, click the name of the additional child OU to set it as a filter.
The page updates automatically to display matching employees. Repeat these steps to set additional OU type filters. The selected filters display at the bottom of the Filters panel.
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Filter by Organizational Unit Custom Fields
This option allows you to filter by OU custom fields, which are created by the administrator in Custom Field Administration. OU custom fields must be added to the View People Preferences page in order for the OU Fields filter to appear on the View People page. Custom Field Availability Note: The custom fields that display are based on a user's availability to view the field and its value. If a user at any point does not meet the availability criteria for a custom field, then the field and value will not appear.
To filter by custom OU fields:
1. Select the Organization filter on the View People page. This opens the list of filters that are available for OUs.
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2. Select the OU Fields filter. This opens the list of custom fields that have been selected on the View People Preferences page to appear in the filter.
3. Select the desired OU custom field. This opens the list of options that are defined for the custom field.
[image: ]
4. Select the custom field options by which you would like to filter the results. When an option is selected, the results on the View People page are automatically updated. In addition, the selected filter will appear in the Applied Filters section at the bottom of the Filters panel.
Performance
Note: This section only displays for portals with Performance or Succession. Performance filters are only visible to portals with Performance. Succession filters are only available for portals with Succession.
This filter allows you to filter by up to five different succession metrics. The metrics that are available are configured by the administrator in View People Preferences.
You can also filter by overall performance rating. The rating that displays is the rating for the user's most recently completed review.
To filter by succession metric:
1. Click the Performance filter. This opens the list of succession metrics and displays the Overall Performance rating filter.
2. Click the metric to view the available ratings.
3. Click a rating to select it as a filter.
To filter by overall Performance:
1. Slide the rating scale from the left to set the minimum rating.
2. Slide the rating scale from the right to set the maximum rating.
The page updates automatically to display matching employees. Repeat these steps to set additional filters. The selected filters display at the bottom of the Filters panel.
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Attributes
This filter allows you to filter by employee attributes and career preferences, as well as User custom fields. You can also filter by tenure, which is the total time elapsed since the user's hire date. You can filter by compa-ratio, which is a numeric value with two decimal points of accuracy and is used to indicate whether or not an employee is underpaid. You can filter by compensation by setting a minimum and maximum annual salary range.
The filter options that are available are configured by the administrator in View People Preferences.
Note: For portals with multiple currencies, Compensation will not be available as a filter for the April '16 release. The Compensation filter will only be available for portals that have a single currency.
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Resume Attributes
To filter by resume attributes:
1. Click the Attributes filter. This opens the list of parent attributes.
2. Click a parent attribute to view the child attributes.
3. Click the child attribute to set it as a filter. Clicking the field displays the list of values that are configured for the field. The value you select will be used to filter the employee results.
Up to four attributes can be selected.
Career Preferences
To add a career preferences question as a filter:
1. Click the Attributes filter.
2. Click Career Preferences. Note: The name of the Career Preferences tab will differ depending on how the administrator named the tab in Bio Resume and Career Center Preferences.
3. Click the career preferences question. This adds the question as a filter.
User Fields
Note: User Record custom fields must be added to the View People Preferences page in order for the OU Fields filter to appear on the View People page.
To filter by custom User Record custom fields:
1. Select the Attributes filter on the View People page. This opens the list of filters that are available for employee attributes.
2. Select the User Fields filter. This opens the list of User Record custom fields that have been selected on the View People Preferences page to appear in the filter.
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3. Select the desired User Record custom field. This opens the list of options that are defined for the custom field.
4. Select the custom field options by which you would like to filter the results. When an option is selected, the results on the View People page are automatically updated. In addition, the selected filter will appear in the Applied Filters section at the bottom of the Filters panel.
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Compensation Options
To filter by compensation options:
1. Slide the bar from the left to set the minimum tenure, compa-ratio, or compensation (annual salary).
2. Slide the bar from the right to set the maximum tenure, compa-ratio, or compensation (annual salary).
The page updates automatically to display matching employees. Repeat these steps to set additional filters. The selected filters display at the bottom of the Filters panel.
Note: The compa-ratio is used to indicate whether or not an employee is underpaid. This is a numeric value with two decimal points of accuracy.
Using Short Text Box Fields as Filters
Short text box field types can be used as search filters, when added by the administrator in View People Preferences. This field type may appear in the OU, Performance, and Attributes filter sections.
When this type of field is selected as a filter, options will be available for Starts With, Contains, or Exact so that you can enter a value that would have been entered by the user when completing the field.
For example, a user filled out a career preferences question titled "Where are you willing to relocate?" The user entered "Beijing" as his response. You can use the Starts With option and enter beij* so that you are more likely to return results for Beijing. You could also use the Exact option and enter the full city name. Or, you could use the Contains option and enter *jing.
The search allows you to carry out multiple searches by providing multiple search terms. For example, you would like to search for users with a Finance or Economics degree. You would enter the search term for Finance, and then add a second parameter for Economics.
The field accepts up to 50 characters.
Applied Filters List
The filters you have selected display in the Applied Filters section at the bottom of the Filters panel.
Clear All
The Clear All option removes all the filters that you have selected in the Filters panel.
[image: ]
Delete Filter
You can remove an individual filter by clicking the X to the right of the filter.
Clear Filters Group
You can remove all filters in a group by clicking Clear. Note: To remove all the filters that you have set, you can click Clear All at the top of the Applied Filters section.
Add/Save Search to Favorites
The favorites section displays at the bottom of the filters panel and allows you to add up to 20 searches as favorites and view your saved searches.
Add Searches to Favorites
To add a search as a favorite, click the Add option and name the search. This saves the search with all of the filters you have selected in the Filters panel.
View Saved Searches
To view your favorite searches, click My Favorites. This allows you to see a list of your favorites and select the search that you would like to view. You can modify the filters you selected for the saved search, and then save the search again or save it with a different name.
Note: When viewing saved searches, the only saved data is the filters that were selected in the Filters panel. Any employee cards that were selected when the search was saved are not retained. In addition, any color criteria defined in the Color by field are not retained.
[bookmark: 1416265973][image: ]
[bookmark: _Ref-1889464768]View People Page - My Lists
The My Lists page displays the lists that you have created and the lists that have been shared with you. From this page, you can:
· Create a new list
· Share an existing list
· Delete a list
· View a shared list
· Add a list of employees to a talent pool
To access the View People page, go to the associated navigation tab and click View People. The location of the View People link is based on the configuration by the administrator. To access the My Lists page, click the List Mode [image: ] icon.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Talent Pools - Manage
	Grants ability to create and manage Talent Pools. This permission also grants access the ability to add candidates to a job requisition. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Talent/Succession - Administration



	View People: View
	Grants access to open View People to see results and share lists. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User's Subordinates.
	View
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New List
You can create a new list directly from the My Lists page. This allows you to develop a collection of lists so that you can add employees to the list from other areas of View People.
To create a new list:
1. Click New List to create a new list. This opens the Create New List pop-up.
2. Enter a name for the list, up to 100 characters.
3. Click Save to save the list.
Once the list is saved, it will not contain any employees. You can add employees from other areas of View People.
Sorting By
The following sorting options are available:
· Sort By - By default, the lists display in order of most to least recently modified. The following sorting options are available:
· Last Modified Date - This allows you to sort by the date on which the lists were most recently modified.
· Title - This allows you to sort by list title.
· Order Ascending/Descending - You can sort the lists in ascending or descending order. The order is based on the Sort By option you have selected. For example, if Title is selected, then the list is sorted in ascending or descending order by list title.
Lists
Each list displays in a separate row. The following information displays for the lists:
· List Title - The name of the list.
· Shared Status - Click the Shared icon [image: ] icon to view the users with whom you shared the list. If the list was shared with you, then you can click the icon to view who shared the list.
· Employee Thumbnails - Picture of the employees in this list. Up to four thumbnails appear. If you have more than four employees in the list, then the number of additional employees displays to the right of the fourth image. Clicking a thumbnail opens the list details page.
· Modified - Date on which the list was most recently modified.
· Options - The following options are available in the drop-down:
· Share - Click Share to share the list. This opens the Share List with Others pop-up. Select the users with whom to share the list. Enter a message that will display to the users with whom the list is shared. Note: You can only share lists that you own. You cannot share a list that was shared with you.
A link to the shared list will appear in the email. For portals with SSO enabled, recipients of the email (who have availability to SSO) can access the shared list directly from the email without being prompted to manually log in to the portal.
· Delete - Click Delete to delete the list. If this is a list that you have shared, then the list is also deleted from the users with whom the list was shared.
View List Details
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The details of the list can be viewed by clicking the list name. This opens the details page for the list. The list details shows the name of the list, the last updated date, and options for adding to a talent pool and sharing the list. You can also apply filters and access an employee's profile page.
Click Back to return to the My Lists page.
Updated Date
The date that the list was most recently updated displays to the right of the list title. If this is a shared list, it will show the date on which the list was shared and the user that shared the list.
Sorting/Succession Options
The following sort options are available:
· Sort By - Sort the list by last name or first name. If tenure is enabled by the administrator in View People Preferences, then you can also sort by tenure. The list is sorted by last name by default.
· Order Ascending/Descending - Sort in ascending or descending order. The order is based on the Sort By option you have selected. For example, if Title is selected, then the list is sorted in ascending or descending order by list title.
· Color by - For portals with Succession, you can identify employees by a succession metric. The metrics that display are the default metrics defined by the administrator in View People Preferences. When a metric is selected, the results are colorized to identify each employee by their rating for the metric. If an employee is not rated, then they display with gray diagonal stripes in the color bar. Note: As with existing functionality, the colors for succession metrics are defined in Custom Field Administration when configuring the Succession custom field.
Add to Talent Pool
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Add the employees in the list to a talent pool. You must have permission to manage talent pools in order to add employees to a talent pool.
Note: Before adding employees to the talent pool, you can remove any employees that you do not want to include on the list by clicking the Remove icon [image: ] in the upper-right corner of their employee card.
To add to a talent pool:
1. Click Add to Talent Pool. This opens the Add to Talent Pool pop-up.
2. Select one of the following options:
· Select an existing talent pool from the Select Talent Pool drop-down, if there is at least one talent pool created.
· Or, click Create New Talent Pool to create a new talent pool. Enter a title for your talent pool in the title text box, up to 100 characters.
3. Click Save to add the employees to the talent pool.
Note: Once a talent pool is created or users are added to a talent pool, you can view the talent pool from the Manage Talent Pools page. This page can be accessed from the associated navigation tab, which is configured by an administrator.
Share List
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This option allows you to share the list with other users. You must have permission to view View People in order to share lists.
To share a list:
1. Click share list. This opens the Share List with Others pop-up. If the list has been shared before, then the users with whom the list has been shared displays at the top of the pop-up, and you can click View All to view all the users with whom the list has been shared.
2. Select the users to add by entering key words into the predictive search field and selecting the users. Or, search for and select users from the Select A User pop-up. Users must be added to the recipient list one at a time. Note: The users that are available to select are the users that are within your permission constraints.
3. Check the Notify All box to send the email to all users with whom you are currently sharing the list and have previously shared the list. If you do not check the box, then the email is only sent to the users with whom you have just selected to share the list. Note: This option only displays if a list has already been shared.
4. Enter a message in the Share List Message field. This is optional.
5. Click Share to share the list. An email is sent to the users in the shared list. If you included a message, then the message displays in the email. The subject of the email is hard-coded as "I Shared [Name of List] on View People." A link to the shared list is automatically included in the email. Recipients cannot modify the list. Recipients can view the employee profile page of the employees in the list, as well as any succession metrics and the team hierarchy.
Lists can be shared multiple times. Follow the steps above to share the list again.
Once a list is shared, a Shared with icon [image: ] displays on the My Lists page. Hover over the link to view the users with whom the list has been shared.
Remove Shared Users
Remove users with whom you shared the list by clicking the View All link in the pop-up. Then, click the X to the right of the user's name. This removes the shared user from list.
Delete Shared List
If you delete the list, the list is also removed from any users with whom you shared the list.
Employee Cards
Each employee in the list displays on the page. The employee cards can be viewed as small or large.
Small Cards
The following information displays in the small employee cards:
· Photo - Photograph of the employee.
· Name - Name of the employee. 
· [Organizational Unit 1] - Displays if an organizational unit (OU) is configured to display by the administrator in View People Preferences. The OU will be an active OU for the portal.
· [Organizational Unit 2] - Displays if an organizational unit (OU) is configured to display by the administrator in View People Preferences. The OU will be an active OU for the portal.
· Checkbox - Select the employee to add to a list or talent pool. When checked, the employee's thumbnail image displays in the upper-right of the page. The thumbnails update to display the most recently selected employees. Deselecting the checkbox removes the thumbnail, and the employee can only be added to a list or talent pool if the box is checked again.
· Tenure - Tenure displays as a number of years and is calculated from the user's hire date to the current date. Tenure displays in the lower-right corner of the card. 
· Color Bar - Color that displays corresponds to the employee's metric rating for the succession metric that is selected in the Color by filter. If the Color by filter is set, then a color displays on the right side of the card. 
Expand All/Collapse All
[image: ]
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View an expanded version of the cards by clicking the EXPAND ALL option for at the top of the page. All user cards expand.
The data in the expanded card is configured by the administrator in the Employee Cards section of View People Preferences. Administrators can add up to six additional OUs, OU custom fields, User Record custom fields, and Performance and Succession metrics, including any career preferences that are selected in the Career Preferences Attributes section of the preferences page.
 To collapse the cards, click COLLAPSE ALL. Individual user cards cannot be expanded.
Custom Field Availability Note: The custom fields that display are based on a user's availability to view the field and its value. If a user at any point does not meet the availability criteria for a custom field, then the field and value will not appear.
View Employee Profile Page
You can view the employee's profile page by clicking anywhere in the card except for on the remove option. This opens the profile page for the employee. 
[bookmark: _Ref-1660108139][bookmark: concept159]View People Page - Results List Panel
The main section of the View People page displays the results list of employees. The employees display in individual cards from left to right and can be selected to add to a list. The employees that display are the employees that are available for the user to view based on permission constraints and who match the filter criteria that has been applied. Up to 200 employees display.
To access the View People page, go to the associated navigation tab and click View People. The location of the View People link is dependent upon the configuration by the administrator.
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Employee Cards
The employee cards can be viewed as small or large, which provides a better ability to make decisions about which employees you would like to add to a specific list.
Small Cards
The following information displays in the small employee cards:
· Photo - Photograph of the employee.
· Name - Name of the employee. 
· [Organizational Unit 1] - Displays if an organizational unit (OU) is configured to display by the administrator in View People Preferences. The OU will be an active OU for the portal.
· [Organizational Unit 2] - Displays if an organizational unit (OU) is configured to display by the administrator in View People Preferences. The OU will be an active OU for the portal.
· Checkbox - Select the employee to add to a list or talent pool. When checked, the employee's thumbnail image displays in the upper-right of the page. The thumbnails update to display the most recently selected employees. Deselecting the checkbox removes the thumbnail, and the employee can only be added to a list or talent pool if the box is checked again.
· Tenure - Tenure displays as a number of years and is calculated from the user's hire date to the current date. Tenure displays in the lower-right corner of the card. 
· Color Bar - Color that displays corresponds to the employee's metric rating for the succession metric that is selected in the Color by filter. If the Color by filter is set, then a color displays on the right side of the card. 
Expand All/Collapse All
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View an expanded version of the cards by clicking the EXPAND ALL option at the top of the page. All user cards expand.
The data in the expanded card is configured by the administrator in the Employee Cards section of View People Preferences. Administrators can add up to six additional OUs, OU custom fields, User Record custom fields, and Performance and Succession metrics, including any career preferences that are selected in the Career Preferences Attributes section of the preferences page.
 To collapse the cards, click COLLAPSE ALL. Individual user cards cannot be expanded.
Custom Field Availability Note: The custom fields that display are based on a user's availability to view the field and its value. If a user at any point does not meet the availability criteria for a custom field, then the field and value will not appear.
View Employee Profile Page
You can view the employee's profile page by clicking anywhere in the card except for the checkbox. This opens the profile page for the employee. 
[bookmark: _Ref1186345384][bookmark: concept160]View People Page - Selected Page
The Selected page displays only the employees that you selected. From this page, you can apply the filters from the actions bar, as well as add the employees to a list.
To access the View People page, go to the associated navigation tab and click View People. The location of the View People link is dependent upon the configuration by the administrator.
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Add to List
Click Add to List to add people to this display.
Remove All
Click Removal All to deselect all the employees, and then click OK on the confirmation pop-up. which opens a confirmation pop-up. This refreshes the page to display your most recent list of results.
You can also access the employee's profile page by clicking anywhere in the employee's card, except on the Remove icon [image: ].
Small Cards
The following information displays in the small employee cards:
· Photo - Photograph of the employee.
· Name - Employe name.
· [Organizational Unit 1] - Displays if an organizational unit (OU) is configured to display by the administrator in View People Preferences. The OU will be an active OU for the portal.
· [Organizational Unit 2] - Displays if an organizational unit (OU) is configured to display by the administrator in View People Preferences. The OU will be an active OU for the portal.
· Checkbox - Select the employee to add to a list or talent pool. When checked, the employee's thumbnail image displays in the upper-right of the page. The thumbnails update to display the most recently selected employees. Deselecting the checkbox removes the thumbnail, and the employee can only be added to a list or talent pool if the box is checked again.
· Tenure - Displays as a number of years and is calculated from the user's hire date to the current date. The tenure displays in the lower-right corner of the card. 
· Color Bar - Color that displays corresponds to the employee's metric rating for the succession metric that is selected in the Color by filter. If the Color by filter is set, then a color displays on the right side of the card. 
Large Cards
View an expanded version of the cards by clicking the EXPAND ALL option at the top of the page. All user cards will expand.
The data in the expanded card is configured by the administrator in the Employee Cards section of View People Preferences. Administrators can add up to six additional OUs, OU custom fields, User Record custom fields, and Performance and Succession metrics, including any career preferences that are selected in the Career Preferences Attributes section of the preferences page.
 To collapse the cards, click COLLAPSE ALL.
Note: Individual user cards cannot be expanded.
[bookmark: _Ref1191191451][bookmark: _Toc161996231]Workflow Engine
[bookmark: _Toc161996232]Workflow Engine - Create Workflow Process
Workflow Engine is a process orchestration platform that is the foundation for process management across all Cornerstone talent suites and external integrations. It is built using Amazon Web Services and is highly extensible and scalable. 
Workflow Engine is flowchart-based and used to configure and edit workflows. 
Use the following process to create and manage workflows: 
1. Enter/edit the workflow name and description. 
2. Create or edit workflow branching logic to assign activities when criteria is met. 
3. View or edit user or system workflow activities. 
4. Set Triggers to enroll or edit employees in a workflow.
5. Publish workflows.
6. Assign Workflows.
7. Execute Workflows.
· To create a new workflow, go to Admin > Tools > Core Functions > Workflow Management > Workflow Library. Then select the Create Workflow button. 
· To edit a workflow, go to Admin > Tools > Core Functions > Workflow Management > Workflow Library and select the workflow you want to edit. Note: You can only edit workflows in Saved as Draft status.
[bookmark: _Toc161996233]Workflow Engine - Manage Navigation Tabs and Links
The Navigational Tabs & Links page enables administrators to customize which tabs and links are available to users in the system by Division. Administrators can rename or change the order of tabs and links.
To manage Navigation Tabs and Links preferences, go to Admin > Tools > Core Functions > Core Preferences > Navigation Tabs and Links.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Navigation Tabs and Links - Manage
	Grants ability to manage Navigation Tabs and Links for the portal. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration


The following links are available to add to Workflow Engine navigation:
· Workflow Library
· Workflow Executions
· Workflow Bulk Assignment
· Global Workflow Settings
See Navigational Tabs and Links.
[bookmark: _Toc161996234]Workflow Engine - Email Administration
Most of the existing email notifications for forms and approvals are used for Workflow Engine to notify users of actions and assignments.
To create an email, go to Admin > Tools > Core Functions > Email Management. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Email Digest Administration - Manage
	Grants ability to create, edit, view, and delete email digests. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User. The permission constraints determine which email digests the administrator can edit and delete. This is an administrator permission.
	Performance - Administration


The following emails are available for Form Management:
· Form Assigned
· Form Completed
· Form Approval Required
For more information about creating an email, see Email - Create.
[bookmark: _Toc161996235]Workflow Engine - Manage Global Workflow Settings
Use the Global Workflow Settings page to configure settings for newly created workflows. The settings on this page do not apply to workflows created previously. 
To access the Global Workflow Settings page, go to Admin > tools > Core Functions > Workflow Management > Global Workflow Settings. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflows - Global Settings
	Grants access to manage Global Workflow Settings.
	Workflow Engine
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Default Settings for New Workflows
You can configure the following settings:
· Stuck Activity Detection - Enable this option to add Stuck status to In Progress activities that are not completed after a specific number of days. Select the number of days in the Number of days in Progress but not completed drop-down. The Stuck status appears on the Workflow Execution pages. See Workflow Engine - Manage Workflow Execution on page 522 for additional information.
· Activity Reassignment - Enable this option to automatically reassign workflow activities to the user's manager or higher if the assignee is Inactive or On Leave at the time of the assignment. This assignment only applies if the activity is assigned to an Employee Relationship or User. Note: If this option is not enabled, activities can be assigned to users who are inactive or on leave.
[bookmark: _Toc161996236]Workflow Engine - Manage Workflow Library
Use the Workflow Library page to search, view, create, activate/inactivate, edit, copy, and archive workflows. 
Note: Workflows are the processes used to deliver forms. Forms are created in Form Management. See Manage Forms on page 95 for additional information.
To access the Workflow Library, go to Admin > Tools > Core Functions > Workflow Management > Workflow Library.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflow Engine - Workflow Library - Manage
	Grants access to view, edit, and publish workflows in the Workflow Library. This is an administrator permission. 
	Workflow Engine
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Search for Workflows
Use the following fields to search for specific workflows:
· Statuses - Filter workflows by Draft, Active, Inactive, or Archived.
· Sort by - Sort workflows by Updated (Newest), Updated (Oldest), Created (Newest), Created (Oldest)
· Name - Search for workflows by name.
Create Workflow
Click the Create Workflow button to create new workflows. See Workflow Engine - Create Workflow Process on page 500 for additional information.
Workflow Library Table
The Workflow Library table contains the following information:
· Active - Activate or inactivate published workflows. This option does not apply to workflows in Saved as Draft status.
· Name - Name of the workflow.
· Description - Description of the workflow.
· Updated - The date and user who updated this workflow. Also includes the current status of the workflow. Workflow status options are Saved as Draft, Published, or Stuck. 
· Created - When the user created this workflow.
View
Select View to open a read-only version of the workflow details, including the Flowchart, Table view, Settings, Activities, and Triggers for the selected workflow. 
Workflow Options
The following options appear on the Workflow Library page for each workflow:
· Edit - Change Saved as Draft workflows.
· Copy - Copy an existing workflow. 
· Archive - Archive a workflow. Applies to Saved as Draft workflow or Published workflow in inactive status.
Note: If you leave a workflow before it is published, it is automatically saved as draft to the Workflow Library. 
[bookmark: _Ref-969776987][bookmark: _Toc161996237][bookmark: _Ref932805881]Manage Workflows
Workflow Engine - Enter/Edit Workflow Name and Description
Enter a name and description for your workflow. 
· To manage the name and description for your workflow go to Admin > Tools > Core Functions > Workflow Management > Workflow Library.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflow Engine - Workflow Library - Manage
	Grants access to view, edit, and publish workflows in the Workflow Library. This is an administrator permission. 
	Workflow Engine


Create a New Workflow Name and Description
Click the Create Workflow button and enter a name and description. Select the Create button to open the Flowchart page. 
Edit a Workflow Name and Description
Select the ellipsis for a workflow and select Edit. Select Name and Description, and then select Save. You can edit the name and description for Saved as Draft workflows only.
 
 
[bookmark: _Ref-977849098]Workflow Engine - Manage Flowchart Activities 
Use the Table page to manage Flowchart activities. You can view activities, add, edit, and delete activities. 
There are two ways to manage workflows:
· Via Flowchart - The workflow is displayed in a chart view. Each activity is presented as a box and dependencies are shown as lines which are connecting boxes.
· Via Table - The workflow is displayed in a table view. Each row within the table represents an activity and dependencies can be identified in the Next Activity column.
To create a new workflow, click Create on the Create a Workflow page. See Workflow Engine - Enter/Edit Workflow Name and Description on page 507 for additional information.
To edit a Flowchart Activity, go to Admin > Tools > Core Functions > Workflow Management > Workflow Library, select the ellipses for the workflow you want to edit, and click Edit. Note: You can only edit workflows in Saved as Draft status.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflow Engine - Workflow Library - Manage
	Grants access to view, edit, and publish workflows in the Workflow Library. This is an administrator permission. 
	Workflow Engine


Add an Activity to the Flowchart
When creating a Form you can add activities that perform actions related to your Workflow. There are two general activity categories: 
· User Activities - Form Completion and Approval. These activities are assigned to (and completed by) a user. 
· System Activities - If/Then, Split, Merge, Save Data, and End Workflow. The user is not required to take any action to complete these activities. are System Activities.
To add an activity:
1. Select the plus sign. The New Activity panel opens. 
2. Select an activity and complete the fields: 
· Approval - This activity is used to Approve, Deny, or Deny and Return the Form Completion activity in a workflow. This activity can be assigned to:
· Users
· Employee Relationships:
· Self
· Manager
· Cost Center Owner
· Approver
· Indirect Manager
· Organizational Units
·  When added to a workflow the Approval activity allows you to create follow-up activities if approval is Approved or Denied. Complete the following:
a. (optional) Enter a Title and Description. 
b. Review the forms being approved. 
c. Select the Assignee. 
· If/Then - This activity allows you to choose an Organization Unit where you want to route further workflow activities. If a user meets the criteria, they move forward down a specific branch. When added to a workflow the Approval activity allows you to create follow-up activities if users meet the specified criteria. Complete the following:
a. (optional) Add a Title and Description. 
b. Select OUs that determine the activity criteria.
· Form Completion - This activity uses forms from your existing Manage Forms to manage employee data. It can be assign to a User, to one of the following Employee Relationships: 
· Self
· Manager
· Cost Center Owner
· Approver
· Indirect Manager
· Organizational Unit
· Complete the following:
a. Enter a Title. You can enter up to 100 characters.
b.  (optional) Enter a Description. You can enter up to 500 characters.
c. Select the Form to complete.
d. Select the Assignee. 
·  Split Activity/Merge Activity- This activity splits the execution of a workflow into multiple parallel branches containing independent activities. After the Split activity is added to a workflow, and a Form Complete activity added to each branch, use the Merge Activity to join the parallel branches into a single execution path. 
· Save Data /End Workflow - The Save activity is used to save employee data changes in a workflow execution. The End activity is used to identify the end of workflow or workflow branch. This activity signals to the system that a workflow is done. 
3. (optional) Click the Detailed View toggle to view the related form and assignees. 
4. Select the Save button for each activity you create.
 
Edit Flowchart Activities
Use the Activity table to view, add, edit, and delete activities. 
Activity Table
The Activity table displays the following information:
· Activity# - The system-generated activity number.
· Title - The name of the activity.
· Activity Type - The type of activity. 
· Outcome - The outcome of the selected activity. 
· Next Activity - The number of the activity that follows the selected activity. 
Options
The following options appear for each activity:
· Add Activity - Add an activity to the Flowchart. This option is only visible for workflows with no activities.
· Manage - Review or adjust configuration details for current workflow steps. 
· Delete - Delete the selected activity from the workflow.
Workflow Engine - Manage Workflow Settings
Use the Workflow Setting page to change the name and description of your workflow, set the individual Activity Reassignment, and turn-on stuck activity detection. 
· If you are creating a new workflow, this page is accessible once you click Create on the Create a Workflow page. See Workflow Engine - Enter/Edit Workflow Name and Description on page 507 for additional information.
· To manage Workflow Settings, go to Admin > Tools > Core Functions > Workflow Management > Workflow Library, select the ellipses for the workflow flowchart you want to edit, and click Edit. Select the Settings tab. Note: You can only edit workflows in Saved as Draft status.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflow Engine - Workflow Library - Manage
	Grants access to view, edit, and publish workflows in the Workflow Library. This is an administrator permission. 
	Workflow Engine


 Name and Description
Select this page to edit the name and description of the selected workflow.
Activity Reassignment
Select this page to enable or disable activity reassignment:
· Enable the toggle to reassign Inactive or On Leave users to the next Active and Present user in the management hierarchy. 
· Disable the toggle to turn off activity reassignment. If disabled, activities may be assigned to users who are Inactive or On Leave status.
· How many levels up the management hierarchy - Select up to 5 levels.   
Stuck Activity Detection
Enable this option to add Stuck status to In Progress activities that are not completed after a specific number of days. Select the number of days in the Number of days in Progress but not completed drop-down. The Stuck status appears on the Workflow Execution pages. See Workflow Engine - Manage Workflow Execution on page 522 for additional information.
[bookmark: _Ref428064978][bookmark: _Ref-2140149049]Workflow Engine - Manage Workflow Triggers
A Trigger is one or more conditions which, when satisfied, initiates a workflow. Employees are enrolled in a workflow by setting Initiation Triggers. You can manage triggers from any Workflow page. 
To create Workflow Triggers, go to Admin > Tools > Core Functions > Workflow Management > Workflow Library, select the ellipses for the appropriate workflow, and click Edit. Select the Create Triggers button. 
To edit Workflow Triggers, go to Admin > Tools > Core Functions > Workflow Management > Workflow Library, select the ellipses for the appropriate workflow, and click Edit. Select the Create Triggers button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflow Engine - Workflow Library - Manage
	Grants access to view, edit, and publish workflows in the Workflow Library. This is an administrator permission. 
	Workflow Engine


Select one or more of the following Triggers: 
· Employee Self-service - Allows an employee to self-initiate the workflow for themselves as the target. This can be triggered from the Universal Profile’s options dropdown.
· Manager Self-service - Allows a manager to initiate the workflow for their direct and in-direct reports as the target.
· Admin initiated - Allows an authorized user to initiate the workflow for any employee within their line of site, based on permissions and constraints. 
Click Save to save the Triggers. 
[bookmark: _Ref-2121152281]Workflow Engine - Publish Workflows
Once a workflow is configured, you can publish it. If a workflow is not correctly and completely configured, an error message appears and you cannot publish until all errors are corrected. 
Note: If you leave a workflow before it is published, it is automatically saved as draft to the Workflow Library. 
To publish a Workflow, click the Publish button on any Workflow page. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflow Engine - Workflow Library - Manage
	Grants access to view, edit, and publish workflows in the Workflow Library. This is an administrator permission. 
	Workflow Engine
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Workflow Engine - Assign Workflow
Use the Universal Profile page to manually assign workflows. The workflows that a user can select depend on the triggers set when editing or creating the workflow. See Workflow Engine - Manage Workflow Triggers on page 513 for additional information.
To access the Universal Profile page, go to Home > Universal Profile. Click the Actions page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflow Engine - Initiate Workflows
	Grants ability to initiate the first step of a workflow. 
	Workflow Engine


Note: Workflow Engine - Initiate Workflows permission applies to assigning workflows through the Universal Profile. 
Assign Workflow
You can self-assign workflows, assign as a manager, or assign as an administrator. These roles can use one of the following Universal Profile pages to assign workflows:
· Bio
· Feedback
· Actions
· Snapshot
Self assign Workflows
Self-assign workflows with triggers set to employee self-service.
To self-assign workflow:
1. Click the ellipses on the top right corner of the appropriate Universal Profile page and select Initiate Workflow. The Initiate a Workflow page opens to display active workflows with employee self-service triggers.
2. Click Start for the appropriate workflow. Forms and Approval activities within workflows generate Actions and Requests in the corresponding Universal Profile pages.
Assign Workflows as Manager 
Assign workflows as a manager to your subordinates with triggers set to manager self-service.
1. Select the appropriate subordinate. 
2. Click the ellipses on the top right corner of the appropriate Universal Profile page and select Initiate Workflow. The Initiate a Workflow page opens to display active workflows with manager self-service triggers.
3. Click Start for the appropriate workflow. Forms and Approval activities within workflows generate Actions and Requests in the corresponding Universal Profile pages.
Assign Workflows as an Administrator
1. Select the appropriate employee or user. 
2. Click the ellipses on the top right corner of the appropriate Universal Profile page and select Initiate Workflow. The Initiate a Workflow page opens to display active workflows with manager self-service triggers.
3. Click Start for the appropriate workflow. Forms and Approval activities within workflows generate Actions and Requests in the corresponding Universal Profile pages.
Workflow Engine - Workflow Bulk Assignment 
Use bulk assignment functionality to assign pre-configured workflows to a group of users. During assignment, users can define the target user group and the assignment date. 
The following new pages within Workflow Bulk Assignment allows users to manage bulk assignment: 
· Workflows - Schedule bulk workflow assignments.
· Assignments - Edit workflow assignments, review executions, and terminate workflow assignments.
You can perform the following tasks:
· Bulk assign workflows
· Edit workflows
· Review executions
· Terminate workflow assignments
To access the Workflow Assignment Tool, go to Admin > Tools > Core Functions > Workflow Management > Initiate Workflow - Mass Enrollment.
Important: To use bulk assignment, the workflow must be published and have the Manager self-service and/or Admin initiated trigger assigned to it. See Workflow Engine - Create Workflow Process on page 500 for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflow - Mass Enrollment
	Grants access to the mass enrollment functionality. This permission cannot be constrained. 
	Workflow Engine



	Workflow Engine - Workflow Library - Manage
	Grants access to view, edit, and publish workflows in the Workflow Library. This is an administrator permission. 
	Workflow Engine
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[bookmark: 1527491697]To bulk assign workflows:
1. On the Manage Workflow Assignments page, select the Workflows tab. 
2. In the Name field, search for the workflow you want to bulk assign or select a workflow from the table. 
3. Click Bulk Assign. The Schedule Workflow fly-out panel appears: 
· Assignment Date: Select Assign Immediately to assign the workflow right away or Assign to Future Date to select a date in the future.
· Target Users: In the Select drop-down, select a target group type, and then select an option from the related drop-down. The options available in the related drop-downs are based on the target group type you select. Target group types are: 
· Users - Select a user or direct report.
· Organizational Unit (OU) - Select a Standard, Group, or Custom OU. Only enabled when Admin initiated trigger is set. 
4. Click the Schedule button. The assignment occurs based on the selected assignment date to the selected target population. 
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[bookmark: 180372551]To edit, review executions, and terminate workflow assignments: 
1. On the Manage Workflow Assignments page, select the Assignments tab. 
2. Search for workflows using the Sort by and Show Actions by Others options.
· Select an option in the Sort by drop-down to sort by created, updated, or enrollment date.
· Check the Show Actions by Others box to see assignments created by others. 
3. Select the appropriate workflow in the workflow table and select the ellipses for the following options:
· View - Opens the Workflow Bulk Assignment fly-out to view details about the assignment. This option is only available if the assignment is completed.
· Executions - Opens an Executions page that provides additional information about workflow executions, including Target User, Assignment Date, Duration, and Status. You can also view details for an individual workflow and export the executions table to a spreadsheet. This option is only available if the assignment is completed.
· Terminate - Terminate all workflows in the workflow assignment. You cannot undo this action. This option is only available if the assignment is completed and workflows are still in progress.
· Edit - Opens a page to edit assignment details. This option is only available if the assignment is scheduled for a future date. 
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Workflow Engine - Manage Workflow Execution
Use the Workflow Executions page to track the execution of workflows in a portal. You can activate or inactivate an execution, view a list of users enrolled in the workflow, export the workflow records to a spreadsheet, terminate a workflow, and reassign an activity for a user. 
To access the Workflow Executions page, go to Admin > Tools > Core Functions > Workflow Management > Workflow Execution. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflow Executions - Manage
	Grants access to manage Workflow Executions.
	Workflow Engine
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Search for Workflows
Use the following fields to search for specific workflows:
· Sort by - Sort workflows by Updated (Newest), Updated (Oldest), Created (Newest), Created (Oldest)
· Targeted User - Search by the name of the user who is the subject of the workflow, even if they are not assigned any activities.
Workflow Executions Table
The Workflow Executions table contains the following information:
· Active - Shows if the workflow is active or inactive.
· Workflow Name - The name of the workflow.
· Description - The description of the workflow.
· Enrollments - The number of enrollees in a workflow.
· Published - The workflow publish date and who published.
· Updated - The date the workflow was updated an who updated. 
View
Click View to open a workflow record page that displays the user's name, enrollment date, enrollment duration, and user status for users enrolled in the workflow. 
Click  View  on the workflow record page to open the selected user's Workflow Instance page. For the selected user you can view each activity in the workflow, who is assigned to the activity, completion dates, duration, and status of each activity. You can also terminate or reassign an activity for a user.
Export
Click Export to download the workflow records for all workflows to a comma separated value (.csv) file. The following information is downloaded to the .csv file:
· Workflow Name
· Workflow Description
· Target User First Name
· Target User Last Name
· Target User ID
· Workflow Enrollment Date
· Duration Days
· Workflow Status
· Workflow Instance Last Updated
 
 
Workflow Engine - Reassign an Activity
Administrators can use the workflow instance page to reassign an activity. 
Note: You cannot reassign activities in Completed status.
To access a user's workflow instance page, go to Admin > Tools > Core Functions > Workflow Management > Workflow Execution. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflow Executions - Manage
	Grants access to manage Workflow Executions.
	Workflow Engine


To terminate a workflow:
1. On the Workflow Executions page, click View for the workflow assigned to the target user. The page of targeted users enrolled in the workflow opens. 
2. Click View for the appropriate user. The user's workflow instance page opens.
3. Click the ellipses for the appropriate activity, select Reassign, and select the new assignee for the activity. The activity is reassigned to the selected user. 
Workflow Engine - Terminate a Workflow
Administrators can use the workflow instance page to terminate a workflow for a specific user. Once the workflow instance is canceled, further activities in the workflow execution will not be assigned.
Note: You can only terminate In Progress workflows. 
To access a user's workflow instance page, go to Admin > Tools > Core Functions > Workflow Management > Workflow Execution. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Workflow Executions - Manage
	Grants access to manage Workflow Executions.
	Workflow Engine


To terminate a workflow:
1. On the Workflow Executions page, click View for the workflow you want to terminate. The page of targeted users enrolled in the workflow opens. 
2. Click View for the appropriate user. The user's workflow instance page opens.
3. Click the Terminate Workflow button. 
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e-days Absence Management Integration
For organizations using e-days for absence management, the Absence Management Integration allows organizations to provide a seamless experience to their employees via Single Sign-On (SSO). Users can log in to e-days and access and manage their absence balances from within their Cornerstone Universal Profile.
In addition, basic user and organizational unit (OU) information is synchronized from the Cornerstone HR system to e-days user profiles. When a new user or OU is added to the Cornerstone HR system, the user or OU will automatically be added to the organization's e-days system as well. When an existing user or OU is updated in the Cornerstone HR system, the user or OU is updated in the organization's e-days system.
This functionality is only available to organizations using Cornerstone HR.
Considerations
· Data is only sent from Cornerstone to e-days. User record data and OU data is not sent from e-days to Cornerstone if users or OUs are updated or added in e-days.
· Only active OUs and users are synced with e-days. Candidates and inactive users and OUs are not synced.
· OU data is only synced from Cornerstone HR to e-days if the integration is configured to do so and if the OU is active in the portal. In addition, the integration syncs with the portal's default culture.
· A user can only SSO in to e-days from their Universal Profile if their user record has already been established in e-days.
· The system begins syncing users after the integration is enabled.
e-days Absence Management Integration Enablement
To enable the e-days Absence Management integration:
1. Log in to e-days and go to Admin > Users) to navigate to the Users page.
2. Edit the Admin account.
3. Select the Roles tab.
4. In the Account Type field, select Api Client.
5. Note the Client ID and Client Secret. These values will be needed when configuring the integration. Note: The Client Secret is displayed only once. If a new Client Secret is regenerated, the old one is no longer valid. 
6. Log in to your Cornerstone portal and go to(Admin > Tools > Edge > Marketplace) to navigate to Open the Edge Marketplace .
7. Search for and install the e-days Absence Management Integration.
8. Review the terms and agreements and select the checkbox. 
9. Select Install then select Configure Now. The Settings page opens. 
10. Go to Admin > Tools > Edge > Integrations to activate the integration via Edge Integrate.
11. Complete the following fields: 
· Client ID - Enter your e-days Client ID. This is provided by your e-days implementation team.
· Client Secret - Enter your e-days Client Secret. This is provided by your e-days implementation team.
· e-days portal URL: e-days application URL.
· e-days Assertion Consumer Service URL - This URL is required if using the IdP SSO functionality that comes with this integration. This endpoint will be provided by your e-days implementation team.
· Third Party IdP - Enable the toggle switch if you are using a third party federated IdP SSO provider. Note: Enabling the toggle disables the IdP SSO functionality that comes with this integration.
· If Third Party IdP is enabled, ID to use for SSO User ID - Allows you to define which Cornerstone user identifier should be passed to e-days if "Third Party IdP" is enabled in your portal. Options are User ID, Username, Email Address, and Cornerstone Internal User ID.
· User Filter- Allows you to exclude users from being created/updated in e-days. To define the users to exclude from the sync, select the user custom field from the drop-down. If no selection is made, all users in your Cornerstone portal will be created/updated in e-days. Note the following:
· The drop-down options only include active user custom fields of type checkbox. If made available, the user custom field checkbox is visible on the User Profile page.
· If the checkbox is selected, the user is created/updated in e-days.
· If the checkbox is NOT selected, the user will be excluded from the sync.
· Notification email - Enter the email address(es) where error notifications should be sent. If entering multiple emails, separate each by a comma.
· Standard OU Sync - Allows you to define which standard OUs will be created/updated in e-days as Group types. To add a standard OU, click on the + Add New Standard OU Sync button and select an OU from the Standard OU Type drop-down. The Comment field is optional. The list below is standard OUs supported with this integration:
· Division
· Position
· Grade
· Cost Center
· Location
Note: A backend setting can be enabled to skip the auto setup of authorizers of the integration. This setting gives customers the option to bypass the auto setup step so administrators can log in to e-days and define the authorizers for their users. Open a Global Customer Support (GCS) case to enable the setting.
Manage Absences via e-days
When the e-days Absence Management integration is enabled for a portal, users can quickly log in to their e-days account from within Cornerstone.
To log in to e-days from the Cornerstone portal:
1. Navigate to the Universal Profile. 
2. From the Options drop-down menu, select Absence Management (e-days). 
The user's credentials are passed to e-days and the user is logged in to e-days without having to enter their username and password. There, the user can access and manage their absences within the e-days system.
User Sync with e-days
When the e-days Absence Management integration is enabled for a portal, basic user profile information is synchronized from the Cornerstone HR system to e-days user profiles. When a new user is added to the Cornerstone HR system, the user will automatically be added to the organization's e-days system as well. In addition, when an existing user is updated in the Cornerstone HR system, the user's profile is updated in the organization's e-days system.
To add a new user record, go to Admin > Tools > Core Functions > Users. Then, select the Add User link.
Edit a user's user record in one of the following ways:
· Go to Admin > Tools > Core Functions > Users and select the name of the appropriate user.
· Navigate to the user's Universal Profile. Select the User Record tab from the Universal Profile navigation. Then, select the Edit Record button.
User Sync Fields
The following user fields are synced from Cornerstone to e-days:
· First Name
· Last Name
· Email
· Last Hire Date
· Active Status
· User's manager (as Authoriser in e-days)
· User ID
Please note the following:
· User custom fields are not sent over to e-days as part of this integration. This includes user custom fields created for Rota, Work Schedule, and FTE. 
· User is placed into the appropriate Division, Position, Grade, Cost Center, and Location organizational units (OU) (Group in e-days). This is true only if the OU type is active AND configured to sync on the Settings page.
· The employee's manager is set as the Authoriser in e-days. 
· e-days does not support multiple names/value for different cultures. As part of the integration, Cornerstone will only send names/values based on the portal's default culture.
OU Sync with e-days
When the e-days Absence Management integration is enabled for a portal, basic OU information is synchronized from the Cornerstone HR system to e-days group. When a new OU is added to the Cornerstone HR system, the OU will automatically be added as a group to the organization's e-days system as well. In addition, when an existing OU is updated in the Cornerstone HR system, the OU is updated as a group in the organization's e-days system.
The integration supports both standard and custom OUs. Cornerstone OUs are created as Groups in e-days. The list below shows standard OUs created in e-days:
· Division
· Position
· Grade
· Cost Center
· Location
To create an OU:
1. Go to Admin > Tools > Core Functions > Organizational Units. 
2. Click the Manage Organizational Unit Hierarchy link. 
3. Select the appropriate OU type from the Select Organizational Unit drop-down list. 
4. Click the Add [OU] link (e.g., Add Division, Add Position, Add Location).
· Custom OU Sync: This table allows you to define which custom OUs are created/updated in e-days as Group types.
5. To add a custom OU, click the + Add New Custom OU Sync button and select an OU from the Custom OU Type drop-down. The Comment field is optional.
OU Sync Fields
The following OU fields are synced from Cornerstone to e-days:
	Cornerstone Field

	OU ID

	OU Name

	OU Creation/Modification


Sync Error Handling
If the e-days Absence Management integration is enabled and an error occurs when the Cornerstone HR system submits a user record or OU to the e-days system for synchronization, the Cornerstone HR system generates an email to the e-days integration email address. This email contains the error messages that were indicated by e-days. The email address to which these error emails are sent is the email address that is configured to receive notification messages in the event of sync failures. 
One failure notification email is generated for each user record or OU that fails to sync.
Implementation
The e-days integration is available to try or purchase via the Edge Marketplace. During this process, the administrator must provide their pre-existing e-days account credentials. To access the Edge Marketplace, go to Admin > Tools > Edge > Marketplace.
This integration is only available to organizations using Cornerstone HR. Organizations must also have an e-days account.
Permissions
The following permissions apply to this functionality:
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Edge Integrations - Manage
	Grants access to the Integrations service for Edge Integrate, where the administrator can configure, enable, and disable their third-party integrations used within the Cornerstone system. This permission cannot be constrained. This is an administrator permission.
	Edge



	Edge Marketplace - Manage
	Grants access to the Marketplace service for Edge Integrate, where the administrator can browse integrations that can be used to extend the Cornerstone system. This permission cannot be constrained. This is an administrator permission.
	Edge
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Employee Record Change Outbound Feed
An Employee Record Change Outbound Feed integration is available in the Edge Marketplace. Once this feed is enabled, administrators can schedule a daily outbound feed of all changes made to the employee master data in the last 24 hours when Cornerstone is the system of record. Feeds are available in the CSV - comma and pipe delimited formats.
Install Feed
To access the Employee Record Change Outbound Feed tile, go to ADMIN > TOOLS > EDGE > MARKETPLACE and search for "Employee Record Change Outbound Feed". Click the tile, and then click Install.
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Once installed, the Edge Integrations page opens so that you can select the settings for your outbound feed. For specific information about each field, click Setup Instructions. Once you are done, click Save Settings. Your outbound feed will run at the scheduled time.
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This integration includes the following functionality:
· Daily feeds can only run once a day.
· The first time you run the Employee Record Change Outbound Feed, the file includes all audit records from the last time Effective Dating was enabled. Subsequent runs include all audit records created after the last run, including future dated records and current changes.
· The feed contains 2 types of data files, modification_history and completed_scheduled changes. The Modification history includes all changes made to the employee record including schedule future changes. The completed_scheduled_changes file contains a list of scheduled changes completed since the last feed was delivered.
· Data files can contain up to 1 million rows each, and any data that is over this limit will result in an additional file being added. For example, if the feed file has 2 million rows, 2 files will be created. The files will be named numerically starting at 1, for example for a .csv feed, files are named modification_history_1.csv and modification_history_2.csv. The size of the feed determines how long it takes to complete.
· Data and metadata files are processed and packaged in a zip file that also includes the metadata read.me file and the schema file.
· Feeds are stored in a Cornerstone FTP folder based on the type of feed. Your scheduled daily feeds are delivered to the "/CHR/ODF/employee_record_changes/scheduled" folder. The optional one-time full feeds are delivered to the "/CHR/ODF/employee_record_changes/ondemand" folder. To access the files, users need valid credentials and permission, and an FTP viewer, such as Filezilla. Files are retained for a maximum of 21 days before they are automatically removed from the FTP folder.
· The data feed is limited to employee user records. All Standard Identifiable Information fields (i.e. date of birth, SSN) are excluded from the feed.
· The table header for the data feed output file is not localized. The localized values and details are provided in an accompanying file.
· If multiple administrators make changes to the configuration page, only the latest changes are observed.
· An administrator can run a one-time full feed on-demand. A full feed may be necessary to sync changes, or to add a new application that requires employee data.
Stop or Pause a Feed
If you need to stop or pause a feed, go to ADMIN > TOOLS > EDGE > Integration, locate "Employee Record Change Outbound Feed", and toggle the on/off button. 
How Does This Enhancement Benefit My Organization?
This integration allows Cornerstone HR clients to effortlessly update downstream systems when employee data changes, eliminating the need to run and export multiple reports or manually import changes.
Implementation
· This functionality is available for all CHR clients who have access to the Edge Marketplace. Enable the data feed in the Edge Marketplace and configure and manage the feed in the Edge Integration Center.
· It is recommended that you implement this integration in your test environment before you implement it in your production environment.
Permissions
The following existing permissions apply to this functionality:
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Edge Marketplace - Manage
	Grants access to the Marketplace service for Edge Integrate, where the administrator can browse integrations that can be used to extend the Cornerstone system. This permission cannot be constrained. This is an administrator permission.
	Edge



	Edge Integrations - Manage
	Grants access to the Integrations service for Edge Integrate, where the administrator can configure, enable, and disable their third-party integrations used within the Cornerstone system. This permission cannot be constrained. This is an administrator permission.
	Edge



	Users – Effective Dating: Manage
	Enables administrator to make effective dated changes to the user record. This permission only works when used in conjunction with the Users - Edit General Information permission. This permission cannot be constrained. This is an administrator permission.
	Core Administration


[bookmark: _Toc161996243]Time & Attendance Integrations - Overview
UKG Ready™ Time & Attendance Integration
The UKG Ready™ Time & Attendance Integration integration allows organizations to provide a seamless experience to their employees via Single Sign-On (SSO). Simply setup an outbound data feed from your Cornerstone portal to UKG Ready™ and enable this integration to allow your employees to log in to UKG Ready™ and access their time and attendance information from within their Cornerstone Universal Profile.
In addition, basic user profile information and organizational unit (OU) data is synchronized from the Cornerstone HR system to UKG Ready™. When a new user or OU is added to the Cornerstone HR system, the user or OU is automatically be added to the organization's UKG Ready™ system as well. In addition, when an existing OU or user is updated in the Cornerstone HR system, the OU or user's profile is updated in the organization's UKG Ready™ system.
This functionality is only available to organizations using Cornerstone HR.
User Sync Field Mapping
The following fields are synced from Cornerstone to UKG Ready™:
	Cornerstone Field
	UKG Ready™ Field

	Username
	Username (required)

	User ID
	Employee ID

	GUID
	External ID

	First Name
	First Name (required)

	Middle Name
	Middle Name

	Last Name
	Last Name (required)

	SSN
	SSN

	Email
	Primary Email

	Home Phone
	Home Phone

	Country
	Country

	Address Line 1
	Address Line 1

	Address Line 2
	Address Line 2

	City
	City

	State
	State

	Zip Code
	Postal Code

	Last Hire Date
	Date Hired (required)

	Division
	Cost Center Trees (mapping based on value provided in integration setup)

	Position
	Cost Center Trees (mapping based on value provided in integration setup)

	Cost Center
	Cost Center Trees (mapping based on value provided in integration setup)

	Grade
	Cost Center Trees (mapping based on value provided in integration setup)

	Location
	Cost Center Trees (mapping based on value provided in integration setup)

	Manager ID
	Manager Information (mapping based on value provided in integration setup)


Considerations
· The integration does not sync from UKG Ready™ to Cornerstone HR, meaning that if a user is added or updated in UKG Ready™, these users are not added or updated in Cornerstone HR.
· The system begins syncing OUs and users after the integration is enabled. Any existing Cornerstone HR users must be added in bulk via the UKG Ready™ solution. User data sync between UKG Ready™ and Cornerstone is not real-time because it uses the outbound or inbound data feed.
· Cornerstone HR does not share any Sensitive Personally Identifiable Information (SPII) with UKG Ready™. Sensitive Personally Identifiable Information (SPII) fields cannot be included in a data load feed. Only manual data loads are supported.
· User record custom fields in Cornerstone cannot be shared with UKG Ready™ with this integration.
· Custom fields on the OU are not currently shared with UKG Ready™.
· Custom OUs are not currently shared with UKG Ready™.
Implementation
To enable the UKG Ready™ Time & Attendance Integration, contact your Account Manager. During the configuration process, the administrator must provide their pre-existing UKG Ready™ account credentials. To access the Edge Marketplace, go to Admin > Tools > Edge > Marketplace.
This integration is only available to organizations using Cornerstone HR. Organizations must also have a UKG Ready™ account. Also, this integration requires that organizations have purchased and configured an outbound or inbound data feed. In order to purchase a data feed, please contact your Sales or Client Executive.
Security
The following existing permissions apply to this functionality:
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Edge Integrations - Manage
	Grants access to the Integrations service for Edge Integrate, where the administrator can configure, enable, and disable their third-party integrations used within the Cornerstone system. This permission cannot be constrained. This is an administrator permission.
	Edge



	Edge Marketplace - Manage
	Grants access to the Marketplace service for Edge Integrate, where the administrator can browse integrations that can be used to extend the Cornerstone system. This permission cannot be constrained. This is an administrator permission.
	Edge
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Position Management helps organizations organize their workforce more efficiently by defining Positions as unique roles within the organization, categorizing them by Jobs and job-related functions, and structuring them by Organizational Units (OUs). This is achieved by moving from a user-centric structure to a position-centric structure that establishes a new hierarchical framework that streamlines talent processes and reporting. 
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As a part of the Cornerstone HR product suite, Position Management in CSX provides an additional option to define, consolidate and map organizational data structures to meet the next levels of demand and flexibility. 
This is the first building block towards a position-centered foundation that empowers administrators to structure their organization around positions.
Key Features
Position Management's key features are as follows:
· Manage Positions - Manage complex organizational scenarios and simplify recurring changes by using a position-based organizational structure
· Manage Jobs - Collect or group several Positions together in a Job and setup a functional job structure
· Position Hierarchy - Specify the parent Position for each Position and to setup a Position based hierarchy representable in a Company Chart.​
· Multiple assignments - One Employee can be assigned to multiple Positions and one Position can be assigned to multiple employees.
· Organizational Unit Assignments - Manage the Organizational Hierarchy and assign Organization Units to Positions.​
· Identify Vacancies - The new relationship structure between Positions and Employees allows to identify and manage Vacancies.​
· Full Time Equivalent (FTE) Management - The ability to maintain and track the utilization of an Employee or Position to identify over-utilization and under-utilization.
· Effective Date of Assignments - Schedule future changes and keep all historic assignments in the organization. 
Essential Concepts
Position Management applies the following essential concepts:
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· User - An employee in the organization with a unique ID and assigned Positions, referred to as Incumbencies.
·  Each Employee has at least one Position, but can also have several Positions.
· Although an Employee can have multiple incumbencies, they normally have only one Position per Employee.
·  An Employee can be assigned to multiple Positions, but only one primary Position incumbency.
·  A Position can be assigned to multiple Employees, but only one primary Employee (Primary incumbent).
· Reporting Relationships (Manager & Subordinates), general Job information and the Standard Organization Unit assignments are derived from the (primary) Position assignments.
· Position - A role or responsibility in the organization or one specific "seat" with a multilingual title, a unique ID, and an assigned Job.
· Positions in a company are to be filled by individual holders - Employees or Users.
· Although a Position can have multiple incumbents, it normally has only one single incumbent. 
· An Employee can be assigned to multiple Positions, but only one primary Position. 
· A Position can be assigned to multiple Employees, but only one primary Employee. 
· The Position remains, even when the Employee leaves the Position.
· Each Position must be assigned to a Job. It is not possible to assign a Position to multiple Jobs.
· Reporting relationships (Manager & Subordinates) and assignments to different types of Organization Units can be defined for each Position.
· Job - A collection or grouping of multiple Positions with a multilingual title, a unique ID, and may have a collection of Positions assigned to it. 
· The Job describes a number of different Positions which are engaged in similar work.
· A Job is not concrete but rather the basis for the creation of various Positions with similar tasks and characteristics.
· Jobs are used to group several related Positions together so that certain types of information and general characteristics can be defined at the Job level and then inherited by all assigned Positions.
· A Position must always be related to a Job; Jobs serve as the layer for attributes that apply to all associated Positions.
· Employees are not directly assigned to Jobs. The Job information can be pushed to Users through Position assignments.
· A functional structure can be defined for each Job.
· Function - Each Job has an OU assignment with a connection between the Organizational Data and Jobs.
· Assignment to a functional type of Organization Units can be defined for each Job.​
· The Organization Unit memberships of a User are derived from the assigned Jobs of all Position assignments.​
· The Unit Assignment remain, even when a Position changes the Job.​
· Job Unit Assignment can be defined for a Functional organizational hierarchical structure.​
In practice, the Position Management structure appears as follows:
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